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14.4 Lesson: Actualizarea Pâlcurilor de Pădure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
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20.14 Results For Interogări spaţiale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 624
20.15 Results For Construirea Geometriei . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 624
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CHAPTER 1

Curs Introductiv

1.1 Cuvânt înainte

1.1.1 Fundal

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who
want to learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the
South African government and has been a phenomenal success, with people all over the world writing to us to
tell us how they are using the materials to run University Training Courses, teach themselves GIS and so on. The
Gentle Introduction is not a software tutorial, but rather aims to be a generic text (although we used QGIS in all
examples) for someone learning about GIS. There is also the QGIS manual which provides a detailed functional
overview of the QGIS application. However, it is not structured as a tutorial, but rather as a reference guide. At
Linfiniti Consulting CC. we frequently run training courses and have realised that a third resource is needed - one
that leads the reader sequentially through learning the key aspects of QGIS in a trainer-trainee format - which
prompted us to produce this work.

This training manual is intended to provide all the materials needed to run a 5 day course on QGIS, PostgreSQL
and PostGIS. The course is structured with content to suit novice, intermediate and advanced users alike and has
many exercises complete with annotated answers throughout the text.

1.1.2 Licenă

The Free Quantum GIS Training Manual by Linfiniti Consulting CC. is based on an earlier version from Linfiniti
and is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this
license may be available at below.

We have published this QGIS training manual under a liberal license that allows you to freely copy, modify and
redistribute this work. A complete copy of the license is available at the end of this document. In simple terms,
the usage guidelines are as follows:

• You may not represent this work as your own work, or remove any authorship text or credits from this work.

• You may not redistribute this work under more restrictive permissions than those under which it was pro-
vided to you.

• If you add a substantive portion to the work and contribute it back to the project (at least one complete
module) you may add your name to the end of the authors list for this document (which will appear on the
front page)

• If you contribute minor changes and corrections you may add yourself to the contributors list below.

1
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• If you translate this document in its entirety, you may add your name to the authors list in the form “Trans-
lated by Joe Bloggs”.

• If you sponsor a module or lesson, you may request the author to include an acknowledgement in the
beginning of each lesson contributed, e.g.:

Note: Această lecie a fost sponsorizată de MegaCorp.

• If you are unsure about what you may do under this license, please contact us at office@linfiniti.com and
we will advise you if what you intend doing is acceptable.

• If you publish this work under a self publishing site such as http://lulu.com we request that you donate the
profits to the QGIS project.

• You may not commercialise this work, except with the expressed permission of the authors. To be clear,
by commercialisation we mean that you may not sell for profit, create commercial derivative works (e.g.
selling content for use as articles in a magazine). The exception to this is if all the profits are given to the
QGIS project. You may (and we encourage you to do so) use this work as a text book when conducting
training courses, even if the course itself is commercial in nature. In other words, you are welcome to make
money by running a training course that uses this work as a text book, but you may not profit off the sales
of the book itself - all such profits should be contributed back to QGIS.

1.1.3 Capitole Sponsorizate

This work is by no means a complete treatise on all the things you can do with QGIS and we encourage others
to add new materials to fill any gaps. Linfiniti Consulting CC. can also create additional materials for you as a
commercial service, with the understanding that all such works produced should become part of the core content
and be published under the same license.

1.1.4 Autori

• Rüdiger Thiede (rudi@linfiniti.com) - Rudi a scris materialele de instruire QGIS i pări din materialele
PostGIS.

• Tim Sutton (tim@linfiniti.com) - Tim a supravegheat i îndrumat proiectul, fiind co-autorul părilor de Post-
greSQL i PostGIS. Tim este, de asemenea, autorul temei sfinx, personalizate, folosită pentru acest manual.

• Horst Düster (horst.duester@kappasys.ch ) - Horst este co-autor al părilor de PostgreSQL i PostGIS

• Marcelle Sutton (marcelle@linfiniti.com) - Marcelle s-a ocupat de lectura i consilierea editorială, pe durata
creării acestei lucrări.

1.1.5 Contribuii Individuale

Introduceţi numele dvs. aici!

1.1.6 Sponsori

• Universitatea de Tehnologie din Cape Peninsula

1.1.7 Date

Note: Datele eantion utilizate în manual pot fi descărcate de aici:

Datele eantion care însoesc această resursă sunt disponibile gratuit, i provin din următoarele surse:

• Seturile de date ale Străzilor i Locaiilor de la OpenStreetMap (http://www.openstreetmap.org/)
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• Limitele de proprietate (urbane i rurale), corpurile de apă de la NGI (http://www.ngi.gov.za/)

• SRTM DEM de la CGIAR-CGI (http://srtm.csi.cgiar.org/)

1.1.8 Ultima versiune

Putei obine întotdeauna cea mai recentă versiune a acestui document, parcurgând versiunea online, care este
integrată în site-ul Documentaiei QGIS (http://docs.qgis.org).

Note: Există link-uri către versiunile on-line i PDF ale Documentaiei i ale Manualelor de Instruire.

Tim Sutton, Mai 2012

1.2 Pregătirea Datelor pentru Exerciii

The sample data provided with the Training Manual refers to the town of Swellendam and its surroundings.
Swellendam is located about 2 hours’ east of Cape Town in the Western Cape of South Africa. The dataset
contains feature names in both English and Afrikaans.

Anyone can use this dataset without difficulty, but you may prefer to use data from your own country or home
town. If you choose to do so, your localised data will be used in all lessons from Module 3 to Module 7.2. Later
modules use more complex data sources which may or may not be available for your region.

Note: This process is intended for course conveners, or more experienced QGIS users who wish to create
localised sample data sets for their course. Default data sets are provided with the Training Manual, but you may
follow these instructions if you wish to replace the default data sets.

Note: Datele eantion utilizate în manual pot fi descărcate de aici:
http://qgis.org/downloads/data/training_manual_exercise_data.zip

1.2.1 Try Yourself

Note: These instructions assume you have a good knowledge of QGIS and are not intended to be used as teaching
material.

If you wish to replace the default data set with localised data for your course, this can easily be done with tools
built into QGIS. The region you choose to use should have a good mix of urban and rural areas, containing roads
of differing significance, area boundaries (such as nature reserves or farms) and surface water, such as streams and
rivers.

• Deschidei un nou proiect QGIS

• In the Vector menu dropdown, select OpenStreetMap -> Download Data. You can then manually enter the
co-ordinates of the region you wish to use, or you can use an existing layer to set the co-ordinates.

• Alegei o locaie pentru a salva fiierul .osm rezultat, apoi facei clic pe Ok:

1.2. Pregătirea Datelor pentru Exerciii 3
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• You can then open the .osm file using the Add Vector Layer button. You may need to select All files in the
browser window. Alternatively, you can drag and drop the file into the QGIS window.

• În caseta de dialog care se deschide, selectai toate straturile, cu excepia straturilor other_relations i
multilinestrings.
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This will load four layers into your map which relate to OSM’s naming conventions (you may need to zoom in/out
to see the vector data).

We need to extract the useful data from these layers, rename them and create corresponding shape files:

• First, double-click the multipolygons layer to open the Layer properties dialog.

• In the General tab, click Query Builder to open the Query builder window.

This layer contains three fields whose data we will need to extract for use throughout the Training Manual:

• building

• natural (în mod specific, apă)

• landuse

You can sample the data your region contains in order to see what kind of results your region will yield. If you
find that “landuse” returns no results, then feel free to exclude it.

1.2. Pregătirea Datelor pentru Exerciii 5
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You’ll need to write filter expressions for each field to extract the data we need. We’ll use the “building” field as
an example here:

• Enter the following expression into the text area: building != "NULL" and click Test to see how many
results the query will return. If the number of results is small, you may wish to have a look at the layer’s
Attribute Table to see what data OSM has returned for your region:

• Click Ok and you’ll see that the layer elements which are not buildings have been removed from the map.

Acum, trebuie să salvăm datele rezultate ca fiiere shape, pentru a le utiliza în timpul cursului:

• Facei clic-dreapta pe stratul multipolygons, apoi selectai Save As...

• Make sure the file type is ESRI Shapefile and save the file in your new exercise_data directory,
under a directory called “epsg4326”.

• Make sure No Symbology is selected (we’ll add symbology as part of the course later on).

• De asemenea, putei selecta Add saved file to map.

Once the buildings layer has been added to the map, you can repeat the process for the natural and landuse
fields using the following expressions:

Note: Make sure you clear the previous filter (via the Layer properties dialog) from the multipolygons layer
before proceeding with the next filter expression!
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• natural: “natural = ‘water”’

• landuse: “landuse != ‘NULL”’

Each resulting data set should be saved in the “epsg4326” directory in your new exercise_data directory (i.e.
“water”, “landuse”).

You should then extract and save the following fields from the lines and points layers to their corresponding
directories:

• lines: “highway != ‘NULL”’ to roads, and “waterway != ‘NULL”’ to rivers

• points: “place != ‘NULL”’ to places

Once you have finished extracting the above data, you can remove the multipolygons, lines and points layers.

You should now have a map which looks something like this (the symbology will certainly be very different, but
that is fine):

The important thing is that you have 6 layers matching those shown above and that all those layers have some
data.

The last step is to create a spatiallite file from the landuse layer for use during the course:

• Facei clic-dreapta pe stratul landuse, apoi selectai Save as...

• Select SpatialLite as the format and save the file as landuse under the “epsg4326” directory.

• Clic pe Ok.

• tergei landuse.shp i fiierele sale aferente (dacă au fost create).

1.2.2 Try Yourself Crearea Fiierelor SRTM DEM tiff

For Module 6 (Creating Vector Data) and Module 8 (Rasters), you’ll also need raster images (SRTM DEM) which
cover the region you have selected for your course.

SRTM DEM se poate descărca de la CGIAR-CGI: http://srtm.csi.cgiar.org/

Vei avea nevoie de imagini care acoperă întreaga regiune pe care ai ales să o utilizai.

1.2. Pregătirea Datelor pentru Exerciii 7
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O dată ce ai descărcat fiierele necesar(e), acestea ar trebui să fie salvate în directorul “exercise_data” de sub
“raster/SRTM/”.

In Module 6, Lesson 1.2 shows close-up images of three school sports fields which students are asked to digitize.
You’ll therefore need to reproduce these images using your new SRTM DEM tiff file(s). There is no obligation to
use school sports fields: any three school land-use types can be used (e.g. different school buildings, playgrounds
or car parks).

Pentru referină, imaginile din datele exerciiului sunt:
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1.2.3 Try Yourself Replace Tokens

Having created your localised dataset, the final step is to replace the tokens in the conf.py file so that the
appropriate names will appear in your localised version of the Training Manual.

The tokens you need to replace are as follows:

• majorUrbanName: this defaults to “Swellendam”. Replace with the name of the major town in your
region.

• schoolAreaType1: this defaults to “athletics field”. Replace with the name of the largest school area
type in your region.

• largeLandUseArea: this defaults to “Bontebok National Park”. Replace with the name of a large
landuse polygon in your region.

• srtmFileName: this defaults to srtm_41_19.tif. Replace this with the filename of your SRTM
DEM file.

• localCRS: this defaults to WGS 84 / UTM 34S. You should replace this with the correct CRS for your
region.

1.2. Pregătirea Datelor pentru Exerciii 9
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CHAPTER 2

Module: Interfaa

2.1 Lesson: O Scurtă Introducere

Bine ai venit la cursul nostru! În următoarele zile vă vom arăta cum să utilizai QGIS uor i eficient. Dacă nu suntei
familiarizai cu GIS, vă vom prezenta ce este necesar pentru a vă descurca. Dacă suntei un utilizator experimentat,
vei vedea cum îndeplinete QGIS funciile pe care le atepai de la un program GIS, i multe altele!

În acest modul vom prezenta proiectul QGIS în sine i interfaa cu utilizatorul.

După completarea acestei seciuni vei putea să identificai corect elementele principale ale ecranului în QGIS i să
tii ce face fiecare, i de asemenea să încărcai un fiier shapefile în QGIS.

Warning: Cursul include instruciuni pentru adăugarea, tergerea i modificarea seturilor de date GIS. Am pus
la disponziie seturi de date special pentru acest scop. Înainte de a folosi tehnicile descrise aici pentru datele
voastre, asigurai-vă că avei salvări corespunzătoare!

2.1.1 Cum se utilizează acest tutorial

Orice text care arată astfel se referă la ceva de pe ecran, pe care se poate efectua clic.

Textul :menuselection:‘ care –> arată –> astfel‘ vă ghidează printre meniuri.

This kind of text înseamnă ceva ce putei scrie, cum ar fi o comandă, o cale sau un nume de fiier.

2.1.2 Gradul de dificultate al obiectivelor cursului

Acest curs satisface diverse nivele de experienă a utilizatorilor. În funcie de categoria în care considerai că vă
încadrai vă putei atepta să obinei rezultate diferite. Fiecare categorie conine informaii eseniale pentru urmăatoarea
categorie, deci este important să efectuai toate exerciiile care sunt sub nivelul vostru de experienă.

Nivelul de Bază

În această categorie, cursul presupune că nu avei experienă sau avei o experienă redusă în ce privete cunotinele
teoretice GIS sau operarea unei aplicaii GIS.

Va fi prezentat un fond teoretic limitat pentru a explica scopul unei aciuni pe care o vei executa în aplicaie, dar
accentul este pus pe învaarea prin exerciiu.

La sfâritul cursului vei avea o imagine mai bună despre posibilităile GIS i despre cum să le exploatai prin QGIS.
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Intermediar

În această categorie, se presupune că avei cunotine i experienă în utilizarea cotidiană a GIS.

Urmând instruciunile pentru nivelul de începători vei obine un grad de familiaritate i vei identifica situaiile în care
QGIS se comportă uor diferit faă de alte aplicaii pe care este posibil să le fi utilizat. Vei învăa i cum să folosii
funciile analitice în QGIS.

La finalizarea cursului ar trebui să vă simii confortabil cu utilizarea QGIS pentru toate funciile uzuale ale unui
GIS.

Avansat

În această categorie, se presupune că suntei experimentat cu GIS, avei cunotine i experienă cu bazele de date
spaiale, utilizarea datelor de pe un server distant, posibil scrierea de scripturi analitice etc.

Urmând instruciunile celorlalte două nivele vă vei familiariza cu abordarea interfeei QGIS i vă vei asigura că tii
cum să accesai funciile de bază de care avei nevoie. Vi se va prezenta i utilizarea sistemului de plugin-uri al QGIS,
sistemul de acces la bazele de date i altele.

La finalizarea cursului ar trebui să fii familiarizai cu operaiile uzuale ale QGIS, ca i cu funciile avansate ale
acestuia.

2.1.3 De ce QGIS?

Dei informaiile devin tot mai spaiale, nu există o penurie de instrumente capabile să îndeplinească unele sau toate
funciile GIS obinuite. De ce ar trebui cineva să folosească QGIS în locul unui alt pachet software GIS?

Aici sunt doar câteva din motive:

• Este la fel de bun ca un prânz gratuit. Instalarea i utilizarea programului QGIS nu vă costă bani. Nu există
o taxă iniială sau alta recurentă, nimic.

• Avei libertatea de a decide. Dacă avei nevoie de funcionalităi suplimentare în QGIS, putei face mai mult
decât să sperai că acestea vor fi incluse în următoarea lansare. Avei posibilitatea să sponsorizai dezvoltarea
unei caracteristici, sau să o adăugai singuri, dacă suntei familiarizai cu programarea.

• Se dezvoltă continuu. Pentru că oricine poate adăuga noi facilităi i le poate îmbunătăi pe cele existente,
QGIS nu stă niciodată pe loc. Dezvoltarea unei noi unelte se poate întâmpla pe cât de repede este nevoie de
ea.

• Sunt disponibile un ajutor i o documentaie extensive. Dacă suntei blocai cu ceva, putei apela la documentaia
extinsă, la ali utilizatori de QGIS sau chiar la dezvoltatori.

• Multi-platformă. QGIS poate fi instalat pe MacOS, Windows i Linux.

Acum, că tii avantajele utilizării QGIS, vă putem arăta cum. Prima lecie vă va ghida în crearea unei hări QGIS.

2.2 Lesson: Adăugarea primului dvs. strat

Vom porni aplicaia, i vom crea o hartă de bază, pentru utilizarea în exemple i exerciii.

Scopul acestei lecii: De a începe cu un exemplu de hartă.

Note: Înainte de a începe acest exerciiu, QGIS trebuie să fie instalat pe computer. De asemenea, descărcai fiierul
training_manual_exercise_data.zip din zona de descărcare a datelor QGIS.
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Lansai QGIS cu ajutorul scurtăturii de pe ecran, din meniul de strat, etc., în funcie de modul în care ai efectuat
instalarea.

Note: Capturile de ecran pentru acest curs au fost luate din QGIS 2.0, rulând pe MacOS. În funcie de configuraie,
interfaa dvs. ar putea să apară oarecum diferită. Cu toate acestea, vei avea disponibile aceleai butoane, iar
instruciunile vor funciona pentru orice sistem de operare. Vei avea nevoie de QGIS 2.0 (cea mai recentă versiune
la momentul elaborării acestui material) pentru a utiliza cursul.

Să începem imediat!

2.2.1 Follow Along: Pregătirea unei hări

• Deschidei QGIS. Vei avea o hartă nouă, albă.

• Look for the Add Vector Layer button:

• Facei clic pe el pentru a deschide următoarea casetă de dialog:

• Clic pe butonul Browse, apoi navigai la fiierul exercise_data/epsg4326/roads.shp (din direc-
torul cursului). Cu acest fiier selectat, facei clic pe Open. Vei vedea dialogul original, dar cu calea către fiier
completată. Facei clic pe Open. Acum se vor încărca datele specificate.

Felicitări! Avei o hartă de bază. Acum ar fi un moment bun pentru a vă salva munca.

• Click on the Save As button:

• Salvai harta sub exercise_data/ i denumii-l basic_map.qgs.

Verificai-vă rezultatele

2.2.2 In Conclusion

Ai învăat cum să adăugai un strat i să creai o hartă de bază!
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2.2.3 What’s Next?

Acum v-ai familiarizat cu funcia butonului de Adăugare Strat Vectorial, dar ce putei spune despre toate celelalte?
Cum funcionează această interfaă? Înainte de a ne implica mai mult, haidei să aruncăm o privire bine la aspectul
general al interfeei QGIS. Aceasta este tema leciei următoare.

2.3 Lesson: O Privire de Ansamblu asupra Interfeei

Vom explora interfaa cu utilizatorul QGIS, pentru a vă familiariza cu meniurile, barele de instrumente, canevasul
hării i lista de straturi care formează structura de bază a interfeei.

Scopul acestei lecii: De a înelege noiunile de bază ale interfeei QGIS.

2.3.1 Try Yourself: Noiuni de Bază

Elementele identificate în figura de mai sus sunt:

1. Lista Straturilor/Panoul Navigatorului

2. Bare de instrumente

3. Canevasul hării

4. Bara de Stare

5. Bara Laterală de Instrumente

Lista Straturilor

În lista Straturi, putei vedea o listă, în orice moment, a tuturor straturilor disponibile pentru dvs.

14 Chapter 2. Module: Interfaa



QGIS Training Manual, Release 2.8

Extinderea obiectelor restrânse (făcând clic pe săgeata sau pe simbolul plus de lângă ei) vă va oferi mai multe
informaii despre aspectul stratului actual.

Un clic-dreapta pe un strat vă va oferi un meniu cu o mulime de opiuni suplimentare. Vei folosi unele dintre ele
mult timp de acum înainte, aa că haidei să aruncăm o privire asupra lor!

Versiunile mai noi ale QGIS pot avea o casetă de Control al ordinii de randare dedesubtul Listei straturilor.
Asigurai-vă că este bifată.

Note: Un strat vectorial este un set de date, de obicei, al unui anumit tip de obiect, cum ar fi drumuri, copaci, etc.
Un strat vectorial poate consta fie în puncte, în linii sau poligoane.

Panoul Navigatorului

Browser-ul QGIS este un panou din QGIS care vă permite să navigai cu uurină în baza de date. Putei avea acces la
fiierele vectoriale comune (cum ar fi fiierele shape ESRI sau fiierele MapInfo), baze de date (ex.: PostGIS, Oracle,
Spatialite sau MSSQL Spatial) i conexiuni WMS/WFS. Putei vizualiza, de asemenea datele dvs. GRASS.

Barele de instrumente

Instrumentele dvs. cel mai des utilizate, pot fi transformate în bare de instrumente, pentru a vă facilita accesul.
De exemplu, bara de instrumente a fiierelor vă permite să salvai, să încărcai, să imprimai, i să începei un nou
proiect. Putei personaliza cu uurină interfaa, pentru a vedea doar instrumentele pe care le utilizai cel mai des, prin
adăugarea sau eliminarea barelor de instrumente necesare cu ajutorul meniului Settings → Toolbars.

Chiar dacă acestea nu sunt vizibile în bara de instrumente, toate instrumentele vor rămâne accesibile prin inter-
mediul meniurilor. De exemplu, dacă scoatei bara de instrumente File (care conine butonul Save), putei salva în
continuare harta făcând clic pe meniul Proiect i făcând clic pe Save.

Canevasul Hării

Aici se va afia harta.

Bara de Stare

Vă arată informaii despre harta curentă. De asemenea, vă permite să reglai scara hării, i să vedei coordonatele
cursorului mouse-ului pe hartă.

2.3.2 Try Yourself 1

Încercai să identificai cele patru elemente enumerate pe ecranul dvs., fără a face referire la diagrama de mai sus.
Vedei dacă putei identifica numele i funciile lor. Vă vei familiariza cu aceste elemente, pe măsură ce le vei folosi
în următoarele zile.

Verificai-vă rezultatele
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2.3.3 Try Yourself 2

Încercai să identificai fiecare dintre aceste instrumente pe ecran. Care este scopul lor?

1.

2.

3.

4.

5.

Note: Dacă nici unul dintre aceste instrumente nu este vizibil pe ecran, încercai să activai unele bare de instru-
mente care sunt în prezent ascunse. De asemenea, reinei că, dacă nu există suficient spaiu pe ecran, o bară de
instrumente poate fi redusă prin ascunderea unora dintre instrumentele sale. Putei vedea instrumentele ascunse,
făcând clic pe butonul cu două săgei îndreptate în dreapta, de pe oricare bară de instrumente restrânsă. Putei vedea
un balon cu numele oricărui instrument, prin trecerea un pic a mouse-ului pe deasupra unui instrument.

Verificai-vă rezultatele

2.3.4 What’s Next?

Acum că ai văzut cum funcionează interfaa QGIS, putei utiliza instrumentele disponibile pentru a starta i îmbunătăi
harta! Aceasta este tema leciei următoare.
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CHAPTER 3

Module: Crearea unei Hări de Bază

În acest modul, vei crea o hartă, care va fi folosită mai târziu ca bază pentru demonstraii ulterioare ale funcional-
ităilor QGIS.

3.1 Lesson: Lucrul cu Datele Vectoriale

Datele vectorial sunt fără îndoială cel mai des întâlnit tip de date pe care îl vei întâlni în utilizarea uzuală a GIS.
Descriu informaii geografice sub formă de puncte, care pot fi conectate în linii sau poligoane. Orice obiect într-un
set de date vectoriale este denumit o entitate i este asociat cu datele care descriu acea entitate.

Scopul acestei lecii: De a învăa despre structura datelor vectoriale, i cum să încărcăm seturile de date vectoriale
într-o hartă.

3.1.1 Follow Along: Vizualizarea Atributelor Straturilor

De asemenea, este important de tiut că datele cu care lucrai nu reprezintă doar locul “unde” se află obiectele în
spaiu, dar vă spun i ce sunt acele obiecte.

Din exerciiul precedent, ar trebui să avei stratul încărcat în harta dvs. Ceea ce putei vedea chiar acum este doar
poziia drumurilor.

Pentru a vedea toate datele disponibile, selectând stratul roads din panoul Straturi:

• Facei clic pe acest buton:

Vă va prezenta un tabel cu mai multe date pentru stratul roads. Aceste date suplimentare se numesc datele
atributelor. Liniile pe care le vedei pe hartă prezintă unde se află străzile; acestea sunt datele spaiale.

Aceste definiii sunt utilizate în mod obinuit în GIS, aa că este esenial să vi le amintii!

• Acum, putei închide tabelul de atribute.

Datele vectoriale reprezintă entităi în termeni de puncte, linii i poligoane într-un plan de coordonate. Sunt utilizate
uzual pentru a stoca elemente discrete, cum ar fi străzi sau cvartale.

3.1.2 Follow Along: Încărcarea Datelor Vectoriale din Fiierele Shape

Formatul Shapefile este un format de fiier care vă permite stocarea de date GIS într-un grup de fiiere asociat.
Fiecare strat constă în câteva fiiere cu acelai nume, dar cu tip diferit. Fiierele Shapefile sunt uor de transmis i pot
fi citite de majoritatea aplicaiilor GIS.

Consultai exerciiul introductiv din seciunea anterioară pentru instruciuni despre cum se adaugă straturile vectori-
ale.
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Încărcai seturile de date din harta dvs., urmând aceeai metodă:

• “poziii”

• “apă”

• “râuri”

• “clădiri”

Verificai-vă rezultatele

3.1.3 Follow Along: Încărcarea Datelor Vectoriale dintr-o Bază de Date

Bazele de date vă permit stocarea unui volum mare de date asociate într-un singuri fiier. Este posibil să fii fa-
miliarizat cu un sistem de gestiune a bazelor de date (DBMS) cum ar fi Microsoft Access. Aplicaiile GIS pot
utiliza baze de date. DBMS-uri specifice GIS (cum ar fi PostGIS) au funcii suplimentare, deoarece au nevoie să
manipuleze date spaiale.

• Click on this icon:

(Dacă suntei sigur că nu se vede deloc, verificai dacă bara de instrumente Gestiune Straturi este activată.)

Vei vedea un nou dialog. În acest dialog:

• Clic pe butonul New.

• În acelai folder cu celelalte date, ar trebui să găsii fiierul landuse.sqlite. Selectai-l, apoi facei clic pe De-
schidere.

Vei vedea din nou primul dialog. Observai că în lista de selectare verticală, de deasupra celor trei butoane scrie
acum “land_use.db@...”, urmat de calea către fiierul bazei de date de pe computerul dvs.

• Clic pe butonul Conectare. Ar trebui să vedei acest lucru în caseta anterior goală:
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QGIS Training Manual, Release 2.8

• Clic pe stratul landuse pentru a-l selecta, apoi pe Add

Note: Amintii-vă să salvai des harta! Fiierul hării nu conine direct datele, dar tie care sunt straturile pe care le-ai
încărcat în hartă.

Verificai-vă rezultatele

3.1.4 Follow Along: Reordonarea Straturilor

Straturile din lista de straturi sunt desenate pe hartă într-o anumită ordine. Stratul cel mai jos în listă este desenat
primul, iar stratul de la vârful listei este desenat ultimul. Schimbând ordinea în care sunt prezentate în listă putei
schimba ordinea în care sunt desenate.

Note: În funcie de versiunea QGIS utilizată, este posibil să avei o casetă de selecie cu numele de Control
rendering order sub lista de straturi. Aceasta trebuie să fie bifată (selectată) pentru ca mutarea straturilor în sus
sau în jos în lista de straturi să le aducă în faă sau să le trimită în spate în hartă. Dacă versiunea QGIS nu are
această opiune, atunci este activată implicit i putei ignora această facilitate.

Ordinea în care straturile au fost încărcate în hartă probabil că nu este logică în acest moment. Este posibil ca
stratul de străzi să fie complet ascuns deoarece alte straturi sunt deasupra lui.

De exemplu, această ordine a straturilor...
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... va produce drumuri i locuri ascunse, pe măsură ce acestea rulează dedesubtul zonelor urbane.

Pentru a rezolva această problemă:

• Clic apoi glisai pe un strat din Lista straturilor.

• Reordonai-le, pentru a arăta în felul următor:

Vei vedea că harta are mai mult sens, cu străzile i clădirile desenate deasupra regiunilor.

3.1.5 In Conclusion

Acum, ai adăugat, din mai multe surse diferite, toate straturile de care avei nevoie.

3.1.6 What’s Next?

Utilizând paleta aleatoare asignată automat la încărcarea straturilor, harta curentă este probabil greu lizibilă. Ar fi
de preferat să alegei propriile culori i simboluri. Asta vei învăa să facei în lecia următoare.
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3.2 Lesson: Simbologia

Simbolistica unui strat reprezintă aspectul său vizual pe hartă. Abilităile de bază ale GIS, comparativ cu alte mod-
uri de reprezentare a datelor cu aspecte spaiale, constă în faptul că, în GIS, avei o reprezentare vizuală dinamică a
datelor cu care lucrai.

Prin urmare, aspectul vizual al hării (care depinde de simbolistica straturilor individuale) este foarte important.
Utilizatorul final a hărilor pe care le producei, va trebui să fie capabil de a înelege cu uurină ceea ce reprezintă
harta. La fel de important, dvs. trebuie să fii în măsură să explorai datele cu care lucrai, iar o bună simbolistică
ajută foarte mult.

Cu alte cuvinte, a avea propria simbologie nu reprezintă un lux sau doar o noiune frumoasă. De fapt, este esenial
să utilizai un GIS în mod corespunzător, pentru a produce hări i informaii pe care oamenii să le poată folosi.

Scopul acestei lecii: De a putea crea simbolistica dorită pentru orice strat vectorial.

3.2.1 Follow Along: Schimbarea Culorilor

Pentru a schimba simbolistica unui strat, deschidei Layer Properties. Să începem prin schimbarea culorii stratului
landuse.

• Clic-dreapta pe stratul landuse din Lista straturilor.

• Selectai elementul Properties din meniul care apare.

Note: De asemenea, în mod implicit, putei accesa proprietăile unui strat făcând un dublu clic pe acesta, în lista
Straturilor.

În fereastra Properties:

• Selectai fila Style, din extrema stângă:
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• Clic pe butonul de selectare a culorii, de lângă eticheta Color.

Va apărea un dialog standard pentru culoare.

• Alegei o culoare gri, apoi facei clic pe OK.

• Clic iarăi pe OK din fereastra Layer Properties, apoi vei vedea schimbarea de culoare asupra stratului.

3.2.2 Try Yourself

Alegei pentru stratul water o culoare albastru deschis.

Verificai-vă rezultatele

3.2.3 Follow Along: Schimbă Structura Simbolului

This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we want to eliminate the
lines between the different land use areas so as to make the map less visually cluttered.

• Deschidei fereastra Proprietăilor Stratului pentru stratul landuse.
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Under the Style tab, you will see the same kind of dialog as before. This time, however, you’re doing more than
just quickly changing the color.

• In the Symbol Layers panel, expand the Fill dropdown (if necessary) and select the Simple fill option:

• Clic pe caseta Border style. În momentul de faă, ar trebui să vedei o linie scurtă i cuvintele Solid Line.

• Schimbai-o pe No Pen.

• Clic pe OK

Acum, stratul landuse nu va avea nici o linie între arii.

3.2.4 Try Yourself

• Schimbai iarăi simbolistica stratului water, pentr a avea un contur albastru mai închis.

• Schimbai simbolistica stratului rivers, într-o reprezentare mai sensibilă a căilor de apă

Verificai-vă rezultatele
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3.2.5 Follow Along: Vizibilitate în funcţie de scară

Sometimes you will find that a layer is not suitable for a given scale. For example, a dataset of all the continents
may have low detail, and not be very accurate at street level. When that happens, you want to be able to hide the
dataset at inappropriate scales.

În cazul nostru, am putea decide să ascundem clădirile din vizualizările la scări mici. Această hartă, de exemplu
...

... nu este foarte utilă. Clădirile sunt greu de distins la acea scară.

Pentru a activa randarea în funcţie de scară:

• Deschidei dialogul Proprietăilor Stratului pentru stratul buildings.

• Activai fila General.

• Enable scale-based rendering by clicking on the checkbox labeled Scale dependent visibility:
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• Change the Minimum value to 1:10,000.

• Clic pe OK

Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and
reappears.

Note: You can use your mouse wheel to zoom in increments. Alternatively, use the zoom tools to zoom to a
window:

3.2.6 Follow Along: Adăugarea Straturilor Simbolului

Now that you know how to change simple symbology for layers, the next step is to create more complex symbol-
ogy. QGIS allows you to do this using symbol layers.

• Go back to the landuse layer’s symbol properties panel (by clicking Simple fill in the Symbol layers panel).

In this example, the current symbol has no outline (i.e., it uses the No Pen border style).

Select the Fill in the Symbol layers panel. Then click the Add symbol layer button:
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• Facei clic pe el, apoi dialogul se va schimba, arătând oarecum ca aceasta:
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(Poate apărea, oarecum, în culori diferite, dar ne vom ocupa curând de acest aspect.)

Now there’s a second symbol layer. Being a solid color, it will of course completely hide the previous kind of
symbol. Plus, it has a Solid Line border style, which we don’t want. Clearly this symbol has to be changed.

Note: It’s important not to get confused between a map layer and a symbol layer. A map layer is a vector (or
raster) that has been loaded into the map. A symbol layer is part of the symbol used to represent a map layer. This
course will usually refer to a map layer as just a layer, but a symbol layer will always be called a symbol layer, to
prevent confusion.

Având noul strat Simple Fill selectat:

• Setai stilul bordurii la No Pen, ca mai înainte.

• Change the fill style to something other than Solid or No brush. For example:
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• Click OK. Now you can see your results and tweak them as needed.

You can even add multiple extra symbol layers and create a kind of texture for your layer that way.
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It’s fun! But it probably has too many colors to use in a real map...

3.2.7 Try Yourself

• Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer
using the methods above.

Verificai-vă rezultatele

3.2.8 Follow Along: Ordonarea Nivelurilor Simbolului

When symbol layers are rendered, they are also rendered in a sequence, similar to the way the different map layers
are rendered. This means that in some cases, having many symbol layers in one symbol can cause unexpected
results.

• Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).

• Give the base line a Pen width of 0.3, a white color and select Dashed Line from the Pen Style dropdown.

• Give the new, uppermost layer a thickness of 1.3 and ensure that it is a Solid Line.

Vei observa că se întâmplă acest lucru:
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Ei bine, asta nu e ceea ce ne dorim, deloc!

To prevent this from happening, you can sort the symbol levels and thereby control the order in which the different
symbol layers are rendered.

To change the order of the symbol layers, select the Line layer in the Symbol layers panel, then click Advanced ->
Symbol levels... in the bottom right-hand corner of the window. This will open a dialog like this:
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Select Enable symbol levels. You can then set the layer ordering of each symbol by entering the corresponding
level number. 0 is the bottom layer.

În cazul nostru, vrem să inversăm ordinea, în acest fel:
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Acest render va desena punctată, linia albă de deasupra liniei groase i negre.

• Facei clic pe Ok pentru a reveni la hartă.

Harta va arăta acum în modul următor:
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Also note that the meeting points of roads are now “merged”, so that one road is not rendered above another.

When you’re done, remember to save the symbol itself so as not to lose your work if you change the symbol again
in the future. You can save your current symbol style by clicking the Save Style ... button under the Style tab of
the Layer Properties dialog. Generally, you should save as QGIS Layer Style File.

Save your style under exercise_data/styles. You can load a previously saved style at any time by clicking
the Load Style ... button. Before you change a style, keep in mind that any unsaved style you are replacing will be
lost.

3.2.9 Try Yourself

• Schimbai iarăi aspectul stratului roads.

The roads must be narrow and mid-gray, with a thin, pale yellow outline. Remember that you may need to change
the layer rendering order via the Advanced -> Symbol levels... dialog.
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Verificai-vă rezultatele

3.2.10 Try Yourself

Symbol levels also work for classified layers (i.e., layers having multiple symbols). Since we haven’t covered
classification yet, you will work with some rudimentary pre-classified data.

• Creai o nouă hartă i adăugai doar setul de date roads.

• Aplicai stilul advanced_levels_demo.qml furnizat în exercise_data/styles.

• Focalizai în aria Swellendam.

• Using symbol layers, ensure that the outlines of layers flow into one another as per the image below:

34 Chapter 3. Module: Crearea unei Hări de Bază
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Verificai-vă rezultatele

3.2.11 Follow Along: Tipurile de straturi ale simbolului

In addition to setting fill colors and using predefined patterns, you can use different symbol layer types entirely.
The only type we’ve been using up to now was the Simple Fill type. The more advanced symbol layer types allow
you to customize your symbols even further.

Each type of vector (point, line and polygon) has its own set of symbol layer types. First we will look at the types
available for points.

Tipurile de Straturi pentru Simbolurile de tip Punct

• Deschidei proiectul dvs. basic_map.

• Modificai proprietăile simbolului pentru stratul places:
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• You can access the various symbol layer types by selecting the Simple marker layer in the Symbol layers
panel, then click the Symbol layer type dropdown:

• Investigate the various options available to you, and choose a symbol with styling you think is appropriate.
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• If in doubt, use a round Simple marker with a white border and pale green fill, with a size of 3,00 and an
Outline width of 0.5.

Tipurile de Straturi pentru Simbolurile de tip Linie

Pentru a vedea diferitele opiuni disponibile pentru datele de tip linie:

• Change the symbol layer type for the roads layer’s topmost symbol layer to Marker line:

• Select the Simple marker layer in the Symbol layers panel. Change the symbol properties to match this
dialog:
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• Schimbai intervalul la 1,00:

38 Chapter 3. Module: Crearea unei Hări de Bază



QGIS Training Manual, Release 2.8

• Ensure that the symbol levels are correct (via the Advanced -> Symbol levels dialog we used earlier) before
applying the style.

Once you have applied the style, take a look at its results on the map. As you can see, these symbols change
direction along with the road but don’t always bend along with it. This is useful for some purposes, but not for
others. If you prefer, you can change the symbol layer in question back to the way it was before.

Tipurile de Straturi pentru Simbolurile de tip Poligon

Pentru a vedea diferitele opiuni disponibile pentru datele poligonale:

• Schimbai tipul stratului simbol pentru stratul water, ca i mai înainte, în cazul celorlalte straturi.

• Investigai ce pot face diferitele opiuni din listă.

• Alegei una dintre ele, pe care o găsii potrivită.

• Dacă avei îndoieli, utilizai Umplere cu model din puncte, având următoarele opiuni:
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• Adăugai un nou strat simbol, cu o Umplere simplă, normală.

• Facei-l în acelai albastru deschis, cu un chenar albastru mai închis.

• Mutai-l sub stratul simbol cu modelul din puncte, cu ajutorul butonului Move down:
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As a result, you have a textured symbol for the water layer, with the added benefit that you can change the size,
shape and distance of the individual dots that make up the texture.

3.2.12 Try Yourself Crearea unei Umpleri pentru SVG Personalizată

Note: Pentru a face acest exerciiu, va trebui să avei instalat soft-ul gratuit de editare vectorială Inkscape.

• Lansai Programul Inkscape.

Vei vedea interfaa de mai jos:
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Ar trebui să vi se pară familiar dacă ai folosit alte programe de editare a imaginilor vectoriale, cum ar fi Corel.

În primul rând, vom schimba canevasul la o dimensiune adecvată pentru o mică textură.

• Click on the menu item File → Document Properties. This will give you the Document Properties dialog.

• Schimbai Unităile în px.

• Schimbai Lăimea i Înălimea la 100.

• Închidei dialogul, după încheiere.

• Facei clic pe elementul de meniu View → Zoom → Page pentru a vedea pagina la care lucrai.

• Selectai instrumentul Circle:
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• Click and drag on the page to draw an ellipse. To make the ellipse turn into a circle, hold the ctrl button
while you’re drawing it.

• Clic-dreapta pe cercul pe care tocmai l-ai creat, apoi deschidei Fill and Stroke:

• Change the Stroke paint to a pale grey-blue and the Stroke style to a darker color with thin stroke:
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• Desenai o linie folosind instrumentul Line:

• Facei clic o dată pentru a începe linia. Reinei apăsată tasta ctrl pentru o acroare în trepte de 15 grade.

• Facei clic o dată pentru a termina segmentul de linie, apoi facei clic-dreapta pentru a finaliza linia.

• Change its color and width to match the circle’s stroke and move it around as necessary, so that you end up
with a symbol like this one:
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• Save it as landuse_symbol under the directory that the course is in, under exercise_data/symbols,
as an SVG file.

În QGIS:

• Deschidei dialogul Proprietăilor Stratului pentru stratul landuse.

• Change the symbol structure to the following and find your SVG image via the Browse button:

46 Chapter 3. Module: Crearea unei Hări de Bază
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De asemenea, ai putea dori să actualizai marginea stratului svg:
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Stratul de folosină a terenului ar trebui să aibă acum o textură ca aceea de pe această hartă:
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3.2.13 In Conclusion

Changing the symbology for the different layers has transformed a collection of vector files into a legible map.
Not only can you see what’s happening, it’s even nice to look at!

3.2.14 Further Reading

Exemple de Hări Aspectuoase

3.2.15 What’s Next?

Changing symbols for whole layers is useful, but the information contained within each layer is not yet available
to someone reading these maps. What are the streets called? Which administrative regions do certain areas belong
to? What are the relative surface areas of the farms? All of this information is still hidden. The next lesson will
explain how to represent this data on your map.

Note: V-ai amintit recent să efectuai o salvare a hării?
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CHAPTER 4

Module: Clasificarea Datelor Vectoriale

Clasificarea datelor vectoriale vă permite să atribuii diferite simboluri entităilor (diverse obiecte din acelai strat),
în funcie de atributele lor. Acest lucru permite celui care folosete harta, să vadă cu uurină atributele feluritelor
entităi.

4.1 Atributele Datelor Lesson:

Până în prezent, nici una dintre schimbările pe care le-am adus hării nu au fost influenate de obiectele afiate. Cu
alte cuvinte, toate zonele de utilizare a terenurilor i toate drumurile arată la fel. Atunci când văd o hartă, privitorii
nu tiu nimic despre drumurile pe care le observă; doar faptul că există un drum de o anumită formă, într-o anumită
zonă.

Adevărata putere a GIS-ului constă în faptul că toate obiectele care sunt vizibile pe harta au, la rândul lor, atribute.
Hările dintr-un GIS nu sunt doar imagini. Ele reprezintă nu numai obiectele din locaii, dar, ci i informaii despre
aceste obiecte.

Scopul acestei lecii: De a explora datele atributelor unui obiect i de a înelege la ce poate fi utilă această varietate
de date.

4.1.1 Atributele Datelor Lesson:

Deschidei tabela de atribute pentru stratul places (v. seciunea ‘’Lucrul cu Date Vectoriale’‘, dacă este necesar).
Care câmp ar fi cel mai util pentru reprezentarea sub formă de etichetă, i de ce?

Verificai-vă rezultatele

4.1.2 In Conclusion

Acum tii cum să folosii tabelul de atribute pentru a vedea ceea ce se află, de fapt, în datele pe care îl utilizai. Orice
set de date va fi util pentru dvs. numai dacă are atributele care vă interesează. Dacă tii de care atribute avei nevoie,
putei decide rapid dacă putei utiliza un anumit set de date, sau dacă trebuie să căutai un altul care are datele cerute.

4.1.3 What’s Next?

Diferite atribute sunt utile pentru diferite scopuri. Unele dintre ele pot fi reprezentate direct sub formă de text,
pentru ca utilizatorul sa le poată vedea. Vei afla cum să facei acest lucru în lecia următoare.
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4.2 Lesson: Instrumentul Etichetă

Labels can be added to a map to show any information about an object. Any vector layer can have labels associated
with it. These labels rely on the attribute data of a layer for their content.

Note: The Layer Properties dialog does have a Labels tab, which now offers the same functionality, but for this
example we’ll use the Label tool, accessed via a toolbar button.

Scopul acestei lecii: De a aplica etichete folositoare i plăcute unui strat.

4.2.1 Follow Along: Folosirea Etichetelor

Înainte de a putea accesa instrumentul Etichetă, va trebui să vă asigurai că acesta a fost activat.

• Mergei la elementul de meniu View → Toolbars.

• Asigurai-vă că elementul Label are o bifă alături. În caz contrar, facei clic pe elementul Label pentru a-l
activa.

• Clic pe stratul places din Lista straturilor, astfel încât acesta să fie evideniat.

• Click on the following toolbar button:

Acesta va deschide dialogul Setărilor pentru etichetarea stratului.

• Clic pe caseta Label this layer with....

You’ll need to choose which field in the attributes will be used for the labels. In the previous lesson, you decided
that the NAME field was the most suitable one for this purpose.

• Selectai numele din listă:

52 Chapter 4. Module: Clasificarea Datelor Vectoriale



QGIS Training Manual, Release 2.8

• Clic pe OK

Etichetele hării ar trebui să arate astfel:
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4.2.2 Follow Along: Opiunile de Schimbare a Etichetelor

În funcie de stilurile alese pentru harta dvs. din leciile anterioare, e posibil să descoperii că etichetele nu sunt
formatate corespunzător i, fie se suprapun, fie nu sunt prea departe de simbolurile lor de tip punct.

• Deschidei din nou Instrumentul de Etichetare, făcând clic pe butonul său, ca i mai înainte.

• Make sure Text is selected in the left-hand options list, then update the text formatting options to match
those shown here:
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That’s the font problem solved! Now let’s look at the problem of the labels overlapping the points, but before we
do that, let’s take a look at the Buffer option.

• Deschidei dialogul Instrumentului etichetă.

• Selectai Tamponul din lista opiunilor enumerate în stânga.

• Select the checkbox next to Draw text buffer, then choose options to match those shown here:
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• Clic pe Aplicare.

You’ll see that this adds a colored buffer or border to the place labels, making them easier to pick out on the map:
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Now we can address the positioning of the labels in relation to their point markers.

• In the Label tool dialog, go to the Placement tab.

• Change the value of Distance to 2mm and make sure that Around point is selected:
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• Clic pe Aplicare.

You’ll see that the labels are no longer overlapping their point markers.

4.2.3 Follow Along: Using Labels Instead of Layer Symbology

In many cases, the location of a point doesn’t need to be very specific. For example, most of the points in the
places layer refer to entire towns or suburbs, and the specific point associated with such features is not that specific
on a large scale. In fact, giving a point that is too specific is often confusing for someone reading a map.

To name an example: on a map of the world, the point given for the European Union may be somewhere in Poland,
for instance. To someone reading the map, seeing a point labeled European Union in Poland, it may seem that the
capital of the European Union is therefore in Poland.

So, to prevent this kind of misunderstanding, it’s often useful to deactivate the point symbols and replace them
completely with labels.

In QGIS, you can do this by changing the position of the labels to be rendered directly over the points they refer
to.

• Open the Layer labeling settings dialog for the places layer.

• Select the Placement option from the options list.

• Click on the Offset from point button.
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This will reveal the Quadrant options which you can use to set the position of the label in relation to the point
marker. In this case, we want the label to be centered on the point, so choose the center quadrant:

• Hide the point symbols by editing the layer style as usual, and setting the size of the Ellipse marker width
and height to 0:
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• Click OK and you’ll see this result:
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If you were to zoom out on the map, you would see that some of the labels disappear at larger scales to avoid
overlapping. Sometimes this is what you want when dealing with datasets that have many points, but at other
times you will lose useful information this way. There is another possibility for handling cases like this, which
we’ll cover in a later exercise in this lesson.

4.2.4 Try Yourself Personalizarea Etichetelor

• Return the label and symbol settings to have a point marker and a label offset of 2.00mm. You may like to
adjust the styling of the point marker or labels at this stage.

Verificai-vă rezultatele

• Set the map to the scale 1:100000. You can do this by typing it into the Scale box in the Status Bar.

• Modificai etichetele, pentru a se potrivi vizualizării la această scară.

Verificai-vă rezultatele
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4.2.5 Follow Along: Etichetarea Liniilor

Now that you know how labeling works, there’s an additional problem. Points and polygons are easy to label, but
what about lines? If you label them the same way as the points, your results would look like this:

Vom reformata acum etichetarea stratului roads, astfel încât acestea să fie uor de îneles.

• Ascundei stratul Places, astfel încât el să nu vă deranjeze.

• Activai etichetele din stratul streets, ca i mai înainte.

• Setai Mărimea fontului la 10 astfel încât să putei vedea mai multe etichete.

• Focalizai în aria oraului Swellendam.

• In the Label tool dialog’s Advanced tab, choose the following settings:
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You’ll probably find that the text styling has used default values and the labels are consequently very hard to read.
Set the label text format to have a dark-grey or black Color and a light-yellow buffer.

Harta va arăta aproximativ în modul următor, în funcie de scară:
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You’ll see that some of the road names appear more than once and that’s not always necessary. To prevent this
from happening:

• In the Label labelling settings dialog, choose the Rendering option and select the Merge connected lines to
avoid duplicate labels:
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• Clic pe OK

Another useful function is to prevent labels being drawn for features too short to be of notice.

• In the same Rendering panel, set the value of Suppress labeling of features smaller than ... to 5mm and note
the results when you click Apply.

Try out different Placement settings as well. As we’ve seen before, the horizontal option is not a good idea in this
case, so let’s try the curved option instead.

• Select the Curved option in the Placement panel of the Layer labeling settings dialog.

Iată rezultatul:
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As you can see, this hides a lot of the labels that were previously visible, because of the difficulty of making some
of them follow twisting street lines and still be legible. You can decide which of these options to use, depending
on what you think seems more useful or what looks better.

4.2.6 Follow Along: Setărilor Definite cu ajutorul Datelor

• Dezactivai etichetele stratului Streets.

• Rezactivai etichetele stratului Places.

• Deschidei tabela de atribute a stratului Places, prin intermediul butonului .

It has one fields which is of interest to us now: place which defines the type of urban area for each object. We
can use this data to influence the label styles.

• Navigate to the Text panel in the places Labels panel.

• In the Italic dropdown, select Edit... to open the Expression string builder:
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In the text input, type: "place" = ’town’ and click Ok twice:
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Observai-i efectele:
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4.2.7 Try Yourself Utilizarea Setărilor Definite cu ajutorul Datelor

Note: We’re jumping ahead a bit here to demonstrate some advanced labeling settings. At the advanced level,
it’s assumed that you’ll know what the following means. If you don’t, feel free to leave out this section and come
back later when you’ve covered the requisite materials.

• Deschidei Tabela de Atribute a stratului places.

• Intrai în modul de editare făcând clic pe acest buton:

• Adăugai o nouă coloană:

• Configurai-l astfel:
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QGIS Training Manual, Release 2.8

• Use this to set custom font sizes for each different type of place (i.e., each key in the PLACE field).

Verificai-vă rezultatele

4.2.8 Alte Posibilităi de Etichetare

We can’t cover every option in this course, but be aware that the Label tool has many other useful functions. You
can set scale-based rendering, alter the rendering priority for labels in a layer, and set every label option using
layer attributes. You can even set the rotation, XY position, and other properties of a label (if you have attribute
fields allocated for the purpose), then edit these properties using the tools adjacent to the main Label tool:

(Aceste instrumente vor fi active dacă există câmpurile de atribute obligatorii i vă aflai în modul de editare.)

Simii-vă liberi să explorai mai multe posibilităi ale sistemului de etichetare.

4.2.9 In Conclusion

Ai învăat cum să folosii atributele stratului, pentru a crea în mod dinamic etichetele. Acest lucru poate face harta
mult mai informativă i mai elegantă!
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4.2.10 What’s Next?

Now that you know how attributes can make a visual difference for your map, how about using them to change
the symbology of objects themselves? That’s the topic for the next lesson!

4.3 Lesson: Clasificarea

Labels are a good way to communicate information such as the names of individual places, but they can’t be used
for everything. For example, let’s say that someone wants to know what each landuse area is used for. Using
labels, you’d get this:

Acest lucru face etichetarea hării dificil de îneles, i chiar copleitoare atunci când există suprafee de teren cu
numeroase utilizări.

Scopul acestei lecii: De a afla cum se pot clasifica în mod eficient datele vectoriale.

4.3.1 Follow Along: Clasificarea Datelor Nominale

• Deschidei dialogul Proprietăilor Stratului pentru stratul landuse.

• Mergei la fila Stil.

• Click on the dropdown that says Single Symbol and change it to Categorized:
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• In the new panel, change the Column to landuse and the Color ramp to Greens.

• Facei clic pe butonul etichetat Classify:
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• Clic pe OK

Vei vedea ceva de genul următor:
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• Click the arrow (or plus sign) next to landuse in the Layer list, you’ll see the categories explained:

Now our landuse polygons are appropriately colored and are classified so that areas with the same land use are the
same color. You may wish to remove the black border from the landuse layer:
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• Deschidei Proprietăile Stratului, mergei la fila Style, apoi selectai Symbol.

• Change the symbol by removing the border from the Simple Fill layer and click OK.

Vei observa că au fost eliminate contururile poligonale ale modurilor de utilizare, lăsând doar noile culori de
umplere pentru fiecare clasificare.

• Dacă dorii, putei schimba culoarea de umplere pentru fiecare zonă de folosină, printr-un dublu-clic pe blocul
de culoare relevant:

Observai că există o categorie necompletată:
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This empty category is used to color any objects which do not have a landuse value defined or which have a NULL
value. It is important to keep this empty category so that areas with a NULL value are still represented on the map.
You may like to change the color to more obviously represent a blank or NULL value.

Amintii-vă să salvai harta dvs. acum, astfel încât să nu pierdei toate modificările greu efectuate!

4.3.2 Try Yourself Mai Multe Clasificări

If you’re only following the basic-level content, use the knowledge you gained above to classify the buildings
layer. Set the categorisation against the building column and use the Spectral color ramp.

Note: Amintii-vă să focusai într-o zonă urbană, pentru a vedea rezultatele.

4.3.3 Follow Along: Raia Clasificării

Există patru tipuri de clasificare: nominal, ordinal, interval i raport.

În clasificarea nominală, categoriile în care sunt clasificate obiectele sunt bazate pe nume; ele nu au nici o ordine.
De exemplu: nume de localităi, coduri de sector, etc.
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În clasificarea ordinală, categoriile sunt aranjate într-o anumită ordine. De exemplu, oraelor lumii li se conferă un
rang. în funcie de importana lor pentru comerul mondial, pentru călătorii, cultură, etc.

În clasificarea de tip interval, numerele sunt poziionate pe o scară cu valori pozitive, negative, i zero. De exemplu:
înălimea peste/sub nivelul mării, temperatura peste/sub punctul de înghe (0 grade Celsius), etc.

În clasificarea de tip raport, cifrele sunt poziionate pe o scară doar cu valori pozitive i zero. De exemplu: temper-
atura peste zero absolut (0 grade Kelvin), distana de la un punct, valoarea lunară medie a traficului pe o anumită
stradă, etc.

In the example above, we used nominal classification to assign each farm to the town that it is administered by.
Now we will use ratio classification to classify the farms by area.

• Save your landuse symbology (if you want to keep it) by clicking on the Save Style ... button in the Style
dialog.

Vom reclasifica stratul, astfel încât clasele existente se vor pierde dacă nu sunt salvate.

• Închidei dialogul Stilului.

• Deschidei Tabela de Atribute a stratului landuse.

Vrem să clasificăm zonele de folosină după dimensiune, dar există o problemă: acestea nu au un câmp de dimen-
siune, aa că vom face unul.

• Introducei modul de editare, făcând clic pe acest buton:

• Adăugai o nouă coloană cu acest buton:

• Configurai dialogul care apare, în felul următor:
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• Clic pe OK

The new field will be added (at the far right of the table; you may need to scroll horizontally to see it). However,
at the moment it is not populated, it just has a lot of NULL values.

Pentru a rezolva această problemă, trebuie să calculăm suprafeele.

• Deschidei calculatorul de câmpuri:

Vei obine acest dialog:
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• Modificai valorile din partea de sus a dialogului pentru a arata ca aceasta:

• În the Lista Funciilor, selectai Geometry → $area:
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• Dublu-clic pe el, astfel încât acesta va apărea în câmpul Expresiei.

• Clic pe OK

Now your AREA field is populated with values (you may need to click the column header to refresh the data). Save
the edits and click Ok.

Note: Aceste zone sunt în grade. Mai târziu, le vom calcula în metri pătrai.

• Deschidei fila Style din dialogul Proprietăilor Stratului.

• Schimbai stilul de clasificare din Categorisit în Gradat.

• Schimbai Coloana în AREA:

• Sub Color ramp, alegei opiunea New color ramp... pentru a obine acest dialog:
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• Alegei Gradient (dacă nu este selectat deja) apoi facei clic pe OK. Vei vedea următoarele:
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You’ll be using this to denote area, with small areas as Color 1 and large areas as Color 2.

• Alegei culori adecvate.

În acest exemplu, rezultatul arată în felul următor:
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• Clic pe OK

• Alegei un nume potrivit pentru noul interval de culoare.

• Clic pe OK, după ce ai completat numele.

Vei vedea ceva de genul următor:
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Lăsai totul aa cum este.

• Clic pe OK:
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4.3.4 Try Yourself Rafinarea Clasificării

• Scăpai de liniile dintre clase.

• Change the values of Mode and Classes until you get a classification that makes sense.

Verificai-vă rezultatele

4.3.5 Follow Along: Clasificarea Bazată pe Reguli

It’s often useful to combine multiple criteria for a classification, but unfortunately normal classification only takes
one attribute into account. That’s where rule-based classification comes in handy.

• Deschidei dialogul Proprietăilor Stratului pentru stratul landuse.

• Mergei la fila Stil tab.

• Schimbai stilul de clasificare pe Bazat pe reguli. Vei obine aa ceva:

4.3. Lesson: Clasificarea 85



QGIS Training Manual, Release 2.8

• Click the Add rule button: .

• Va apărea un nou dialog.

• Clic pe butonul cu cele trei puncte ..., de lângă textul Filter.

• Using the query builder that appears, enter the criterion "landuse" = ’residential’ AND
"name" != ’ |majorUrbanName| ’ , click Ok and choose a pale blue-grey for it and remove the
border:
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• Add a new criterion "landuse" != ’residential’ AND AREA >= 0.00005 and choose a
mid-green color.

• Add another new criterion "name" = ’ |majorUrbanName| ’ and assign it a darker grey-blue color
in order to indicate the town’s importance in the region.

• Facei clic i glisai acest criteriu în partea de sus a listei.

These filters are exclusive, in that they collectively exclude some areas on the map (i.e. those which are smaller
that 0.00005, are not residential and are not ‘Swellendam‘). This means that the excluded polygons take the style
of the default (no filter) category.

We know that the excluded polygons on our map cannot be residential areas, so give the default category a suitable
pale green color.

Dialogul dvs. ar trebui să arate astfel:
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• Aplicai această simbologie.

Harta dvs. va arăta în felul următor:

4.3. Lesson: Clasificarea 89



QGIS Training Manual, Release 2.8

Now you have a map with Swellendam the most prominent residential area and other non-residential areas colored
according to their size.

4.3.6 In Conclusion

Symbology allows us to represent the attributes of a layer in an easy-to-read way. It allows us as well as the map
reader to understand the significance of features, using any relevant attributes that we choose. Depending on the
problems you face, you’ll apply different classification techniques to solve them.

4.3.7 What’s Next?

Now we have a nice-looking map, but how are we going to get it out of QGIS and into a format we can print out,
or make into an image or PDF? That’s the topic of the next lesson!
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Module: Crearea Hărilor

În acest modul, vei învăa cum să utilizai Compozitorul de Hări QGIS pentru a produce hări de calitate, însoite de
toate componentele necesare.

5.1 Lesson: Utilizarea Compozitorului de Hări

Acum, că avei o hartă, trebuie să fii în măsură să o imprimai sau să o exportai într-un document. Aceasta, din
cauză că un fiier de hartă GIS nu este o imagine. Mai degrabă, se salvează starea programului GIS, cu trimiteri
către straturi, etichetele i culorile lor, etc. Însă, pentru cineva care nu are datele sau acelai program GIS (cum ar
fi QGIS), fiierul hării va fi inutil. Din fericire, QGIS poate exporta fiierul hării într-un format pe care computerul
oricui îl poate citi i imprima, dacă avei o imprimantă conectată. Atât exportul cât i imprimarea sunt gestionate
prin intermediul Compozitorului de Hări.

Scopul acestei lecii: Utilizarea Compozitorului de Hări din QGIS la crearea unei hări de bază, cu toate setările
necesare.

5.1.1 Follow Along: Compozitorul de Hări

QGIS vă permite să creai mai multe hări utilizând acelai fiier de hartă. Din acest motiv, există un instrument numit
Managerul de Compoziii.

• Clic pe intrarea de meniu Project → Composer Manager, pentru a deschide acest instrument. Vei vedea
apărând fereastra Managerului de Compoziii.

• Clic pe butonul Adăugare i denumii noua compoziie Swellendam.

• Clic pe OK

• Clic pe butonul Afiare

(Aii putea închide, de asemenea, dialogul i să navigai la un compozitor, prin intermediul meniului File → Print
Composers, aa cum se arată în imaginea de mai jos.)
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Indiferent de ruta aleasă pentru a ajunge acolo, vei vedea acum fereastra Compozitorului de Hări:
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5.1.2 Follow Along: Crearea Hării de Bază

În acest exemplu, compoziia arată deja în modul dorit. Asigurai-vă că i a dvs. arată aa cum ai intenionat.

• În fereastra Print Composer, verificai dacă valorile de sub Composition → Paper and Quality sunt setate în
modul următor:

• Mărimea: A4 (210x297mm)

• Orientarea: Peisaj

• Calitatea: 300dpi

Acum avei aspectul paginii pe care l-ai dorit, dar această pagină este în continuare neagră. Îi lipsete în mod clar o
hartă. Haidei să reparăm asta!

• Click on the Add New Map button:

Cu acest instrument activat, vei putea plasa o hartă pe pagină.

• Facei clic i trasai un dreptunghi pe pagina albă:

Harta va apărea pe pagină.

• Deplasai harta făcând clic i micând-o după dorină:
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• Redimensionai-o, efectuând clic i trăgând de coluri:

Note: Harta poate să prezinte un lot diferit, desigur! Acest lucru depinde de modul în care este configurat propriul
proiect. Dar nu vă facei griji! Aceste instruciuni sunt generale, astfel încât ele vor lucra la fel, indiferent de ceea
ce se afiează pe hartă.

• Asigurai-vă că lăsai marginile în jurul conturului, i un spaiu în partea de sus pentru titlu.

• Mării i micorai pagina (dar nu i harta!) folosind aceste butoane:
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• Zoom and pan the map in the main QGIS window. You can also pan the map using the Move item content

tool:

Când are loc o mărire, harta nu se va actualiza de la sine. Acest mod de lucru are loc pentru ca dvs. să nu pierdei
timpul cu redesenarea hării în timpul măririi, dar aceasta înseamnă, de asemenea, că la mărire sau micorare harta
va fi prezentată la rezoluia greită i va arăta urât, sau va fi imposibil de citit.

• Forai harta să se actualizeze, făcând clic pe acest buton:

Amintii-vă că dimensiunea i poziia care le-ai stabilit pentru hartă nu este necesar să fie finale. Putei teveni mereu
înapoi i să re schimbai, dacă nu vă convin. Pentru moment, trebuie să vă asigurai că ai salvat munca efe tuată pentru
această hartă. Deoarece, în GIS, un Compozitor este o parte a fiierului hării principale, trebuie să salvai proiectul
principal. Mergei la fereastra principală a QGIS (cea cu Lista straturilor i toate celelalte elemente familiare la
care ai lucrat înainte), i salvai proiectul dumneavoastră de acolo, ca de obicei.

5.1.3 Follow Along: Adăugarea unui Titlu

Acum harta este arată bine pe pagină, dar privitorilor/utilizatorilor dvs. nu le putei spune ce se întâmplă încă. Ei
au nevoie de context, care este ceea ce le vei oferi, prin adăugarea elementelor de hartă. În primul rând, haidei să
adăugai un titlu.

• Click on this button:

• Facei clic pe pagină, deasupra hării, iar o etichetă va apărea în partea de sus a hării.

• Redimensionai-o i punei-o în partea centrală, de sus, a paginii. Aceasta poate fi redimensionată i mutată în
acelai mod în care se redimensionează i se mută harta.

Pe măsură ce mutai titlul, vei observa că liniile directoare apar pentru a vă ajuta să-l poziionai în centrul paginii.

Cu toate acestea, există, de asemenea, un instrument care va ajuta la poziionarea titlului în raport cu harta (nu
pagina):

• Facei clic pe hartă pentru a o selecta.

• inei apăsată tasta shift i facei clic pe etichetă, astfel încât, atât harta cât i eticheta, să fie selectate.

• Look for the Align button and click on the dropdown arrow next to it to reveal the positioning options
and click Align center:

5.1. Lesson: Utilizarea Compozitorului de Hări 95
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Pentru a vă asigura că aceste elemente nu se mică accidental, o dată ce le-ai aliniat:

• Facei clic dreapta atât pe hartă cât i pe etichetă.

O mică pictogramă de blocare va apărea în col pentru a vă spune că un element nu poate fi glisat. Totui, întotdeauna
putei face clic dreapta pe un element pentru a-l debloca.

Acum eticheta este centrată pe hartă, dar nu i coninutul. Pentru a centra coninutul etichetei:

• Selectai eticheta făcând clic pe ea.

• Clic pe fila Item Properties din panoul lateral al ferestrei Composer.

• Modificai textul etichetei în “Swellendam”:

• Utilizai această interfaă pentru a seta opiunile pentru font i aliniere:

• Alegei un font mare, dar sensibil (exemplul va folosi fontul implicit cu o dimensiune de 36), apoi setai
Alinierea Orizontală pe Centru.

96 Chapter 5. Module: Crearea Hărilor
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De asemenea, putei schimba culoarea fontului, dar probabil că cel mai bine este să-l păstrai negru, aa cum este în
mod implicit.

Setarea implicită nu adăugă un cadru casetei de text a titlului. Cu toate acestea, dacă dorii să adăugai un cadru,
putei proceda astfel:

• În fila Proprietăilor elementului, derulai caseta verticală până vei vedea opiunea Frame.

• Clic pe caseta Frame pentru a activa cadrul. Putei schimba culoarea cadrului i lăimea.

În acest exemplu, nu vom activa rama, aa că aceasta este pagina noastră de până acum:

5.1.4 Follow Along:

Cititorul hării, de asemenea, trebuie să fie capabil să vadă ce înseamnă de fapt diversele lucruri de pe hartă. În
unele cazuri, cum ar fi numele locurilor, acest lucru este destul de evident. În alte cazuri, este mult mai greu de
ghicit, cum ar fi culorile fermelor. Haidei să adăugăm o nouă legendă.

• Click on this button:

• Facei clic pe pagină pentru a plasa legenda, i mutai-o acolo unde dorii:
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5.1.5 Follow Along: Personalizarea Articolelor din Legendă

Nu este chiar totul necesar în legendă, deci, să eliminăm unele elemente nedorite.

• În fila Proprietăilor elementului, vei găsi panoul Legend items.

• Selectai intrarea buildings.

• Delete it from the legend by clicking the minus button:

Putei redenumi, de asemenea, elementele.

• Selectai un strat din aceeai listă.

• Clic pe butonul Edit button:

• Redenumii straturile în Places, Roads and Streets, Surafce Water, i Rivers.

• Setai landuse pe Hidden, apoi facei clic pe săgeata îndreptată în jos i editai fiecare categorie, pentru a le
redenumi ca în legendă. Putei reordona, de asemenea, i elementele:
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Pe măsură ce legenda va fi probabil extinsă cu noile nume de straturi, ai putea dori să mutai i să redimensionai
legenda i/sau harta. Acesta este rezultatul:

5.1.6 Follow Along: Exportarea Hării Dvs.

Note: i-ai amintit să vă salvai munca adesea?

În cele din urmă harta este gata pentru export! Vei vedea butoanele de export lângă colul din stânga sus al ferestrei
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Compozitorului:

Butonul din stânga este cel de Imprimare, care se interfaează cu o imprimantă. Deoarece opiunile de imprimantă
vor diferi în funcie de modelul de imprimantă cu care lucrai, fiind, probabil, mai bine să se consulte manualul
imprimantei, sau un ghid general, pentru mai multe informaii despre acest subiect.

Celelalte trei butoane vă permit să exportai pagina hării într-un fiier. Există trei formate de export din care să putei
alege:

• Exportare ca Imagine

• Exportare ca SVG

• Exportare ca PDF

Exportarea sub formă de imagine vă va oferi o selecie de diferite formate de imagine, comune, din care să putei
alege. Aceasta este, probabil, cea mai simplă opiune, dar imaginea care se creează este “improprie” i greu de
editat.

Celelalte două opiuni sunt mai frecvente.

Dacă trimitei harta unui cartograf (care poate dorii să editeze harta, în scopul publicării), cel mai bine este să-l
exportai ca SVG. SVG vine de la “Scalable Vector Graphic”, i poate fi importat în programe ca Inkscape, sau
într-o altă aplicie de editare a imaginilor vectoriale.

Dacă trebuie să transmitei harta unui client, este cel mai bine să folosii un PDF, pentru că sunt mai uor de configurat
opiunile de imprimare pentru un PDF. i ali cartografi pot prefera PDF la fel de bine, în cazul în care au un program
care le permite importarea i editarea acestui format.

Pentru scopurile noastre, vom folosi PDF.

• Click the Export as PDF button:

• Alegei o locaie pentru salvare i un nume de fiier, ca de obicei.

• Clic pe Salvare.

5.1.7 In Conclusion

• Închidei fereastra Compozitorului.

• Salvai harta dvs.

• Găsii PDF-ul exportat, folosind managerul de fiiere al sistemului de operare.

• Deschidei-l.

• Admirai-l în toată gloria sa!

Felicitări pentru primul dvs. proiect finalizat, de hartă QGIS!

5.1.8 What’s Next?

Pe pagina următoare, vi se va da o misiune de finalizat. Acest lucru vă va permite să practicai tehnicile pe care
le-ai învăat până acum.

5.2 Exerciiul 1

Deschidei proiectul existent al hării i revizuii-l bine. Dacă ai observat mici erori sau lucruri pe care v-ar fi plăcut
să le remediai mai devreme, facei acest lucru acum.
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În timp ce personalizai harta, punei-vă întrebări. Este uor de citit i de îneles aceată hartă pentru cineva care nu
este familiarizat cu datele respective? Dacă ai vedea această hartă pe Internet, pe un poster sau într-o revistă, v-ar
capta atenia? V-ar interesa această hartă în cazul în care nu v-ar aparine?

Dacă urmai acest curs la nivel de Bază sau Intermediar, citii despre tehnici din seciunile mai avansate.
Dacă ai văzut vreun lucru anume care ai dori să apară i în harta dvs., de ce nu încercai să-l punei în aplicare?

Dacă acest curs vă este prezentat, lectorul cursul vă poate cere să prezentai o versiune finală a hării dvs., exportate
în format PDF, pentru evaluare. Dacă urmai acest curs în mod individual, este recomandabil să vă evaluai propria
hartă utilizând aceleai criterii. Harta dvs. va fi evaluată pentru aspectul general i simbolistica proprie, precum i
pentru aspectul i aezarea în pagină a hării i a elementelor. Amintii-vă că, la evaluarea hărilor, accentul se va pune
întotdeauna pe uurina în utilizare. Cu cât este mai frumoasă harta, cu atât este mai uor să o înelegei dintr-o privire.

Personalizare plăcută!

5.2.1 In Conclusion

Primele patru module v-au învăat cum să creai i să stilizai o hartă vectorială. În următoarele patru module, vei
învăa cum să folosii QGIS pentru o analiză completă GIS. Aceasta va include crearea i editarea datelor vectoriale;
analiza lor; utilizarea i analiza datelor raster; i utilizarea GIS pentru a rezolva o problemă de la început până la
sfârit, utilizând atât surse de date raster cât i vectoriale.
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CHAPTER 6

Module: Crearea Datelor Vectoriale

Crearea hărilor folosind datele existente este doar începutul. În acest modul, vei afla cum să modificai datele
vectoriale existente, i cum să creai noi seturi de date.

6.1 Lesson: Crearea unui Nou Set de Date Vectoriale

Datele pe care le utlizai trebuie să vină de undeva. Pentru aplicaiile uzuale, datele există deja; dar cu cât proiectul
este mai aparte i mai specializat, cu atât scad ansele ca datele să fie disponibile. În asemenea cazuri va fi nevoie
să va creai propriile date.

Scopul acestei lecii: De a crea un nou set de date vectoriale.

6.1.1 Follow Along: Dialogul de Creare a unui Strat

Înainte de a adăuga date vectoriale noi vei avea nevoie de un set de date la care să le adăugai. În cazul nostru vei
începe prin a creea date complet noi, mai degrabă decât să editai un set de date existent. În concluzie, va trebui să
începei prin a crea propriul set de date.

Trebuie să deschidei dialogul Noului Strat Vectorial care vă permite definirea unui nou strat.

• Facei clic pe intrarea de meniu Layer → New → New Shapefile Layer.

Vi se va prezenta urmatorul dialog:
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Este important să decidei ce fel de set de date dorii. Fiecare tip de strat vectorial este “construit diferit” în fundal,
deci odată ce ai creat un strat, nu îi putei schimba tipul.

Pentru următorul exerciiu, vom crea noi entităi care descriu zonele. Pentru astfel de entităi, va trebui să creai un
set de date poligonale.

• Clic pe butonul radio Polygon:
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Aceasta nu are nici un impact asupra restului dialogului, dar va determina folosirea tipului corect de geometrie
care să fie utilizat la crearea setului de date vectorial.

Câmpul următor vă permite să specificai Sistemul de Coordonate de Referină, sau CRS. Un CRS specifiă cum se
descrie un punct de pe Pământ ca i cooronate, i pentru că există mai multe moduri de a face asta, există diferite
CRS-uri. CRS-ul pentru acest proiect este WGS84, deci este deja corect de la început:

În continuare exista o colecie de câmpuri grupate sub New attribute. În mod implicit, un strat nou are doar un
atribut, câmpul id (pe care ar trebui să îl vedei în Attributes list). Dar, pentru ca datele creeate să fie utile, vei
avea nevoie să spunei ceva despre caracteristicile pe care le vei crea în acest nou strat. Pentru scopul actual va fi
suficient să adăugai un câmp numit name.

• Reproducei setarea de mai jos, apoi facei clic pe butonul Add to attributes list:

• Verificai dacă dialogul dvs. arată acum astfel:
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• Clic pe OK. Va apărea un dialog de salvare.

• Navigai la directorul exercise_data.

• Salvai noul strat ca i school_property.shp.

Noul strat ar trebui să apară în Lista straturilor dvs.
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6.1.2 Follow Along: Sursele de Date

Când creai date noi, este evident necesar să se refere la obiecte care există întradevăr pe teren. De aceea, va fi
nevoie să obinei informaia de undeva.

Există multe moduri de a obine date despre obiecte. De exemplu, ai putea folosi un GPS pentru a caputra puncte
din lumea reală, după care să importai datele in QGIS. Sau ai putea să identificai punctele folosind un teodolit,
după care să introducei manual coordonatele pentru a crea noi entităi.

Pentru exemplul nostru, vei folosi digitizarea. Eantioanele seturilor de date raster vă sunt puse la dispoziie, aa că
va trebui să le importai după nevoie.

• Click on the Add Raster Layer button:

• Navigai la directorul exercise_data/raster/.

• Selectai fiierul 3420C_2010_327_RGB_LATLNG.tif.

• Facei clic pe Open. O imagine va fi încărcată în harta dvs.

• Căutai noua imagine în Lista straturilor.

• Facei clic i glisai-o în partea de jos a listei, astfel încât să putei vedea în continuare celelalte straturi.

• Găsii i transfocai în această arie:

Note: Dacă simbologia stratului buildings acoperă o parte sau toate straturile raster, putei dezactiva tempo-
rar stratul prin deselectarea lui în Layers panel. Ai putea dori de asemenea să ascundei simbologia roads dacă
considerai că vă distrage.

Vei digitiza aceste trei câmpuri:
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Pentru a începe digitizarea trebuie să intrai în modul editare. Aplicaiile GIS cer asta în mod curent pentru
a preveni modificarea sau tergerea accidentală a datelor importante. Modul editare este activat sau dezactivat
independent pentru fiecare strat.

Pentru a intra în modul de editare, în cazul stratului school_property:

• Facei clic pe stratul din Lista straturilor pentru a-l selecta. (Asigurai-vă că este selectat stratul corect, în caz
contrar vei edita un alt strat!)

• Clic pe butonul Toggle Editing button:

Dacă nu putei găsi acest buton, verificai dacă bara de instrumente Digitizing este activată. Ar trebui să existe un
semn de selectare lângă elementul de meniu View → Toolbars → Digitizing.

De îndată ce vă aflai în modul de editare, vei vedea că instrumentele de digitizare sunt acum active:

Alte patru butoane relevante sunt încă inactive, dar se vor activa atunci când vom începe interaciunea cu noile
noastre date:

De la stânga la dreapta, în bara de instrumente, acestea sunt:
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• Salvare Editare: salvează modificările aduse stratului.

• Adăugare Entităi: începe digitizarea unei noi entităi.

• Deplasează Entităil(e): deplasează o entitate.

• Instrumentul Nod: deplasează doar o parte a unei entităi.

• tergere Selecie: terge entitatea selectată.

• tergere Entitate: terge entitatea selectată.

• Copie Entităile: copie entitatea selectată.

• Lipire Entităi: lipete în hartă o entitate decupată sau copiată.

Dorii să adăugai o nouă entitate.

• Clic pe butonul Adăugare Entitate, pentru a începe digitizarea câmpurilor colii noastre.

Vei observa modificarea cursorului de la mouse într-o intă. Aceasta vă permite să plasai cu o mai mare acuratee
punctele pe care le vei digitaliza. Nu uitai că dei folosii instrumentul de digitalizare, putei schimba planul hării
prin rotia mouse-ului i putei deplasa harta apăsând rotia mouse-ului i trăgând harta.

Prima entitate pe care o vei digitaliza este athletics field:

• Începei digitizarea făcând clic pe un punct, de-a lungul marginii câmpului.

• Plasai mai multe puncte, făcând clic în continuare de-a lungul marginii, până când forma desenată acoperă
complet câmpul.

• După introducerea ultimului punct, facei clic-dreapta, pentru a încheia desenarea poligonului. Acest lucru
va finaliza entitatea i vă va prezenta dialogul Atributelor.

• Completai valorile, aa cum se arată mai jos:
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• Facei clic pe OK, creând astfel o nouă entitate!

Amintii-vă că dacă ai făcut o greeală în timp ce digitizai o entitate, o putei edita oricând după ce ai definitivat
crearea ei. Dacă ai făcut o greeală, continuai digitizarea până ai terminat crearea entităii de mai sus. Apoi:

• Selectai entitatea cu ajutorul instrumentului Select Single Feature:

Putei utiliza:

• instrumentul Move Feature(s) pentru a deplasa întreaga entitate,

• Instrumentul Nod pentru a deplasa doar un punct, în cazul în care ai efectuat un clic eronat,

• tergere Selecie pentru a scăpa de entitate în întregime, astfel încât să putei încerca din nou, i
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• elementul de meniu Edit → Undo sau combinaia de taste ctrl + z, pentru a anula greelile.

6.1.3 Try Yourself

• Digitizarea colii propriu-zise i a câmpului de sus. Utilizai această imagine pentru a vă ajuta:

Amintii-vă că fiecare entitate nouă trebuie să aibă o valoare id unică!

Note: După ce ai terminat de adăugat entităile într-un strat, nu uitai să salvai modificările i să ieii din modul de
editare.

Note: Putei personaliza umplerea, conturul, poziionarea i formatarea etichetelor pentru school_property folosind
tehnicile învăate în leciile anterioare. În exemplul nostru vom folosi un contur de linie întreruptă violet deschis
fără umplere.
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6.1.4 Try Yourself

• Creai un nou tip de linie denumit routes.shp cu atributele id i type. (Folosii ca ghid abordarea de mai
sus.)

• Vom digitiza două rute care nu sunt deja marcate pe stratul de drumuri; unul este o cărare, celălalt este o
pistă.

Cărarea merge de-a lungul marginii de sud a suburbiei Railton, începând i terminându-se la drumurile marcate:

Piste este situată un pic mai departe de sud:
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Digitizai, pe rând, cărarea i pista în stratul routes. Încercai să urmai traseele cât mai exact posibil, folosind puncte
(clic-stânga) la coluri sau viraje.

La crearea fiecărei rute, acordai atributului type valoarile path sau track.

Vei găsi, probabil că sunt marcate doar punctele; folosii dialogul Proprietăilor Stratului pentru a stiliza rutele.
Alegei, după dorină, două stiluri diferite pentru cărare i pentru pistă.

Salvai modificările i ieii din modul de Editare.

Verificai-vă rezultatele

6.1.5 In Conclusion

Acum tii cum să creai entităi! Acest curs nu acoperă adăugarea entităilor de tip punct, deoarece nu este neapărat
necesară după ce ai lucrat cu entităi mai complexe (lini i poligoane). Funionează exact la fel, cu excepia faptului
că dai clic doar o singură dată unde dorii să plasai punctul, îi completai atributele ca de obicei, după care entitatea
este creată.

Cunoaterea digitizării este importantă deoarece reprezintă o activitate frecventă în aplicaiile GIS.

6.1.6 What’s Next?

Caracteristicile dintr-un strat GIS nu sunt doar imagini, ci obiecte în spaiu. De exemplu, poligoanele adiacente
tiu unde se află unul faă de celălalt. Aceasta se numete topologie. În lecia următoare vei vedea un exemplu de
utilizare.

6.2 Lesson: Topologia Entităii

Topologia reprezintă un aspect util de straturi de date vectoriale, deoarece minimizează erorile, cum ar fi supra-
punerile sau lacunele.
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De exemplu: dacă două entităi au o frontieră comună, i editai grania cu ajutorul topologiei, atunci nu va trebui
să editai mai întâi un element, apoi pe celălalt, i ulterior să aliniai cu atenie frontierele, astfel încât acestea să se
potrivească. În schimb, putei edita bordurile lor comune, ambele entităi schimbându-se în acelai timp.

Scopul acestei lecii: De a înelege topologia, cu ajutorul exemplelor.

6.2.1 Follow Along: Acroarea

Pentru a face mai uoară editarea topologică, este cel mai bine să activai acroarea. Acest lucru va permite cursorului
mouse-ului să se fixeze pe alte obiecte în timpul digitizării. Pentru a seta opiunile de acroare:

• Navigai la elementul de meniu Settings → Snapping Options....

• Setai dialogul Opiunilor de acroare aa cum se arată:

• Asigurai-vă că este bifată (pusă pe true) coloana Evitare Intersecii.

• Clic pe OK, pentru a salva modificările i pentru a părăsi dialogul.

• Intrai în modul de editare, având stratul landuse selectat.

• Verificai în View → Toolbars pentru a vă asigura că bara instrumentelor Avansate de Digitizare este activată.

• Focalizai această arie (activând straturile i etichetele, dacă este necesar):
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• Digitizai această nouă zonă (fictivă) din Bontebok National Park:

• Când vi se solicită, introducei un OGC_FID de 999, dar nu ezitai să lăsai celelalte valori nemodificate.

Dacă suntei ateni pe durata digitizării i permitei acroarea cursorului la nodurile fermelor învecinate, vei observa
că nu vor fi lacune între noua fermă i cele existente, adiacente acesteia.

• Notai instrumentele undo/redo din bara instrumentelor de Digitizare Avansată:
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6.2.2 Follow Along: Caracteristicile Topologice Corecte

Caracteristicile topologice trebuie uneori să fie actualizate. În exemplul nostru, stratul landuse are unele zone
forestiere complexe, care au fost recent unite pentru a forma o singură zonă:

În loc de a crea noi poligoane care să se alăture zonelor forestiere, vom utiliza Instrumentul Nod pentru a edita
poligoanele existente, i pentru a le îmbina.

• Activai modul de editare, dacă nu este deja activat.

• Selectai Instrumentul Nod.

• Alegei o zonă de pădure, selectai un col i mutai-l la un col alăturat, astfel încât cele două seciuni de pădure
să se întâlnească:
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• Facei clic i glisai nodurile până când se fixează pe poziie.

Limitele topologic corecte vor arăta astfel:
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Mergei mai departe i îmbinai mai multe zone folosind Instrumentul Nod. Putei folosi, de asemenea, instrumentul
Adăugare Entitate dacă este necesar. Dacă utilizai eantionul nostru de date, ar trebui să avei o zonă de pădure
arătând în genul următor:

Nu vă facei griji dacă ai îmbinat mai multe, mai puine sau zone diferite de pădure.
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6.2.3 Follow Along: Instrumentul: Simplificarea Entităilor

Acesta este instrumentul de Simplificare a Entităilor:

• Facei clic pe el pentru a-l activa.

• Facei clic pe una dintre ariile pe care le-ai îmbinat utilizând fie instrumentul Nod, fie pe cel de Adăugare
Entităi. Vei vedea acest dialog:

• Mutai cursorul de la o parte i de alta, apoi observai ceea ce se întâmplă:
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Acest lucru vă permite reducerea cantităii de noduri din entităile complexe.

• Clic pe OK

Observai modificările aduse topologiei de către acest instrument. Poligonul simplificat nu mai atinge poligoanele
adiacente, aa cum ar trebui. Acest lucru arată că acest instrument este mai bine adaptate la generalizarea entităilor
de sine-stătătoare. Avantajul este acela că vi se oferă o interfaă simplă, intuitivă, pentru generalizare.

Înainte de a merge mai departe, setai poligonul înapoi la starea iniială, prin anularea ultimei modificări.

6.2.4 Try Yourself Instrument: Adăugarea Inelului

Acesta este instrumentul de Adăugare Inel:

Vi se va permite să extragei o gaură dintr-o entitate, atât timp cât gaura este mărginită pe toate pările de către
entitate. De exemplu, dacă ai digitizat limitele exterioare ale Africii de Sud i trebuie să adăugai o gaură pentru
Lesotho, vei utiliza acest instrument.

Dacă experimentai cu acest instrument, vei observa că opiunile de acroare curente vă împiedică să creai unui
inel în mijlocul poligonului. Acest lucru ar fi bun, dacă zona pe care dorii să o excludei este legată de limitele
poligonului.

• Dezactivarea acroării pentru stratul landuse, prin intermediul dialogului utilizat anterior.

• Acum, încercai să folosii instrumentul de Adăugare Inel, pentru a crea o lacună în mijlocul Bontebok
National Park.
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• tergei noua entitate, folosind instrumentul tergere Inel:

Note: Trebuie să selectai un vârf al inelului pentru a-l terge.

Verificai-vă rezultatele

6.2.5 Try Yourself Instrumentul: Adăugare Parte

Acesta este instrumentul Adăugare Parte:

Acesta vă permite să creai o parte suplimentară de entitate, neconectată direct la principala entitate. De exemplu,
dacă ai digitalizat limitele Africii de Sud, dar nu ai adăugat încă Insulele Prince Edward, atunci vei utiliza acest
instrument pentru a le crea.

• Pentru a utiliza acest instrument, trebuie să selectai mai întâi poligonul la care dorii să adăugai o parte,
folosind în acest scop instrumentul Select Single Feature:

• Acum, încercai să folosii instrumentul de Adăugare Parte, pentru a adăuga o zonă periferică în Bontebok
National Park.

• tergei noua entitate prin utilizarea instrumentului tergere Parte:

Note: Trebuie să selectai un nod al pării, pentru a-l terge.

Verificai-vă rezultatele

6.2.6 Follow Along: Instrumentul: Remodelarea Entităilor

Acesta este instrumentul de Remodelare a Entităilor:

Se poate adăuga un nod la o entitate existentă. Având acest instrument selectat:

• Facei clic stânga în interiorul Bontebok National Park pentru a începe desenarea unui poligon.

• Desenai un poligon cu trei coluri, dintre care ultimul ar trebui să fie în interiorul poligonului iniial, formând
un dreptunghi deschis pe o latură.

• Clic-dreapta pentru a termina punctele de marcare:
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Acest lucru va genera un rezultat similar cu:

Putei face, de asemenea, opusul:

• Facei clic în afara poligonului.

• Desenai un dreptunghi în interiorul poligonului.

• Facei iarăi clic-dreapta în afara poligonului:
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Iată rezultatul:

6.2.7 Try Yourself Instrumentul: Divizare Entităi

Instrumentul Split Features este similar celui de îndepărtare a fermei, cu excepia faptului că nu terge nici una
dintre pări. În schimb, le păstrează pe amândouă.
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• În primul rând, re-activai acroarea pentru stratul landuse.

Vom folosi acest instrument pentru a diviza un col din Bontebok National Park.

• Selectai instrumentul Split Features, apoi facei clic pe un vertex pentru a începe desenarea unei linii. Facei
clic pe nodul de pe partea opusă a colului pe care dorii să-l divizai, apoi facei clic-dreapta pentru a finaliza
linia:

• În acest moment, poate părea că nu s-a întâmplat nimic. Dar amintii-vă că simbologia dvs. pentru stratul
landuse nu are nici o bordură, astfel încât noua linie de divizare nu se va afia.

• Folosii instrumentul Select Single Feature pentru a selecta colul pe care tocmai l-ai divizat; noua entitate
fiind acum evideniată:
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6.2.8 Try Yourself Instrumentul: Îmbinare Entităi

Acum vom re-îmbina în poligonul original, entitatea pe care tocmai ai creat-o:

• Experimentai cu instrumentele Îmbină Entităile Selectate i Îmbină Atributele Entităilor Selectate.

• Notai diferenele.

Verificai-vă rezultatele

6.2.9 In Conclusion

Editarea topologică este un instrument puternic, care vă permite să creai i să modificai obiectele rapid i uor,
asigurându-vă în acelai timp că ele rămân corecte din punct de vedere topologic.

6.2.10 What’s Next?

Acum tii cum să digitizai cu uurină forma obiectelor, dar adăugarea atributelor încă reprezintă o mică durere de
cap! În continuare vă vom arăta cum să utilizai formularele, astfel încât editarea atributelor să fie cât mai simplă i
cât mai eficientă.

6.3 Lesson: Formulare

Atunci când adăugai prin digitizare noi date, vi se prezintă o fereastră de dialog care vă permite să completai
atributele entităilor. Totui, acest dialog nu este, în mod implicit, prea aspectuos. Acest lucru poate cauza o
problemă de uzabilitate, mai ales dacă avei de creat seturi de date de mari dimensiuni, sau dacă dorii ca alte
persoane să vă ajute la digitizare, acetia descoperind repede că formularele implicite sunt confuze.

Din fericire, QGIS vă permite să creai propriile dialoguri personalizate pentru un strat. Această lecie vă arată cum.

Scopul acestei lecii: De a crea un formular pentru un strat.
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6.3.1 Follow Along: Utilizarea Funcionalităii de Proiectare a Formularelor
din QGIS

• Selectai stratul roads din Lista straturilor.

• Introducei Modul de Editare ca mai înainte.

• Deschidei Tabela sa de Atribute.

• Facei clic dreapta pe oricare celulă din tabel. Va apărea un scurt meniu, cu o singură intrare: Open form.

• Facei clic pe ea pentru a vedea forma pe care QGIS o generează pentru acest strat.

Evident, ar fi frumos să fii în măsură să facei acest lucru, mai degrabă, în timp ce vă uitai la hartă, decât să fie
nevoie să căutai tot timpul o stradă specifică în Tabela de Atribute.

• Mergei la meniul Settings → Options.

• În caseta de dialog care apare, selectai fila Map Tools.

• Bifai caseta Open feature form ...:

• Clic pe OK

• Selectai stratul roads din Lista straturilor.

• Folosind instrumentul Identify, facei clic pe oricare stradă din hartă.

În locul dialogului normal Identify, vei vedea în loc formularul de-acum familiar:
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6.3.2 Try Yourself Folosirea Formularului pentru Editarea Valorilor

Dacă suntei în modul de editare, putei utiliza acest formular pentru a edita atributele unei entităi.

• Activai modul de editare (dacă nu este deja activat).

• Folosind instrumentul Identify, facei clic pe oricare stradă din hartă care trece prin Swellendam:
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• Setai-le valoarea guilabel:highway pe secondary.

• Salvai modificările dvs.

• Ieii din modul de editare.

• Deschidei Tabela de Atribute i observai că valoarea din tabelul de atribute a fost actualizat i, prin urmare, i
în datele sursă.

Note: Dacă, în mod implicit, utilizai setul de date, vei descoperi că există mai mult de un drum pe această hartă
denumit Voortrek Street.

6.3.3 Follow Along: Setarea Tipurilor de Câmpuri ale Formularelor

E frumos să editai lucruri folosind un formular, dar tot trebuie să introducei manual totul. Din fericire, formele au
aa-numitele widgets, care vă permit să editai datele în diverse moduri.

• Deschidei fereastra de dialog a Proprietăilor stratului roads.

• Mergei la fila Câmpuri. Vei vedea următoarele:
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• Facei clic pe butonul Line edit din acelai rând cu man_made, apoi vei fi obine un nou dialog.

• Selectai Checkbox din lista de opiuni:
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• Clic pe OK

• Intrai în modul de editare (dacă stratul roads nu se află deja în modul de editare.

• Clic pe instrumentul Identify.

• Facei clic pe acelai drum principal pe care l-ai ales mai devreme.

Vei vedea acum că atributul man_made are o casetă de selectare de lângă el, care poate indica True (bifat) sau
False (debifat).

6.3.4 Try Yourself

Setai un widget mai adecvat pentru câmpul highway.

Verificai-vă rezultatele

6.3.5 Try Yourself Crearea Datelor de Test

Avei posibilitatea să proiectai, de asemenea, formularul propriu complet de la zero.

• Creai un simplu strat de tip punct, denumit test-data, având două atribute:

– Nume (text)

– Vechimea (text)
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• Capturai câteva puncte de pe noul strat folosind instrumentele de digitizare, aa că vei avea un pic de date cu
care să operai. Ar trebui să vedei în continuare formularul implicit, generat de QGIS, de fiecare dată când
capturai un nou punct.

Note: Este posibil să trebuiască să dezactivai Acroarea, dacă este activată în urma aciunilor anterioare.
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6.3.6 Follow Along: Crearea unui Nou Formular

Acum dorim să creăm formularul nostru personalizat pentru faza de captura a datelor atributelor. Pentru a face
acest lucru, trebuie să avei instalat Qt4 Designer (necesar numai pentru persoana care creează formulare). Ar trebui
să fie furnizat ca parte a materialelor dumneavoastră de curs, dacă utilizai Windows. Este posibil să trebuiască să-l
căutai, dacă utilizai un alt sistem de operare. Pentru Ubuntu, efectuai următoarele în terminal:

Note: La momentul scrierii acestui tutorial, Qt5 este cea mai recentă versiune disponibilă. Cu toate acestea, acest
proces necesită în mod specific Qt4, i nu este neapărat compatibil cu Qt5.

sudo apt-get install qt4-designer

... i ar trebui să se instaleze automat. În caz contrar, căutai-l în Software Center.

• Pornii Designer-ul, prin deschiderea intrării sale din Meniul de Start din Windows (sau oricare altă abordare
adecvată din sistemul dvs. de operare).

• În caseta de dialog care apare, creai un nou dialog:
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• Căutai Widget Box în partea stângă a ecranului (implicit). Aceasta conine un element denumit Line Edit.

• Facei clic i tragei acest articol în formular. Aceasta va crea o nouă Linie de Editare în formular.

• Având selectat noul element de linie de editare, îi vei vedea proprietăile de-a lungul pării laterale a ecranului
(din partea dreaptă, în mod implicit):

6.3. Lesson: Formulare 133



QGIS Training Manual, Release 2.8

134 Chapter 6. Module: Crearea Datelor Vectoriale



QGIS Training Manual, Release 2.8

• Redenumii-l Name.

• Folosind aceeai abordare, creai un nou câmp cu incrementare i denumii-l Age.

• Adăugai o Etichetă având textul Add a New Person scris cu un font îngroat (uitai-vă la proprietăile
obiectului, pentru a afla cum să efectuai aceste setări). Alternativ, poate dorii să setai titlul dialogului în sine
(mai degrabă decât prin adăugarea unei etichete).

• Facei clic oriunde, în fereastra de dialog.

• Găsii butonul Lay Out Vertically (într-o bară de instrumente din lungul marginii de sus a ecranului, în mod
implicit). Acesta va organiza automat fereastra de dialog.

• Setai dimensiunea maximă a dialogului (în proprietăile sale) la 200 (lăimea) pe 100 (înălimea).

• Salvai noul formular ca i exercise_data/forms/add_people.ui.

• Când salvareaeste gata, putei închide programul Qt4 Designer.

6.3.7 Follow Along: Asocierea Formularului cu Stratul Dvs.

• Mergei înapoi în QGIS.

• Dublu clic pe stratul test-data din legendă, pentru a-i accesa proprietăile.

• Clic pe fila Câmpuri din dialogul Layer Properties.

• În caseta cu lista derulantă Attribute editor layout, selectai Provide ui-file.

• Facei clic pe butonul cu puncte de suspensie, apoi alegei fiierul add_people.ui, pe care tocmai l-ai
creat:
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• Clic OK în dialogul Layer Properties.

• Intrai în modul de editare i capturai un nou punct.

• Când facei acest lucru, vă va fi prezentat dialogul personalizat (în loc de cel generic, pe care îl creează de
obicei QGIS).

• Dacă facei clic pe unul dintre puncte folosind instrumentul Identify, se va deschide acum formularul, făcând
clic dreapta în fereastra de identificare a rezultatelor, i alegând View Feature Form din meniul contextual.

• Dacă suntei în modul de editare pentru acest strat, meniul contextual vă va prezenta Edit Feature Form în
schimb, apoi vei putea ajusta atributele în noul formular, chiar i după captura iniială.

6.3.8 In Conclusion

Folosind formularele, vă putei face viaa mai uoară, atunci când editai sau când creai date. Prin editarea tipurilor
de widget sau pin crearea unui formular cu totul nou, de la zero, putei controla experiena cuiva care digitalizează
date noi, minimizând, astfel, neînelegerile i erorile inutile.
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6.3.9 Further Reading

Dacă ai terminat seciunea avansată de mai sus, i avei cunotine de Python, poate dorii să verificai acest articol
de blog despre crearea formelor artistice personalizate cu logica Python, care permite funcii avansate, inclusiv
validarea datelor, autocompletarea, etc.

6.3.10 What’s Next?

Deschiderea unui formular o dată cu identificarea unei entităi este una dintre aciunile standard, pe care o poate
efectua QGIS. Cu toate acestea, putei efectua direct aciunile personalizate pe care le definii. Acesta este subiectul
leciei următoare.

6.4 Lesson: Acţiuni

Acum că am văzut o aciune implicită în lecia precedentă, este timpul să definii propriile aciuni. O aciune este
ceva ce se întâmplă când dai clic pe o entitate. Putei adăuga funcionalităi extinse la hartă, permiând de exemplu
colectarea de informaii adiionale pentru un obiect. Asignarea aciunilor poate adăuga o noua dimensiune hării!

Scopul acestei lecii: De a afla cum să adăugai aciuni particularizate.

6.4.1 Follow Along: Deschiderea unei Imagini

Utilizai stratul school_property creeat anterior. Materialele cursului includ fotografii pentru fiecare din cele trei
propietăi digitalizate. În continuare vom asocia fiecare propietate cu imaginea ei. Vom creea după aceea o aciune
care va deschide imaginea propietăii la clic pe propietate.

6.4.2 Follow Along: Adăugarea unui Câmp pentru Imagini

Stratul school_property încă nu are nici o modalitate de a asocia o imagine cu o proprietate. În primul rând, vom
crea un câmp în acest scop.

• Deschidei dialogul Layer Properties.

• Dai clic pe fila Fields.

• Comutai în modul de editare:
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• Adăugai o nouă coloană:
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• Introducei valorile de mai jos:
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• După ce a fost creat câmpul, facei clic pe butonul Line edit de lângă noul câmp.

• Setai-l pentru un Nume de fiier:
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• Clic OK în dialogul Layer Properties.

• Folosii instrumentul Identify pentru a facei clic pe una dintre cele trei entităi din stratul school_property.

Din moment ce suntei încă în modul de editare, dialogul ar trebui să fie activ i va arăta astfel:
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• Clic pe butonul de răsfoire (... de lângă câmpul imagine).

• Selectai calea pentru imagini. Imaginile se află în exercise_data/school_property_photos/ i
sunt denumite la fel ca i caracteristicile cu care trebuie asociate.

• Clic pe OK

• Asociai toate imaginile cu entităile corecte folosind această metodă.

• Salvai modificările i ieii din modul de editare.

6.4.3 Follow Along: Crearea unei Aciuni

• Deschidei formularul Actions pentru stratul school_property.

• În panoul Action properties, introducei cuvintele Show Image în dreptul câmpului Nume:
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Ceea ce vei face în continuare diferă în funcie de sistemul de operare, asa că alegei un curs adecvat:

Windows

• Dai clic pe meniul vertical Type i alegei Open.

Ubuntu Linux

• În câmpul Action scriei eog pentru Gnome Image Viewer, sau display pentru a utiliza ImageMagick. Nu
uitai să punei un spaiu după comandă!

MacOS

• Clic pe caseta Type, apoi alegei Mac.

• Sub Aciuni, scriei open. Reinei că trebuie să punei un spaiu după comandă!
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Continuai scrierea comenzilor

Vrei să deschidei imaginea, si QGIS tie unde se află. Tot ce rămâne de făcut este să îi spunei Action unde se află
imaginea.

• Selectai image din listă:

• Dai clic pe butonul Insert field. QGIS va adăuga fraza [% "image" %] în câmpul Action.

• Clic pe butonul Add to action list.

• Clic OK în dialogul Layer Properties.

Acum vom testa noua Aciune:

• Clic pe stratul school_property în Layers list astfel încât acesta să fie evideniat.

• Găsii butonul Run feature action (în aceeai bară de instrumente cu butonul Open Attribute Table):

• Clic pe săgeata în jos la dreapta acestui buton. Există o singură aciune definită în acest strat, cea pe care
tocmai ai creat-o.

• Apăsai butonul pentru a activa instrumentul.

• Folosind acest instrument, facei clic pe oricare din cele trei proprietăi colare.

• Imaginea pentru acea proprietate se va deschide acum.

6.4.4 Follow Along: Căutarea pe Internet

Să spunem că ne uităm la hartă i vrem să tim mai multe despre zona în care se află o fermă. Presupunem că nu tii
nimic despre zona respectivă i că vrei să găseti informaii generale despre ea. Primul impuls, tiind că foloseii un
calculator în acest moment, ar fi probabil să căutai pe Google numele zonei. Deci, să îi spunem lui QGIS să facă
asta în mod automat!

• Deschidei tabela de atribute a stratului landuse.

Vom folosi câmpul :kbd:‘name‘pentru fiecare dintre zonele care vor fi căutate în Google.

• Închidei tabelul de atribute.

• Mergei înapoi la Aciuni în Proprietăile Stratului.

• În câmpul Action Properties → Name, scriei Google Search.

Ceea ce vei face în continuare diferă în funcie de sistemul de operare, asa că alegei un curs adecvat:
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Windows

• Sub Tip, alegei Deschidere. Acest lucru va spune Windows-ului să deschidă o adresă de Internet din
browser-ul implicit, cum ar fi Internet Explorer.

Ubuntu Linux

• Sub Action, alegei xdg-open. Acest lucru va spune Windows-ului să deschidă o adresă de Internet din
browser-ul implicit, cum ar fi Chrome sau Firefox.

MacOS

• Sub Action, alegei open. Acest lucru va spune MacOS-ului să deschidă o adresă de Internet din browser-ul
implicit, cum ar fi Safari.

Continuai scrierea comenzilor

Orice comandă ai folosit mai sus, trebuie să îi spunei ce adresă să deschidă în continuare. Vrei să accesai Google
i să căutai automat o expresie.

În mod uzual când folosii Google introducei termenii de căutare în Bara de Căutare Google. Dar în
acest caz, calculatorul trebuie să facă asta. Modul de a-i spune lui Google să caute ceva (dacă nu
vrei să folosii bara lui de căutare în mod direct) este prin a-i transmite browser-ului tău Internet adresa
http://www.google.com/search?q=SEARCH_PHRASE, unde SEARCH_PHRASE este ceea ce vrei să
căutai. De vreme ce nu tim încă ce termen de căutare dorim, o să introducem doar prima parte (fără termenul de
căutare).

• În câmpul Aciune, scriei http://www.google.com/search?q=. Amintii-vă să adăugai un spaiu
după comanda iniială, înainte de a introduce link-ul!

Acum vrei ca browser-ul QGIS să caute în Google valoarea name pentru orice entitate pe care ai putea face clic.

• Selectai câmpul name.

• Clic pe Inserare câmp:
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Aceasta va spune QGIS să adauge fraza următoare:

Asta înseamnă că QGIS va deschide browser-ul i îl va trimite la adresa
http://www.google.com/search?q=[% "name" %]. Dar [% "name" %] îi spune lui QGIS
să folosească coninutul câmpului name ca termen de căutare.

Deci, de exemplu, dacă zona pe care dai clic se numete Marloth Nature Reserve, atunci QGIS va trim-
ite browserul la http://www.google.com/search?q=Marloth%20Nature%20Reserve, ceea ce va
face ca browerul să acceseze Google, care va căuta la rândul lui “Marloth Nature Reserve”.
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• Dacă nu ai făcut deja acest lucru, setai totul aa cum s-a explicat mai sus.

• Clic pe butonul Add to action list. Noua aciune va apărea în lista de mai sus.

• Clic OK în dialogul Layer Properties.

Acum vom testa noua versiune.

• Cu stratul landuse activ în Layers list, dai clic pe butonul Run feature action.

• Clic pe orice zonă vizibilă pe hartă. Browserul se va deschide i va porni automat o căutare Google pentru
oraul care este înregistrat în valoarea name pentru acea zonă.

Note: În cazul în care aciunea nu funcionează, verificai dacă totul a fost introdus corect; erorile de introducere
sunt comune pentru această activitate!

6.4.5 Follow Along: Deschiderea unei Pagini Web Direct din QGIS

Mai us, am văzut cum se poate deschide o pagină într-un browser extern. Există câteva dezavantaje pentru această
abordare, i anume că adaugă o dependenă necunoscută – va avea utilizatorul final în sistem software-ul necesar
pentru a executa aciunea? După cum am văzut, nu este nepărat să aibă aceeai comandă de bază pentru aceeai
aciune, dacă nu stim ce sistem de operare vor folosi. Pentru anumite versiuni de sisteme de operare, comenzile de
mai sus pentru deschiderea unui browser nu vor funciona deloc. Aceasta ar putea fi o problemă de neînvins.

Dar QGIS se bazează pe librăria Qt4, care este extrem de puternică i versatilă. De asemenea, aciunile QGIS pot fi
comenzi Python arbitrare, parametrizate (de ex. utilizând informaii variabile bazate pe coninutul unui cămp)!

Acum vom vedea cum să utilizăm o aciune Python pentru a afia o pagina web. Ideea de bază este aceeai cu a
deschide un site într-un browser extern, dar nu necesită un browser pe sistemul utilizatorului deoarece folosete
clasa QWebView a Qt4 (care este un widget html bazat pe webkit) pentru a afia coninutul într-o fereastră pop-up.

În loc de Google, haidei să folosim Wikipedia de această dată. Deci URL-ul pe care îl cerei va arăta astfel:

http://wikipedia.org/wiki/SEARCH_PHRASE

Pentru a crea aciunea stratului:

• Deschidei dialogul Proprietăilor Stratului i mergei la fila Actions.

• Setai o nouă aciune, folosind următoarele proprietăi pentru aciune:

– Type: Python

– Name: Wikipedia

– Aciunea (toate pe o singură linie): from PyQt4.QtCore import QUrl;
from PyQt4.QtWebKit import QWebView; myWV = QWebView(None);
myWV.load(QUrl(’http://wikipedia.org/wiki/[% "name" %]’));
myWV.show()
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Aici se întâmplă mai multe lucruri:

• Tot codul Python este într-o singură linie, comenzile fiind separate prin punct i virgulă (în loc de linii noi,
modul uzual de separare a comenzilor Python).

• [% "name" %] va fi înlocuit cu valoarea atribului când se va invoca aciunea (ca i mai devreme).

• Codul creează o nouă instană QWebView, îi setează URL-ul i apoi apelează show() pentru a o face
vizibilă ca o fereastră pe ecranul utilizatorului.

De remarcat este că acesta este un exemplu forat. Python funcionează cu indentare cu semnificaie semantică, deci
separarea lucrurilor cu punct i virgulă nu este cea mai bună variantă de scriere. Deci, în aplicaiile reale, ar fi mai
plauzibil ca logica să fie importată dintr-un modul Python i apoi să se apeleze o funcie care să primească un cămp
ca i parametru.

Ai putea utiliza de asemenea abordarea pentru a afia o imagine fără a fi nevoie ca utilizatorul să aibă în sistem un
anumit vizualizator de imagini.

• Încercai să utilizai metodele descrise mai sus pentru a încărca o pagină Wikipedia utilizând aciunea
Wikipedia proaspăt creată.
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6.4.6 In Conclusion

Aciunile vă permit să îi dai hării funcionalităi suplimentare, utile pentru utilizatorul final care vizualizează harta în
QGIS. Datorită faptului că putei utiliza comenzii shell pentru orice sistem de operare, i de asemenea putei utiliza
Pyton, nu există limite pentru funciile pe care le putei integra!

6.4.7 What’s Next?

Acum că ai completat diverse tipuri de creare date vectoriale, vei învăa cum să analizai aceste date pentru a rezolva
probleme. Acesta este subiectul următorului modul.
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CHAPTER 7

MOD| Analiza Vectorială

Acum, după ce ai editat câteva entităi, trebuie să tii ce altceva se poate face cu ele. Având entităi cu atribute este
frumos, dar, în final, aceasta nu reprezintă chiar ceva care să se detaeze net faă de o hartă non-GIS.

Avantajul cheie al unui GIS este: un GIS poate răspunde întrebărilor.

Pentru următoarele trei module, ne vom strădui să răspundem la o întrebare de cercetare folosind funcii GIS.
De exemplu, dacă suntei un agent imobiliar i vă aflai în căutarea unei proprietăi rezideniale în Swellendam, care
trebuie să respecte următoarele criterii:

1. Să fie situată în Swellendam.

2. Trebuie să fie la distană de conducere rezonabilă, faă de o coală (de exemplu, 1 km).

3. Trebuie să aibă mai mult de 100m pătrai în dimensiune.

4. Să fie situată sub 50m faă de un drum principal.

5. Să fie situată la maximumb500m faă de un restaurant.

În următoarele câteva module, vom valorifica puterea instrumentelor de analiză GIS, pentru a localiza proprietăile
agricole potrivite pentru această nouă dezvoltare rezidenială.

7.1 Lesson: Reprojectarea i Transformarea Datelor

Haidei să vorbim din nou despre Sistemele de Coordonate de Referină (CRS-uri). Am atins acest subiect mai
înainte, dar nu am discutat ce înseamnă practic.

Scopul acestei lecii: De a reproiecta i transforma seturile de date vectoriale.

7.1.1 Follow Along: Proiecii

CRS-ul folosit în acest moment pentru toate datele, precum i pentru harta în sine, este denumit WGS84. Acesta
este un Sistem de Coordonate Geografic (GCS) utilizat, în mod comun, la reprezentarea datelor. Dar există o
problemă, după cum vom vedea.

• Salvai harta curentă.

• Apoi deschidei harta lumii, pe care o vei găsi în exercise_data/world/world.qgs.

• Focalizai Africa de Sud, folosindu-vă de instrumentul Zoom In.

• Try setting a scale in the Scale field, which is in the Status Bar along the bottom of the screen. While over
South Africa, set this value to 1:5000000 (one to five million).

• Deplasai harta în timp ce aruncai o privire i la câmpul Scale.
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Notice the scale changing? That’s because you’re moving away from the one point that you zoomed into at
1:5000000, which was at the center of your screen. All around that point, the scale is different.

Pentru a înelege de ce, gândii-vă la un glob al Pământului. Acesta are linii care pornesc de la Nord înspre Sud.
Aceste linii longitudinale sunt situate departe una de alta la ecuator, dar se întâlnesc la poli.

In a GCS, you’re working on this sphere, but your screen is flat. When you try to represent the sphere on a flat
surface, distortion occurs, similar to what would happen if you cut open a tennis ball and tried to flatten it out.
What this means on a map is that the longitude lines stay equally far apart from each other, even at the poles
(where they are supposed to meet). This means that, as you travel away from the equator on your map, the scale
of the objects that you see gets larger and larger. What this means for us, practically, is that there is no constant
scale on our map!

To solve this, let’s use a Projected Coordinate System (PCS) instead. A PCS “projects” or converts the data in a
way that makes allowance for the scale change and corrects it. Therefore, to keep the scale constant, we should
reproject our data to use a PCS.

7.1.2 Follow Along: Reproiectarea “Din-Zbor”

QGIS allows you to reproject data “on the fly”. What this means is that even if the data itself is in another CRS,
QGIS can project it as if it were in a CRS of your choice.

• Pentru a activa proiecia “din zbor”, efectuai clic pe butonul Starea CRS-ului din Bara de Stare din partea de
jos a ferestrei QGIS:

• În caseta de dialog care apare, bifai caseta de lângă Activarea transformării ‘din zbor’ a CRS-ului.

• Type the word global into the Filter field. One CRS (NSIDC EASE-Grid Global) should appear in the
list below.

• Clic pe NSIDC EASE-Grid Global pentru a-l selecta, apoi clic pe OK.

• Observai modul în care forma Africii de Sud se schimbă. Toate proieciile lucrează prin schimbarea formelor
aparente ale obiectelor de pe Terra.

• Mării iarăi până la scara 1:5000000, ca înainte.

• Deplasai un pic harta.

• Observai că scara rămâne la fel!

Reproiectarea “din zbor” este folosită, de asemenea, pentru a combina seturile de date aflate în diverse CRS-uri

• Dezactivează iarăi reproiectarea “din zbor”:

– Clic iarăi pe butonul CRS Status.

– De-bifează caseta Enable ‘on the fly’ CRS transformation.

– Clic pe OK

• In QGIS 2.0, the ‘on the fly’ reprojection is automatically activated when layers with different CRSs are
loaded in the map. To understand what ‘on the fly’ reprojection does, deactivate this automatic setting:

– Mergei la Settings → Options...

– În panoul din stânga al casetei de dialog, selectai CRS.

– Debifai Reproiectarea automată ‘din zbor’ atunci când straturile au CRS-uri diferite.

– Clic pe OK

• Adăugai un alt strat vectorial hării care are datele doar pentru Africa de Sud. Îl vei găsi ca
exercise_data/world/RSA.shp.
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Ce observai?

Stratul nu este vizibil! Dar aceasta este uor de remediat, nu?

• Clic dreapta pe stratul RSA din Lista straturilor.

• Selectai Zoom to Layer Extent.

OK, acum se vede Africa de Sud, ... dar unde este restul lumii?

It turns out that we can zoom between these two layers, but we can’t ever see them at the same time. That’s because
their Coordinate Reference Systems are so different. The continents dataset is in degrees, but the RSA dataset is in
meters. So, let’s say that a given point in Cape Town in the RSA dataset is about 4 100 000 meters away from
the equator. But in the continents dataset, that same point is about 33.9 degrees away from the equator.

This is the same distance - but QGIS doesn’t know that. You haven’t told it to reproject the data. So as far as it’s
concerned, the version of South Africa that we see in the RSA dataset has Cape Town at the correct distance of 4
100 000 meters from the equator. But in the continents dataset, Cape Town is only 33.9 meters away from the
equator! You can see why this is a problem.

QGIS doesn’t know where Cape Town is supposed to be - that’s what the data should be telling it. If the data tells
QGIS that Cape Town is 34 meters away from the equator and that South Africa is only about 12 meters from
north to south, then that is what QGIS will draw.

Pentru a corecta acest lucru:

• Click on the CRS Status button again and switch Enable ‘on the fly’ CRS transformation on again as before.

• Transfocare la extinderea setului de date RSA.

Acum, pentru că sunt proiectate în acelai CRS, cele două seturi de date se potrivesc perfect:

When combining data from different sources, it’s important to remember that they might not be in the same CRS.
“On the fly” reprojection helps you to display them together.

Before you go on, you probably want to have the ‘on the fly’ reprojection to be automatically activated whenever
you open datasets having different CRS:

• Deschidei iarăi Settings → Options... apoi selectai CRS.

• Activează Reproiectarea automată ‘din zbor’ atunci când straturile au CRS-uri diferite.
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7.1.3 Follow Along: Salvarea unui Set de Date într-un Alt CRS

Remember when you calculated areas for the buildings in the Classification lesson? You did it so that you could
classify the buildings according to area.

• Deschidei iarăi harta dvs. oinuită (care conine datele Swellendam).

• Deschidei tabela de atribute a stratului buildings.

• Derulai înspre dreapta până când vedei câmpul AREA.

Notice how the areas are all very small; probably zero. This is because these areas are given in degrees - the data
isn’t in a Projected Coordinate System. In order to calculate the area for the farms in square meters, the data has
to be in square meters as well. So, we’ll need to reproject it.

But it won’t help to just use ‘on the fly’ reprojection. ‘On the fly’ does what it says - it doesn’t change the data,
it just reprojects the layers as they appear on the map. To truly reproject the data itself, you need to export it to a
new file using a new projection.

• Clic dreapta pe stratul clădiri din Lista straturilor.

• Selectai Save As... în meniul care apare. Vi se va prezenta dialogul Save vector layer as....

• Clic pe butonul Browse de lângă câmpul Save as.

• Navigai la exercise_data/, apoi specificai numele noului strat ca
buildings_reprojected.shp.

• Lăsai Encoding neschimbat.

• Schimbai valoarea casetei Layer CRS în Selected CRS.

• Clic pe butonul Browse de lângă caseta cu derulare verticală.

• Va apărea dialogul CRS Selector.

• În câmpul Filter, căutai 34S.

• Alegei WGS 84 / UTM zone 34S din listă.

• Lăsai Symbology export neschimbat.

Dialogul Save vector layer as... arată acum în felul următor:
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• Clic pe OK

• Începei o nouă hartă i încărcai stratul reproiectat, pe care tocmai l-ai creat.

Consultai încă o dată lecia Classification, pentru a vă aminti cum se calculează suprafeele.

• Actualizai (sau adăugai) câmpul AREA prin rularea aceleiai expresii de mai înainte:
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Aceasta va adăuga un câmp AREA, având dimensiunea fiecărui imobil în metri pătrai

• Pentru a calcula aria în alte unităi de măsură, de exemplu, în hectare, utilizai câmpul AREA, pentru a crea o
a doua coloană:
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Aruncai o privire la noile valori din tabelul de atribute. Acestea sunt mult mai utile, deoarece oamenii măsoară,
de fapt, mărimea clădirii în metri, nu în grade. Acesta este motivul pentru care reproiectarea datelor reprezintă o
idee bună, la nevoie, înaintea calculării suprafeelor, a distanelor i a altor valori care depind de proprietăile spaiale
ale stratului.

7.1.4 Follow Along: Crearea Propriei Dvs. Proiecii

Există mai multe proiecii decât cele incluse în QGIS în mod implicit. De asemenea, putei crea propriile proiecii.

• Creai o nouă hartă.

• Încărcai setul de date world/oceans.shp.

• Mergei la Settings → Custom CRS... i vei vedea acest dialog:
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• Clic pe butonul Adaugă un nou CRS pentru a crea o nouă proiecie.

O proiecie interesantă de utilizat se numete Van der Grinten I.

• Introducei-i numele în câmpul Name.

Această proiecie reprezintă Pământul pe un teren circular, în locul uneia dreptunghiulară, la fel ca majoritatea
celorlalte proiecii.

• Pentru parametri, folosii următorul ir:

+proj=vandg +lon_0=0 +x_0=0 +y_0=0 +R_A +a=6371000 +b=6371000 +units=m
+no_defs
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• Clic pe OK

• Activai reproiectarea “din zbor”.

• Alegei proiecia dumneavoastră nou definită (căutai denumirea în câmpul Filter).

• După aplicarea acestei proiecii, harta va fi reproiectată astfel:

7.1. Lesson: Reprojectarea i Transformarea Datelor 159



QGIS Training Manual, Release 2.8

7.1.5 In Conclusion

Diferite proiecii sunt utile pentru scopuri diferite. Prin alegerea proiecia corectă, vă putei asigura că entităile de
pe hartă sunt reprezentate cu precizie.

7.1.6 Further Reading

Materialele pentru seciunea Avansată a acestei lecii au fost preluate din acest articol.

Mai multe informaii despre Sistemele de Coordonate de Referină sunt disponibile aici.

7.1.7 What’s Next?

În lecia următoare vei învăa cum să analizai datele vectoriale, folosind diverse instrumente de analiză vectorială
din QGIS.

7.2 Lesson: Analiza Vectorială

Vector data can also be analyzed to reveal how different features interact with each other in space. There are many
different analysis-related functions in GIS, so we won’t go through them all. Rather, we’ll pose a question and try
to solve it using the tools that QGIS provides.

Scopul acestei lecii: De a pune o întrebare i de a o rezolva folosind instrumentele de analiză.

7.2.1 Procesul GIS

Before we start, it would be useful to give a brief overview of a process that can be used to solve any GIS problem.
The way to go about it is:

160 Chapter 7. MOD| Analiza Vectorială
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1. Definirea Problemei

2. Obinerea Datelor

3. Analiza Problemei

4. Prezentarea Rezultatelor

7.2.2 Problema

Let’s start off the process by deciding on a problem to solve. For example, you are an estate agent and you are
looking for a residential property in Swellendam for clients who have the following criteria:

1. Să fie situată în Swellendam.

2. Trebuie să fie situată la o distană de conducere rezonabilă, faă de o coală (de exemplu, 1 km).

3. Trebuie să aibăo dimensiune de peste 100m pătrai.

4. Să fie situată sub 50m faă de un drum principal.

5. Să fie situată la maximum 500m faă de un restaurant.

7.2.3 Datele

Pentru a răspunde la aceste întrebări, vom avea nevoie de următoarele date:

1. Proprietăile rezideniale (clădirile) din zonă.

2. Drumurile din jurul i din cadrul oraului.

3. Amplasarea colilor i a restaurantelor.

4. Dimensiunea clădirilor.

All of this data is available through OSM and you should find that the dataset you have been using throughout
this manual can also be used for this lesson. However, in order to ensure we have the complete data, we will
re-download the data from OSM using QGIS’ built-in OSM download tool.

Note: Although OSM downloads have consistent data fields, the coverage and detail does vary. If you find that
your chosen region does not contain information on restaurants, for example, you may need to chose a different
region.

7.2.4 Follow Along: Startarea unui Proiect

• Deschidei un nou proiect QGIS

• Use the OpenStreetMap data download tool found in the Vector -> OpenStreetMap menu to download the
data for your chosen region.

• Salvai rezultatul ca osm_data.osm, în folderul exercise_data.

• Note that the osm format is a type of vector data. Add this data as a vector layer as usually Layer -> Add
vector layer..., browse to the new osm_data.osm file you just downloaded. You may need to select Show
All Files as the file format.

• Selectai osm_data.osm, apoi facei clic pe Open

• În caseta de dialog care se deschide, selectai toate straturile, cu excepia straturilor other_relations i
multilinestrings:
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Acest lucru va importa datele OSM în hartă ca i straturi separate.

The data you just downloaded from OSM is in a geographic coordinate system, WGS84, which uses latitude and
longitude coordinates, as you know from the previous lesson. You also learnt that to calculate distances in meters,
we need to work with a projected coordinate system. Start by setting your project’s coordinate system to a suitable
CRS for your data, in the case of Swellendam, WGS 84 / UTM zone 34S:

• Deschidei dialogul Proprietăile Proiectului, selectai CRS i filtrai lista pentru a găsi WGS 84 /
UTM zone 34S.

• Clic pe OK

We now need to extract the information we need from the OSM dataset. We need to end up with layers representing
all the houses, schools, restaurants and roads in the region. That information is inside the multipolygons layer and
can be extracted using the information in its Attribute Table. We’ll start with the schools layer:

• Facei clic-dreapta pe stratul multipolygons din Lista straturilor dvs., apoi deschidei dialogul Proprietăilor
Stratului.

• Mergei la meniul General.

• În Subsetul Entităilor facei clic pe butonul [Query Builder] deschide dialogul Query builder.

• În lista Cămpurilor din partea stângă a acestui dialog, derulai până când vei vedea câmpul amenity.

• Facei clic pe el o dată.

• Facei clic pe butonul All de sub lista Valori:

Acum, trebuie să indicai aplicaiei QGIS să arate doar poligoanele în care valoarea amenity este egală cu
school.

• Dublu-clic pe cuvântul amenity din lista Câmpurilor.

• Privii ce se întâmplă în câmpul ExpresiIor de filtrare specifice furnizorului de mai jos:
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A apărut cuvântul "amenity". Pentru a construi restul interogării:

• Facei clic pe butonul = (de sub lista Operatorilor).

• Dublu-clic pe valoarea school din lista Valorilor.

• Clic pe OK, de două ori.

This will filter OSM’s multipolygons layer to only show the schools in your region. You can now either:

• Rename the filtered OSM layer to schools and re-import the multipolygons layer from
osm_data.osm, OR

• Duplicate the filtered layer, rename the copy, clear the Query Builder and create your new query in the
Query Builder.

7.2.5 Try Yourself Extragei Straturile Cerute din OSM

Using the above technique, use the Query Builder tool to extract the remaining data from OSM to create the
following layers:

• roads (din stratul OSM lines)

• restaurants (din stratul OSM multipolygons)
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• houses (din stratul OSM multipolygons)

Ai putea re-utiliza stratul roads.shp pe care le-ai creat în leciile anterioare.

Verificai-vă rezultatele

• Save your map under exercise_data, as analysis.qgs (this map will be used in future modules).

• In your operating system’s file manager, create a new folder under exercise_data and call it
residential_development. This is where you’ll save the datasets that will be the results of the
analysis functions.

7.2.6 Try Yourself Găsii drumurile importante

Some of the roads in OSM’s dataset are listed as unclassified, tracks, path and footway. We want to
exclude these from our roads dataset.

• Deschidei Constructorul de Interogări pentru stratul roads, clic pe Clear i construii urmă-
toarea interogare:

"highway" != ’NULL’ AND "highway" != ’unclassified’ AND "highway" !=
’track’ AND "highway" != ’path’ AND "highway" != ’footway’

You can either use the approach above, where you double-clicked values and clicked buttons, or you can copy and
paste the command above.

Acest lucru ar trebui să reducă imediat numărul de drumuri de pe hartă:

7.2.7 Try Yourself Convertii CRS-ul Straturilor

Because we are going to be measuring distances within our layers, we need to change the layers’ CRS. To do this,
we need to select each layer in turn, save the layer to a new shapefile with our new projection, then import that
new layer into our map.
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Note: In this example, we are using the WGS 84 / UTM zone 34S CRS, but you may use a UTM CRS which is
more appropriate for your region.

• Facei clic-dreapta pe stratul roads din panoul Layers.

• Clic pe Save as...

• In the Save Vector As dialog, choose the following settings and click Ok (making sure you select Add
saved file to map):

Noul fiier shape va fi creat, iar stratul rezultat va fi adăugat la hartă.
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Note: If you don’t have activated Enable ‘on the fly’ CRS transformation or the Automatically enable ‘on the fly’
reprojection if layers have different CRS settings (see previous lesson), you might not be able to see the new layers
you just added to the map. In this case, you can focus the map on any of the layers by right click on any layer and
click Zoom to layer extent, or just enable any of the mentioned ‘on the fly’ options.

• Eliminai vechiul strat roads.

Repeat this process for each layer, creating a new shapefile and layer with “_34S” appended to the original name
and removing each of the old layers.

Once you have completed the process for each layer, right click on any layer and click Zoom to layer extent to
focus the map to the area of interest.

Now that we have converted OSM’s data to a UTM projection, we can begin our calculations.

7.2.8 Follow Along: Analyzing the Problem: Distances From Schools and
Roads

QGIS allows you to calculate distances from any vector object.

• Make sure that only the roads_34S and houses_34S layers are visible, to simplify the map while you’re
working.

• Click on the Vector → Geoprocessing Tools → Buffer(s) tool:

This gives you a new dialog.

• Setai-l astfel:
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The Buffer distance is in meters because our input dataset is in a Projected Coordinate System that uses meter as
its basic measurement unit. This is why we needed to use projected data.

• Save the resulting layer under exercise_data/residential_development/ as
roads_buffer_50m.shp.

• Click OK and it will create the buffer.

• When it asks you if it should “add the new layer to the TOC”, click Yes. (“TOC” stands for “Table of
Contents”, by which it means the Layers list).

• Close the Buffer(s) dialog.

Now your map will look something like this:
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If your new layer is at the top of the Layers list, it will probably obscure much of your map, but this gives us all
the areas in your region which are within 50m of a road.

However, you’ll notice that there are distinct areas within our buffer, which correspond to all the individual roads.
To get rid of this problem, remove the layer and re-create the buffer using the settings shown here:
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• Note that we’re now checking the Dissolve buffer results box.

• Save the output under the same name as before (click Yes when it asks your permission to overwrite the old
one).

• Click OK and close the Buffer(s) dialog again.

Once you’ve added the layer to the Layers list, it will look like this:
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Now there are no unnecessary subdivisions.

7.2.9 Try Yourself Distance from schools

• Use the same approach as above and create a buffer for your schools.

It needs to be 1 km in radius, and saved under the usual directory as schools_buffer_1km.shp.

Check your results

7.2.10 Follow Along: Overlapping Areas

Now we have areas where the road is 50 meters away and there’s a school within 1 km (direct line, not by road).
But obviously, we only want the areas where both of these criteria are satisfied. To do that, we’ll need to use the
Intersect tool. Find it under Vector → Geoprocessing Tools → Intersect. Set it up like this:
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The two input layers are the two buffers; the save location is as usual; and the file name is
road_school_buffers_intersect.shp. Once it’s set up like this, click OK and add the layer to the
Layers list when prompted.

In the image below, the blue areas show us where both distance criteria are satisfied at once!
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You may remove the two buffer layers and only keep the one that shows where they overlap, since that’s what we
really wanted to know in the first place:

7.2.11 Follow Along: Select the Buildings

Now you’ve got the area that the buildings must overlap. Next, you want to select the buildings in that area.

• Click on the menu entry Vector → Research Tools → Select by location. A dialog will appear.
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• Setai-l astfel:

• Click OK, then Close.

• You’ll probably find that not much seems to have changed. If so, move the school_roads_intersect
layer to the bottom of the layers list, then zoom in:

7.2. Lesson: Analiza Vectorială 173
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The buildings highlighted in yellow are those which match our criteria and are selected, while the buildings in
green are those which do not. We can now save the selected buildings as a new layer.

• Right-click on the houses_34S layer in the Layers list.

• Select Save Selection As....

• Set the dialog up like this:

• The file name is well_located_houses.shp.

• Clic pe OK
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Now you have the selection as a separate layer and can remove the houses_34S layer.

7.2.12 Try Yourself Further Filter our Buildings

We now have a layer which shows us all the buildings within 1km of a school and within 50m of a road. We now
need to reduce that selection to only show buildings which are within 500m of a restaurant.

Using the processes described above, create a new layer called houses_restaurants_500m which further
filters your well_located_houses layer to show only those which are within 500m of a restaurant.

Check your results

7.2.13 Follow Along: Select Buildings of the Right Size

To see which buildings are the correct size (more than 100 square meters), we first need to calculate their size.

• Open the attribute table for the houses_restaurants_500m layer.

• Enter edit mode and open the field calculator.

• Setai-l astfel:
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• If you can’t find AREA in the list, try creating a new field as you did in the previous lesson of this module.

• Clic pe OK

• Scroll to the right of the attribute table; your AREA field now has areas in metres for all the buildings in your
houses_restaurants_500m layer.

• Click the edit mode button again to finish editing, and save your edits when prompted.

• Build a query as earlier in this lesson:
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• Click OK. Your map should now only show you those buildings which match our starting criteria and which
are more than 100m squared in size.

7.2.14 Try Yourself

• Save your solution as a new layer, using the approach you learned above for doing so. The file should be
saved under the usual directory, with the name solution.shp.

7.2.15 In Conclusion

Using the GIS problem-solving approach together with QGIS vector analysis tools, you were able to solve a
problem with multiple criteria quickly and easily.

7.2.16 What’s Next?

In the next lesson, we’ll look at how to calculate the shortest distance along the road from one point to another.
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7.3 Lesson: Analiza Reelelor

Calcularea celei mai scurte distane dintre două puncte reprezintă o utilizare frecvent utilizată în GIS. QGIS este
livrat împreună cu acest instrument, lucru care nu este vizibil, în mod implicit. În această scurtă lecie, vă vom
arăta cum putei începe.

Scopul acestei lecii: De a activa, configura i utiliza pluginul Road Graph.

7.3.1 Follow Along: Activarea Instrumentului

QGIS are multe plugin-uri care se adaugă la funciile sale de bază. Multe dintre aceste plugin-uri sunt atât de utile
încât se livrează împreună cu programul, fiind disponibile imediat după instalare. Ele sunt totui ascunse, în mod
implicit. Astfel, pentru a le putea folosi, trebuie mai întâi să le activai.

Pentru a activa plugin-ul Road Graph:

• Startai Managerul de Plugin-uri făcând clic pe elementul din meniul principal al ferestrei QGIS Plugin-uri
→ Gestionare i Instalare Plugin-uri.... Va apărea un dialog.

• Selectai pluginul în felul următor:

• Facei clic pe Close din dialogul Plugin Manager.

Note: Dacă nu vedei plugin-ul în interfaa aplicaiei dvs., mergei la Vizualizare → Panouri i asigurai-vă că este
bifată Calea cea mai scurtă.

Acest panou va apărea în interfaa dvs.:
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7.3.2 Follow Along: Configurarea Instrumentului

Pentru a avea un strat pentru calculat, salvai mai întâi harta curentă. În cazul în care nu ai făcut deja acest lucru,
salvai stratul dvs. roads_34S într-un fiier shape, efectuând clic-dreapta pe strat i alegând Salvare ca.... Creai o
hartă nouă i încărcai stratul în ea.

Din moment ce atât de multe configuraii diferite sunt posibile în analiza reelelor, plugin-ul nu îi asumă nimic în
afara configuraiilor introduse de către dvs. Prin urmare, el nu va efectua nici o operaiune dacă nu-l configurai mai
întâi.

• Facei clic pe elementul de meniu Vector → Road graph → settings. Va apărea un dialog.

• Asigurai-vă că ai efectuat următoarele setări (folosii valorile implicite dacă nu se specifică altfel):
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• Unitatea de timp: ora

• Unitatea de distană: kilometru

• Stratul: roads_34S

• Câmpul vitezei: Întotdeauna se folosete cel implicit / km/h
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• Direcia: O direcie cu două sensuri

• Viteza: 60

7.3.3 Follow Along: Utilizarea Instrumentului

Găsii două puncte pe drumurile din harta dvs. Ele nu trebuie să aibă nici o semnificaie, dar acestea ar trebui să fie
conectate prin drumuri i să fie separate de o distană rezonabilă:
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• În panoul plugin-ului facei clic pe butonul Capture Point, de lângă câmpul Start:
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• Facei clic pe punctul de pornire ales.

• Folosii butonul Captură Punct de lângă câmpul Stop i capturai punctul final ales.

• Clic pe butonul Calculate pentru a vedea soluia:
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7.3.4 Follow Along: Folosirea Criteriilor

Note: Seciune dezvoltată de Linfiniti i S Motala (Cape Peninsula University of Technology)

• Adăugai stratul restaurants_34S la hartă (extrăgânfu-l din harta analyis, dacă este cazul).

• Deschidei tabela de atribute a stratului roads_34S i intrai în modul de intrare.

• Adăugai o nouă coloană cu numele SPEED, i atribuii-i tipul Whole number (integer) cu o lungime de 3.

• În fereastra principală, activai instrumentul Select Features by Rectangle:
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• Selectai drumurile principale din zonele urbane - dar nu i rezideniale:

(Pentru a selecta mai mult de un drum, inei butonul ctrl i glisai caseta de-a lungul oricărui drum pe care dorii
să-l includei în selecie.)

• În tabelade atribute, selectai Arată entităile selectate.
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• Setai valoarea SPEED, pentru toate străzile selectate, la 60:

În context, aceasta înseamnă că ai stabilit limita de viteză de pe acele drumuri la 60 km/h.

• Selectai autostrăzile sau drumurile principale din afara zonelor urbane:
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• Setai valoarea SPEED, pentru toate străzile selectate, la 120:

• Închidei tabela de atribute, salvai modificările i ieii din modul de editare.

• Bifai Vector → Graful Drumului → Setările pentru stratul drumului pentru a vă asigura că este configurat
aa cum s-a explicat anterior în această lecie, dar având valoarea pentru Speed setată pentru câmpul SPEED,
pe care tocmai l-ai creat.

• În panoul Shortest path, facei clic pe butonul Punctul de start.

• Setai punctul de plecare pe un drum secundar din Swellendam, iar punctul final pe un drum important din
cealaltă parte a oraului:
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• În lista derulantă Criterii din panoul Celei mai scurte căi, selectai Lungime.

• Facei clic pe Calculate. Se va calcula traseul cu distana cea mai scurtă:

Notai valorile pentru Lungime i Timp din panoul Calea cea mai scurtă.

• Schimbai Criterion pe Timp.

• Facei iarăi clic pe Calculate. Se va calcula traseul cu timpul cel mai scurt:
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Putei comuta înainte i înapoi între aceste criterii, să recalculai de fiecare dată, i să notai schimbările de Lungime
i Timp. Amintii-vă că ipoteza de a ajunge într-un timp dat pentru a parcurge un traseu nu ine cont de acceleraie,
presupunând că deplasarea se va face, în orice moment, la limita de viteză. Într-o situaie reală, ai putea dori să
împării drumurile în seciuni mai mici, notând mai degrabă viteza medie sau pe cea ateptată decât limita de viteză,
pentru fiecare seciune.

În cazul în care vei face clic pe Calcul i vei întâmpina o eroare care să indice faptul că o cale nu a putut fi găsită,
asigurai-vă că drumurile pe care le-ai digitizat s-au întâlnit de fapt unul pe altul. În cazul în care acestea nu sunt
destul de apropiate, putei remedia acest lucru fie prin modificarea entităilor, fie prin setarea Toleranei topologiei în
setările pluginului. Dacă traseele vor trece unele peste altele, fără a se intersecta, folosii instrumentul de Divizare
a entităilor pentru a “tăia” drumurile la intersecie:

Amintii-vă că instrumentul Divizare entităi funcionează asupra entităilor selectate numai în modul de editare!

Ai putea afla, de asemenea, că cea mai scurtă rută este i cea mai rapidă, dacă este returnată această eroare.

7.3.5 In Conclusion

Acum tii cum să utilizai pluginul Road Graph, pentru a rezolva problema celei mai scurte căi.

7.3.6 What’s Next?

Mai departe, vei vedea cum să rulai algoritmii statisticilor spaiale asupra seturilor de date vectoriale.

7.4 Lesson: Statistici Spaiale

Note: Lecia a fost dezvoltată de Linfiniti i S Motala (Cape Peninsula University of Technology
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Statisticile spaiale vă permit să analizai i să înelegei ce se întâmplă într-un anumit set de date. QGIS include mai
multe instrumente standard de analiză statistică, care se dovedesc utile în acest sens.

Scopul acestei lecii: De a afla cum se pot utiliza instrumentele de statistici spaiale QGIS.

7.4.1 Follow Along: Crearea unui Set de Date de Test

În scopul de obinerii unui set de date pentru a lucra cu el, vom crea un set de puncte aleatorii.

Pentru a face acest lucru, vei avea nevoie de un set de date poligonale, care definete extinderea zonei în care dorii
să creai punctele.

Vom folosi aria acoperită de străzi.

• Creai o nouă hartă albă.

• Adăugai stratul dvs. roads_34S, la fel ca i rasterul srtm_41_19.tif (datele de elevatie) găsite în
exercise_data/raster/SRTM/.

Note: Stratul dvs. DEM SRTM este posibil să aibă un alt CRS decât cel al stratului drumurilor. Dacă este aa,
atunci putei reproiecta fie stratul drumurilor, fie pe cel al DEM-ului, folosind tehnicile învăate mai devreme în
acest modul.

• Folosii instrumentul Convex hull(s) (disponibil în Vector → Geoprocessing Tools) pentru a genera o zonă
care să includă toate drumurile:
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• Salvai rezultatul în exercise_data/spatial_statistics/, sub denumirea roads_hull.shp.

• Add it to the TOC (Layers list) when prompted.

Crearea de puncte aleatorii

• Crearea de puncte aleatorii în această arie, prin utilizarea instrumentului Vector → Research Tools → Ran-
dom points:
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• Salvai rezultatul în exercise_data/spatial_statistics/, sub denumirea
random_points.shp.

• Add it to the TOC (Layers list) when prompted:
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Eantionarea datelor

• Pentru a crea un set de eantion de date raster, va trebui să utilizai plugin-ul Point sampling tool.

• Căutai mai întâi modulul în plugin-uri, dacă este necesar.

• Căutai fraza point sampling în Plugin –> Manage and Install Plugins... apoi vei găsi plugin-ul.

• O dată ce ai activat Managerul de Plugin-uri, vei găsi instrumentul sub Plugins → Analyses → Point
sampling tool:
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• Alegei random_points ca fiind stratul care conine punctele de prelevare, precum i rasterul SRTM ca fiind
banda din care se vor obine valorile.

• Asigurai-vă că ai bifat “Add created layer to the TOC”.

• Salvai rezultatul în exercise_data/spatial_statistics/, sub denumirea
random_samples.shp.

Acum putei verifica datele eantion din fiierul raster în tabelul de atribute al stratului random_samples, acestea
aflându-se în coloana denumită srtm_41_19.tif.

Un posibil strat eantion este prezentat aici:
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Punctele eantion sunt clasificate în funcie de valorile lor, astfel că punctele mai întunecate sunt situate la o altitu-
dine joasă.

Vei folosi acest strat eantion pentru restul exerciiilor statistice.

7.4.2 Follow Along: Statistici de Bază

Obine statisticile de bază pentru acest strat.

• Facei clic pe elementul de meniu Vector → Analysis Tools → Basic statistics.

• În caseta de dialog care apare, specificai stratul random_samples ca i sursă.

• Asigurai-vă că Target field este setat la srtm_41_19.tif, care este câmpul pentru care vei calcula statis-
ticile.

• Facei clic pe Ok. Vei obine rezultate ca acesta:
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Note: Putei copia i lipi rezultatele într-o foaie de calcul. Datele folosesc un separator (două puncte :).
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• Închidei dialogul plugin-ului, după încheiere.

Pentru a înelege statisticile de mai sus, consultai această listă cu definiii:

Media Valoarea medie (medie) valoarea reprezintă pur i simplu suma valorilor împărită la cantitatea de valori.

StdDev Abaterea standard. Oferă o indicaie despre cât de strâns sunt grupate valorile în jurul mediei. Cu cât este
mai mică deviaia standard, cu atât mai apropiată tinde să fie media.

Sum Toate valorile adunate.

Min Valoarea minimă.

Max Valoarea maximă.

N Cantitatea de eantioane/valori.

CV Covariana spaială a setului de date.

Numărul de valori unice Numărul de valori, care sunt unice în acest set de date. Dacă există 90 de valori unice
într-un set de date cu N = 100, atunci cele 10 valori rămase pot fi identice între ele.

Intervalul Diferena dintre valorile minime i maxime.

Mediana Dacă aranjai toate valorile de la cea mai mică la cea mai mare, valoarea de mijloc (sau media celor două
valori de mijloc, în cazul în care N este un număr par) este mediana valorilor.

7.4.3 Follow Along: Calculul unei Matrici a Distanelor

• Creai un strat nou, de tip punct, în aceeai proiecie ca i alte seturi de date (WGS 84 / UTM 34S).

• Intraibîn modul de editare i digitizai trei puncte, undeva printre celelalte.

• Ca o alternativă, utilizai aceeai metodă de generare a punctelor aleatorii la fel ca înainte, însă specificai doar
trei puncte.

• Salvai noul strat ca i distance_points.shp.

Pentru a genera o matrice a distanelor folosind aceste puncte:

• Deschidei instrumentul Vector → Analysis Tools → Distance matrix.

• Selectai stratul distance_points ca i sursă, apoi stratul random_samples ca destinaie.

• Setai-l astfel:
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• Salvai rezultatul ca i distance_matrix.csv.

• Clic pe OK, pentru a genera matricea distanelor.

• Deschidei-l într-un program de calcul tabelar pentru a vedea rezultatele. Iată un exemplu:

198 Chapter 7. MOD| Analiza Vectorială
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7.4.4 Follow Along: Analiza Celui Mai Apropiat Vecin

Pentru a face o analiză a celui mai apropiat vecin:

• Facei clic pe elementul de meniu Vector → Analysis Tools → Nearest neighbor analysis.

• În caseta de dialog care apare, specificai stratul random_samples, apoi facei clic pe OK.

• Rezultatele vor apărea în textul ferestrei de dialog, de exemplu:

Note: Putei copia i lipi rezultatele într-o foaie de calcul. Datele folosesc un separator (două puncte :).
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7.4.5 Follow Along: Coordonatele Medii

Pentru a obine coordonatele medii ale unui set de date:

• Clic pe elementul de meniu Vector → Analysis Tools → Mean coordinate(s).

• În caseta de dialog care apare, specificai stratul random_samples ca i intrare, dar lăsai alegerile opionale
neschimbate.

• Specificai stratul de ieire mean_coords.shp.

• Clic pe OK

• Adăugai stratul la Lista straturilor, atunci când vi se cere.

Haidei să-l comparăm cu coordonatele centrale ale poligonului care a fost folosit pentru a crea eantionul aleator.

• Facei clic pe elementul de meniu Vector → Geometry Tools → Polygon centroids menu item.

• În caseta de dialog care apare, selectai stratul roads_hull ca intrare.

• Salvai rezultatul ca i center_point.

• Adăugai-l în Lista straturilor, atunci când vi se cere.

După cum putei vedea din exemplul de mai jos, coordonatele medii i centrul zonei de studiu (în portocaliu) nu
coincid în mod necesar:

7.4.6 Follow Along: Histogramele de tip Imagine

Histograma unui set de date arată distribuia valorilor sale. Cel mai simplu mod de a demonstra acest lucru în
QGIS este prin histograma imaginii, disponibilă în dialogul Layer Properties al oricărui strat de imagine.

• În Lista straturilor facei clic-dreapta pe stratul SRTM DEM.

• Selectai Proprietăi.

• Alegei fila Histogram. Poate fi necesar să facei clic pe butonul Compute Histogram pentru a genera graficul.
Vei vedea un grafic care descrie frecvena valorilor din imagine.
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• O putei exporta ca o imagine:

• Selectând fila Metadatelor, putei vedea informaii mai detaliate în interiorul casetei Properties.

Valoarea medie este 332.8, iar valoarea maximă este 1699! Dar aceste valori nu apar pe histogramă. Oare de
ce? Din cauză că sunt atât de puine, comparativ cu abundena de pixeli cu valori sub medie. Acesta este motivul
pentru care histograma se extinde mult spre dreapta, chiar dacă nu este vizibilă linia roie care marchează valori de
frecvenă mai mari de 250.

Prin urmare, reinei că o histogramă vă arată distribuia valorilor, dar nu toate valorile sunt în mod necesar vizibile
pe grafic.

• (Acum putei închide Stratul Proprietăilor.)

7.4.7 Follow Along: Interpolarea Spaială

Să presupunem că avei o colecie de puncte de eantionare din care ai dori să extrapolai datele. De exemplu, ai
putea avea acces la setul de date random_samples pe care l-am creat mai devreme, i să vă facei o idee despre cum
ar arăta terenul.

Pentru a începe, utilizai instrumentul Grid (Interpolation), prin efectuarea unui clic pe elementul de meniu Raster
→ Analysis → Grid (Interpolation).

• În câmpul Input file field, selectai random_samples.
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• Bifai caseta Z Field, apoi selectai câmpul srtm_41_19.

• Setai locaia Fiierului de ieire la exercise_data/spatial_statistics/interpolation.tif.

• Bifai caseta Algorithm, apoi selectai Inverse distance to a power.

• Setai Power la 5.0 i Smoothing la 2.0. Lăsai celelalte valori aa cum sunt.

• Bifaţi caseta Load into canvas when finished, apoi facei clic pe OK.

• Când ai terminat, facei clic pe OK, în dialogul care spune că Procesul s-a încheiat, facei clic pe
OK, în dialogul care arată informaia returnată (dacă aceasta apare), i în final facei clic pe Close în dialogul
de (Interpolare) Grilă.

Iată o comparaie a setului de date original (stânga) cu cel construit din eantionul nostru de puncte (dreapta). Al
dvs. poate să arate diferit, din cauza naturii aleatorii a locaiei punctelor de eantionare.

După cum putei vedea, un eantion compus din 100 puncte nu este cu adevărat suficient pentru a obine o imagine
detaliată a terenului. El oferă doar o idee foarte generală, care, însă, poate fi înelătoare. De exemplu, în imaginea
de mai sus, nu este clar dacă există un munte masiv, neîntrerupt, întinzându-se de la est la vest; mai degrabă,
imaginea pare să arate o vale, cu vârfuri înalte la vest. Folosind doar inspecia vizuală, observăm că setul de date
eantion nu este reprezentativ pentru teren.

7.4.8 Try Yourself

• Utilizai procedeele prezentate mai sus pentru a crea un nou set de 1000 de puncte aleatorii.

• Folosii aceste puncte pentru a eantiona DEM-ul original.

• Aplicai instrumentul de (Interpolare) Grilă pe acest nou set de date, ca mai sus.

• Setai numele fiierului de ieire la interpolation_1000.tif, având Power i Smoothing setate la 5.0
i respectiv 2.0.

Rezultatele (în funcie de poziionarea punctelor aleatorii) va arata mai mult, sau mai puin, ca aceasta:
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Bordura din jurul stratului roads_hull (care reprezintă limita punctelor aleatorii de eantionare), explică lipsa bruscă
a detaliilor dincolo de marginile sale. Aceasta este o reprezentare a terenului mult mai bună, ca urmare a ridicatei
densităi de puncte eantion.

Aici este un exemplu despre cum arată cu 10 000 de puncte eantion:

Note: Nu se recomandă să încercai cu 10 000 de puncte de eantionare dacă nu lucrai pe un computer rapid,
deoarece mărimea setului de date eantion determină timpul de procesare.
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7.4.9 Follow Along: Instrumente Adiionale de Analiză Spaială

Iniial, un proiect separat i apoi accesibil sub formă de plugin, soft-ul SEXTANTE a fost adăugat la QGIS ca o
funcie de bază începând cu versiunea 2.0. Îl putei găsi într-un nou meniu din QGIS, sub numele Processing,
care oferă un bogat set de instrumente de analiză spaială, alături de diverse plugin-uri, toate fiind accesibile din
interiorul unei singure interfee.

• Activai acest set de instrumente, prin accesarea elementului de meniu Processing → Toolbox menu entry.
Setul de instrumente arată astfel:

Îl vei vedea, probabil, andocat în QGIS, în dreapta hării. Reinei că instrumentele enumerate aici sunt link-uri către
instrumente reale. Unele dintre ele reprezintă algoritmi proprii SEXTANTE, iar altele reprezintă trimiteri către
instrumente accesate din aplicaii externe, cum ar fi GRASS, SAGA sau Orfeo Toolbox. Aceste aplicaii externe
sunt instalate o dată cu QGIS, astfel că suntei deja în măsură să facei uz de ele. În cazul în care trebuie să schimbai
configuraia instrumentelor Processing sau când, de exemplu, trebuie să trecei la o nouă versiune a uneia dintre
aplicaiile externe, putei accesa setările sale din Processing → Options and configurations.

7.4.10 Follow Along: Analiza Modelului de Puncte Spaiale

Pentru o indicaie simplă a distribuiei spaiale a punctelor în setul de date random_samples, putem folosi instru-
mentul Spatial Point Pattern Analysis din SAGA, prin intermediul Instrumentarului Processing pe care tocmai
l-ai deschis.

• În Processing Toolbox, căutai instrumentul Spatial Point Pattern Analysis.

• Dublu-clic pe el pentru a-i deschide dialogul.
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Instalarea SAGA

Note: Dacă SAGA nu este instalat pe sistemul dvs., dialogul plugin-ului vă va informa că dependena lipsete.
Dacă nu vă aflai în acest caz, putei sări peste aceti pai.

Pe Windows

Inclus în materialele dvs. de curs, vei găsi programul de instalare al aplicaiei SAGA pentru Windows.

• Pornii programul i urmai instruciunile sale pentru a instala SAGA pe sistemul dvs. Windows. Notai calea
de instalare!

O dată ce ai instalat SAGA, va trebui să specificai calea sa de instalare în SEXTANTE.

• Facei clic pe elementul de meniu Analysis → SAGA options and configuration.

• În caseta de dialog care apare, expandai elementul SAGA, apoi căutai folderul SAGA. Valoarea sa va fi albă.

• În acest spaiu, introducei calea în care ai instalat SAGA.

Pe Ubuntu

• Căutai SAGA GIS în Software Center, sau introducei fraza sudo apt-get install saga-gis în
terminalul dvs. (Este posibil să trebuiască mai întâi să adăugai un depozit SAGA la sursele dvs.)

• QGIS va găsi SAGA automat, dei ar putea fi necesar să repornii QGIS în cazul în care nu funcionează
imediat.

Pe Mac

Utilizatorii Homebrew pot instala SAGA cu această comandă:

• brew install saga-core

Dacă nu utilizai Homebrew, vă rugăm să urmai instruciunile de aici:

http://sourceforge.net/apps/trac/saga-gis/wiki/Compiling%20SAGA%20on%20Mac%20OS%20X

După instalare

Acum, că ai instalat i configurat SAGA, funciile sale vor deveni accesibile pentru dvs.

Folosirea SAGA

• Deschidei fereastra de dialog SAGA.

• SAGA produce trei ieiri, aa că va fi nevoie de trei căi de ieire.

• Salvai aceste trei ieiri în exercise_data/spatial_statistics/, folosind orice nume de fiier pe
care îl vei considera adecvat.
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Ieirea va arata astfel (simbolistica a fost schimbată pentru acest exemplu):
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Punctul rou reprezintă centrul mediei; cercul mare este distana standard, care oferă indicaii despre cât de strâns
sunt distribuite punctele în jurul centrului mediei; iar dreptunghiul reprezintă caseta de încadrare, care descrie cel
mai mic dreptunghi posibil care include toate punctele.

7.4.11 Follow Along: Analiza Distanei Minime

De multe ori, ieirea unui algoritm nu va fi un fiier shape, ci mai degrabă un tabel care rezumă proprietăile statistice
ale un set de date. Un astfel de exemplu este instrumentul Minimum Distance Analysis.

• Găsii acest instrument în Processing Toolbox ca Analiza Distanei Minime.

Nu este nevoie de nici o altă intrare, în afară de specificarea setului vectorial de date de tip punct, de analizat.

• Alegei setul de date random_points.

• Facei clic pe:guilabel:OK. La finalizare, un tabel DBF va apărea în Lista straturilor.

• Selectai-l, apoi deschidei tabelul de atribute. Dei cifrele pot varia, rezultatele vor fi în acest format:
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7.4.12 In Conclusion

QGIS oferă multe posibilităi de analiză a proprietăilor statistice spaiale pentru seturile de date.

7.4.13 What’s Next?

Acum, că am acoperit analiza vectorială, de ce să nu vedem i ce se poate face cu rasterele? Asta e ceea ce vom
face în modulul următor!
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CHAPTER 8

Module: Rastere

Am folosit rastere pentru digitizarea anterioară, dar datele raster pot fi folosite, de asemenea, i în mod direct. În
acest modul, vei vedea cum se face acest lucru în QGIS.

8.1 Lesson: Lucrul cu Datele Raster

Datele raster sunt foarte diferite de datele vectoriale. Datele vectoriale au entităi discrete construite din verteci,
uneori conectai cu linii i/sau cu zone. Datele raster, în schimb, sunt similare imaginilor. Dei pot prezenta diverse
proprietăi despre obiectele din lumea reală, în datele raster nu întâlnim obiecte separate; mai degrabă, acestea sunt
reprezentate folosind pixeli de diferite valori, corespunzătoare unor culori diverse.

În timpul acestui modul vei utiliza datele raster pentru a suplimenta analiza GIS existentă.

Scopul acestei lecii: De a afla cum se poate lucra cu datele raster în mediul QGIS.

8.1.1 Follow Along: Încărcarea Datelor Raster

• Open your analysis.qgs map (which you should have created and saved during the previous module).

• Dezactivai toate straturile, cu excepia straturilor solution i important_roads.

• Clic pe butonul Încărcare Strat Raster:

The Load Raster Layer dialog will open. The data for this project is in exercise_data/raster.

• Either load them all in separately, or hold down ctrl and click on all four of them in turn, then open them
at the same time.

The first thing you’ll notice is that nothing seems to be happening in your map. Are the rasters not loading? Well,
there they are in the Layers list, so obviously they did load. The problem is that they’re not in the same projection.
Luckily, we’ve already seen what to do in this situation.

• Selectai Project –> Project Properties din meniu:

• Selectai fila CRS, din meniu:

• Activai reproiectarea “din zbor”.

• Setai-l la aceeai proiecie ca i restul datelor dvs. (WGS 84 / UTM zone 33S).

• Clic pe OK

Rasterele ar trebui să se potrivească bine:
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Le avem aici - patru fotografii aeriene care acoperă zona întregului nostru studiu.

8.1.2 Follow Along: Crearea unui Raster Virtual

Now as you can see from this, your solution layer lies across all four photographs. What this means is that you’re
going to have to work with four rasters all the time. That’s not ideal; it would be better to have one file for one
(composite) image, right?

Luckily, QGIS allows you to do exactly this, and without needing to actually create a new raster file, which could
take up a lot of space. Instead, you can create a Virtual Raster. This is also often called a Catalog, which explains
its function. It’s not really a new raster. Rather, it’s a way to organize your existing rasters into one catalog: one
file for easy access.

Pentru a face un catalog:

• Facei clic pe elementul de meniu Raster → Miscellaneous → Build Virtual Raster (Catalog).

• In the dialog that appears, check the box next to Use visible raster layers for input.

• Introducei exercise_data/residential_development ca locaie de ieire.

• Introducei aerial_photos.vrt ca nume de fiier.

• Bifaţi caseta Încărcare în canevas după finalizare.
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Notice the text field below. What this dialog is actually doing is that it’s writing that text for you. It’s a long
command that QGIS is going to run.

Note: Keep in mind that the command text is editable, so you can customize the command further if
preferred. Search online for the initial command (in this case, gdalbuildvrt) for help on the syntax.

• Clic pe OK, pentru a rula comanda.

Este posibil să dureze un timp pentru a finaliza. Când este gata, acest lucru va fi indicat de o casetă de mesaje.

• Clic pe OK, pentru a îndepărta mesajul.

• Click Close on the Build Virtual Raster (Catalog) dialog. (Don’t click OK again, otherwise it’s going to
start running that command again.)
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• Acum putei elimina cele patru straturi originale din Lista straturillor.

• If necessary, click and drag the new aerial_photos raster catalog layer to the bottom of the Layers list so
that the other activated layers become visible.

8.1.3 Transformarea Datelot Raster

The above methods allow you to virtually merge datasets using a catalog, and to reproject them “on the fly”.
However, if you are setting up data that you’ll be using for quite a while, it may be more efficient to create new
rasters that are already merged and reprojected. This improves performance while using the rasters in a map, but
it may take some time to set up initially.

Reproiectare rasterelor

• Facei clic pe elementul de meniu Raster → Projections → Warp (Reproject).

Note that this tool features a handy batch option for reprojecting the contents of whole directories. You can also
reproject virtual rasters (catalogs), as well as enabling a multithreaded processing mode.
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Îmbinarea rastererelor

• Facei clic pe elementul de meniu Raster → Miscellaneous → Merge.

You can choose to process entire directories instead of single files, giving you a very useful built-in batch process-
ing capability. You can specify a virtual raster as input file, too, and all of the rasters that it consists of will be
processed.

You can also add your own command line options using the Creation Options checkbox and list. This only applies
if you have knowledge of the GDAL library’s operation.
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8.1.4 In Conclusion

QGIS face mai uoară includerea datelor raster în proiectele existente.

8.1.5 What’s Next?

Next, we’ll use raster data that isn’t aerial imagery, and see how symbolization is useful in the case of rasters as
well.

8.2 Lesson: Schimbarea Simbologiei Raster

Not all raster data consists of aerial photographs. There are many other forms of raster data, and in many of those
cases, it’s essential to symbolize the data properly so that it becomes properly visible and useful.

Scopul acestei lecii: De a schimba simbolistica pentru un strat raster.

8.2.1 Try Yourself

• Începei cu harta actuală, care ar fi trebuit să fie creată în timpul exerciiului precedent: analysis.qgs.

• Folosii butonul Add Raster Layer pentru a încărca noul set de date.

• Încărcai setul de date srtm_41_19.tif, de sub directorul exercise_data/raster/SRTM/.

• O dată ce apare în Lista straturilor, redenumii-l DEM.

• Focusai pe extinderea acestui strat prin clic-dreapta pe el în Lista Straturilor, apoi selectai Zoom to Layer
Extent.

This dataset is a Digital Elevation Model (DEM). It’s a map of the elevation (altitude) of the terrain, allowing us
to see where the mountains and valleys are, for example.

Once it’s loaded, you’ll notice that it’s a basic stretched grayscale representation of the DEM. It’s seen here with
the vector layers on top:
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QGIS has automatically applied a stretch to the image for visualization purposes, and we will learn more about
how this works as we continue.

8.2.2 Follow Along: Schimbarea Simbologiei Straturilor Raster

• Open the Layer Properties dialog for the SRTM layer by right-clicking on the layer in the Layer tree and
selecting Properties option.

• Mergei la fila Stil.
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These are the current settings that QGIS applied for us by default. Its just one way to look at a DEM, so lets
explore some others.

• Schimbai Tipul Randării pe Singleband pseudocolor, i folosii opiunile implicite prezentate.

• Click the Classify button to generate a new color classification, and click OK to apply this classification to
the DEM.
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Vei vedea un raster care arată în felul următor:
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Acesta este un mod interesant de a privi DEM-ul, dar poate că nu dorim să-l simbolizăm folosind aceste culori.

• Deschidei iarăi dialogul Layer Properties.

• Schimbai Tipul Randării înapoi pe Singleband gray.

• Facei clic pe Ok pentru a aplica aceste setări rasterului.

Vei vedea acum un dreptunghi complet gri, care nu este foarte util.
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This is because we have lost the default settings which “stretch” the color values to show them contrast.

Let’s tell QGIS to again “stretch” the color values based on the range of data in the DEM. This will make QGIS
use all of the available colors (in Grayscale, this is black, white and all shades of gray in between).

• Specificai valorile Min i Max aa cum se arată mai jos.

• Setai valoarea Contrast enhancement pe Stretch To MinMax:
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But what are the minimum and maximum values that should be used for the stretch? The ones that are currently
under Min and Max values are the same values that just gave us a gray rectangle before. Instead, we should be
using the minimum and maximum values that are actually in the image, right? Fortunately, you can determine
those values easily by loading the minimum and maximum values of the raster.

• Sub Load min / max values, selectai opiuna Min / Max.

• Clic pe butonul Încărcare:

Reinei că Valorile personalizate min / max s-au schimbat, pentru a reflecta valorile reale din DEM-ul nostru:
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• Facei clic pe Ok pentru a aplica aceste setări imaginii.

You’ll now see that the values of the raster are again properly displayed, with the darker colors representing valleys
and the lighter ones, mountains:
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Dar nu există o modalitate mai bună sau mai uoară?

Yes, there is. Now that you understand what needs to be done, you’ll be glad to know that there’s a tool for doing
all of this easily.

• Scoatei DEM-ul curent din Lista straturilor.

• Încărcai rasterul din nou, redenumindu-l DEM, ca mai înainte. Este, din nou, un dreptunghi gri...

• Activai instrumentul de care vei avea nevoie View → Toolbars → Raster. Aceste pictograme vor apărea în
interfaă:

The third button from the left Local Histogram Stretch will automatically stretch the minimum and maximum
values to give you the best contrast in the local area that you’re zoomed into. It’s useful for large datasets. The
button on the left Local Cumulative Cut Stretch ... will stretch the minimum and maximum values to constant
values across the whole image.

• Click the fourth button from the left (Stretch Histogram to Full Dataset). You’ll see the data is now correctly
represented as before.

You can try the other buttons in this toolbar and see how they alter the stretch of the image when zoomed in to
local areas or when fully zoomed out.
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8.2.3 In Conclusion

These are only the basic functions to get you started with raster symbology. QGIS also allows you many other
options, such as symbolizing a layer using standard deviations, or representing different bands with different colors
in a multispectral image.

8.2.4 Referină

Setul de date SRTM a fost obinut de la http://srtm.csi.cgiar.org/

8.2.5 What’s Next?

Acum, că putem vedea datele noastre afiate corect, să investigăm modul în care putem analiza mai departe.

8.3 Lesson: Analiza Terenului

Certain types of rasters allow you to gain more insight into the terrain that they represent. Digital Elevation Models
(DEMs) are particularly useful in this regard. In this lesson you will use terrain analysis tools to find out more
about the study area for the proposed residential development from earlier.

Scopul acestei lecii: De a utiliza instrumentele de analiză a terenului pentru a extrage mai multe informaii despre
teren.

8.3.1 Follow Along: Calculul Umbrei Versanţilor

The DEM you have on your map right now does show you the elevation of the terrain, but it can sometimes seem
a little abstract. It contains all the 3D information about the terrain that you need, but it doesn’t look like a 3D
object. To get a better look at the terrain, it is possible to calculate a hillshade, which is a raster that maps the
terrain using light and shadow to create a 3D-looking image.

Pentru a lucra cu DEM-uri, ar trebui să utilizai instrumentele de analiză all-in-one DEM (Terrain models) din
QGIS.

• Facei clic pe elementul de meniu Raster → Analysis → DEM (Terrain models).

• În caseta de dialog care apare, asigurai-vă că Fiierul de intrare este stratul DEM.

• Setai Fiierul de ieire ca hillshade.tif, în directorul exercise_data/residential_development/.

• De asemenea, asigurai-vă că pentru opiunea Mode s-a ales Hillshade.

• Bifaţi caseta de lângă Load into canvas when finished.

• Putei lăsa toate celelalte opiuni neschimbate.

• Clic pe OK, pentru a genera umbra versanilor.

• Atunci când vi se spune că prelucrarea este finalizată, facei clic pe OK, pentru închiderea mesajului.

• Facei clic pe Close din dialogul principal al DEM (Terrain models).

Avei acum un nou strat denumit hillshade, care arată astfel:
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That looks nice and 3D, but can we improve on this? On its own, the hillshade looks like a plaster cast. Can’t
we use it together with our other, more colorful rasters somehow? Of course we can, by using the hillshade as an
overlay.

8.3.2 Follow Along: Folosirea Umbrei Versanilor pentru Suprapunere

Umbra versanilor poate furniza informaii foarte utile despre lumina solară, la un moment dat al zilei. Ea poate
fi, de asemenea, utilizată în scopuri estetice, pentru a face harta să arate mai bine. Cheia pentru acest lucru este
setarea reliefului de a fi în cea mai mare parte transparent.

• Schimbarea simbologiei DEM-ului original pentru utilizarea schemei guilabel:Pseudocolor, ca i în exerciiul
anterior.

• Ascundei toate straturile, cu excepia straturilor DEM i hillshade.

• Efectuai clic pe DEM i glisai-l sub stratul hillshade din Lista straturilor.

• Set the hillshade layer to be transparent by opening its Layer Properties and go to the Transparency tab.

• Setai Transparena globală la 50%:

• Clic OK în dialogul Layer Properties. Vei obine un rezultat ca aceasta:
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• Switch the hillshade layer off and back on in the Layers list to see the difference it makes.

Using a hillshade in this way, it’s possible to enhance the topography of the landscape. If the effect doesn’t seem
strong enough to you, you can change the transparency of the hillshade layer; but of course, the brighter the
hillshade becomes, the dimmer the colors behind it will be. You will need to find a balance that works for you.

Amintii-vă să salvai harta, după ce ai definitivat.

Note: For the next two exercises, please use a new map. Load only the DEM raster dataset into it
(exercise_data/raster/SRTM/srtm_41_19.tif). This is to simplify matters while you’re working
with the raster analysis tools. Save the map as exercise_data/raster_analysis.qgs.

8.3.3 Follow Along: Calculul Pantei

În cazul unui teren, este util să-i cunoatei panta. Dacă, de exemplu, dorii să construii nite case pe un teren, atunci
este necesar ca un teren să fie relativ plat.

Pentru a face acest lucru, trebuie să folosii modul Slope al instrumentului DEM (Terrain models).

• Deschidei instrumentul ca i înainte.

• Selectai Slope pentru opiunea Mode:
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• Setai locaia pentru salvare exercise_data/residential_development/slope.tif

• Bifai caseta Load into canvas....

• Click OK and close the dialogs when processing is complete, and click Close to close the dialog. You’ll see
a new raster loaded into your map.

• With the new raster selected in the Layers list, click the Stretch Histogram to Full Dataset button. Now
you’ll see the slope of the terrain, with black pixels being flat terrain and white pixels, steep terrain:

8.3.4 Try Yourself Calculai aspectul

The aspect of terrain refers to the direction it’s facing in. Since this study is taking place in the Southern Hemi-
sphere, properties should ideally be built on a north-facing slope so that they can remain in the sunlight.

• Use the Aspect mode of the DEM (Terain models) tool to calculate the aspect of the terrain.

Verificai-vă rezultatele
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8.3.5 Follow Along: Folosirea Calculatorului Raster

Think back to the estate agent problem, which we last addressed in the Vector Analysis lesson. Let’s imagine
that the buyers now wish to purchase a building and build a smaller cottage on the property. In the Southern
Hemisphere, we know that an ideal plot for development needs to have areas on it that are north-facing, and with
a slope of less than five degrees. But if the slope is less than 2 degrees, then the aspect doesn’t matter.

Fortunately, you already have rasters showing you the slope as well as the aspect, but you have no way of knowing
where both conditions are satisfied at once. How could this analysis be done?

Răspunsul se află cu ajutorul: Calculatorului raster.

• Facei clic pe Raster > Raster calculator... pentru a deschide acest instrument.

• To make use of the aspect dataset, double-click on the item aspect@1 in the Raster bands list on the left. It
will appear in the Raster calculator expression text field below.

North is at 0 (zero) degrees, so for the terrain to face north, its aspect needs to be greater than 270 degrees and less
than 90 degrees.

• În câmpul Expresiei calculatorului raster, introducei:

aspect@1 <= 90 OR aspect@1 >= 270

• Setai ca fiierul de ieire aspect_north.tif din directorul exercise_data/residential_development/.

• Asigurai-vă că este selectată caseta Add result to project.

• Facei clic pe Ok pentru a începe procesarea.
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Rezultatul va fi acesta:

8.3.6 Try Yourself

Acum, că ai definitivat aspectul, crea două noi analize separate, ale stratului DEM.

• Prima va fi de a identifica toate zonele unde panta este mai mică sau egală cu 2 grade.

• A doua este similară, dar panta trebuie să fie mai mică sau egală cu 5 grade.

• Salvai-le sub exercise_data/residential_development/ ca slope_lte2.tif i
slope_lte5.tif.

Verificai-vă rezultatele

8.3.7 Follow Along: Combinarea Rezultatelor Analizei Raster

Acum avei trei noi Analize Raster ale stratului DEM:

• aspect_north: terenul orientat spre nord

• slope_lte2: panta este la, sau sub, 2 grade

• slope_lte5: panta este la, sau sub, 5 grade

Where the conditions of these layers are met, they are equal to 1. Elsewhere, they are equal to 0. Therefore, if
you multiply one of these rasters by another one, you will get the areas where both of them are equal to 1.
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The conditions to be met are: at or below 5 degrees of slope, the terrain must face north; but at or below 2 degrees
of slope, the direction that the terrain faces in does not matter.

Therefore, you need to find areas where the slope is at or below 5 degrees AND the terrain is facing north; OR the
slope is at or below 2 degrees. Such terrain would be suitable for development.

Pentru a calcula zonele care îndeplinesc aceste criterii:

• Deschidei iarăi Calculatorul raster.

• Folosii Raster bands, butoanelor Operatorilor, i tastatura dvs. pentru a construi această expresie din zona
de text a Calculatorului de expresii raster:

( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

• Salvai rezultatul în exercise_data/residential_development/ ca all_conditions.tif.

• Clic OK în dialogul Calculatorul raster. Rezultatele dvs.:

8.3.8 Follow Along: Simplificarea Rasterului

As you can see from the image above, the combined analysis has left us with many, very small areas where the
conditions are met. But these aren’t really useful for our analysis, since they’re too small to build anything on.
Let’s get rid of all these tiny unusable areas.

• Deschidei instrumentul Sieve (Raster → Analysis → Sieve).

• Setai Fiierul de intrare pe all_conditions, iar Fiierul de ieire pe all_conditions_sieve.tif
(de sub exercise_data/residential_development/).

• Setai valorile Threshold i Pixel connections pe 8, apoi rulai instrumentul.
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O dată de s-a încheiat prelucrarea, noul strat se va încărca în canevas. Dar atunci când încercai să utilizai instru-
mentul de întindere a histogramei pentru a vizualiza datele, se întâmplă următorul lucru:
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Ce se întâmplă? Răspunsul se află în metadatele noului fiier raster.

• Vizualizarea metadatelor de sub fila Metadata, a dialogului Layer Properties. Uitai-vă în seciunea Proper-
ties din partea de jos.
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Whereas this raster, like the one it’s derived from, should only feature the values 1 and 0, it has the
STATISTICS_MINIMUM value of a very large negative number. Investigation of the data shows that this number
acts as a null value. Since we’re only after areas that weren’t filtered out, let’s set these null values to zero.

• Deschidei iarăi Calculatorul raster, i construii această expresie:

(all_conditions_sieve@1 <= 0) = 0

Acest lucru va menine toate valorile existente la zero, în timp ce, de asemenea, se pun pe zero numerele
negative; ceea ce va lăsa intacte toate zonele cu valoarea 1.

• Salvai rezultatul în exercise_data/residential_development/ ca
all_conditions_simple.tif.

Rezultatul dvs. arată în felul următor:
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This is what was expected: a simplified version of the earlier results. Remember that if the results you get from
a tool aren’t what you expected, viewing the metadata (and vector attributes, if applicable) can prove essential to
solving the problem.

8.3.9 In Conclusion

You’ve seen how to derive all kinds of analysis products from a DEM. These include hillshade, slope and aspect
calculations. You’ve also seen how to use the raster calculator to further analyze and combine these results.

8.3.10 What’s Next?

Now you have two analyses: the vector analysis which shows you the potentially suitable plots, and the raster
analysis that shows you the potentially suitable terrain. How can these be combined to arrive at a final result for
this problem? That’s the topic for the next lesson, starting in the next module.
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Module: Finalizarea analizei

Avei acum două jumătăi ale unei analize: o parte vector i o parte raster. În acest modul, vei afla cum să le combinai.
Vei încheia analiza i vei prezenta rezultatele finale.

9.1 Lesson: Conversia din Raster în Vector

Conversia între formatele raster i cele vectoriale, vă permite să facei uz atât de datele raster cât i de cele vectoriale,
atunci când rezolvai o problemă GIS, precum i utilizarea diferitelor metode unice de analiză, pentru aceste două
forme de date geografice. Acest lucru crete flexibilitatea atunci când luai în calcul sursele de date i metodele de
procesare pentru rezolvarea unei probleme GIS.

Pentru a combina analiza raster cu cea vectorială, trebuie să convertii un tip de date în altul. Haidei să convertim
rasterul rezultat din lecia anterioară într-un vector.

Scopul acestei lecii: De a obine rezultatul raster într-un vector, care să poată fi utilizat pentru a completa analiza.

9.1.1 Follow Along: Instrumentul Raster to Vector

Începei cu harta de la ultimul modul, raster_analysis.qgs. Ar trebui să avei
all_conditions_simple.tif calculat în timpul exerciiilor anterioare.

• Clic pe Raster → Conversion → Polygonize (Raster to Vector). Va apărea fereastra de dialog a instrumen-
tului.

• Setai-l astfel:
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• Schimbai numele câmpului (descriind valorile rasterului) în suitable.

• Salvai fiierul shape exercise_data/residential_development sub denumirea
all_terrain.shp.

Acum avei un fiier vectorial care conine toate valorile rasterului, dar singurele zone care vă interesează sunt cele
care sunt adecvate; adică, acele poligoane unde valoarea suitable este 1. Putei schimba stilul acestui strat,
dacă dorii să avei o vizualizare mai clară a lui.

9.1.2 Try Yourself

Consultai înapoi la modulul de analiză vectorială.

• Creai un nou fiier vectorial care conine numai poligoanele unde suitable are valoarea 1.

• Salvai noul fiier exercise_data/residential_development/ sub denumirea
suitable_terrain.shp.

Verificai-vă rezultatele

9.1.3 Follow Along: Instrumentul Vector to Raster

Dei nu este cazul pentru problema noastră actuală, este util să cunoatei că există i conversia inversă faă de cea
efectuată mai sus. Convertii într-un raster fiierul vectorial suitable_terrain.shp, pe care tocmai l-ai creat
în pasul anterior.

• Clic pe Raster → Conversion → Rasterize (Vector to Raster) pentru a lansa acest instrument, apoi setai-l ca
în imaginea de mai jos:
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• Fiierul de intrare este all_terrain;

• Fiierul de intrare... este exercise_data/residential_development/raster_conversion.tif;

• Lăimea i Înălimea sunt 837 i respectiv 661.

Note: Dimensiunea imaginii de ieire este specificată aici pentru a fi similară cu cea a rasterului original, care a fost
vectorizat. Pentru a vizualiza dimensiunile unei imagini, deschidei-i metadatele (fila Metadata din Proprietăile
Stratului).

• Clic pe OK, în fereastra de dialog, pentru a începe procesul de conversie.

• Atunci când ai încheiat, evaluai succesul prin compararea noului raster cu cel original. Cele două ar trebui
să se potrivească exact, pixel cu pixel.

9.1.4 In Conclusion

Conversia între formatele raster i cele vectoriale vă permite să extindei aplicabilitatea datelor, i nu trebuie să ducă
la degradarea datelor.

9.1.5 What’s Next?

Acum, că avem rezultatele analizei de teren disponibile în format vectorial, ele pot fi folosite pentru a rezolva
problema clădirii pe care ar trebui să o propunem în scopul dezvoltării rezideniale.
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9.2 Lesson: Combinarea Analizelor

Folosind rezultatele vectorizate ale analizei raster, vei putea selecta numai acele clădiri de pe terenul potrivit.

Scopul acestei lecii: De a utiliza terenul vectorizat rezultat la selectarea terenurilor adecvate.

9.2.1 Try Yourself

• Salvai harta curentă (raster_analysis.qgs).

• Deschidei harta pe care ai creat-o în timpul analizei vectoriale anterioare (ar fi trebuit să fi salvat fiierul sub
denumirea analysis.qgs).

• În Lista straturilor activai aceste straturi:

– relieful,

– soluia (or buildings_over_100)

• În plus faă de aceste straturi, care ar trebui să fie deja încărcate în hartă, din moment ce ai lucrat la ea înainte,
se adaugă i setul de date suitable_terrain.shp.

• Dacă vă lipsesc unele straturi, ar trebui să le găsii în exercise_data/residential_development/

• Use the Intersect tool (Vector -> Geoprocessing Tools) to create a new vector layer called
new_solution.shp which contains only those buildings which intersect the suitable_terrain
layer.

Ar trebui să avei de acum un strat care prezintă anumite clădiri din soluia dvs., cum ar fi:

Note: Dacă descoperii că instrumentul Intersect nu produce nici un rezultat, verificai setările CRS-ului pen-
tru fiecare dintre straturile dumneavoastră. CRS-urile trebuie să fie aceleai pentru ambele straturi pe care le
comparai. Poate fi necesară reproiectarea unui strat prin salvarea stratului ca un nou fiier shape, cu CRS-ul
cerut. În exemplul nostru, stratul suitable_terrain a fost reproiectat în WGS 84 / UTM 34S i redenumit
suitable_terrain_34S.
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9.2.2 Try Yourself Inspectarea Rezultatelor

Uitai-vă la fiecare dintre clădirile dumneavoastră din stratul new_solution. Comparai-le cu stratul suitable_terrain,
prin schimbarea simbologiei stratului new_solution, astfel încât acesta să aibă numai are contur. Ce părere avei
despre observa unele dintre clădiri? Sunt toate acestea potrivite doar pentru că se intersectează cu stratul suit-
able_terrain? De ce sau de ce nu? Pe care dintre ele le-ai considera ca fiind necorespunzătoare?

Verificai-vă rezultatele

9.2.3 Try Yourself Rafinarea Analizei

Putei vedea din rezultate, că unele clădirile care au fost incluse nu au fost cu adevărat adecvate, astfel încât să
putem rafina acum analiza.

Dorim să ne asigurăm că analiza noastră returnează numai acele clădiri care intră în întregime în stratul
suitable_terrain. Cum putei realiza acest lucru? Utilizai unul sau mai multe instrumente de analiză vecto-
rială, i reinei că toate clădirile noastre au o suprafaă de peste 100m pătrai.

Verificai-vă rezultatele

9.2.4 In Conclusion

Ai răspuns acum la întrebarea de cercetare originală, i v-ai conturat deja o opiune (argumentată i susinută de o
analiză) care poate sta la baza unei recomandări cu privire la proprietatea de dezvoltat.

9.2.5 What’s Next?

Mai departe, vom prezenta aceste rezultate ca parte a celei de-a doua dvs. misiuni.

9.3 Exerciiu

Folosind Compozitorul de Hări, creai o nouă hartă care reprezintă rezultatele analizei dumneavoastră. Includei
următoarele straturi:

• locuri (cu etichete),

• umbrire relief,

• soluie (sau noua_soluie),

• drumuri i

• fie aerial_photos, fie DEM.

Scriei un scurt text explicativ, însoitor. Includei în acest text criteriile care au fost luate în considerare pentru
achiziiea i dezvoltarea ulterioară a casei, precum i recomandările dvs. de utilizare a clădirilor.

9.4 Lesson: Exerciiu Suplimentar

În această lecie, vei efectua o analiză GIS completă în QGIS.

Note: Lecia a fost dezvoltată de Linfiniti i S Motala (Cape Peninsula University of Technology)
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9.4.1 Definirea Problemei

Vi se cere să găsii zone în interiorul i în jurul Peninsulei Cape, care este un habitat potrivit pentru o specie de plante
rare, Fynbos. Extinderea ariei dumneavoastră de investigare din Peninsula Cape este: la sud de Melkbosstrand, la
vest de Strand. Botanitii vă informează despre următoarele cerine pentru specia în cauză:

• Crete pe pante orientate spre est.

• Crete pe pante cu o înclinaie între 15% i 60%.

• Crete în zone cu precipitaii anuale totale de >1200 mm.

• Se găsete numai la cel puin 250 de m distană faă de orice aezare umană.

• Zona de vegetaie în care apare ar trebui să aibă o suprafaă de cel puin 6000m2.

Ca voluntar pentru Cape Nature, ai fost de acord să căutai planta pe cea mai apropiată suprafaă de teren faă de
casa dvs. Folosii-vă abilităile GIS pentru a determina unde ar trebui să efectuai căutarea.

9.4.2 Conturarea unei Soluii

Pentru a rezolva această problemă, va trebui să utilizai datele disponibile (în
exercise_data/more_analysis) pentru a găsi zona candidat, cea mai apropiată de casa dvs. Dacă
nu locuii în Cape Town (cazul pe care se bazează această problemă), putei alege orice casă din regiunea Cape
Town. Soluia va implica:

• analiza DEM-ului, pentru a găsi pantele orientate spre est i având înclinaiile specificate;

• analiza rasterului de precipitaii, pentru a găsi zonele cu cantitatea corectă de precipitaii;

• analiza stratul vectorial de Zonare, pentru a găsi zonele care sunt situate la distana specificată faă de aezările
umane i au dimensiunea corectă.

9.4.3 Setarea Hării

• Clic pe butonul “CRS status” din colul din extrema dreaptă-jos a ecranului. Sub fila CRS a ecranului care
apare, vei vedea caseta de Coordinate reference systems of the world.

• În această casetă, navigai la Projected Coordinate Systems → Universal Transverse Mercator (UTM).

• Selectai WGS 84 / UTM zone 33S (având codul EPSG 32733).

• Clic pe OK. Harta este acum în sistemul de coordonate de referină UTM33S.

• Salvai harta făcând clic pe butonul Save Project As din bara de instrumente, sau utilizând elementul de
meniu File → Save Project As....

• Salvai harta în directorul numit Rasterprac, pe care îl putei crea oriunde, pe calculatorul dvs. Vei salva
în acest director orice alte straturi create ulterior.

9.4.4 Încărcarea Datelor în Hartă

Pentru a procesa datele, va trebui să încărcai straturile necesare (numele străzilor, zonele, precipitaiile, DEM-ul)
în canevasul hării.

Pentru vectori ...

• Facei clic pe butonul Add Vector Layer, sau folosii elementul de meniu Layer → Add Vector Layer....

• În caseta de dialog care apare, asigurai-vă că butonul radio File este selectat.

• Clic pe butonul Browse.
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• În caseta de dialog care apare, deschidei directorul exercise_data/more_analysis/streets.

• Selectai fiierul Street_Names_UTM33S.shp.

• Clic pe Deschidere.

Dialogul se închide i arată dialogul iniial, cu calea de fiier specificată în câmpul de text de lângă butonul Browse.
Acest lucru vă permite să vă asigurai că este selectat fiierul corect. Este, de asemenea, posibilă introducerea
manuală a căii fiierului în acest câmp, dacă dorii acest lucru.

• Clic Open. Stratul vectorial se va încărca din harta dvs. Culoarea sa este atribuită în mod automat. Aceasta
va fi schimbată ulterior.

• Redenumii stratul în Streets.

• Facei clic dreapta în Lista straturilor (în mod implicit, panoul din partea stângă a ecranului).

• Facei clic pe Rename în caseta de dialog care apare i redenumii stratul, apăsând tasta Enter în momentul
când sunti gata.

• Repetai procesul de adăugare a straturilor vectoriale, dar de data aceasta selectai fiierul Gener-
alised_Zoning_Dissolve_UTM33S.shp din directorul Zoning.

• Redenumii-l Zoning.

Pentru rastere ...

• Facei clic pe butonul Add Raster Layer, sau folosii elementul de meniu Layer → Add Raster Layer....

• Navigai la fiierul corespunzător, selectai-l i facei clic pe Open.

• Facei acest lucru pentru fiecare dintre cele două fiiere raster. Fiierele dorite sunt: DEM/reproject/DEM and
Rainfall/reprojected/rainfall.tif.

• Redenumii rasterul de precipitaii în Rainfall (prima literă fiind majusculă). Iniial, atunci când le încărcai,
imaginile vor fi afiate ca dreptunghiuri gri. Nu vă facei griji, acest lucru se va schimba ulterior.

• Salvai harta.

Pentru a vedea în mod corespunzător ce se întâmplă, simbolistica pentru straturi trebuie să fie schimbată.

9.4.5 Schimbarea simbologiei straturilor vectoriale

• În Lista straturilor facei clic-dreapta pe stratul Streets.

• Selectai Properties din meniul care apare.

• Mergei la fila Style , în dialogul care va apărea.

• Click on the button labeled Change, with a square showing the current color of the Streets layer.

• Selectai o culoare nouă din dialogul care va apărea.

• Clic pe OK

• Clic pe butonul Change, care are un pătrat prezentat în culoarea actuală a stratului Streets.

• Urmai un proces similar pentru stratul Zoning, apoi alegei o culoare potrivită pentru el.

9.4.6 Schimbarea simbologiei straturilor raster

Simbologia straturilor raster este oarecum diferită.

• Deschidei dialogul Properties pentru rasterul Rainfall.

• Mergei în stratul Style. Vei observa că stilul acestui dialog este foarte diferit de versiunea folosită pentru
straturile vectoriale.
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• Asigurai-vă că butonul Use standard deviation

• Modificai valoarea din caseta asociată la 2.00 (ar trebui să fie setată la 0.00 în mod implicit).

• În seciunea Contrast enhancement, schimbai valoarea listei derulante Current la Stretch to MinMax.

• Clic OK. Rasterul “Precipitaiilor”, în cazul în care este vizibil, trebuie să-i schimbe culorile, permiându-vă
să vedei valori diferite de luminozitate pentru fiecare pixel.

• Repetai acest proces pentru DEM, dar stabilii abaterile standard utilizate pentru întindere la 4.00.

9.4.7 Modificarea ordinii straturilor

• În Lista straturilor, facei clic i deplasai straturile în sus i în jos, pentru a modifica ordinea în care vor apărea
în hartă.

• Versiunile mai noi de QGIS pot avea o casetă Control rendering order dedesubtul Listei straturilor.
Asigurai-vă că este bifată.

Acum, că toate datele sunt încărcate i vizibile în mod corespunzător, analiza poate începe. Cel mai bine este dacă
are loc, mai întâi, operaiunea de decupare. Astfel, puterea de procesare nu va fi irosită pe calcularea valorilor
pentru zonele care nu vor fi deloc utilizate.

9.4.8 Găsires Districtelor Corecte

• Încărcai stratul vectorial admin_boundaries/Western_Cape_UTM33S.shp în harta dvs.

• Redenumii-l Districts.

• Facei clic-dreapta pe stratul Districts din Layers list.

• În meniul care apare, selectai elementul de meniu Query.... Va apărea dialogul Query Builder.

Vei construi acum o interogare pentru a selecta doar următoarea listă de districte:

• Bellville,

• Cape,

• Goodwood,

• Kuils River,

• Mitchells Plain,

• Simons Town, i

• Wynberg.

• În lista Fields, facei dublu-clic pe câmpul NAME_2. Acesta va apărea în câmpul de text SQL where clause
de mai jos.

• Făcând clic pe butonul = button; un semn = va fi ataat interogării SQL.

• Clic pe butonul All de sub lista (acum vidă) a. După o scurtă întârziere, lista Valorilor se va popula cu
valoarea câmpului selectat (NAME_2).

• Facei dublu-clic pe valoarea Bellville din lista Valorilor. Ca i mai înainte, aceasta se va adăuga în interogarea
SQL.

Pentru a selecta mai mult de un district, va trebui să utilizai operatorul boolean OR.

• Facei clic pe butonul OR pentru a adăuga textul în interogarea SQL.

• Folosind un proces similar cu cel de mai sus, adăugai următoarele la interogarea SQL existentă:

"NAME_2" = ’Cape’

• Adăugai un alt operator OR, apoi procedai într-un mod similar cu lista de districte de mai sus .
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• Interogarea finală ar trebui să fie

"NAME_2" = ’Bellville’ OR "NAME_2" = ’Cape’ OR "NAME_2" = ’Goodwood’ OR
"NAME_2" = ’Kuils River’ OR "NAME_2" = ’Mitchells Plain’ OR "NAME_2" =
’Simons Town’ OR "NAME_2" = ’Wynberg’

• Clic OK. Districtele prezentate în harta dvs. sunt acum limitate la cele din lista de mai sus.

9.4.9 Decuparea Rasterelor

Acum, că avei o zonă de interes, putei decupa rasterele după ea.

• Asigurai-vă că sunt vizibile numai straturile DEM, Rainfall i Districts.

• Districtele trebuie să fie în partea de sus, astfel încât acestea sunt vizibile.

• Deschidei caseta dialogului de decupare prin selectarea elementului de meniu Raster → Extraction → Clip-
per.

• În caseta cu lista derulantă Input file (raster), selectai stratul DEM.

• Specificai o locaie de ieire în câmpul de text Output file, făcând clic pe butonul Select....

• Navigai în directorul Rasterprac.

• Introducei un nume de fiier.

• Salvai fiierul. Lăsai caseta No data value nebifată.

• Folosii modul de decupare Extent, prin selectarea butonului radio corect.

• Facei clic i deplasai o zonă pe canevas, astfel încât aria care include districtele să fie selectată.

• Bifaţi caseta Load into canvas when finished.

• Clic pe OK

• După finalizarea operaiunii de tăiere, NU ÎNCHIDEI dialogul Clipper. (Acest lucru ar putea provoca
pierderea zonelor de decupare pe care le-ai definit deja.)

• Selectai rasterul Rainfall din lista derulantă Input file (raster), apoi alegei un nume de fiier de ieire diferit.

• Nu modificai alte opiuni. Nu modificai zona de decxupare existentă, pe care ai definit-o anterior. Lăsai totul
la fel i facei clic pe OK.

• După finalizares celei de-a doua operaiuni de tăiere, putei închide dialogul Clipper.

• Salvai harta.

9.4.10 Curăarea hării

• Eliminai straturile originale Rainfall i DEM din Lista straturillor:

• Clic-dreapta pe aceste straturi apoi selectai Remove.

– Acest lucru nu va elimina datele de pe dispozitivul de stocare, doar le va scoate din harta dvs.

• Dezactivai etichetele din stratul Streets:

– Clic pe butonul Etichetare.

– Debifai caseta Label this layer with.

– Clic pe OK

• Afiai iarăi toate Streets:

– Clic-dreapta pe stratul din Lista straturilor.

– Selectai Query.
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• În fereastra de dialog care apare, Query, facei clic pe butonul Clear, apoi pe OK.

• Ateptai în timp ce datele sunt încărcate. Toate străzile vor fi de acum vizibile.

• Schimbai simbologia straturilor raster ca mai înainte (parcurgei Schimbarea simbolisticii straturilor raster).

• Salvai harta.

• Putei ascunde acum straturile vectoriale debifând caseta de lângă ele, în Lista straturilor. Acest lucru va
face randarea hării mai rapidă i, astfel, vei salva ceva timp.

Pentru a crea relieful, va trebui să utilizai un plugin care a fost scris special în acest scop.

9.4.11 Activarea plugin-ul de Analiză a Terenurilor Raster

Acest plugin este inclus în mod implicit în QGIS 1.8. Cu toate acestea, el nu poate fi imediat vizibil. Pentru a
verifica dacă acesta este accesibil pe sistemul dumneavoastră:

• Facei clic pe elementul de meniu Plugins –> Manage Plugins....

• Asigurai-vă că este selectată caseta de lângă Raster Terrain Analysis plugin.

• Clic pe OK

Vei avea acum acces la acest plugin prin intermediul elementului de meniu Raster → Terrain analysis.

Reinei că plugin-uri pot depinde, uneori, de anumite module Python, instalate pe sistemul dumneavoastră. În cazul
în care un plugin refuză să lucreze, specificând lipsa dependenelor, vă rugăm să cerei asistenă lectorului dvs.

9.4.12 Crearea reliefului

• În Lista straturilor, asigurai-vă că DEM este stratul activ (adică, acesta este evideniat, după ce ai făcut clic
pe el).

• Clic pe elementul de meniu Raster → Terrain analysis → Hillshade pentr a deschide dialogul Hillshade.

• Specificai o locaie adecvată pentru stratul de ieire i denumii-o hillshade.

• Bifai caseta Add result to project.

• Clic pe OK

• Ateptai să se termine prelucrarea.

Noul strat hillshade a apărut în Lista straturilor dvs.

• Făcând clic dreapta pe stratul hillshade din Lista straturilor dvs., se va desxchide dialogul Properties.

• Clic pe fila Transparency, apoi setai transparena la 80%.

• Clic pe OK, în fereastra de dialog.

• Observai efectul, atunci când relieful transparent este suprapus peste DEM-urile decupate.

9.4.13 Panta

• Facei clic pe elementul de meniu Raster → Terrain analysis.

• Selectai tipul de analiză Slope, având ca intrare DEM-ul decupat.

• Specificai un nume corespunzător i o locaie pentru fiierul de ieire.

• Bifai caseta Add result to project.

• Clic pe OK

Imaginea pantei a fost calculată i adăugată la hartă. Cu toate acestea, ca de obicei, se vede doar un dreptunghi gri.
Pentru a observa corect ce se întâmplă, schimbai simbolistica, după cum urmează.
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• Deschidei dialogul Properties (ca de obicei, prin intermediul meniului clic-dreapta al stratului).

• Clic pe fila Stilului.

• Acolo unde scrie Grayscale (în caseta cu derulare verticală Harta culorilor), alegei Pseudocolor.

• Asigurai-vă că butonul radio Use standard deviation este selectat.

9.4.14 Aspectul

• Utilizai aceeai abordare ca i pentru calculul pantei, dar selectai Aspectul, în fereastra de dialog iniială.

Amintii-vă să salvai periodic modificările.

9.4.15 Reclasificarea rasterelor

• Facei clic pe elementul de meniu Raster → Raster calculator.

• Specificai directorul dvs. Rasterprac,

• Asigurai-vă că este selectată caseta Add result to project.

În lista din stânga, a Benzilor raster, vei vedea toate straturile raster din Lista straturilor. În cazul în care stratul
pantei este denumit slope, acesta va fi listat ca slope@1.

Panta trebuie să aibă între 15 i 60 grade. Orice pantă mai mică de 15 sau mai mare de 60 va fi astfel exclusă.

• Folosind elementele din listă i butoanele din interfaă, construii următoarea expresie:

((slope@1 < 15) OR (slope@1 > 60)) = 0

• Alegei o locaie pentru câmpul Output layer i numele de fiier corespunzător.

• Clic pe OK

Acum găsi aspectul corect (orientat spre est: între 45 i 135 grade) folosind aceeai abordare.

• Construii următoarea expresie:

((aspect@1 < 45) OR (aspect@1 > 135)) = 0

• Găsii precipitaiile corecte (mai mari de 1200mm) în acelai fel. Construii următoarea expresie:

(rainfall@1 < 1200) = 0

După ce ai reclasificat toate rasterele, le vei vedea afiate sub formă de dreptunghiuri gri pe hartă (presupunând că
acestea au fost adăugate corect pe hartă). Pentru a afia corect datele raster cu numai două clase (1 i 0, ceea ce
înseamnă adevărat sau fals), va trebui să le schimbai simbologia.

9.4.16 Setarea stilului pentru straturile reclasificate

• Deschidei fila Style în fereastra de dialog a Proprietăilor stratului, ca de obicei.

• Sub titlul Încărcare valori min / max din bandă, selectai butonul radio Actual (lent).

• Clic pe butonul Load.

Câmpurile Valori min / max personalizate ar trebui să fie populate acum cu 0 i, respectiv, 1. (Dacă acest lucru nu
s-a întâmplat, atunci a existat o greeală cu reclasificarea datelor, i va trebui să repetai aceai aciune.)

• Sub antetul Îmbunătăire contrast, alegei din lista Curent Întindere la MinMax.

• Clic pe OK

• Facei acest lucru pentru toate cele trei rastere reclasificate, i amintii-vă să vă salvai munca!
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Singurul criteriu care rămâne este cel referitor la faptul că zona trebuie să fie la 250m faă de zonele urbane. Vom
îndeplini această cerină prin asigurarea faptului că suprafeele pe care le calculăm se află la :kbd:250m sau la mai
mult faă de marginea unei zone rurale. Prin urmare, trebuie să găsim, mai întâi, toate zonele rurale.

9.4.17 Găsirea zonele rurale

• Ascunderea tuturor straturilor din Lista straturilor.

• Afiarea straturilor vectoriale Zoning.

• Clic-dreapta pentru a se deschide dialogul Query.

• Construii următoarea interogare:

"Gen_Zoning" = ’Rural’

Consultai instruciunile anterioare pentru construirea interogării Streets, dacă v-ai blocat.

• Când ai terminat, închidei dialogul :guilabel:‘Query.

Ar trebui să vedei o colecie de poligoane din partea stratului Zonare. Va trebui să le salvai în fiierul unui nou strat.

• În meniul descis printr-un clic-dreapta pe stratul Zoning, selectai Save as....

• Salvai stratul în directorul Zoning.

• Denumii fiierul rezultat rural.shp.

• Clic pe OK

• Adăugai straturile în harta dvs.

• Facei clic pe elementul de meniu Vector > Geoprocessing Tools > Dissolve.

• Selectai stratul vectorial rural ca intrare, lăsând nebifată opiunea Se utilizează doar entităile selectate.

• Sub Câmpul de dizolvare, selectai — Dizolvă tot —.

• Salvai stratul în directorul Zoning.

• Facei clic pe OK. Va apărea un dialog care vă întreabă dacă dorii să adăugai noul strat la TOC (“Cuprins”,
făcând referire la Lista straturilor).

• Clic Yes.

• Închidei dialogul Dissolve.

• Eliminai straturile rural i Zoning.

• Salvai harta.

Acum trebuie să excludem zonele care se află la 250m de marginea zonelor rurale. Facei acest lucru prin crearea
unui tampon negativ, aa cum se explică mai jos.

9.4.18 Crearea unui tampon negativ

• Facei clic pe elementul de meniu Vector → Geoprocessing Tools → Buffer(s).

• În caseta de dialog care apare, selectai stratul vectorial rural_dissolve ca intrare (nu trebuie bifată opiunea
Se utilizează numai entităile selectate).

• Selectai butonul Distana tamponului i introducei valoarea -250 în câmpul asociat; valoarea negativă arată
că tamponul trebuie să fie de tip intern.

• Bifai caseta Dissolve buffer results.

• Setai fiierul de ieire la acelai director ca i celelalte fiiere vectoriale rurale.

• Denumii fiierul rezultat rural_buffer.shp.

246 Chapter 9. Module: Finalizarea analizei



QGIS Training Manual, Release 2.8

• Clic pe Salvare.

• Facei clic pe Ok i ateptai procesarea, pentru a îmcheia.

• Selectai Yes din fereastra de dialog care apare.

• Închidei dialogul Buffer.

• Eliminai stratul rural_dissolve.

• Salvai harta.

Pentru a încorpora zonele rurale în aceeai analiză cu cele trei rastere existente, acesta va trebui să fie, de asemenea,
rasterizat. Dar, pentru ca rasterele să fie compatibile cu analiza, acestea vor trebui să fie de aceeai dimensiune.
De aceea, înainte de a putea rasteriza, va trebui să decupai vectorul după aceeai suprafaă ca i cele trei rastere.
Un vector poate fi decupat după un alt vector, aa că va trebui mai întâi să creai un poligon de încadrare cu aceeai
dimensiune ca a rasterelor.

9.4.19 Crearea unei casete de încadrare vectoriale

• Facei clic pe elementul de meniu Layer –> New –> New Shapefile Layer....

• În rubrica Type, selectai butonul Polygon.

• Clic pe Specify CRS, apoi stabilii sistemul de coordonate de referină WGS 84 / UTM zone 33S :
EPSG:32733.

• Clic pe OK.

• Clic OK în dialogul New Vector Layer.

• Salvai stratul vectorial în directorul Zoning.

• Denumii fiierul rezultat atlas_coverage.shp.

• Ascundei toate straturile, cu excepia noului strat bbox i unul dintre rasterele reclasificate.

• Asigurai-vă că stratul bbox este evideniat în Layers list.

• Apelai la elementul de meniu View > Toolbars pentru a vă asigura că Digitizarea este selectată. Ar trebui să
vedei pe bara de instrumente o pictogramă cu un creion sau o cariocă. Acesta este butonul Toggle editing.

• Clic pe butonul de Activare editare pentru a intra în modul de editare. Acest lucru vă permite să editai un
strat vectorial.

• Facei clic pe butonul Adăugare entitate, care ar trebui să se afle lângă butonul Trecere în modul de editare.
Acesta se poate ascunde în spatele unui buton cu o săgeată dublă; în cazul în care acest lucru, facei clic pe
săgeile duble pentru a afia butoanele ascunse ale bării instrumentelor de Digitizare.

• Având activat instrumentul de Adăugare entitate, facei clic-stânga pe colurile rasterului. Este posibil să
trebuiască să mării harta folosind rotia mouse-ului pentru a vă asigura că este corectă. Putei deplasa harta,
în acest mod, inând apăsat butonul din mijloc sau rotia mouse-ului.

• Pentru al patrulea i ultimul punct, facei clic-dreapta pentru a finaliza forma.

• Introducei orice număr arbitrar pentru ID-ul formei.

• Clic pe OK

• Clic pe butonul Save edits.

• Clic pe butonul Toggle editing

• Salvai harta.

Acum, că avei o casetă de încadrare, o putei folosi pentru a decupa stratul tampon rural.
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9.4.20 Decuparea unui strat vectorial

• Asigurai-vă că numai straturile bbox i rural_buffer sunt vizibile, ultimul aflându-se în partea superioară.

• Facei clic pe elementul de meniu Vector > Geoprocessing Tools > Clip.

• În caseta de dialog care apare, setai rural_buffer pentru stratul de intrare vectorial i bbox pentru stratul de
decupare, având nebifate ambele casete de Utilizare doar a entităilor selectate.

• Punei fiierul de ieire sub directorul Zoning.

• Denumii fiierul rezultat rural_clipped.

• Clic pe OK

• Când vi se solicită să adăugai stratul în Cuprins, facei clic pe Yes.

• Închidei dialogul.

• Comparai cei trei vectori i vizualizai rezultatele.

• Eliminai straturile bbox i rural_buffer, apoi salvai harta.

Acum estte gata fr a fi rasterizat.

9.4.21 Rasterizarea unui strat vectorial

Va trebui să specificai o dimensiune a pixelului pentru un nou raster pe care îl creai, aa că mai întâi va trebui să
cunoatei dimensiunea unuia dintre rasterele existente.

• Deschidei dialogul Properties al oricăruia dintre cele trei rastere existente.

• Mergei la fila Metadata.

• Notai valorile X i Y de sub antetul Dimensiuni din tabela Metadatelor.

• Închidei dialogul Properties.

• Clic pe elementul de meniu Raster → Conversion → Rasterize. Este posibil să primii un avertisment despre
un set de date care este neacceptat. Facei clic pentru a-l ignora.

• Selectai rural_clipped pentru stratul de intrare.

• Cresi o locaie pentru fiierul de ieire, în directorul Zoning.

• Denumii fiierul rezultat rural_raster.tif.

• Bifai caseta Dimensiune nouă, apoi introducei valorile X i Y notate anterior.

• Bifaţi caseta Load into canvas.

• Dai clic pe pictograma creionului de lângă câmpul de text, care arată comanda ce va fi rulată. La finalul
textului existent, adăugai un spaiu i apoi textul -burn 1. Acest lucru indică funciei de Rasterizare să
“calcineze” vectorul existent în noul raster i să dea zonelor acoperite de vector noua valoare de 1 (spre
deosebire de restul imaginii, care va fi în mod automat 0).

• Clic pe OK

• Noul raster ar trebui să apară în harta dvs. o dată ce a fost calculată.

• Noul raster va arăta ca un dreptunghi gri - putei schimba stilul de afiare aa cum ai procedat i pentru rasterele
reclasificate.

• Salvai harta dvs.

Acum, că avei toate cele patru criterii, fiecare într-un raster separat, trebuie să le combinai pentru a vedea care
zone îndeplinesc toate criteriile. Pentru a face acest lucru, rasterele vor fi multiplicate unele cu altele. Atunci când
se întâmplă acest lucru, toi pixelii care se suprapun i au o valoare de 1 vor păstra valoarea 1, dar în cazul în care
vreun pixel are valoarea de 0 în oricare dintre cele patru rastere, atunci rezultatul va avea valoarea 0. În acest fel,
se vor păstra doar zonele care se suprapun.

248 Chapter 9. Module: Finalizarea analizei



QGIS Training Manual, Release 2.8

9.4.22 Combinarea rasterelor

• Facei clic pe elementul de meniu Raster → Raster calculator.

• Construii următoarea expresie (folosind denumirile corespunzătoare pentru straturile dvs, în funcie de modul
în care le-ai denumit):

[Rural raster] * [Reclassified aspect] * [Reclassified slope] *
[Reclassified rainfall]

• Setai locaia de ieire în directorul Rasterprac.

• Denumii fiierul rezultat cross_product.tif.

• Asigurai-vă că este selectată caseta Add result to project.

• Clic pe OK.

• Schimbai simbolistica noului raster în acelai mod în care setai stilul pentru celelalte rastere reclasificate.
Noul raster va afia acum în mod corespunzător zonele în care toate criteriile sunt îndeplinite.

Pentru a obine rezultatul final, trebuie să selectai zonele care sunt mai mari de 6000m^2. Cu toate acestea,
calcularea cu precizie a acestor suprafee este posibilă numai pentru un strat vectorial, astfel încât va trebui să
vectorizai rasterul.

9.4.23 Vectorizarea rasterului

• Facei clic pe elementul de meniu Raster → Conversion → Polygonize.

• Selectai rasterul cross_product.

• Stabilii locaia de ieire pe Rasterprac.

• Denumii fiierul candidate_areas.shp.

• Asigurai-vă că este selectată caseta Load into canvas when finished.

• Clic pe OK.

• Închidei caseta de dialog atunci când prelucrarea este completă.

Toate zonele rasterului au fost vectorizate, deci va trebui să selectai numai zonele care au valoarea 1.

• Deschidei dialogul Interogărilor pentru noul vector.

• Construii această interogare:

"DN" = 1

• Clic pe OK

• Creai un nou fiier vectorial din rezultate, salvând vectorul candidate_areas după ce interogarea este com-
pletă (i numai zonele cu valoarea 1 sunt vizibile). Pentru aceasta utilizai funcia de Salvare ca... din meniul
care apare la efectuarea unui clic dreapta pe strat.

• Salvai fiierul în directorul Rasterprac.

• Denumii fiierul candidate_areas_only.shp.

• Salvai harta dvs.

9.4.24 Calculai aria pentru fiecare poligon

• Deschidei prin clic-dreapta, meniul noului strat vectorial.

• Selectai Deschidere tabelă de atribute.

• Clic pe butonul de Activare editare din partea de jos a tabelei, sau apăsai Ctrl+E.
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• Clic pe butonul de Deschidere calculator de câmpuri din partea de jos a tabelei, sau apăsai Ctrl+I.

• Sub antetul Câmpului nou din dialogul care apare, introducei numele câmpului area. Tipul câmpului de
ieire ar trebui să fie un număr întreg, iar lăimea câmpului ar trebui să fie de 10.

• În Expresia calculatorului raster, introducei:

$area

Astfel, acest calculator câmp va calcula suprafaa fiecărui poligon din stratul vectorial, iar apoi va popula
apoi o nouă coloană (denumită area) , de tip întreg, cu valoarea determinată.

• Clic pe OK

• Facei acelai lucru pentru un alt câmp nou denumit id. În Expresia calculatorului de câmpuri, introducei:

$id

Acest lucru ne asigură că fiecare poligon are un ID unic, în scop de identificare.

• Facei clic iarăi pe butonul Toggle editing, apoi salvai modificările dacă vi se solicită acest lucru.

9.4.25 Selectarea zonelor cu o dimensiune dată

Acum, că ariile sunt cunoscute:

• Construii o interogare (ca de obicei) pentru a selecta numai poligoanele mai mari de 6000m^2. Interogarea
este:

"area" > 6000

• Salvai selecia într-un nou strat vectorial denumit solution.shp.

Acum avei zonele dumneavoastră calculate, din care o vei alege pe cea mai apropiată de casa dvs.

9.4.26 Digitizai casa dvs.

• Creai un nou strat vectorial, ca i mai înainte, dar de această dată, selectând ca Tip Punctul.

• Asigurai-vă că acesta se află în CRS-ul corect!

• Denumii noul strat house.shp.

• Finalizai crearea noului strat.

• Intrai în modul de editare (în timp ce noul strat este selectat).

• Efectuai clic pe punctul care reprezintă reedina dvs. sau un alt loc de rezidenă, folosind străzile pentru a
vă ghida. S-ar putea să trebuiască să deschidei i alte straturi pentru a vă ajuta să identificai casa respectivă.
În cazul în care nu locuii prin apropiere, e suficient să facei clic pe undeva, printre străzile unde ar putea fi
situată o casă.

• Introducei orice număr arbitrar pentru ID-ul formei.

• Clic pe OK

• Salvai modificările i ieii din modul de editare.

• Salvai harta.

Va trebui să găsii centroidele (“centrele de masă”) pentru poligoane, pentru a decide care este cel mai apropiat de
casa dvs.

250 Chapter 9. Module: Finalizarea analizei



QGIS Training Manual, Release 2.8

9.4.27 Calculai centroizii poligoanelor

• Facei clic pe elementul de meniu Vector → Geometry Tools → Polygon centroids menu item.

• Specificai stratul de intrare solution.shp.

• Stabilii locaia de ieire Rasterprac.

• Apelai fiierul destinaie solution_centroids.shp.

• Clic OK pentru a-l adăuga la Cuprins (Lista straturilor), apoi închidei dialogul.

• Setai noul strat în partea superioară a ordinii stratului, astfel încât să îl putei vedea.

9.4.28 Aflai care este cel mai apropiat centroid de casa dvs.

• Facei clic pe elementul de meniu Vector –> Analysis Tools –> Distance matrix.

• Stratul de intrare ar trebui să fie cel al reedinei dvs., iar stratul intă solution_centroids. Ambele ar trebui să
utilizeze câmpul id ca i ID unic.

• Tip matricii de ieire ar trebui să fie linear.

• Stabiliţi o locaie şi un nume corespunzătoare pentru rezultat.

• Clic pe OK

• Deschidei fiierul într-un editor de texte (sau importai-l într-o foaie de calcul). Atenie la ID-ul destinaiei care
se va asocia cu cea mai scurtă Distană. Pot exista mai multe de una la aceeai distană.

• Construii o interogare în QGIS pentru a selecta numai zonele cele mai apropiate de casa dvs. (selecionându-
le folosind câmpul id).

Acesta este răspunsul final la întrebarea.

Includei i stratul reliefului semi-transparent peste un raster plăcut, la alegerea dvs. (de exemplu: guilabel: DEM-
ul sau rasterul pantei). De asemenea, includei poligonul din cea mai apropiată zon(ă) soluie, precum i casa dvs.
Urmai cele mai bune practici cartografice, pentru a crea harta de ieire.
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CHAPTER 10

Module: Plugin-uri

Plugin-uri vă permit extinderea funcionalitatăii QGIS. În acest modul, vi se arată cum să activai i să utilizai
plugin-uri.

10.1 Lesson: Instalarea i Gestionarea Plugin-urilor

Pentru a începe să utilizai plugin-uri, trebuie să tii cum să le descărcai, să le instalai i să le activai. Pentru a face
acest lucru, vei învăa cum să utilizai Instalatorul de Plugin-uri i Managerul de Plugin-uri.

Scopul acestei lecii: Pentru a înelege i pentru a utiliza sistemul de plugin-uri QGIS.

10.1.1 Follow Along: Gestionarea Plugin-urilor

• Pentru a deschide Plugin Manager, facei clic pe elementul de meniu Plugins → Manage and Install Plugins.

• În fereastra de dialog care apare, identificai plugin-ul Processing:

• Facei clic în caseta de lângă acest plug-in, apoi debifai-l, pentru a-l dezinstala.
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• Clic Close.

• Privind la meniu, vei observa că meniul Processing nu mai este. Acest lucru înseamnă că multe dintre
funciile de prelucrare utilizate mai înainte au dispărut! Acest lucru se datorează faptului că acestea fac parte
din plugin-ul Processing, care trebuie să fie activat pentru a-l folosi.

• Deschidei iarăi Managerul de Plugin-uri i reactivai Plugin-ul Processing prin efectuarea unui clic pe caseta
de bifare de lângă el, apoi facei clic pe Close..

• Meniul Processing ar trebui să fie din nou disponibil.

10.1.2 Follow Along: Instalarea Noilor Plugin-uri

Lista de plugin-uri pe care le putei activa i dezactiva, se realizează cu plugin-urile pe care le-ai instalat în mod
curent.

• Pentru a instala plugin-uri noi, selectai opiunea Not Installed din dialogul Managerul de Plugin-uri. Plugin-
uri disponibile pentru instalare vor fi listate aici. Această listă diferă în funcie de configurarea sistemului
existent.

• Putei obine informaii despre fiecare plugin, selectându-l din lista de plugin-uri afiate.
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• Un plugin poate fi instalat făcând clic pe butonul Install Plugin de sub panoul de informaii al plugin-ului.

10.1.3 Follow Along: Configurarea Depozitelor Adiionale de Plugin-uri

Plugin-urile care sunt disponibile pentru instalare depind de depozitele configurate pentru utilizare.

Plugin-urile QGIS sunt stocate online în arhive. În mod implicit, numai depozitele oficiale sunt active, ceea ce
înseamnă că putei accesa numai plugin-uri oficiale. Acestea sunt, de obicei, primele plugin-uri pe care le dorii,
pentru că ele au fost testate temeinic i sunt adesea incluse în QGIS, în mod implicit.

Este posibil, totui, să încercai mai multe plugin-uri decât cele implicite. În primul rând, ai vrea să configurai
depozite suplimentare. Pentru a face acest lucru:

• Deschidei fila Settings din fereastra de dialog a Managerului de Plugin-uri
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• Clic pe butonul Adăugare, pentru a găsi i a adăuga un nou depozit.

• Furnizai un Nume i Adresa URL pentru noul depozit pe care dorii să-l configurai i asigurai-vă că este
selectată caseta Enabled.

• Vei vedea acum noul depozit de plugin-uri, enumerat în lista Depozitelor configurate pentru Plugin-uri
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• Putei selecta, de asemenea, opiunea de a afia Plugin-urile Experimentale, prin alegerea Show also experi-
mental plugins

• Dacă acum mergei înapoi la fila Get More, vei vedea că plugin-urile suplimentare sunt acum disponibile
pentru instalare.

• Pentru a instala un plugin, pur i simplu facei clic pe el în listă, apoi facei clic pe butonul Install plugin.

10.1.4 In Conclusion

Instalarea plugin-uri în QGIS este simplă i eficace!

10.1.5 What’s Next?

Mai departe, vă vom prezenta câteva plugin-uri utile ca exemple.

10.2 Lesson: Plugin-uri QGIS Utile

Acum, că putei instala, activa i dezactiva plugin-uri, să vedem cum vă poate ajuta în practică acest lucru, privind
la câteva exemple de plugin-uri utile.

Scopul acestei lecii: De a vă familiariza cu interfaa plugin-urilor i de a face cunotină cu unele plugin-uri utile.

10.2.1 Follow Along: Plugin-ul de Analiză a Terenurilor Raster

• Începei o nouă hartă, doar cu setul de date raster srtm_41_19.tif (parcurgei
exercise_data/raster/SRTM).

Din lecia de analiză a rasterelor, suntei deja familiarizai cu funciile de analiză raster. Ai folosit instrumentele
GDAL (accesibile prin Raster –> Analysis) pentru aceasta. Cu toate acestea, ar trebui să cunoatei că există i
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plugin-ul Raster Terrain Analysis. Acesta vine o dată cu versiunile mai noi de QGIS, i astfel, nu va fi nevoie să-l
instalai separat.

• Deschidei Plugin Manager i asigurai-vă că plugin-ul Raster Terrain Analysis este activat:

• Deschidei meniul Raster. Ar trebui să vedei submeniul Terrain analysis.

• Clic pe Terrain analysis → Relief, apoi introducei următoarele opiuni:

• Salvai noul fiier în exercise_data/plugins/relief.tif (creai un nou dosar, dacă este necesar).

• Lăsai Formatul de Ieire i Z factor neschimbat.
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• Asigurai-vă că este selectată caseta Add result to project.

• Clic pe butonul Create automatically. Lista de mai jos va fi populată:

Acestea sunt culorile pe care plugin-ul le va folosi pentru a crea relieful.

• Dacă vă place, putei schimba aceste culori printr-un dublu-clic pe fiecare rând de culori. De exemplu:

• Facei clic pe Ok iar relieful va fi creat:
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Astfel se va realiza un efect similar, ca i atunci când ai folosit reliful semi-transparent, ca o suprapunere peste un
alt strat raster. Avantajul acestui plugin este acela că el creează acest efect folosind un singur strat.

10.2.2 Follow Along: Plugin-ul OpenLayers

• Începei o nouă hartă i încărcai stratul roads.shp.

• Focalizai în aria Swellendam.

• Folosind Managerul de Plugin-uri, găsii un nou plugin, prin introducerea cuvântului OpenLayers în
câmpul Filter.

• Selectai plugin-ul OpenLayers din lista filtrată:
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• Clic pe butonul Instalare plugin.

• Când ai terminat, închidei Managerul de Plugin-uri.

Înainte de a-l utiliza, asigurai-vă că atât harta cât i plugin-ul sunt configurate în mod corespunzător:

• Deschidei setările plugin-ului făcând clic pe Web → OpenLayers plugin → OpenLayers Overview.

• Utilizai panoul, pentru a alege un tip de hartă pe care îl dorii. În acest exemplu, vom folosi tipul de hartă
“Hybrid”, dar putei alege oricare altul, dacă dorii.

• Deschidei dialogul Proprietăilor Proiectului prin selectarea Project –> Project Properties din meniu.

• Activai proiecia “din zbor”, apoi folosii proiecia Google Mercator:
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• Acum folosii plugin-ul pentru a vă afia o hartă Google a zonei. Putei face clic pe Plugins → OpenLayers
Plugin → Add Google Hybrid Layer pentru a o adăuga:

Aceasta va încărca o nouă imagine raster de la Google, pe care o putei folosi ca un fundal, sau pentru a vă ajuta să
vă identificai locaia pe hartă. Aici este un astfel de strat, având suprapus propriul nostru strat rutier vectorial:
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Note: E posibil să trebuiască să poziionai stratul drumurilor deasupra stratului Google pentru a-l face vizibil.
Poate fi, de asemenea, necesar să focalizai până la extinderea stratului de drumuri, pentru a re-centra harta.

10.2.3 Follow Along: Plugin-ul GeoSearch

• Începei o nouă hartă, fără seturi de date.

• Deschidei Plugin Manager i filtrai-l, pentru a găsi Plugin-ul GeoSearch, apoi facei clic pe Instalare Plugin.
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• Îîchidei Managerul de Plugin-uri.

• Acum putei folosi plugin-ul GeoSearch pentru a căuta toponime. Click pe Plugins –> GeoSearch Plugin
–> GeoSearch pentru a deschide dialogul GeoSearch.

• Căutai Swellendam în Dialogul GeoSearch pentru a-l localiza pe harta dvs.:
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10.2.4 In Conclusion

Sunt disponibile multe plugin-uri utile pentru QGIS. Folosind instrumentele încorporate, pentru instalarea i ges-
tionarea acestor plugin-uri, putei găsi noi plugin-uri i să efectuai o utilizare optimă a acestora.

10.2.5 What’s Next?

Apoi, vom analiza modul de utilizare al straturilor care sunt găzduite pe servere aflate la distană, în timp real.
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CHAPTER 11

Module: Resurse Online

Atunci când se analizează sursele de date pentru o hartă, nu este necesar să vă limitai la datele pe care le-ai salvat
pe computerul la care lucrai. Există surse de date online, pe care le putei încărca atât timp cât suntei conectat la
Internet.

În acest modul, vom acoperi cele două tipuri de servicii GIS bazate pe web: Servicii Web Mapping (WMS) i
Servicii Web Feature (WFS).

11.1 Lesson: Serviciile Web Mapping

Un Serviciu de Cartografiere Web (WMS) este un serviciu găzduit pe un server aflat la distană. Similar unui site
web, îl putei accesa, atât timp cât avei o conexiune la server. Cu ajutorul QGIS, putei încărca un WMS direct în
harta existentă.

Din lecia despre plugin-uri, ne amintim că este posibilă încărcarea unei noi imagini raster, spre exemplu, de la
Google. Totui, aceasta este o tranzacie once-off: o dată ce ai descărcat imaginea, aceasta nu se mai schimbă. Un
WMS este diferit prin faptul că este un serviciu live, care se va actualiza automat, la deplasarea sau mărirea hării.

Scopul acestei lecii: De a folosi un WMS i de a-i înelege limitările.

11.1.1 Follow Along: Încărcarea unui strat WMS

For this exercise, you can either use the basic map you made at the start of the course, or just start a new map and
load some existing layers into it. For this example, we used a new map and loaded the original places and landuse
layers and adjusted the symbology:
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• Încărcai aceste straturi într-o nouă hartă, sau folosii harta originală doar cu aceste straturi vizibile.

• Before starting to add the WMS layer, first deactivate “on the fly” projection. This may cause the layers to
no longer overlap properly, but don’t worry: we’ll fix that later.

• Pentru a adăuga straturi WMS, facei clic pe butonul Add WMS Layer:

Remember how you connected to a SpatiaLite database at the beginning of the course. The landuse, places, and
water layers are in that database. To use those layers, you first needed to connect to the database. Using a WMS
is similar, with the exception that the layers are on a remote server.

• Pentru a crea o nouă conexiune la un WMS, facei clic pe butonul New.

You’ll need a WMS address to continue. There are several free WMS servers available on the Internet. One of
these is terrestris, which makes use of the OpenStreetMap dataset.

• Pentru a face uz de acest WMS, setai-l în dialogul curent, astfel:
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• Valoarea câmpului Name ar trebui să fie terrestris.

• Valoarea câmpului URL ar trebui să fie http://ows.terrestris.de/osm/service.

• Facei clic pe Ok. Ar trebui să vedei listat noul server WMS:
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• Facei clic pe Conectare. În lista de mai jos, ar trebui să vedei încărcate acum, aceste noi intrări:

Acestea sunt toate straturile găzduite de acest server WMS.
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• Facei clic o dată pe stratul OSM-WMS. Se va afia Sistemul său de Coordonate de Referină:

Din moment ce nu utilizăm WGS 84 pentru harta noastră, să vedem toate CRS-urile dintre care putem alege.

• Facei clic pe butonul Change. Vom vedea un dialog standard de Selector de Sisteme de Coordonate de
Referină.

• Dorim un CRS proiectat, aa că haidei să alegem WGS 84 / Pseudo Mercator.
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• Clic pe OK

• Clic Add, apoi noul strat va apărea în hartă sub denumirea OSM-WMS.

• În Lista straturilor, facei clic i deplasai-l în josul listei.

You will notice that your layers aren’t located correctly. This is because “on the fly” projection is disabled. Let’s
enable it again, but using the same projection as the OSM-WMS layer, which is WGS 84 / Pseudo Mercator.

• Activai proiecia “din zbor”.

• În fila CRS (dialogul Proprietăilor Proiectului), introducei valoarea pseudo în câmpul Filtru:
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• Alegei WGS 84 / Pseudo Mercator din listă.

• Clic pe OK

• Now right-click on one of your own layers in the Layers list and click Zoom to layer extent. You should see
the Swellendam area:
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Notă cum se suprapun străzile stratului WMS cu propriile noastre străzi. Ăsta e un semn bun!

Natura i limitele WMS

By now you may have noticed that this WMS layer actually has many features in it. It has streets, rivers, nature
reserves, and so on. What’s more, even though it looks like it’s made up of vectors, it seems to be a raster, but you
can’t change its symbology. Why is that?

This is how a WMS works: it’s a map, similar to a normal map on paper, that you receive as an image. What
usually happens is that you have vector layers, which QGIS renders as a map. But using a WMS, those vector
layers are on the WMS server, which renders it as a map and sends that map to you as an image. QGIS can display
this image, but can’t change its symbology, because all that is handled on the server.

This has several advantages, because you don’t need to worry about the symbology. It’s already worked out, and
should be nice to look at on any competently designed WMS.

On the other hand, you can’t change the symbology if you don’t like it, and if things change on the WMS server,
then they’ll change on your map as well. This is why you sometimes want to use a Web Feature Service (WFS)
instead, which gives you vector layers separately, and not as part of a WMS-style map.

Acest lucru va fi acoperit în lecia următoare, cu toate acestea. În primul rând, haidei să adăugai un alt strat WMS
din serverul terrestris.

11.1.2 Try Yourself

• Ascundei stratul OSM-WSM din Lista straturilor.

• Adăugai serverul WMS “ZAF CGS 1M Bedrock Lithostratigraphy” la acest URL:
http://196.33.85.22/cgi-bin/ZAF_CGS_Bedrock_Geology/wms

• Load the BEDROCKGEOLOGY layer into the map (use the Add WMS Layer button as before). Remember
to check that it’s in the same WGS 84 / World Mercator projection as the rest of your map!

• Ai putea să-i setai Codificarea ca JPEG i opiunea Tile size la 200 pe 200, pentru a se încărca mai rapid:
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Verificai-vă rezultatele

11.1.3 Try Yourself

• Ascundei toate celelalte straturi WMS, pentru a preveni randarea inutilă din fundal.

• Adăugai serverul “OGC” WMS acestui URL: http://ogc.gbif.org:80/wms

• Adăugai stratul bluemarble.

Verificai-vă rezultatele

11.1.4 Try Yourself

O parte din dificultatea de a folosi WMS, este de a găsi un server bun (i gratuit).

• Find a new WMS at spatineo.com (or elsewhere online). It must not have associated fees or restrictions, and
must have coverage over the Swellendam study area.

Amintii-vă că pentru un WMS avei nevoie doar de URL-ul său (i, de preferină, un fel de descriere).

Verificai-vă rezultatele

11.1.5 In Conclusion

Folosind un WMS, putei adăuga hări inactive ca fundaluri pentru datele hărilor existente.

11.1.6 Further Reading

• spatineo.com

• Geopole.org

• Lista de servere WMS OpenStreetMap.org

11.1. Lesson: Serviciile Web Mapping 275

http://www.spatineo.com/
http://www.spatineo.com/
http://geopole.org/
http://wiki.openstreetmap.org/wiki/WMS


QGIS Training Manual, Release 2.8

11.1.7 What’s Next?

Now that you’ve added an inactive map as a backdrop, you’ll be glad to know that it’s also possible to add features
(such as the other vector layers you added before). Adding features from remote servers is possible by using a
Web Feature Service (WFS). That’s the topic of the next lesson.

11.2 Lesson: Serviciile Web Feature

Un Serviciu Web Feature (WFS) pune la dispoziie utilizatorilor date GIS în formate care pot fi încărcate direct în
QGIS. Spre deosebire de un WMS, care oferă doar o hartă pe care nu o putei edita, un WFS oferă acces direct la
entităi.

Scopul acestei lecii: De a folosi un WFS i de a-i înelege cum diferă de un WMS.

11.2.1 Follow Along: Încărcarea unui Strat WFS

• Începei o nouă hartă. Aceasta are scop demonstrativ i nu va fi salvată.

• Asigurai-vă că reproiectarea “din zbor” este dezactivată.

• Clic pe butonul Add WFS Layer:

• Clic pe butonul New.

• În caseta de dialog care apare, introducei nsidc.org ca i Nume i
http://nsidc.org/cgi-bin/atlas_south?version=1.1.0 ca i URL.

• Clic OK, apoi noua conexiune va apărea în Conexiunile serverului.

• Clic pe Connect. Va apărea o listă a straturilor disponibile:
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• Găsii stratul south_poles_wfs.

• Facei clic pe strat pentru a-l selecta.
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• Clic pe Add.

Este posibil ca încarcarea stratului să dureze. După ce s-a încărcat, va apărea pe hartă. În cazul nostru este
suprapus peste conturul Antarcticii (disponibil pe acelai server, sub numele de antarctica_country_border):

Prin ce diferă faă de un strat WMS? Asta va deveni evident când vei vedea atributele stratului.

• Deschidei tabelul de atribute al south_poles_wfs. Ar trebui să vedei asta:

De vreme ce punctele au atribute, putem să le punem etichete i să le schimbăm simbolistica. Iată un exemplu:
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• Adăugai etichete la strat pentru a beneficia de datele de atribute din acest strat.

Diferene între straturile WMS

Un Serviciu Web Feature întoarce stratul însui, nu doar o hartă redată pentru acesta. Asta vă dă acces direct la date,
însemnând că putei să schimbai simbologia i putei rula funcii analitice. Cu toate acestea, costul este transmiterea
unui volum mai mare de date. Asta va fi evident dacă straturile pe care le încărcai au forme complexe, multe
atribute sau multe entităi; sau chiar dacă doar încărcai multe straturi. Din această cauză straturile WFS au nevoie
de regulă de mult timp pentru a se încărca.

11.2.2 Follow Along: Interogarea unui Strat WFS

Dei este posibil să interogai un strat WFS după încărcare, este de regulă mai eficient să îl interogai înainte de a-l
încărca. În felul acesta cerei doar entităile pe care le dorii, ceea ce înseamnă că utilizai o bandă mai mică.

De exemplu, pe serverul WFS pe care îl utilizăm în acest moment, există un strat numit countries (excluding
Antarctica). Să spunem că dorim să tim unde se află Africa de Sud faă de stratul south_poles_wfs (i poate i faă de
antarctica_country_border layer) care a fost deja încărcat.

Există două metode. Putei încărca tot stratul countries ..., după care să construii o interogare ca în mod normal
după ce acesta s-a încărcat. Dar, transmiând datele pentru toate ările lumii i utilizând pe urmă doar datele pentru
Africa de Sud pare a fi o irosire a lăimii de bandă. În funcie de conexiune, acest set de date poate necesita mai
multe minute pentru a se încărca.

Alternativa este de a construi o interogare ca pe un filtru, chiar înainte de încărcarea stratului de pe server.

• În dialogul Add WFS Layer ..., conectai-vă la serverul pe care l-am utilizat anterior i ar trebui să vedei lista
de straturi disponibile.

• Dai dublu-clic pe stratul countries ... în câmpul Filter, sau dai clic pe Build query:
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• În dialogul care apare, construii interogarea "Countryeng" = ’South Africa’:
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• Acesta va apărea ca valoare Filter:
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• Dai clic pe Add cu stratul countries selectat ca mai sus. Din acest strat se vor încărca numai ările având
valoarea South Africa pentru Countryeng:

Dacă ai încercat ambele metode, vei observa că această variantă este mult mai rapidă decât încărcarea tuturor
ărilor înaintea filtrării!

Note cu privire la disponibilitatea WFS

Este o raritate să găsii un WFS care să pună la dispoziie caracteristicile dorite dacă acestea sunt foarte specifice.
Motivul pentru care cele mai multe servicii Web Feature sunt relativ rare este pentru că necesită transmiterea unui
volum mare de date pentru a descrie complet o entitate. În concluzie nu este foarte rentabilă găzduirea unui WFS
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în comparaie cu un WMS, care trimite doar imagini.

Cel mai comun tip de WFS pe care îl vei întâlni va fi deci probabil într-o reea local sau chiar pe propriul calculator,
mai degrabă decât in Internet.

11.2.3 In Conclusion

Straturile WFS sunt de preferat faă de straturile WMS dacă avei nevoie de acces direct la atributele si geometriile
acestora. Cu toate acestea, inând cont de volumul de date care trebuie descărcat (ceea ce duce la probleme de
viteză i de asemenea la lipsa de servere WFS disponibile publicului larg) nu este întotdeauna posibil să folosii un
WFS în loc de un WMS.

11.2.4 What’s Next?

În continuare, vom vedea cum se utilizează QGIS ca o interfaă pentru faimosul GIS GRASS.
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Module: GRASS

GRASS (Sistem de Suport pentru Analiza Resurselor Geografice) este un GIS bine-cunoscut, cu sursă deschisă,
i cu o gamă largă de funcii utile. Acesta a fost lansat în 1984, i a cunoscut multe îmbunătăiri i funcionalităi
suplimentare de atunci. QGIS vă permite să facei uz direct de puternicele instrumente GIS din Grass.

12.1 Lesson: Instalarea GRASS

Utilizarea GRASS în QGIS cere o abordare uor diferită a interfeei. Să ne amintim că nu lucrăm direct in QGIS, ci
în GRASS prin QGIS.

Scopul acestei lecii: Pentru a începe un proiect GRASS în QGIS.

12.1.1 Follow Along: Începerea unui Nou Proiect GRASS

Pentru a lansa GRASS din interiorul QGIS, trebuie să-l activai, la fel ca pe oricare alt plugin. În primul rând,
deschidei un nou proiect QGIS.

• În Managerul de plugin-uri, activai GRASS din listă:
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Va apărea bara de instrumente GRASS:

Înainte de a putea utiliza GRASS, va trebui să creeai un mapset. GRASS funcionează întotdeauna pe o bază de
date, ceea ce înseamnă că va trebui să importai toate datele pe care dorii să le utilizai într-o bază de date GRASS.

• Clic pe butonul New mapset:

Vei vedea un dialog care explică structura unui set de hări GRASS.

• Creai un nou director denumit grass_db, în exercise_data.

• Setai-l ca director care va fi utilizat de către GRASS pentru instalarea bazei de date:
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• Clic pe Next.

GRASS trebuie să creeze o “locaie”, care descrie extinderea maximă a zonei geografice în care lucrai.

• Denumii noua locaie South_Africa:
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• Clic pe Next.

• Vom lucra cu WGS 84, deci căutai i selectai acest CRS:
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• Clic pe Next.

• Acum selectai regiunea Africii de Sud din caseta cu derulare verticală i facei clic pe Set:
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• Clic pe Next.

• Creai un set de hări, care este fiierul hării cu care vei lucra.
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O dată ce ai terminat, vei vedea o casetă de dialog care vă cere să confirmai că setările pe care le afiează sunt
corecte.

• Clic Finish.

• Clic pe OK, în dialogul de încheiere cu succes.

12.1.2 Follow Along: Încărcarea Datelor Vectoriale în GRASS

Vei avea acum o hartă goală. Pentru a încărca date în GRASS, trebuie să urmai un proces în doi pai.

• Încărcai datele în QGIS ca de obicei. Folosii acum setul de date roads.shp (care se găsete în
exercise_data/epsg4326/).

• De îndată ce este încărcat, facei clic pe butonul Instrumentelor GRASS:
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• În noul dialog, selectai Lista modulelor.

• Găsii instrumentul de importare a vectorului, prin introducerea termenului v.in.ogr.qgis în câmpul
Filter.

v înseamnă “vector”, in semnifică faptul că este o funcie de import a datelor într-o bază de date, ogr este librăria
utilizată pentru a citi datele vectoriale, iar qgis semnifică faptul că va căuta vectori printre vectorii deja încărcai
în QGIS.

• O dată ce ai găsit acest instrument, facei clic pe el pentru a-l lansa în execuie:

• Alegei roads pentru stratul încărcat, împreună cu numele g_roads pentru versiunea de GRASS, pentru a
evita confuziile.
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Note: Remarcai opiunile suplimentare specificate la Advanced Options. Acestea includ facilitatea de a
adăuga o clauză WHERE pentru interogarea SQL folosită la importul datelor.

• Facei clic pe Run pentru a începe importul.

• După finalizare, dai clic pe butonul View output pentru a vedea noul strat GRASS importat în hartă.

• Închidei primul instrument de import (dai clic pe butonul Close imediat în dreapta de View output), după
care închidei fereastra GRASS Tools.

• Eliminai stratul original roads.

Acum ai rămas doar cu stratul GRASS importat, aa cum este afiat în harta dvs. din QGIS.

12.1.3 Follow Along: Încărcarea Datelor Raster în GRASS

Amintii-vă că DEM-ul nostru se află în CRS-ul proiectat UTM 33S / WGS 84, însă proiectul nostru GRASS
este în CRS-ul Geografic WGS 84. Haidei, mai întâi, să re-proiectăm DEM-ul.

• Încărcai în hartă, ca de obicei, setul de date srtm_41_19.tif (care se găsete în
exercise_data/raster/SRTM/), folosind instrumentul QGIS Add Raster Layer.
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• Re-proiectai-l, folosind instrumentul GDAL Warp (Raster → Projections → Warp (Reproject)), i efectuând
setările aa cum se arată:

• Salvai rasterul sub acelai folder ca i originalul, dar cu numele de fiier DEM_WGS84.tif. O dată ce apare
în harta dvs., eliminai setul de date srtm_41_19.tif din Lista straturilor dvs.

Acum, că este reproiectat, îl putei încărca în baza de date GRASS.
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• Deschidei iarăi dialogul Instrumentelor GRASS.

• Clic pe fila Modules List.

• Căutai r.in.gdal.qgis, apoi facei dublu clic pe instrument, pentru a deschide dialogul instrumentului.

• Setai-l astfel, încât stratul de intrare să fie DEM_WGS84 iar ieirea g_dem.

• Clic pe Run

• Când procesul s-a încheiat, facei clic pe Vizualizare rezultat.

• Închidei fila curentă, apoi Închidei întregul dialog.
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• Acum putei elimina stratul original DEM_WGS84.

12.1.4 In Conclusion

Fluxul de lucru GRASS pentru asimilarea datelor este uor diferit de metoda QGIS pentru că GRASS încarcă
datele într-o structură de bază de date spaială. Cu toate acestea, utilizănd QGIS ca interfaă, putei uura setarea unui
mapset GRASS prin utilizarea straturilor existente QGIS ca surse de date pentru GRASS.

12.1.5 What’s Next?

Acum, o dată ce datele sunt importate în GRASS, ne putem uita la operaiunile avansate de analiză pe care le oferă
GRASS.

12.2 Lesson: Instrumentele GRASS

În această lecie vom prezenta o selecie de instrumente pentru a vă oferi o idee despre capabilităile GRASS.

12.2.1 Follow Along: Setarea Culorilor Raster

• Deschidei dialogul Instrumentelor GRASS.

• Căutai modulul r.colors.table în câmpul Filter din fila Modules List.

• Deschidei instrumentul, apoi setai-l astfel:
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Când rulai instrumentul, acesta va recolora rasterul:
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12.2.2 Follow Along: Vizualizarea Datelor în 3D

GRASS vă permite să utilizai un DEM, pentru a vizualiza datele în trei dimensiuni. Instrumentul pe care îl vei
utiliza pentru aceasta funcionează în regiunea GRASS, care la moment este setat la întreaga extindere a Africii de
Sud, aa cum l-ai configurat anterior.

• Pentru a redefini extinderea, în scopul acoperirii doar a setului nostru de date raster, facei clic pe acest buton:

Când este activat acest instrument, cursorul se va transforma într-o cruce, la deplasarea pe canevasul hării QGIS.

• Folosind acest instrument, facei clic i trasai un dreptunghi în jurul rasterului GRASS.

• Clic pe OK în dialogul Setărilor Regiunii GRASS, la final.

• Căutai instrumentul nviz:
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• Setai-l după cum urmează:
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• Amintii-vă să activai ambele butoane Use region of this map din dreapta meniurilor cu derulare verticală,
pentru selecia celor două rastere. Asta va permite corecia rezoluiei rasterelor de către NVIZ.

• Clic pe butonul Run.

NVIZ va înfiina un mediu 3D, folosind rasterul i vectorul selectat. Acest lucru poate dura ceva timp, în funcie de
hardware-ul dvs. La final, vei vedea harta randată în 3D, într-o fereastră nouă:
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Experimentai cu setările înălime, z-exag, i Vizualizare metodă, pentru a schimba vizualizarea datelor. Poate dura
ceva timp până vă acomodai cu metodele de navigare.

După experimentare, închidei fereastra NVIZ.

12.2.3 Follow Along: Instrumentul Mapcalc

• Deschidei fila cu Lista Modulelor din dialogul Instrumentelor GRASS, apoi căutai calc.

• Din lista modulelor, selectai r.mapcalc (nu r.mapcalculator, care este mai simplu).

• Startai instrumentul.

Dialogul Mapcalc vă permite să construii o secvenă de analize care trebuie efectuate pe un raster, sau pe o colecie
de rastere. Vei folosi mai multe instrumente.

În ordine, acestea sunt:

• Add map: Adaugă un fiier raster din setul curent de hări GRASS.

• Add constant value: Adaugă o valoare constantă care va fi utilizată în funcii.

• Add operator or function: Adaugă un operator sau o funcie care va fi conectată la intrări i ieiri.

• Add connection: conectează elementele. Folosind acest instrument, facei clic i tragei punctul rou al
unui element peste punctul rou al unui alt element. Punctele care sunt conectate corect la un conector de
tip linie se vor colora în gri. În cazul în care linia sau punctul este de culoare roie, aceasta nu este conectat
corect!

• Select item: Selectează un element i mută elementele selectate.
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• tergei elementul selectat: Elimină elementul selectat din foaia mapcalc curentă, dar nu din
setul de hări (în cazul unui raster existent).

Folosind aceste instrumente:

• Construii următorul algoritm:

• Când facei clic pe Run, rezultatul dvs. va arăta astfel:
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• Clic pe Vizualizare rezultat pentru a vedea ieirea afiată în harta dvs:

Acest lucru arată toate zonele în care terenul este mai mic de 500 de metri sau mai mare de 1000 de metri.
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12.2.4 In Conclusion

În această lecie, am acoperit doar câteva dintre numeroasele instrumente GRASS. Pentru a explora capacităile
GRASS, deschidei dialogul Instrumentelor GRASS, apoi derulai până la Lista Modulelor. Sau, pentru o abordare
mai structurată, căutai în fila Modules Tree, care prezintă instrumentele organizate după tip.
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CHAPTER 13

Module: Evaluare

Folosii datele dvs pentru această secţiune. Vei avea nevoie de:

• un set de date vectoriale al punctelor de interes, cu numele punctelor i multiple categorii

• un set vectorial cu datele drumurilor

• un set vectorial cu date poligonale despre utilizarea terenurilor (folosind limitele de proprietate)

• o imagine a spectrului vizibil (cum ar fi o fotografie aeriană)

• un DEM (accesibil la acest URL dacă nu avei unul propriu)

13.1 Crearea unei hări de bază

Înainte de a orice, avei nevoie de o hartă de bază, care va asigura un context pentru rezultatele analizei dvs.

13.1.1 Adăugarea unui strat de tip punct

• Adăugai stratul de tip punct. În funcie de nivelul la care urmai cursul, efectuai doar ceea ce este listat în
seciunea corespunzătoare de mai jos:

• Etichetai punctele în conformitate cu un atribut unic, cum ar fi numele locurilor. Utilizai un font mic pentru
a nu scoate în evidenă etichetele. Informaiile trebuie să fie disponibile, dar nu ar trebui să fie principalele
entităi de pe hartă.

• Clasificai punctele în culori diferite, pe baza unei categorii. De exemplu, categoriile ar putea include “des-
tinaie turistică”, “secie de poliie” i “centrul oraului”.

• Procedai exact ca în secţiunea .

• Clasificai dimensiunea punctului după importană: cu cât mai semnificativă e o entitate, cu atât mai mare
este punctul. Cu toate acestea, nu depăii o dimensiune a punctului de 2.00.

• Entităilor care nu sunt localizate într-un singur punct (cum ar fi un nume de provincie/regiune, sau un nume
de ora, la o scară mai mare), nu le atribuii nici un punct.
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• Nu folosii deloc simboluri punctiforme pentru a simboliza stratul. În schimb, folosii etichetele centrate pe
puncte; simbolurile punctiforme nu ar trebui să aibă o dimensiune.

• Folosii Setări definite cu ajutorul datelor pentru a stiliza etichetele în categorii semnificative.

• Adăugai coloanele corespunzătoare pentru datele atributelor, dacă este necesar. Când facei acest lucru, nu
creai date fictive - mai degrabă, utilizai Calculatorul de Câmpuri pentru a popula noile coloane, pe baza
valorilor existente în setul de date.

13.1.2 Adăugarea stratului de tip linie

• Adăugai stratul rutier i apoi schimbai-i simbolistica. Nu etichetai drumurile.

• Alegei pentru simbolistica drumului o linie lată, de culoare deschisă. De asemenea, adăugai-i o oarecare
transparenă.

• Creai un simbol cu straturi multiple pentru simboluri. Simbolul rezultat ar trebui să arate ca un drum
adevărat. Avei posibilitatea să utilizai un simbol simplu pentru aceasta; de exemplu, o linie neagră, cu o
linie solidă, albă i subire în centru. Simbolul ar putea arăta chiar i mai elaborat, totui, harta rezultată nu ar
trebui să arate prea încărcată.

• Dacă setul dvs. de date are o densitate mare de drumuri la scara la care dorii să prezentai harta, atunci, ar
trebui să avei două straturi rutiere: unul cu un simbol mai complex, i altul cu un simbol mai simplu, pentru
scări mai mici. (Utilizai vizibilitatea în funcie de scară, pentru a se face trecerea la scara adecvată.)

• Toate mqrcajele ar trebui să aibă straturi multiple cu simboluri. Utilizai simbolurile pentru a le afia corect.

• Procedai exact ca în secţiunea de mai sus.

• În plus, drumurile ar trebui să fie clasificate. Atunci când se utilizează simboluri de teren realiste, fiecare
tip de drum ar trebui să aibă un simbol adecvat; de exemplu, o autostradă ar trebui să apară cu două benzi
pentru fiecare sens.

13.1.3 Adăugarea stratului de tip poligon

• Adăugai stratul de folosină a terenurilor i schimbai-i simbolistica.

• Clasificai stratul conform utilizării terenului. Folosii culori solide.

306 Chapter 13. Module: Evaluare



QGIS Training Manual, Release 2.8

• Clasificai stratul conform utilizării terenurilor. Dacă este cazul, includei straturi simbol, diferite tipuri de
simboluri, etc. Avei grijă ca rezultatele să aibă intensitate redusă i să arate uniform, cu toate acestea. inei
minte că acesta va fi parte a unui fundal!

• Utilizai clasificarea bazata pe reguli pentru a clasifica utilizarea terenurilor în categorii generale, cum ar fi
“urban”, “rural”, “rezervaie naturală”, etc.

13.1.4 Crearea fundalului raster

• Creai o reliefare din DEM, i utilizai-o ca o suprapunere pentru o versiune clasificată a DEM-ului în sine. Ai
putea folosi, de asemenea, plugin-ul Relief (după cum se arată în lecia despre plugin-uri).

13.1.5 Finalizarea hării de bază

• Utilizând resursele de mai sus, creai o hartă de bază folosind unele straturi sau pe toate. Această hartă ar
trebui să includă toate informaiile de bază necesare pentru a orienta utilizatorul, i să fie vizual unificată /
“simplă”.

13.2 Analiza datelor

• Căutai o proprietate care îndeplinete anumite criterii.

• Putei decide cu privire la propriile criterii, pe care le trebuie să le documentai.

• Iată unele indicaii pentru aceste criterii:

– proprietatea intă ar trebui să aibă (un) anumit tip(uri) de utilizare a terenului

– ar trebui să fie la o anumită distană de drumuri, sau să fie traversată de un drum

– ar trebui să fie la o anumită distană de unele categorii de puncte, cum ar fi un spital, de exemplu

13.2.1 /

• Includei analiza raster în rezultatele dvs. Luai în considerare cel puin o proprietate derivată din raster, cum
ar fi aspectul sau panta acestuia.

13.3 Harta Finală

• Folosii Map Composer pentru a crea o hartă finală, care include rezultatele analizei.

• Includei această hartă într-un document, împreună cu criteriile documentate. Dacă harta a devenit prea
ocupată vizual, datorită strat(ului) adăugat, deselectai straturile care vă sunt cel mai puin necesare.

• Harta dvs. trebuie să includă un titlu i o legendă.
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CHAPTER 14

Module: O Aplicaie pentru Silvicultură

În modulele 1 până la 13, ai învăat deja destul de multe despre lucrul în QGIS. Dacă vă interesează să aflai despre
unele utilizări forestiere ale GIS, urmând acest modul vei avea posibilitatea de a aplica ceea ce ai învăat, i, în plus,
vi se vor prezenta câteva noi instrumente utile.

Dezvoltarea acestui modul a fost sponsorizată de Uniunea Europeană.

14.1 Lesson: Prezentarea Modulului pentru Silvicultură

Utilizarea acestui modul pentru silvicultură necesită cunotinele acumulate în modulele de la 1 la 11 din acest
manual de formare. Exerciiile din următoarele lecii presupun că avei abilitatea de a face multe dintre operaiunile
de bază din QGIS, iar instrumentele care nu au mai fost utilizate înainte sunt prezentate acum în detaliu.

În plus, modulul urmează un nivel de bază de-a lungul leciilor, astfel încât, dacă avei experienă anterioară cu
QGIS, putei urma instruciunile fără probleme.

Reinei că trebuie să descărcai un pachet de date suplimentare pentru acest modul.

14.1.1 Datele Eantion pentru Silvicultură

Note: Datele eantion utilizate în acest modul fac parte din setul de date al manualului de instruire i pot fi
descărcate de aici. Descărcai fiierul zip i dezarhivai folderul forestry\ în exercise_data\.

Datele respective (harta forestiere, datele despre păduri) sunt puse la dispoziie de coala forestieră EVO-HAMK.
Seturile de date au fost modificate pentru a se adapta la nevoile lecii.

Datele eantion generale (imagini aeriene, date LIDAR, hări de bază) au fost obinute din serviciul de date deschise
al National Land Survey din Finlanda, i adaptate în scopul exerciiilor. Fiierul de date al serviciului de descărcare
poate fi accesat în limba engleză aici.

Warning: În ceea ce privete restul manualului de instruire, acest modul include instruciuni privind adău-
garea, tergerea i modificarea seturilor de date GIS. V-am furnizat seturile de date de instruire în acest scop.
Înainte de a utiliza tehnicile descrise aici asupra datelor dvs., asigurai-vă întotdeauna că avei copiile de rezervă
corespunzătoare!
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14.2 Lesson: Georeferenierea unei Hări

A common forestry task would be the update of the information for a forestry area. It is possible that the previous
information for that area dates several years back and was collected analogically (that is, in paper) or perhaps it
was digitized but all you have left is the paper version of that inventory data.

Most likely you would like to use that information in your GIS to, for example, compare later with later inventories.
This means that you will need to digitize the information at hand using your GIS software. But before you can
start the digitizing, there is an important first step to be done, scanning and georeferencing your paper map.

Scopul acestei lecii: De a afla cum să utilizai instrumentul de Georefereniere din QGIS.

14.2.1 Scanarea hării

The first task you will have to do is to scan your map. If your map is too big, then you can scan it in different parts
but keep in mind that you will have to repeat preprocessing and georeferencing tasks for each part. So if possible,
scan the map in as few parts as possible.

If you are going to use a different map that the one provided with this manual, use your own scanner to scan the
map as an image file, a resolution of 300 DPI will do. If your map has colors, scan the image in color so that
you can later use those colors to separate information from your map into different layers (for ex., forest stands,
contour lines, roads...).

Pentru acest exerciiu, vei utiliza o hartă scanată anterior, pe care o putei găsi ca rautjarvi_map.tif în
folderul de date exercise_data/forestry

14.2.2 Follow Along: Georeferenierea hării scanate

Open QGIS and set the project’s CRS to ETRS89 / ETRS-TM35FIN in Project → Project Properties → CRS,
which is the currently used CRS in Finland. Make sure that Enable ‘on the fly’ CRS transformation is checked,
since we will be working with old data that is another CRS.
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Salvai proiectul QGIS sub numele map_digitizing.qgs.

You will use the georeferencing plugin from QGIS, the plugin is already installed in QGIS. Activate the plugin
using the plugin manager as you have done in previous modules. The plugin is named Georeferencer GDAL.

Pentru a georeferenia harta:

• Deschidei instrumentul de georefereniere, Raster → Georeferencer → Georeferencer.

• Adăugai fiierul cu imaginea hării, rautjarvi_map.tif, ca imagine de georefereniat, File → Open
raster.

• When prompted find and select the KKJ / Finland zone 2 CRS, it is the CRS that was used in
Finland back in 1994 when this map was created.

• Clic pe OK

Ulterior ar trebui să definii setările de transformare pentru georeferenierea hării:

• Deschidei Settings → Transformation settings.

• Facei clic pe pictograma de lângă caseta Output raster, mergei i creai folderul
exercise_data\forestry\digitizing, apoi denumii fiierul rautjarvi_georef.tif.

• Setai restul parametrilor aa cum se arată mai jos.

14.2. Lesson: Georeferenierea unei Hări 311
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• Clic pe OK

The map contains several cross-hairs marking the coordinates in the map, we will use those to georeferenciate
this image. You can use the zooming and panning tools as you usually do in QGIS to inspect the image in the
Georeferencer’s window.

• Zoom in to the left lower corner of the map and note that there is a cross-hair with a coordinate pair, x and
y, that as mentioned before are in KKJ / Finland zone 2 CRS. You will use this point as the first
ground control point for the georeferencing your map.

• Selectai instrumentul Adăugare punct, apoi facei clic pe intersecia firelor reticulare (deplasai i mării după
nevoie).

• În dialogul Enter map coordinates notai coordonatele care apar pe hartă (X: 2557000 si Y: 6786000).

• Clic pe OK

Prima coordonată de georefereniat deja este gata.
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Look for other cross-hairs in the black lines image, they are separated 1000 meters from each other both in North
and East direction. You should be able to calculate the coordinates of those points in relation to the first one.

Zoom out in the image and move to the right until you find other cross-hair, and estimate how many kilometres
you have moved. Try to get ground control points as far from each other as possible. Digitize at least three more
ground control points in the same way you did the first one. You should end up with something similar to this:

With already three digitized ground control points you will be able to see the georeferencing error as a red line
coming out of the points. The error in pixels can be seen also in the GCP table in the dX[pixels] and dY[pixels]
columns. The error in pixels should not be higher than 10 pixels, if it is you should review the points you have
digitized and the coordinates you have entered to find what the problem is. You can use the image above as a
guide.

O dată ce vă mulumesc punctele dvs. de control, salva punctele de control de pe teren, în cazul în care vei avea
nevoie de ele mai târziu:

• File → Save GCP points as....
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• În folderul exercise_data\forestry\digitizing, denumii fiierul
rautjarvi_map.tif.points.

În cele din urmă, georefereniai harta dvs.:

• File → Start georeferencing.

• Reinei că deja ai denumit fiierul rautjarvi_georef.tif, când ai editat setările Georefereniatorului.

Now you can see the map in QGIS project as a georeferenced raster. Note that the raster seems to be slightly
rotated, but that is simply because the data is KKJ / Finland zone 2 and your project is in ETRS89 /
ETRS-TM35FIN.

To check that your data is properly georeferenced you can open the aerial image in the
exercise_data\forestry folder, named rautjarvi_aerial.tif. Your map and this image
should match quite well. Set the map transparency to 50% and compare it to the aerial image.
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Salvai modificările proiectului QGIS, apoi vei continua din acest punct cu lecia următoare.

14.2.3 In Conclusion

După cum ai văzut, georeferenierea unei hări de hârtie este o operaiune relativ simplă.

14.2.4 What’s Next?

În lecia următoare, vei digitiza pâlcurile de pădure din harta dvs. sub formă de poligoane, iar apoi vei adăuga
datele de inventar la ele

14.3 Lesson: Digitizarea Pâlcurilor de Pădure

Unless you are going to use your georeferenced map as a simple background image, the next natural step is to
digitize elements from it. You have already done so in the exercises about creating vector data in Lesson: Crearea
unui Nou Set de Date Vectoriale , when you digitized the school fields. In this lesson, you are going to digitize the
forest stands’ borders that appear in the map as green lines but instead of doing it using an aerial image, you will
use your georeferenced map.

Scopul acestei lecii: Învăarea unei tehnici pentru a ajuta activitatea de digitizare a pâlcurilor forestiere i, în cele
din urmă, adunarea datelor de inventar în acestea.

14.3.1 Follow Along: Extragerea Limitelor pentru Pâlcurile Pădurilor

Deschidei în QGIS proiectul map_digitizing.qgs, pe care l-ai salvat în lecia anterioară.

Once you have scanned and georeferenced your map you could start to digitize directly by looking at the image
as a guide. That would most likely be the way to go if the image you are going to digitize from is, for example, an
aerial photograph.

If what you are using to digitize is a good map, as it is in our case, it is likely that the information is clearly
displayed as lines with different colors for each type of element. Those colors can be relatively easy extracted as
individual images using an image processing software like GIMP. Such separate images can be used to assist the
digitizing, as you will see below.

Primul pas va fi de a utiliza GIMP la obinerea unei imagini care conine doar pâlcuri de pădure, reprezentate de
toate acele linii verzui pe care le putei vedea în harta originală, scanată:

• Deschidei GIMP (dacă nu l-ai instalat încă, descărcai-l de pe internet sau cerei-l profesorului dvs.).

• Open the original map image, File → Open, rautjarvi_map.tif in the
exercise_data/forestry folder. Note that the forest stands are represented as green lines
(with the number of the stand also in green inside each polygon).
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Acum putei selecta pixelii din imagine, care reprezintă graniele pâlcurilor forestiere (pixelii verzui):

• Deschidei instrumentul Select → By color.

• With the tool active, zoom into the image (Ctrl + mouse wheel) so that a forest stand line is close enough to
differentiate the pixels forming the line. See the left image below.

• Facei clic i glisai cursorul mouse-ului în partea din mijloc a liniei, astfel încât instrumentul va colecta
valorile câtorva dintre culorile pixelilor.

• Release the mouse click and wait a few seconds. The pixels matching the colors collected by the tool will
be selected through the whole image.

• Micorai, pentru a vedea cum au fost selectai pixelii verzui din întreaga imagine.

• Dacă nu suntei mulumii de rezultat, repetai operaiunea de clic i glisare.

• Selecia dumneavoastră de pixeli ar trebui să arate în genul imaginii din dreapta-jos.
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Once you are done with the selection you need to copy this selection as a new layer and then save it as separate
image file:

• Copiai (Ctr+C) pixelii selectai.

• And paste the pixels directly (Ctr+V), GIMP will display the pasted pixels as a new temporary layer in the
Layers - Brushes panel as a Floating Selection (Pasted Layer).

• Facei clic dreapta pe stratul temporar i selectai Către Noul Strat.

• Click the “eye” icon next to the original image layer to switch it off, so that only the Pasted Layer is visible:
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• Finally, select File → Export..., set Select File Type (By Extension) as a TIFF image, select the
digitizing folder and name it rautjarvi_map_green.tif. Select no compression when asked.

You could do the same process with other elements in the image, for example extracting the black lines that
represent roads or the brown ones that represent the terrain’ contour lines. But for us, the forest stands is enough.

14.3.2 Try Yourself Georefereniai Imaginea Pixelilor Verzi

As you did in the previous lesson, you need to georeference this new image to be able to use it with the rest of
your data.

Note that you don’t need to digitize the ground control points any more because this image is basically the same
image as the original map image, as far as the Georeferencer tool is concerned. Here are some things you should
remember:

• Această imagine este, de asemenea, în CRS-ul KKJ / Finland zone 2.

• Ar trebui să utilizai punctele de control de la sol salvate, File → Load GCP points.

• Amintii-vă să revizuii Setările de Transformare.

• Denumii stratul de ieire green_centroids.shp, din folderul digitizing.

Verificai dacă noul raster se potrivete bine cu harta originală.

14.3.3 Follow Along: Crearea Punctelor Suport pentru Digitizare.

Having in mind the digitizing tools in QGIS, you might already be thinking that it would be helpful to snap to those
green pixels while digitizing. That is precisely what you are going to do next create points from those pixels to
use them later to help you follow the forest stands’ borders when digitizing, by using the snapping tools available
in QGIS.

• Use the Raster → Conversion → Polygonize (Raster to Vector) tool to vectorize your green lines to polygons.
If you don’t remember how, you can review it in Lesson: Conversia din Raster în Vector.

• Salvai-l ca rautjarvi_green_polygon.shp, în interiorul folderului digitizing.

Mării i analizai forma poligoanelor. Vei obine ceva de genul:
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Următoarea opiune de a scoate punctele din acele poligoane, este de a le obine centroizii:

• Deschidei Vector → Geometry tools → Polygon centroids.

• Setai stratul poligonal pe care tocmai l-ai obinut, ca fiier de intrare pentru instrument.

• Denumii rezultatul ca green_centroids.shp, în folderul digitizing.

• Bifai Add result to canvas.

• Folosii instrumentul pentru a calcula centroizii poligoanelor.
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Acum putei elimina stratul rautjarvi_green_polygon din TOC.

Schimbai simbologia stratului centroizilor:

• Deschidei Proprietăile Stratului pentru green_centroids.

• Mergei la fila Stil tab.

• Setai Unităile ca Unităi de hartă.

• Setai Dimensiunea la 1.

It is not necessary to differentiate points from each other, you just need them to be there for the snapping tools to
use them. You can use those points now to follow the original lines much easily than without them.

14.3.4 Follow Along: Digitizarea Pâlcurilor de Pădure

Now you are ready to start with the actual digitizing work. You would start by creating a vector file of polygon
type, but for this exercise, there is a shapefile with part of the area of interest already digitized. You will just finish
digitizing the half of the forest stands that are left between the main roads (wide pink lines) and the lake:
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• Mergei la folderul digitizare folosind exploratorul dvs. de fiiere.

• Glisai fiierul vectorial pe harta dvs. forest_stands.shp.

Schimbai simbologia noului strat, astfel încât să putei identifica mai uor ce poligoane au fost deja digitizate:

• Umplei poligonul cu verde.

• Bordura poligonului va fi de 1 mm.

• Setai transparena la 50%.

Acum, aa cum vă amintii de la modulele din trecut, trebuie să configurai i activai opiunile de acroare:

• Mergei la Settings → Snapping options....
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• Activai acroarea straturilor green_centroids i forest_stands.

• Setai Tolerana la 5 unităi de hartă.

• Bifai caseta Avoid Int., pentru stratul forest_stands.

• Bifai Enable topological editing.

• Clic pe Aplicare.

With these snapping settings, whenever you are digitizing and get close enough to one of the points in the centroids
layer or any vertex of your digitized polygons, a pink cross will appear on the point that will be snapped to.

Finally, turn off the visibility of all the layers except forest_stands and rautjarvi_georef. Make sure
that the map image has not transparency any more.

Câteva lucruri importante de reinut, înainte de a începe digitizarea:

• Nu încercai să fii prea exaci în digitizarea frontierelor.

• If a border is a straight line, digitize it with just two nodes. In general, digitize using as few nodes as
possible.

• Zoom in to close ranges only if you feel that you need to be accurate, for example, at some corners or when
you want a polygon to connect with another polygon at a certain node.

• Folosii butonul din mijloc al mouse-ului pentru a mări/micora i deplasa, pe durata digitizării.

• Digitizai doar un singur poligon la un moment dat.

• După digitizarea unui poligon, scriei id-ul pâlcului de pădure pe care îl putei vedea în hartă.

Acum putei începe digitizarea:

• Localizai numărul pâlcului forestier 357 în fereastra hării.

• Activai editarea pentru stratul forest_stands.shp.

• Selectai instrumentul Add feature.

• Începei digitizarea pâlcului 357 prin conectarea unora dintre puncte.

• Notai cruciliele roz care indică acroarea.
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• Când ai terminat, facei clic-dreapta pentru a termina digitizarea acelui poligon.

• Introducei pâlcul forestier id (în acest caz 357).

• Clic pe OK

If you were not prompted for the polygon id when you finished digitizing it, go to Settings → Options →
Digitizing and make sure that the Suppress attribute form pop-up after feature creation is not checked.

Poligonul dvs. digitizat va arăta astfel:
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Now for the second polygon, pick up the stand number 358. Make sure that the Avoid int. is checked for the
forest_stands layer. This option does not allow intersecting polygons at digitizing, so that if you digitize
over an existing polygon, the new polygon will be trimmed to meet the border of the already existing polygons.
You can use this characteristic to automatically obtain a common border.

• Începei digitizarea standului 358 la unul dintre colurile comune cu pâlcul 357.

• Apoi continuai în mod normal, până când ajungei la celălalt col comun cu ambele pâlcuri.

• Finally, digitize a few points inside polygon 357 making sure that the common border is not intersected.
See left image below.

• Clic-dreapta pentru a termina editarea pâlcului de pădure 358.

• Introducei 358 ca i id.

• Click OK, your new polygon should show a common border with the stand 357 as you can seen in the image
on the right.
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The part of the polygon that was overlapping the existing polygon has been automatically trimmed out and you
are left with a common border, as you intended it to be.

14.3.5 Try Yourself Încheierea Digitizării Pâlcurilor de Pădure

Now you have two forest stands ready. And a good idea on how to proceed. Continue digitizing on your own until
you have digitized all the forest stands that are limited by the main road and the lake.

It might look like a lot of work, but you will soon get used to digitizing the forest stands. It should take you about
15 minutes.

During the digitizing you might need to edit or delete nodes, split or merge polygons. You learned about the
necessary tools in Lesson: Topologia Entităii, now is probably a good moment to go read about them again.

Remember that having Enable topological editing activated, allows you to move nodes common to two polygons
so that the common border is edited at the same time for both polygons.

Rezultatul dvs. va arăta în felul următor:
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14.3.6 Follow Along: Îmbinarea Datelor pentru Pâlcurile de Pădure

It is possible that the forest inventory data you have for you map is also written in paper. In that case, you would
have to first write that data to a text file or a spreadsheet. For this exercise, the information from the inventory for
1994 (the same inventory as the map) is ready as a comma separated text (csv) file.

Open the rautjarvi_1994.csv file from the exercise_data\forestry directory in a text editor and
note that the inventory data file has an attribute called ID that has the numbers of the forest stands. Those
numbers are the same as the forest stands ids you have entered for your polygons and can be used to link
the data from the text file to your vector file. You can see the metadata for this inventory data in the file
rautjarvi_1994_legend.txt in the same folder.

• Open the .csv in QGIS with the Layer → Add Delimited Text Layer... tool. In the dialog, set it as follows:
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Pentru a adăuga date din fiierul .csv:

• Deschidei proprietăile pentru stratul forest_stands.

• Mergei la fila Îmbinări.

• Facei clic pe semnul plus din partea de jos a casetei de dialog.

• Select rautjarvi_1994.csv as the Join layer and ID as the Join field.

• Asigurai-vă că, de asemenea, câmpul Target este setat pe id.

• Facei clic pe Ok de două ori.

The data from the text file should be now linked to your vector file. To see what has happened, open the attribute
table for the forest_stands layer. You can see that all the attributes from the inventory data file are now
linked to your digitized vector layer.

14.3.7 Try Yourself Redenumirea Numelor pentru Atribut, i Adăugarea
Suprafeei i a Perimetrului

The data from the .csv file is just linked to your vector file. To make this link permanent, so that the data is
actually recorded to the vector file you need to save the forest_stands layer as a new vector file. Close the
attribute table and right click the forest_stands layer to save it as forest_stands_1994.shp.

Open your new forest_stands_1994.shp in your map if you did not added yet. Then open the attribute
table. You notice that the names of the columns that you just added are no very useful. To solve this:

• Adăugai plugin-ul Table Manager procedând la fel ca i în cazul altor plugin-uri.
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• Asigurai-vă că plugin-ul este activat.

• În TOC selectai stratul forest_stands_1994.shp.

• Apoi, mergei la Vector → Table Manager → Table manager.

• Utilizai caseta de dialog pentru a edita numele coloanelor, în aa fel încât să se potrivească cu cele din fiierul
.csv.

• Clic pe Salvare.

• Selectai Yes pentru a păstra stilul stratului.

• Închidei dialogul Table Manager.

To finish gathering the information related to these forest stands, you might calculate the area and the perimeter
of the stands. You calculated areas for polygons in Lesson: Exerciiu Suplimentar. Go back to that lesson if you
need to and calculate the areas for the forest stands, name the new attribute Area and make sure that the values
calculated are in hectares.

Now your forest_stands_1994.shp layer is ready and packed with all the available information.

Save your project to keep the current map presentation in case you need to come back later to it.
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14.3.8 In Conclusion

It has taken a few clicks of the mouse but you now have your old inventory data in digital format and ready for
use in QGIS.

14.3.9 What’s Next?

You could start doing different analysis with your brand new dataset, but you might be more interested in perform-
ing analysis in a dataset more up to date. The topic of the next lesson will be the creation of forest stands using
current aerial photos and the addition of some relevant information to your dataset.

14.4 Lesson: Actualizarea Pâlcurilor de Pădure

Acum, că ai digitizat informaiile din hările de inventariere vechi i ai adăugat informaiile corespunzătoare pâlcurilor
de pădure, următorul pas ar fi crearea inventarului stării actuale a pădurii.

You will digitize new forest stands from scratch following an aerial photo from that forest area. The forestry map
you digitized in the previous lesson was created from an aerial Color Infrared (CIR) photograph. This type of
imagery, where the infrared light is recorded instead of the blue light, are widely used to study vegetated areas.
You will also use a CIR photograph in this lesson.

După digitizarea pâlcurilor de pădure, vei adăuga informaii, cum ar fi noile constrângeri rezultate din reglemen-
tările de conservare.

Scopul acestei lecii: De a digitiza un nou set de standuri forestiere din fotografiile CIR, aeriene, i de a adăuga
informaiile din alte seturi de date.

14.4.1 Comparând Pâlcurile Vechi de Pădure pentru Fotografiile Aeriene
Actuale

The National Land Survey of Finland has an open data policy that allows you downloading a variety of geograph-
ical data like aerial imagery, traditional topographic maps, DEM, LiDAR data, etc. The service can be accessed
also in English here. The aerial image used in this exercise has been created from two orthorectified CIR images
downloaded from that service (M4134F_21062012 and M4143E_21062012).

• Deschidei QGIS i stabilii CRS-ul proiectului la ETRS89 / ETRS-TM35FIN din Project → Project Prop-
erties → CRS.

• Asigurai-vă că este bifată opiunea de Activare a transformării CRS-ului ‘din zbor’.

• Din folderul exercise_data\forestry\, adăugai imaginea CIR rautjarvi_aerial.tif care
conine lacurile digitizate.

• Apoi salvai proiectul QGIS ca digitizing_2012.qgs.

Imaginile CIR sunt din 2012. Putei compara pâlcurile care au fost create în 1994 cu aproape 20 de ani mai târziu.

• Adăugai stratul forest_stands_1994.shp.

• Setai-i stilul, astfel încât să putei vedea prin poligoanele dumneavoastră.

• Examinai modul în care vechiul pâlc forestier poate fi interpretat vizual (sau nu) ca o pădure omogenă.

Focalizai i deplasai-vă în jurul zonei. Vei observa, probabil, că unele dintre pâlcurile vechi de pădure ar putea
corespunde încă cu imaginea, pe când altele nu.

This is a normal situation, as some 20 years have passed by and different forest operations have been done (har-
vesting, thinning...). It is also possible that the forest stands looked homogeneous back in 1992 to the person who
digitized them but as time has passed some forest has developed in different ways. Or simply the priorities for the
forest inventory were different that they are today.
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Apoi, vei crea noi pâlcuri de pădure pentru această imagine, fără a le utiliza pe cele vechi. Mai târziu, le putei
compara pentru a vedea diferenele.

14.4.2 Interpretarea Imaginii CIR

Let’s digitize the same area that was covered by the old inventory, limited by the roads and the lake. You don’t
have to digitize the whole area, as in the previous exercise you can start with a vector file that already contains
most of the forest stands.

• Eliminai stratul forest_stands_1994.shp.

• Adăugai stratul forest_stands_2012.shp‘localizat în folderul
:kbd:‘exercise_data\forestry\.

• Setai stilul acestui strat, astfel încât poligoanele să fie umplute, iar graniele să fie vizibile.
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Putei vedea că o regiune din nordul zonei inventariate încă lipsete. Aceasta va fi sarcina dvs.: digitizarea pâlcurilor
de pădure care lipsesc.

But before you start, spend some time reviewing the forest stands already digitized and the corresponding forest
in the image. Try to get an idea about how the stands borders are decided, it helps if you have some forestry
knowledge.

Unele idei despre ceea ce s-ar putea identifica din imagini:

• What forests are deciduous species (in Finland mostly birch forests) and which ones are conifers (in this
region pine or spruce). In CIR images, deciduous species will often come as bright red color whereas
conifers present dark green colors.

• When a forest stand age changes, by looking at the sizes of the tree crowns that can be identified in the
imagery.

• The different forest stands’ densities, for example forest stand were a thinning operation has recently been
done would clearly show spaces between the tree crowns and should be easy to differentiate from other
forest stands around it.

• Zonele albăstrui indică terenuri virane, drumuri i zone urbane, culturi care nu au ajuns să crească, etc.

• Don’t use zooms too close to the image when trying to identify forest stands. A scale between 1:3 000 and
1: 5 000 should be enough for this imagery. See the image below (1 : 4 000 scale):
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14.4.3 Try Yourself Încheierea Digitizării Pâlcurilor, pornind de la Imaginile
CIR

When digitizing the forest stands, you should try to get forest areas that are as homogeneous as possible in terms
of tree species, forest age, stand density... Don’t be too detailed though, or you will end up making hundreds of
small forest stands that would not be useful at all. You should try to get stands that are meaningful in the context
of forestry, not too small (at least 0.5 ha) but not too big either (no more than 3 ha).

inând cont de aceste indicaii, putei digitiza de acum pâlcurile forestiere lipsă.

• Activai editarea pentru stratul forest_stands_2012.shp.

• Setai opiunile de topologie i de acroare aa cum se arată în imagine.

• Amintii-vă să facei clic pe Aplicare sau OK.

Start digitizing as you did in the previous lesson, with the only difference that you don’t have any point layer
that you are snapping to. For this area you should get around 14 new forest stands. While digitizing, fill in the
Stand_id field with numbers starting at 901.

Când vei definitiva, stratul dvs. ar trebui să arate în felul următor:

332 Chapter 14. Module: O Aplicaie pentru Silvicultură
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Now you have a new set of polygons defining the different forest stands for the current situation as can interpreted
from the CIR images. But you are obviously still missing the forest inventory data, right? For that you will still
need to visit the forest and get some sample data that you will use to estimate the forest attributes for each of the
forest stands. You will see how to do that in the next lesson.

For the moment, you still can improve your vector layer with some extra information that you have about conser-
vation regulation that should be taken into account for this area.

14.4.4 Follow Along: Actualizarea Pâlcurile de Pădure cu Informaii de Con-
servare

For the area you are working with, it has been researched that the following conservation regulations must be
taken into account while doing the forest planning:

• Two locations of a protected species of Siberian flying squirrel (Pteromys volans) have been identified.
According to the regulation, an area of 15 meters around the spots must be left untouched.

• A riparian forest of special interest growing along a stream in the area must be protected. In a visit to the
field, it was found that 20 meters to both sides of the stream must be protected.

You have one vector file containing the information about the squirrel locations and another containing the digi-
tized stream running in the North area towards the lake. From the exercise_data\forestry\ folder, add
the vector files squirrel.shp and stream.shp.
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For the protection of the squirrels locations, you are going to add a new attribute (column) to your new forest
stands that will contain information about point locations that have to be protected. That information will later be
available whenever a forest operation is planned, and the field team will be able to mark the area that has to be left
untouched before the work starts.

• Deschidei tabela de atribute pentru stratul squirrel.

• You can see that there are two locations that are defined as Siberian flying squirrel, and that the area to be
protected is indicated by a distance of 15 meters from the locations.

To join the information about the squirrels to your forest stands, you can use the Join attributes by location:

• Deschidei Vector → Managementul Datelor → Îmbină atributele după locaie.

• Stabilii forest_stands_2012 ca i Strat Vectorial de Destinaie.

• Ca i Strat vectorial de îmbinare selectai stratul de tip punct squirrel.shp.

• Denumii fiierul rezultat stands_squirrel.shp.

• In Output table select Keep all records (including non-matching target records). So that you keep all the
forest stands in the layer instead of only keeping those that are spatially related to the squirrel locations.

• Clic pe OK

• Selectai Yes când vi se cere să adăugai stratul în TOC.

• Închidei caseta de dialog.
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Now you have a new forest stands layer, stands_squirrel where there are new attributes corresponding to
the protection information related to the Siberian flying squirrel.

Open the table of the new layer and order it so that the forest stands with information for the Protection attribute
are on top. You should have now two forest stands where the squirrel has been located:
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Although this information might be enough, look at what areas related to the squirrels should be protected. You
know that you have to leave a buffer of 15 meters around the squirrels location:

• Deschidei Vector → Geoprocessing Tools → Buffer.

• Creai un tampon de 15 metri pentru stratul squirrel.

• Denumii rezultatul ca i squirrel_15m.shp.
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You will notice that if you zoom in to the location in the Northern part of the area, the buffer area extends to
the neighbouring stand as well. This means that whenever a forest operation would take place in that stand, the
protected location should also be taken into account.
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Din analizele anterioare, nu ai obinut pâlcul în care să înregistrai informaiile despre starea de protecie. Pentru a
rezolva această problemă:

• Rulai iarăi instrumentul Îmbinare atribute după locaie.

• De această dată, utilizai stratul squirrel_15m pentru îmbinare.

• Denumii fiierul rezultat stands_squirrel_15m.shp.
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Open the attribute table for the this new layer and note that now you have three forest stands that have the infor-
mation about the protection locations. The information in the forest stands data will indicate to the forest manager
that there are protection considerations to be taken into account. Then he or she can get the location from the
squirrel dataset, and visit the area to mark the corresponding buffer around the location so that the operators
in the field can avoid disturbing the squirrels environment.

14.4.5 Try Yourself Actualizarea Pâlcurilor de Pădure folosind Distana până
la Flux

Following the same approach as indicated for the protected squirrel locations you can now update your forest
stands with protection information related to the stream identified in the field:
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• Amintii-vă că tamponul, în acest caz, este de 20 de metri în jurul său.

• You want to have all the protection information in the same vector file, so use the
stands_squirrel_15m layer as the target.

• Denumii rezultatul ca forest_stands_2012_protect.shp.

Open the attributes table for the new vector layer and confirm that you now have all the protection information for
the stands that are affected by the protection measures to protect the riparian forest associated with the stream.

Salvai acum proiectul dvs. QGIS.

14.4.6 In Conclusion

You have seen how to interpret CIR images to digitize forest stands. Of course it would take some practice to
make more accurate stands and usually using other information like soil maps would give better results, but you
know now the basis for this type of task. And adding information from other datasets resulted to be quite a trivial
task.

14.4.7 What’s Next?

The forest stands you digitized will be used for planning forestry operations in the future, but you still need to get
more information about the forest. In the next lesson, you will see how to plan a set of sampling plots to inventory
the forest area you just digitized, and get the overall estimate of forest parameters.

14.5 Lesson: Planul de Eantionare Sistematică

You have already digitized a set of polygons that represent the forest stands, but you don’t have information about
the forest just yet. For that purpose you can design a survey to inventory the whole forest area and then estimate
its parameters. In this lesson you will create a systematic set of sampling plots.

When you start planning your forest inventory it is important to clearly define the objectives, the types of sample
plots that will be used, and the data that will be collected to achieve the objectives. For each individual case, those
will depend on the type of forest and the management purpose; and should be carefully planned by someone with
forestry knowledge. In this lesson, you will implement a theoretical inventory based on a systematic sampling plot
design.

Scopul acestei lecii: De a crea un grafic de eantionare sistematic, proiectat pentru o vedere de ansamblu a zonei
de pădure.

14.5.1 Inventarierea Pădurii

There are several methods to inventory forests, each of them suiting different purposes and conditions. For exam-
ple, one very accurate way to inventory a forest (if you consider only tree species) would be to visit the forest and
make a list of every tree and their characteristics. As you can imagine this is not commonly applicable except for
some small areas or some special situations.

The most common way to find out about a forest is by sampling it, that is, taking measurements in different
locations at the forest and generalizing that information to the whole forest. These measurements are often made
in sample plots that are smaller forest areas that can be easily measured. The sample plots can be of any size
(for ex. 50 m2, 0.5 ha) and form (for ex. circular, rectangular, variable size), and can be located in the forest in
different ways (for ex. randomly, systematically, along lines). The size, form and location of the sample plots are
usually decided following statistical, economical and practical considerations. If you have no forestry knowledge,
you might be interested in reading this Wikipedia article.
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14.5.2 Lesson: Implementarea unui Plan de Eantionare Sistematică

For the forest you are working with, the manager has decided that a systematic sampling design is the most
appropriate for this forest and has decided that a fixed distance of 80 meters between the sample plots and sampling
lines will yield reliable results (for this case, +- 5% average error at a probability of 68%). Variable size plots has
been decided to be the most effective method for this inventory, for growing and mature stands, but a 4 meters
fixed radius plots will be used for seedling stands.

În practică, trebuie pur i simplu să reprezentăm parcelele eantion ca puncte care vor fi folosite ulterior de către
echipele din teren:

• Deschidei proiectul digitizing_2012.qgs

• Eliminai toate straturile, cu excepia forest_stands_2012.

• Salvai proiectul dumneavoastră ca forest_inventory.qgs

Acum trebuie să creai o reea dreptunghiulară de puncte separate, aflate la 80 de metri unul de altul:

• Deschidei Vector → Research Tools → Regular points.

• În definiiile Ariei, selectai Input Boundary Layer.

• Iar ca i strat de intrare setai forest_stands_2012.

• În setările de Spaiere a Grilei, selectai Folosirea acestei spaieri între puncte i stabilii-o la 80.

• Salvai rezultatul ca systematic_plots.shp, în folderul forestry\sampling\.

• Bifai caseta Add result to canvas.

• Clic pe OK

Note: The suggested Regular points creates the systematic points starting in the corner upper-left corner of the
extent of the selected polygon layer. If you want to add some randomness to this regular points, you could use
a randomly calculated number between 0 and 80 (80 is the distance between our points), and then write it as the
Initial inset from corner (LH side) parameter in the tool’s dialog.

You notice that the tool has used the whole extent of your stands layer to generate a rectangular grid of points. But
you are only interested on those points that are actually inside your forest area (see the images below):
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• Deschidei Vector → Geoprocessing Tools → Clip.

• Selectai systematic_plots ca Strat vectorial de intrare.

• Setai forest_stands_2012 ca i Strat de decupare.

• Salvai rezultatul ca i systematic_plots_clip.shp.

• Bifai caseta Add result to canvas.

• Clic pe OK

You have now the points that the field teams will use to navigate to the designed sample plots locations. You
can still prepare these points so that they are more useful for the field work. At the least you will have to add
meaningful names for the points and export them to a format that can be used in their GPS devices.

Lets start with the naming of the sample plots. If you check the Attribute table for the plots inside the forest area,
you can see that you have the default id field automatically generated by the Regular points tool. Label the points
to see them in the map and consider if you could use those numbers as part of your sample plot naming:

• Deschidei Layer Properties –> Labels pentru systematic_plots_clip.

• Bifai Label this layer with, apoi selectai câmpul ID.

• Go to the Buffer options and check the Draw text buffer, set the Size to 1.

• Clic pe OK

Now look at the labels on your map. You can see that the points have been created and numbered first West to
East and then North to South. If you look at the attribute table again, you will notice that the order in the table is
following also that pattern. Unless you would have a reason to name the sample plots in a different way, naming
them in a West-East/North-South fashion follows a logical order and is a good option.

Note: If you would like to order or name them in a different way, you could use a spreadsheet to be able to order
and combine rows and columns in any different way.
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Nevertheless, the number values in the id field are not so good. It would be better if the naming would be
something like p_1, p_2.... You can create a new column for the systematic_plots_clip layer:

• Mergei la Tabelul de atribute pentru systematic_plots_clip.

• Activai modul de editare.

• Deschidei Calculatorul de câmpuri, apoi denumii noua coloană Plot_id.

• Setai Output field type la Text (string).

• In the Expression field, write, copy or construct this formula concat(’P_’, $rownum ). Remember
that you can also double click on the elements inside the Function list. The concat function can be found
under String and the $rownum parameter can be found under Record.

• Clic pe OK

• Dezactivai modul de editare i salvai modificările.

Now you have a new column with plot names that are meaningful to you. For the systematic_plots_clip
layer, change the field used for labeling to your new Plot_id field.
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14.5.3 Follow Along: Exportai Graficele în format GPX

The field teams will be probably using a GPS device to locate the sample plots you planned. The next step is
to export the points you created to a format that your GPS can read. QGIS allows you to save your point and
line vector data in GPS eXchange Format (GPX)<http://en.wikipedia.org/wiki/GPS_Exchange_Format>, which
is an standard GPS data format that can be read by most of the specialized software. You need to be careful with
selecting the CRS when you save your data:

• Clic dreapta pe systematic_plots_clip, apoi selectai Save as.

• În Format selectai GPS eXchange Format [GPX].
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• Salvai rezultatul ca plots_wgs84.gpx.

• În CRS alegei CRS-ul Selectat.

• Alegei WGS 84 (EPSG:4326).

..note:: The GPX format accepts only this CRS, if you select a different one, QGIS will give no error but you will
get an empty file.

• Clic pe OK

• In the dialog that opens, select only the waypoints layer (the rest of the layers are empty).

The inventory sample plots are now in a standard format that can be managed by most of the GPS software. The
field teams can now upload the locations of the sample plots to their devices. That would be done by using the
specific devices own software and the plots_wgs84.gpx file you just saved. Other option would be to use the
GPS Tools plugin but it would most likely involve setting the tool to work with your specific GPS device. If you
are working with your own data and want to see how the tool works you can find out information about it in the
section Working with GPS Data in the QGIS User Manual.

Salvai acum proiectul dvs. QGIS.
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14.5.4 In Conclusion

You just saw how easily you can create a systematic sampling design to be used in a forest inventory. Creating
other types of sampling designs will involve the use of different tools within QGIS, spreadsheets or scripting to
calculate the coordinates of the sample plots, but the general idea remains the same.

14.5.5 What’s Next?

In the next lesson you will see how to use the Atlas capabilities in QGIS to automatically generate detailed maps
that the field teams will be using to navigate to the sample plots assigned to them.

14.6 Lesson: Crearea hărilor detaliate folosind instrumentul Atlas

Proiectarea sistematică de eantionare este gata, iar echipele de teren i-au încărcat coordonatele GPS în dispozitivele
de navigare. Există, de asemenea, un formular pentru date, în care se vor colecta informaiile măsurate pentru
fiecare schiă. Pentru a găsi mai uor drumul spre fiecare parcelă, s-au solicitat o serie de hări detaliate, în cazul
în care unele informaii din teren pot fi văzute în mod clar, împreună cu un subset mic de schie i câteva informaii
despre zonă. Putei utiliza instrumentul Atlas pentru a genera automat o serie de hări, având un format comun.

Scopul acestei lecii: Aflai cum să utilizai instrumentul Atlas în QGIS, pentru a genera hări tipăribile detaliate, în
scopul sprijinirii activităii de inventariere în teren.

14.6.1 Follow Along: Pregătirea Compozitorului de Hări

Înainte de a putea automatiza hările detaliate ale zonei forestiere i schiele noastre de eantionare, trebuie să creăm
un ablon cu toate elementele pe care le considerăm utile în munca de teren. Desigur, cea mai importantă va fi
o stilizare corectă, dar, după cum ai văzut mai înainte, va trebui să adăugai i o mulime de alte elemente care
completează harta tipărită.

Deschidei proiectul QGIS din lecia anterioară forest_inventory.qgs. Ar trebui să avei cel puin urmă-
toarele straturi:

• forest_stands_2012 (cu o transparenă de 50% , umplere cu verde deschis i închis a liniilor marginii).

• systematic_plots_clip.

• rautjarvi_aerial.

Salvai proiectul cu un nume nou, map_creation.qgs.

Pentru a crea o hartă tipăribilă, amintii-vă să utilizai Managerul de Compoziii:

• Deschidei Project → Composer Manager....

• În dialogul Managerului de compoziii.

• Clic pe butonul Adăugare i denumii compoziia forest_map.

• Clic pe OK

• Clic pe butonul Afiare

Setai opiunile imprimantei, astfel încât hările să se potrivească unei hârtii A4 i marginilor acesteia:

• Deschidei menuselection:Composer –> Page Setup.

• Dimensiunea este A4 (217 x 297 mm).

• Orientarea este Peisaj.

• Marginile (milimeri) sunt setate la 5.
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În fereastra Compozitorului de Hări mergei la fila Compoziie (în panoul din dreapta) i asigurai-vă că aceste setări
pentru Hârtie i calitate sunt similare cu cele pe care la definii pentru imprimantă:

• Mărimea: A4 (210x297mm).

• Orientarea: Peisaj.

• Calitatea: 300dpi.

Compunerea unei hări este mai uoară dacă facei uz de grila canevasului pentru a poziiona diferitele elemente.
Revedei setările pentru grila compozitorului:

• În fila Compoziiilor extindei regiunea Grid.

• Asigurai-vă că Spaierea este setată la 10 mm.

• i că Tolerana este setată la 2 mm.

Trebuie să activai folosirea grilei:

• Deschidei meniul :menuselection:‘Vizualizare

• Bifai Afiarea grilei.

• Bifai Acroare la grilă.

• Observai că opiunile pentru utilizarea ghidajelor sunt verificate în mod implicit, ceea ce vă permite să vedei
linii de ghidare roii, atunci când deplasai elementele în compozitor.

Acum putei începe să adăugai elemente în canevasul hării. Adăugai, mai întâi, un element de hartă, astfel încât să
vei putea vedea cum arată, pe măsură ce facei schimbări în simbologia straturilor:

• Click on the Add New Map button: .

• inei apăsat butonul stâng al mouse-ului i trasai un dreptunghi în care să încadrai cea mai mare parte a hării.

Observai modul în care cursorul mouse-ului se acroează la grila canevasului. Utilizai această funcie atunci când
adăugai alte elemente. Dacă dorii să avei mai multă acuratee, schimbai setările de Spaiere ale grilei. Dacă dintr-
un motiv oarecare nu mai dorii acroarea la grilă la un moment dat, putei întotdeauna bifa sau debifa meniul
Vizualizare.
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14.6.2 Follow Along: Adăugarea Fundalului Hării

Lăsai compozitorul deschis, dar mergei înapoi la hartă. Haidei să adăugăm unele date de fundal i să creăm unele
stiluri, astfel încât coninutul hării sa fie cât mai clar posibil.

• Adăugai rasterul de fundal basic_map.tif, pe care îl putei găsi în folderul
exercise_data\forestry\.

• Când vi se solicită, selectai pentru raster CRS-ul ETRS89 / ETRS-TM35FIN.

După cum putei vedea, harta de fundal este deja stilizată. Acest tip de raster cartografic gata de utilizare este foarte
frecvent. El este creat din date vectoriale, stilizate într-un format standard i stocate ca un raster, aa că nu trebuie
să vă îngrijoreze obinerea unui rezultat bun.

• Acum mării schiele dvs., astfel încât să putei vedea doar aproximativ patru sau cinci linii de parcele.

Stilul actual pentru schiele de probă nu este cel mai bun, dar cum arată el în harta compozitorului ?:

În timp ce, în ultimele exerciii, tamponul alb a fost OK, fiind situat în partea de sus a imaginii aeriene, acum că
imaginea de fundal este în cea mai mare parte albă, abia se mai pot vedea etichetele. De asemenea, putei verifica
modul în care arată acesta în compozitor:

• Mergei la fereastra Compozitorului de Hări.

• Use the button to select the map element in the composer.

• Mergei la fila Proprietăile itemului tab.

• Sub Extents facei clic pe Set to map canvas extent.

• Dacă trebuie să actualizai elementul, sub Main properties facei clic pe Update preview.

Evident, acest lucru nu este suficient de bun, atât timp cât dorii să afiai numerele, pe cât posibil, cât mai vizibil
pentru echipele din teren.

14.6.3 Try Yourself Schimbarea Simbologiei Straturilor

Ai exersat simbologia cu Module: Crearea unei Hări de Bază, i etichetarea cu Module: Clasificarea Datelor
Vectoriale. Revenii la aceste module dacă trebuie să vă reamintii unele dintre opiunile i instrumentele disponibile.
Scopul dvs. este de a afia locaiile loturilor i numele lor cât mai clar, dar întotdeauna să fie posibilă vizualizarea
elementelor din fundalul hării. Vă putei orienta după această imagine:
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Vei folosi mai târziu stilizarea cu verde a stratului forest_stands_2012.În scopul păstrării sale, i pentru a
avea o vizualizare a acestuia care arată numai marginile masivului:

• Clic dreapta pe forest_stands_2012, apoi selectai Duplicare

• vei obine un nou strat denumit forest_stands_2012 copy, pe care îl putei folosi pentru a defini un
stil diferit, de exemplu, fără umplere i cu marginile roii.

Acum avei două vizualizări diferite ale parcelelor împădurite i putei decide pe care să o afiai pentru harta dvs.
detaliată.

Revenii adesea în fereastra Compozitorului de hări pentru a vedea cum va arăta harta. În scopul creării de hări
detaliate, suntei în căutarea unor simboluri care să arate bine nu doar la scara de ansamblu a zonei forestiere
(imaginea stângă de mai jos), ci i la o scară mai apropiată (imaginea din dreapta jos). Amintii-vă să folosii Update
preview i Set to map canvas extent ori de câte ori refocalizai harta sau compozitorul.
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14.6.4 Try Yourself Crearea unui abblon pentru Harta de Bază

O dată ce avei o simbologie care vă mulumete, suntei gata să adăugai alte câteva informaii hării dvs. Adăugai cel
puin următoarele elemente:

• Titlu.

• O scară grafică.

• Cadrul grilei pentru harta dvs.

• Coordonate situate pe pările laterale ale grilei.

Ai creat deja o compoziie similară în Module: Crearea Hărilor. Mergei înapoi la acel modul pentru a vi-l reaminti.
Pentru referină, putei privi această imagine exemplu:

Exportai harta dvs. ca o imagine i privii-o.

• Composer → Export as Image.

• Utilizai, de exemplu, Formatul JPG.

Iată cum va arăta atunci la tipărire.

14.6.5 Follow Along: Adăugarea mai multor elemente Compozitorului

Aa cum probabil ai observat în imaginea hării ablon propusă, există o mulime de loc în partea dreaptă a caneva-
sului. Haidei să vedem ce altceva ar putea merge acolo. Pentru scopul hării noastre, o legendă nu este cu adevărat
necesară, dar o imagine de ansamblu a hării i nite casete de text ar putea adăuga valoare hării.

Harta de ansamblu va ajuta echipele de teren să plaseze harta detaliată în interiorul suprafeei generală a pădurii:

• Adăugai un alt element de hartă pe canevas, chiar sub textul din titlu.

• În fila Proprietăilor elementului, deschidei caseta cu derulare verticală Overview.
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• Punei Overview frame pe Map 0. Acest lucru creează un dreptunghi umbrit deasupra hării mici, care reprez-
intă extinderea vizibilă în harta mai mare.

• Selectai, de asemenea, pentru opiunea Frame o culoare neagră, apoi 0.30 pentru Thickness.

Observai că imaginea de ansamblu a hării nu oferă cu adevărat imaginea zonei forestiere pe care ne-am fi dorit-
o. Vrem ca această hartă să arate întreaga suprafaă împădurită i să prezinte numai harta de fundal i stratul
forest_stands_2012, nu i parcele eantion. De asemenea, se dorete blocarea imaginii, în aa fel încât ea
să nu se mai modifice ori de câte ori se schimbă vizibilitatea sau ordinea straturilor.

• Mergei înapoi, dar nu închidei Compozitorul de Hări.

• Clic dreapta pe stratul forest_stands_2012, apoi pe Zoom to Layer Extent.

• Dezactivai toate straturile, cu excepia basic_map i forest_stands_2012.

• Mergei înapoi la Compozitorul de Hări.

• Având selectată harta mică, facei clic pe Set to map canvas extent, pentru a seta extinderile până la care se
poare vedea în fereastra hării.

• Blocai ecranul pentru harta generală prin bifarea Lock layers for map item sub Main properties.

Acum imaginea de ansamblu a hării este mai apropiată de ceea ce dorim, i în plus, nu se va mai schimba. Însă,
acum harta detaliată nu mai are margini i nici parcele eantion. Haidei să le remediem:

• Merge din noui la fereastra hării i selectai straturile pe care le dorii să fie vizibile
(systematic_plots_clip, forest_stands_2012 copy i Basic_map).

• Transfocai iarăi, pentru a avea vizibile doar câteva linii ale parcelelor.

• Mergei înapoi la fereastra Compozitorului de Hări.

• Select the bigger map in your composer ( ).

• În Properietăile elementului facei clic pe Update preview i pe Set to map canvas extent.
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Observai că numai harta mai mare afiează vizualizarea curentă a hării, iar harta mai mică de ansamblu păstrează
aceeai vedere pe care ai blocat-o.

Reinei, de asemenea, că o vedere de ansamblu afiează un cadru umbrit pentru extinderea prezentată în harta
detaliată.

ablonul hării dvs. este aproape gata. Adăugai în hartă cele două casete de text de mai jos, una coninând textul
‘Zona detaliată a hării:’, iar cealaltă ‘Observaii:’. Plasai-le aa cum se vede în imaginea de mai sus.

Putei adăuga, de asemenea, o săgeată a Nordului la harta generală:

• Use the Add image tool, .

• Facei clic pe colul din dreapta sus al hării imaginii de ansamblu.

• În fila Proprietăilor elementului, deschidei Search directories i navigai la imaginea unei săgei.

• Sub Image rotation, bifai Sync with map i selectai Map 1 (vizualizarea hării).

• Degifai Fundalul.

• Redimensionai imaginea săgeii la o dimensiune care arată bine pe hările mici.

Harta de bază a compozitorului este gata, acum dorind să facem uz de instrumentul Atlas, pentru a genera cât mai
multe hări detaliate în acest format, atâtea cât sunt necesare.

14.6.6 Follow Along: Crearea unei Acoperiri de Atlas

Acoperirea Atlasului reprezintă doar un strat vectorial care va fi folosit pentru a genera hările detaliate, o hartă
pentru fiecare entitate din aria de acoperire. Pentru a vă face o idee despre aceasta, iată un set complet de hări
detaliate pentru zona de pădure:
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Acoperirea poate fi orice strat existent, dar, de obicei, are mai mult sens crearea unuia în acest scop specific.
Haidei să creăm o reea de poligoane care acoperă zona de pădure:

• În vizualizarea hării QGIS, deschidei Vector → Research Tools → Vector grid.

• Setai instrumentul aa cum se arată în această imagine:
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• Salvai rezultatul ca atlas_coverage.shp.

• Stilizai noul strat atlas_coverage, astfel încât poligoanele să nu aibă umplere.

Noile poligoane acoperă întreaga zonă de pădure i vă conferă o idee despre ceea ce va conine fiecare hartă (creată
din fiecare poligon).
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14.6.7 Follow Along: Configurarea Instrumentului Atlas

Ultimul pas este de a crea instrumentul Atlas:

• Mergei înapoi la Constructorul de Hări.

• În panoul din dreapta, mergei la fila Atlas generation.

• Setai opiunile după cum urmează:
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Aceasta spune instrumentului Atlas să utilizeze entităile (poligoanele) din interiorul atlas_coverage ca focus
pentru fiecare detaliu al hării. Se va afia o hartă pentru fiecare entitate din strat. Hidden coverage layer spune
Atlasului să nu arate poligoanele din hările de ieire.

Mai trebuie să fie făcut un lucru. Trebuie să indicai Atlasului care element va fi actualizat pentru fiecare hartă de
ieire. Până acum, probabil că ai ghicit că harta care urmează a fi schimbată pentru fiecare entitate, este cea pe
care ai pregătit-o să conină vederile detaliate ale parcelelor eantion, ea reprezentând elementul cel mai mare de pe
canevas:

• Selectai elementul cel mai mare din hartă.

• Mergei la fila Proprietăile itemului tab.

• În listă, bifai Controlat de atlas.

• Apoi setai Marging around feature la 10%. Extinderea vederii va fi cu 10% mai mare decât poligoanele,
ceea ce înseamnă că detaliile hărilor vor avea o suprapunere de 10%.
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Acum putei utiliza instrumentul de vizualizare pentru Atlas, pentru a revizui ceea ce vor arăta hările:

• Activate the Atlas previews using the button or if your Atlas toolbar is not visible, via Atlas → Preview
Atlas.

• Putei folosi săgeile din bara de instrumente a Atlasului, sau din meniul Atlas, pentru a vă deplasa printre
hările care vor fi create.

Reinei că unele dintre ele acoperă zone care nu sunt interesante. Haidei să facem ceva i să salvăm nite copaci,
neimprimând aceste hări inutile.

14.6.8 Follow Along: Editarea Stratului de Acoperire

Pe lângă eliminarea poligoanelor pentru acele zone care nu sunt interesante, putei personaliza, de asemenea,
etichetele din harta dvs., prin generarea coninutului acestora din Tabela de atribute a stratului de acoperire.

• Mergei înapoi la vizualizarea hării.

• Activai editarea pentru stratul atlas_coverage.
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• Selectai poligoanele care sunt evideniate (în galben) în imaginea de mai jos.

• Eliminai poligoanele selectate.

• Dezactivai editarea i salvai modificările.

Putei merge înapoi la Print Composer, i să verificai dacă previzualizările din Atlas folosesc doar poligoanele pe
care le-ai lăsat în strat.

Stratul de acoperire pe care îl utilizai, încă nu conine informaii utile, pe care să le putei folosi la personalizarea
coninutului etichetelor din hartă. Primul pas este de a le crea; în acest scop putei adăuga, de exemplu, un cod de
zonă pentru zonele poligonale, i un câmp cu câteva observaii pe care să le aibă în vedere echipele din teren:

• Deschidei Tabela de atribute pentru stratul atlas_coverage.

• Activează editarea.

• Use the calculator to create and populate the following two fields.

• Creai un câmp denumit Zonă i tastai Număr întreg (integer).

• În caseta Expresiei scriei/copiai/construiî $rownum.

• Creai un alt câmp denumit Observaii, de tipul Text (ir) i cu dimensiunea de 255.
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• În caseta Expression scriei ’No remarks.’. Acest lucru va seta toate valorile implicite pentru toate
poligoanele.

Managerul silvic va obine unele informaii din zonă, care ar putea fi utile atunci când se va vizita suprafaa re-
spectivă. De exemplu, existena unui pod, a unei mlatini, sau locaia unei specii protejate. Deoarece stratul
atlas_coverage probabil că se află încă, în modul de editare, adăugai, în continuare, următorul text în câmpul
Remarks poligoanelor corespunzătoare (dublu clic pe celulă pentru a o edita):

• Pentru Zona 2: Podul din Nordul planului 19. Veveriă siberiană între p_13
i p_14..

• Pentru Zona 6: Dificil de tranzitat mlatina, în nordul lacului..

• Pentru Zona 7: Veveriă siberiană în Sud Estul p_94..

• Dezactivează editarea i salvează modificările.

Aproape de final, trebuie să-i spunei instrumentului Atlas că dorii ca unele dintre etichetele de text să utilizeze
informaiile din tabela de atribute a stratului atlas_coverage.

• Mergei înapoi la Constructorul de Hări.

• Selectai eticheta care conine textul Hartă detaliată....

• Setai dimensiunea Fontului la 12.

• Ducei cursorul la sfâritul textului din etichetă.

• În fila Proprietăile elementului, în interiorul Proprietăilor principale facei clic pe Insert an expression.

• În Lista funciilor facei dublu clic pe câmpul Zonă de sub Câmpuri i Valori.

• Clic pe OK

• Textul din interiorul casetei Item properties ar trebui să prezinte Detail map inventory zone:
[% "Zone" %]. Reinei că [% "Zona" %] va fi substituită de valoarea Zone, pentru entitatea core-
spunzătoare din stratul atlas_coverage.

Testai coninutul etichetei, prin vizualizarea unor diferite hări din Atlas.

Procedai similar pentru etichetele cu textul Remarks:, folosind câmpul cu informaii despre zonă. Putei lăsa o
linie de pauză înainte de a introduce expresia. Putei vedea rezultatul previzualizării zonei 2, în imaginea de mai
jos:
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Utilizai previzualizarea din Atlas pentru a naviga prin toate hările care vor fi create în curând!

14.6.9 Follow Along: Tipărirea Hărilor

Nu în ultimul rând, imprimai sau exportai hările în fiiere imagine sau PDF. Avei posibilitatea să utilizai Atlas →
Export Atlas as Images... sau Atlas → Export Atlas as PDF.... În prezent, formatul de export SVG nu funcionează
în mod corespunzător i va da un rezultat slab.

Haidei să exportăm hările într-un singur PDF pe care îl putei trimite la biroul teritorial pentru imprimare:

• Mergei la fila Atlas generation, în panoul din dreapta.

• Sub Output bifai Single file export when possible. Acest lucru va pune toate hările împreună într-un fiier
PDF; în cazul în care această opiune nu este bifată, vei obtine câte un fiier pentru fiecare hartă.

• Apelai Composer → Export as PDF....

• Salvai fiierul PDF inventory_2012_maps.pdf în folderul exercise_data\forestry\samplig\map_creation\.

Deschidei fiierul PDF pentru a verifica dacă totul a mers cum era de ateptat.

Putei crea la fel de uor imagini separate pentru fiecare hartă (amintii-vă să debifai crearea unui singur fiier), unde
putei vedea miniaturile imaginilor care vor fi create:
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În Print Composer, salvai harta dvs. ca ablon pentru compozitor, forestry_atlas.qpt, în folderul
exercise_data\forestry\map_creation\. Folosii Composer → Save as Template. Vei putea reutiliza
acest ablon, după dorină.

Închidei Compozitorul de Hări, apoi salvai-vă proiectul QGIS.

14.6.10 In Conclusion

Ai reuit să creai o hartă ablon, care poate fi folosită pentru a genera automat hări detaliate, în scopul uurării
utilizării în teren. După cum ai observat, acest lucru nu a fost o sarcină uoară, dar beneficiul va veni atunci când
va trebui să creai hări similare pentru alte regiuni, unde putei utiliza ablonul pe care tocmai l-ai salvat.

14.6.11 What’s Next?

În lecia următoare, vei vedea cum se pot utiliza datele LIDAR pentru a crea un DEM, pe care să-l utilizai la
îmbunătăirea vizibilitatea datelor i hărilor dvs.

14.7 Lesson: Calcularea Parametrilor Forestieri

Estimating the parameters of the forest is the goal of the forest inventory. Continuing the example from previous
lesson, you will use the inventory information gathered in the field to calculate the forest parameters, for the whole
forest first, and then for the stands you digitized before.

Scopul acestei lecii: De a calcula parametrii forestieri la nivel general i la nivel de pâlc.

14.7.1 Follow Along: Adăugarea Rezultatelor Inventarului

The field teams visited the forest and with the help of the information you provided, gathered information about
the forest at every sample plot.

Most often the information will be collected into paper forms in the field, then typed to a spreadsheet. The sample
plots information has been condensed into a .csv file that can be easily open in QGIS.

Continuând cu proiectul QGIS din lecia despre proiectarea inventarului, probabil că l-ai denumit
forest_inventory.qgs.

În primul rând, adăugai măsurătorile din suprafeele de probă în proiectul dvs. QGIS:

• Mergei la Layer → Add Delimited Text Layer....
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• Navigai la fiierul systematic_inventory_results.csv localizat în
exercise_data\forestry\results\.

• Asigurai-vă că este selectată opiunea Point coordinates.

• Setai câmpurile pentru coordonatele din câmpurile X and Y.

• Clic pe OK

• Când vi se solicită, selectai ca i CRS ETRS89 / ETRS-TM35FIN.

• Deschidei noul Tabel de Atribute i aruncai o privire datelor.

You can read the type of data that is contained in the sample plots measurements in the text file
legend_2012_inventorydata.txt located in the exercise_data\forestry\results\ folder.

The systematic_inventory_results layer you just added is actually just a virtual representation of the
text information in the .csv file. Before you continue, convert the inventory results to a real shapefile:

• Clic dreapta pe stratul systematic_inventory_results.

• Navigai la folderul exercise_data\forestry\results\.

• Denumii fiierul sample_plots_results.shp.

• Bifai caseta Add saved file to map.

• Eliminai stratul systematic_inventory_results din proiectul dvs.

14.7.2 Follow Along: Parametrii de Evaluare a Întregii Păduri

You can calculate the averages for this whole forest area from the inventory results for the some interesting
parameters, like the volume and the number of stems per hectare. Since the systematic sample plots represent
equal areas, you can directly calculate the averages of the volumes and number of stems per hectare from the
sample_plots_results layer.

Putei calcula media unui câmp dintr-un strat vectorial, folosind instrumentul Basic statistics:

• Deschidei Vector → Analysis Tools → Basic statistics.

• Selectai sample_plots_results ca Strat Vectorial de Intrare.

• Selectai Vol ca i Câmp Destinaie.

• Clic pe OK

Volumul mediu din pădure este 135.2 m3/ha.

În acelai mod, putei calcula media pentru numărul de tulpini, 2745 stems/ha.
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QGIS Training Manual, Release 2.8

14.7.3 Follow Along: Estimarea Parametrilor Zonali

You can make use of those same systematic sample plots to calculate estimates for the different forest stands
you digitized previously. Some of the forest stands did not get any sample plot and for those you will not get
information. You could have planned some extra sample plots when you planned the systematic inventory, so
that the field teams would have measured a few extra sample plots for this purpose. Or you could send a field
team later to get estimates of the missing forest stands to complete the stand inventory. Nevertheless, you will get
information for a good number of stands just using the planned plots.

What you need is to get the averages of the sample plots that are falling within each of the forest stands. When
you want to combine information based on their relative locations, you perform a spatial join:

• Deschidei instrumentul Vector → Data Management → Join attributes by location.

• Setai forest_stands_2012 ca i Strat Vectorial de Destinaie. Stratul pentru care dorii rezultatele.

• Setai sample_plots_results ca i Strat Vectorial de Îmbinare. Stratul din care vrei să calculai es-
timările.

• Bifai Take summary of intersecting features.

• Bifai pentru a calcula doar Media.

• Denumii rezultatul ca forest_stands_2012_results.shp, iar apoi salvai-l în folderul
exercise_data\forestry\results\.

• La final, selectai Keep all records..., astfel încât să putei verifica mai târziu care locaie nu a primit informaii.

• Clic pe OK

• Acceptai adăugarea noului strat la proiectul dvs. când vi se solicită.

• Închidei instrumentul de Îmbinare a atributelor după locaie.

Open the Attribute table for forest_stands_2012_results and review the results you got. Note that a
number of forest stands have NULL as the value for the calculations, those are the ones having no sample plots.
Select them all review them in the map, they are some of the smaller stands:
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Lets calculate now the same averages for the whole forest as you did before, only this time you will use the
averages you got for the stands as the bases for the calculation. Remember that in the previous situation, each
sample plot represented a theoretical stand of 80x80 m. Now you have to consider the area of each of the stands
individually instead. That way, again, the average values of the parameters that are in, for example, m3/ha for the
volumes are converted to total volumes for the stands.

Trebuie să calculai mai întâi ariile pentru locaii, iar apoi volumele totale i numărul de tulpini pentru fiecare dintre
acestea:

• Activai editarea în Tabela de Atribute.

• Deschidei Calculatorul de câmpuri.

• Creai un nou câmp denumit area.
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• Lăsai Output field type pe Decimal number (real).

• Setai Precizia la 2.

• În caseta Expression scriei $area / 10000. Aceasta va calcula zona pâlcului în ha.

• Clic pe OK

Acum calculai un câmp cu volumele totale i numărul estimat de tulpini, pentru fiecare element:

• Denumii câmpurile s_vol and s_stem.

• Valorile numerice din câmpurile pot fi de tip întreg sau chiar i de tip real.

• Utilizai expresiile "area" * "MEANVol" i "area" * "MEANStems" pentru volumurile totale i,
respectiv, totalul tulpinilor.

• Închidei editările, după ce ai încheiat.

• Dezactivai editarea.

In the previous situation, the areas represented by every sample plot were the same, so it was enough to calculate
the average of the sample plots. Now to calculate the estimates, you need to divide the sum of the stands volumes
or number of stems by the sum of the areas of the stands containing information.

• În Tabela de Atribute pentru stratul forest_stands_2012_results, selectai toate pâlcurile care
conin informaii.

• Deschidei Vector → Analysis Tools → Basic statistics.

• Selectai forest_stands_2012_results ca i Strat Vectorial de Intrare.

• Selectai aria ca i Câmp Destinaie.

• Bifai Use only selected features

• Clic pe OK
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As you can see, the total sum of the stands’ areas is 66.04 ha. Note that the area of the missing forest stands is
only about 7 ha.

In the same way, you can calculate that the total volume for these stands is 8908 m3/ha and the total number of
stems is 179594 stems.

Folosind informaiile din pâlcurile forestiere, în locul folosirii directe a celor din parcelele eantion, rezultă urmă-
toarele estimări medii:

• 184.9 m3/ha i

• 2719 stems/ha.

Salvai proiectul dumneavoastră QGIS ca i forest_inventory.qgs

14.7.4 In Conclusion

You managed to calculate forest estimates for the whole forest using the information from your systematic sample
plots, first without considering the forest characteristics and also using the interpretation of the aerial image into
forest stands. And you also got some valuable information about the particular stands, which could be used to
plan the management of the forest in the coming years.
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14.7.5 What’s Next?

In the following lesson, you will first create a hillshade background from a LiDAR dataset which you will use to
prepare a map presentation with the forest results you just calculated.

14.8 Lesson: Crearea unui DEM din datele LiDAR

Putei îmbunătăi aspectul hări folosind diverse imagini de fundal. Ai putea folosi harta de bază sau imaginile
aeriene pe care le-ai utilizat înainte, dar un raster cu relieful terenului va arata mai frumos în anumite situaii.

Vei folosi LAStools pentru a extrage un DEM dintr-un set de date LIDAR, i apoi să creai un raster al reliefului pe
care să-l folosii mai târziu în prezentarea hării dvs.

Scopul acestei lecii: Instalarea LAStools i calcularea unui DEM din datele LiDAR i dintr-un raster cu relieful.

14.8.1 Follow Along: Instalarea Lastools

Gestionarea datelor LiDAR în cadrul QGIS este posibil cu ajutorul Cadrului de Procesare i a algoritmilor furnizai
de LAStools.

Putei obine un model de elevaie digital (DEM), dintr-un nor de puncte LiDAR, iar ulterior se poate crea un raster
al umbririi reliefului, care este vizual mai intuitiv în scopuri de prezentare. În primul rând, va trebui să configurai
setările cadrului de lucru Processing pentru a lucra în mod corespunzător cu LAStools:

• Închidei QGIS, dacă ai început deja.

• Un plugin LIDAR vechi ar putea fi deja instalat în sistemul dvs., în dosarul C:/Program Files/QGIS
Valmiera/apps/qgis/python/plugins/processing/.

• Dacă avei un folder denumit lidar, tergei-l. Acest lucru este valabil pentru anumite instalări de QGIS 2.2
i 2.4.
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• Mergei la folderul exercise_data\forestry\lidar\, unde vei putea găsi fiierul
QGIS_2_2_toolbox.zip. Deschidei-l i extragei-l în folderul lidar, pentru a-l înlocui pe cel
pe care tocmai l-ai ters.

• Dacă utilizai o versiune diferită de QGIS, putei vedea mai multe instruciuni de instalare în acest tutorial.

Acum trebuie să instalai LAStools în computerul dvs. Descărcai de aici cea mai nouă versiune lastools, apoi
extragei coninutul fiierului lastools.zip într-un folder din sistem, de exemplu, c:\lastools\. Calea
către folderul lastools nu poate conine spaii sau caractere speciale.

Note: Citii fiierul LICENSE.txt din interiorul folderului lastools. Unele dintre aceste instrumente LAS
sunt gratuite, pe când altele nu, acestea necesitând liceniere pentru utilizare comercială i guvernamentală. În
scopuri educaionale sau de evaluare, putei utiliza i testa LAStools oricât de mult dorii.

Plugin-ul i algoritmii cureni sunt de acum instalai în computerul dvs., aproape gata de utilizare, fiind nevoie doar
să configurai cadrul de lucru Processing pentru a începe utilizarea lor:

• Deschidei un nou proiect în QGIS.

• Setai ETRS89 / ETRS-TM35FIN ca CRS al proiectului.

• Salvai proiectul ca forest_lidar.qgs.

Pentru a seta LAStools în QGIS:

• Mergei la Processing → Options and configuration.

• În dialogul Opiunilor de procesare, mergei la Furnizori i apoi la Instrumente pentru datele LiDAR.

• Bifai Activare.

• Pentru Folderul LAStools setai c:\lastools\ (sau folderul în care ai extras LAStools).
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14.8.2 Follow Along: Calcularea unui DEM, cu ajutorul LAStools

Ai folosit deja bara de instrumente Processing din Lesson: Statistici Spaiale pentru a rula câiva algoritmi SAGA.
Acum o vei utiliza pentru a rula programele LAStools:

• Deschidei Processing → Toolbox.

• În meniul derulant din partea inferioară, selectai Interfaă avansată.

• Ar trebui să vedei categoria Instrumentelor pentru datele LiDAR.
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• Extindei-o pentru a vedea instrumentele disponibile, apoi extindei, de asemenea, categoria LAStools
(numărul de algoritmi poate varia).

• Derulai în jos până când găsii algoritmul lasview, apoi facei dublu-clic pentru a-l deschide.

• Ca i fiier Input LAS/LAZ file, navigai la exercise_data\forestry\lidar\ i selectai fiierul
rautjarvi_lidar.laz.
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• Clic pe Run

Acum putei vedea datele LiDAR în fereastra dialogului Doar un mic vizualizator LAS i LAZ:

Există multe alte lucruri pe care le putei efectua în cadrul acestui vizualizator, dar pentru moment trebuie doar să
facei un clic i să glisai norul de puncte LiDAR, pentru a vedea cum arată.

Note: Dacă dorii să aflai mai multe detalii cu privire la modul de funcionare al LAStools, putei citi fiierele text
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README corespunzătoare fiecărui instrument, din folderul C:\lastools\bin\. Tutorialele, alături de alte
materiale, sunt disponibile pe pagina web Rapidlasso.

• Închidei vizualizatorul atunci când suntei gata.

Crearea unui DEM cu LAStools se poate face în două etape, mai întâi pentru a clasifica norul de puncte în ground
i no ground, iar apoi pentru a calcula DEM-ul folosind numai punctele ground.

• Mergei înapoi la Bara Instrumentelor de Procesare.

• Notai Search... box, write lasground.

• Dublu clic pentru a deschide instrumentul lasground, apoi setai-l aa cum se arată în această imagine:

• Fiierul de ieire este salvat în acelai folder în care este localizat rautjarvi_lidar.laz, fiind denumit
rautjarvi_lidar_1.las.

Putei să-l deschidei cu lasview,
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Punctele maro sunt punctele clasificate drept sol, spre deosebire de cele gri care reprezintă restul, astfel, putei face
clic pe litera g pentru a vizualiza numai punctele de la sol, sau litera u pentru a vedea doar punctele neclasificate.
Facei clic pe litera a pentru a vedea toate punctele din nou. Citii fiierul lasview_README.txt pentru mai
multe comenzi. De asemenea, în cazul în care suntei interesat, acest tutorial despre editarea manuală a punctelor
LiDAR prezintă diverse alte operaii disponibile în cadrul vizualizatorului.

• Închidei iarăi vizualizatorul.

• În Processing Toolbox, căutai las2dem.

• Deschidei instrumentul las2dem, apoi setai-l aa cum se arată în această imagine:

14.8. Lesson: Crearea unui DEM din datele LiDAR 373

http://www.rapidlasso.com/2014/03/02/tutorial-manual-lidar-editing/


QGIS Training Manual, Release 2.8

DEM-ul rezultat este adăugat la hartă cu numele generic Output raster file.

Note: Instrumentele lasground i las2dem necesită liceniere. Le putei utiliza chiar i în lipsa licenei, aa cum este
indicat în fiierul licenei, dar vei obine diagonale în imaginile rezultate.

14.8.3 Follow Along: Crearea unui Teren Reliefat

În scopuri de vizualizare, un relief generat de un DEM oferă o mai bună vizualizare a terenului:

• Deschidei Raster → Terrain analysis → Hillshade.

• Ca i Strat de ieire, navigai la exercise_data\forestry\lidar\ i denumii fiierul
hillshade.tif.

• Lasă restul parametrilor la setările implicite.
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• Selectai ETRS89 / ETRS-TM35FIN ca i CRS, atunci când vi se solicită.

În ciuda liniilor diagonale rămase în relieful rasterului rezultat, putei vedea în mod clar un relief exact al zonei.
Putei vedea chiar i diferite albii săpate de curgerea apelor prin pădure.
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14.8.4 In Conclusion

Folosirea LiDAR pentru a obine un DEM, în special în zonele împădurite, oferă rezultate bune, fără mult efort.
Ai putea folosi, de asemenea, DEM-uri gata derivate din LiDAR sau din alte surse precum DEM-urile SRTM
cu rezoluie de 9m. Oricum ar fi, le putei utiliza pentru a crea un raster al versanilor umbrii, pentru a-l utiliza în
prezentările de hări.

14.8.5 What’s Next?

În următorul, i ultimul pas din acest modul, vei folosi un raster rezultat i rezultatele inventarului forestier pentru a
crea o prezentare pentru harta rezultatelor.

14.9 Lesson: Prezentarea Hării

În leciile anterioare ai importat, sub formă de proiect GIS, un vechi inventar de pădure, l-ai actualizat, ai proiectat
un inventar, ai creat hări pentru munca de teren i ai calculat parametrii pădurii folosind măsurătorile din teren.

Adesea, pentru a prezenta rezultatele, este importantă crearea de hări, în cadrul unui proiect GIS. O hartă care
prezintă inventarul forestier va facilita înelegerea acestuia dintr-o simplă privire, fără analiza detaliată a cifrelor.
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Scopul acestei lecii: De a crea o hartă care să prezinte rezultatele inventarerii, folosind ca fundal un raster al
reliefului umbrit.

14.9.1 Follow Along: Pregătirea Datelor Hării

Deschidei proiectul QGIS din lecia de calculare a parametrilor, forest_inventory.qgs. Păstrai cel puin
următoarele straturi:

• forest_stands_2012_results.

• basic_map.

• rautjarvi_aerial.

• kbd:lakes (dacă nu îl avei, adăugai-l din exercise_data\forestry\ folder).

Vei prezenta pe o hartă volumele medii ale pâlcurilor de pădure. Dacă deschidei Tabela de atribute pentru stratul
forest_stands_2012_results, vei vedea valorile NULL în cazul pâlcurilor fără informaii. Pentru a le
putea include i pe acestea în stilul dvs. ar trebui să modificai valorile NULL în, de exemplu, -999, tiind că
numerele negative semnifică faptul că nu există date pentru acele poligoane.

Pentru stratul forest_stands_2012_results:

• Deschidei Tabela sa de Atribute i activai editarea.

• Selectati poligoanele cu valoarea NULL.

• Utilizai calculatorul pentru a actualiza valorile din câmpul MEANVol la -999, doar pentru entităile selec-
tate.

• Dezactivai editarea i salvai modificările.

Acum putei un stil implicit pentru acest strat:

• Mergei la fila Stil tab.

• Clic pe fila Încărcare Stil.

• Selectai folderul forest_stands_2012_results.qml from the
exercise_data\forestry\results\.

• Clic pe OK
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Harta dvs. va arăta în felul următor:
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14.9.2 Try Yourself Încercai Diferite Moduri de Amestecare

Stilul pe care l-ai încărcat:
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utilizează Iluminarea puternică pentru Modul de îmbinare a stratului. Reinei că diversele moduri aplică
filtre diferite pentru combinarea stratului din fundal cu cel de deasupra, în acest caz rasterul reliefului i stratul
pâlcurilor forestiere. Putei citi despre aceste moduri în Ghidul utilizatorului.

Încercai în diverse moduri i observai diferenele în hartă. Apoi, stabilii unul care vă place cel mai mult pentru harta
finală.

14.9.3 Try Yourself Folosirea unui ablon de Compozitor pentru Crearea
Hării rezultatelor

Utilizai un ablon pregătit în avans, pentru a prezenta rezultatele. ablonul forest_map.qpt este localizat în
dosarul exercise_data\forestry\results\. Încărcai-l, folosind dialogul Proiect → Managerul Com-
poziiilor....
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Deschidei compozitorul hării i editai harta finală pentru a obine un rezultat mulumitor.

ablonul hării pe care îl utilizai vă va oferi o hartă similară cu aceasta:
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Salvai proiectul dumneavoastră QGIS ca referină pentru viitor.

382 Chapter 14. Module: O Aplicaie pentru Silvicultură
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14.9.4 In Conclusion

Prin intermediul acestui modul ai văzut cum poate fi planificat i prezentat un inventar forestier de bază în QGIS.
Mult mai multe analize forestiere sunt posibile în varietatea de instrumente pe care le putei accesa, dar sperăm că
acest manual va oferit un bun punct de plecare pentru a explora noi modalităi de obinere a rezultatelor dorite.
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CHAPTER 15

Noiuni despre Bazele de date folosind PostgreSQL

Baze de date relaionale sunt o parte importantă a oricărui sistem GIS. În acest modul, vei învăa despre Sistemele
de Gestiune a Bazelor de date Relaionale (RDBMS), utilizând PostgreSQL pentru a crea o nouă bază de date în
scopul stocării datelor, i vei afla despre alte funcii tipice RDBMS.

15.1 Lesson: Introducere în Baze de date

Înainte de a utiliza PostgreSQL, să ne asigurăm de terenul nostru prin acoperirea teoriei generale a bazelor de date.
Nu va fi nevoie să introducei codul exemplificat; acesta este prezent doar în scopuri ilustrative.

Scopul acestei lecii: De a înelege conceptele fundamentale ale bazelor de date.

15.1.1 Ce este o bază de date?

O bază de date constă într-o colecie organizată de date, pentru una sau mai multe utilizări, de obicei în formă
digitală. - Wikipedia

Un sistem de management al bazelor de date (DBMS) este format din software care operează bazele de date,
oferind depozitare, acces, securitate, backup i alte facilităi. - Wikipedia

15.1.2 Tabele

În bazele de date tradiionale i în bazele de date tip fiier, o tabelă este un set de elemente de date (valori) care este
organizat utilând un model de coloane verticale (care sunt identificate prin numele lor) i de rânduri orizontale. O
tableă are un număr specificat de coloane, dar poate avea oricâte rânduri. Fiecare rând este identificat prin valorile
unui anumit subset de coloane care a fost identificat ca o potenială cheie. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)

În bazele de date SQL, o tabelă este, de asemenea, cunoscută ca relaie.

15.1.3 Coloane / Câmpuri

O coloană este un set de valori de date având un anume tip simplu, câte una pentru fiecare rând din tabel. Coloanele
funizează structura pe baza căreia se compune fiecare rând. Termenul de câmp este utilizat interschimbabil cu
coloană, dei muli consideră că este mai corect să se utilizeze câmp (sau valoare a câmpului) când este vorba de
elementul care există la intersecia dintre o coloană i un rând. - Wikipedia
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O coloană:

| name |
+-------+
| Tim |
| Horst |

Un câmp:

| Horst |

15.1.4 Înregistrări

O înregistrare reprezintă informaia stocată într-un rând din tabelă. Fiecare înregistrare va avea câte un câmp pentru
fiecare dintre coloanele tabelei.

2 | Horst | 88 <-- one record

15.1.5 Tipuri de date

Tipurile de date restrâng tipurile de informaii care pot fi stocate într-o coloană. - Tim and Horst

Există mai multe feluri de tipuri de date. Să ne concentrăm pe cele mai comune:

• String - pentru stocarea datelor de tip text, de orice formă

• Integer - pentru a stoca numere întregi

• Integer - pentru a stoca numere zecimale

• Date - pentru a stoca ziua de natere a lui Horst, astfel încât nimeni să nu o uite

• Boolean - pentru a stoca valori simple true/false

Putei spune că baza de date vă permite să stocai, de asemenea, nimic într-un câmp. Dacă într-un câmp nu se află
nimic, atunci coninutul câmpului este menionată ca valoare ‘null’:

insert into person (age) values (40);

select * from person;

Rezultat:

id | name | age
----+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

Putei folosi mai multe tipuri de date - verificai manualul PostgreSQL!

15.1.6 Modelarea unei Baze de Date cu Adrese

Să folosim un studiu de caz simplu, pentru a vedea cum este construită o bază de date. Dorim să creăm o bază de
date cu adrese.
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Try Yourself

Notai proprietăile care alcătuiesc o adresă simplă i pe care am dori să le stocăm în baza noastră de date.

Verificai-vă rezultatele

Structura Adresei

Propietăile care descriu o adresă sunt coloanele. Tipul de informaie stocat în fiecare coloană este tipul de date al
acesteia. În seciunea următoare vom analiza tabela noastră conceptuală de adrese pentru a vedea cum o putem
înbunătăi!

15.1.7 Teoria Bazelor de Date

Procesul de creare a unei baze de date presupune crearea unui model al lumii reale; luând concepte din lumea
reală i reprezentându-le, ca entităi, în baza de date.

15.1.8 Normalizarea

Un concept de bază al bazelor de date este evitarea duplicării / redundanei datelor. Procesul eliminării redundanei
dintr-o bază de date este numit Normalizare.

Normalizarea este o metodă sistematică de garantare că structura bazei de date este potrivită pentru interogări de
uz general i nu prezintă anumite caracterisitici - anomalii de inserare, modificare sau tergere - care ar putea duce
la pierderea integrităii datelor. - Wikipedia

Există diferite tipuri de ‘forme’ de normalizare.

Să aruncăm o privire la un exemplu simplu:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
--+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Imaginai-vă că avei muli prieteni cu acelai nume de stradă sau ora. Fiecare dintre aceste date sunt duplicate,
consumă spaiu. Mai rău, dacă un nume de ora se schimbă, trebuie să depunei mult efort pentru a actualiza baza de
date.
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15.1.9 Try Yourself

Reproiectai tabela people de mai sus pentru a reduce duplicarea i pentru a normaliza structura de date.

Putei citi mai multe despre normalizarea bazei de date aici

Verificai-vă rezultatele

15.1.10 Indeci

Un index în baza de date este o structură de date care îmbunătăete viteza operaiilor de extragere de date dintr-o
tabelă a bazei de date. - Wikipedia

Imaginai-vă că citii un manual i căutai explicaia unui concept - i că manualul nu are index! Va trebui să începei să
citii de la un capăt prin întregul manual până când găsii informaia de care avei nevoie. Indexul de la sfăritul unei
cări vă ajută să ajungei direct la pagina cu informaie relevantă:

create index person_name_idx on people (name);

Acum, căutarea numelui va fi mai rapidă:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Secvene

O secvenă este un generator de numere unice. Este utilizat în mod normal pentru a creea un identificator unic
pentru o coloană a unei tabele.

În aceste exemplu, id este o secvenă - numărul este incrementat la fiecare adăugare a unei înregistrări în tabelă:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Diagrama Relaiilor dintre Entităi

Într-o bază de date normalizată, există în mod uzual multe relaii (tabele). Diagrama relaiilor între entităi (Diagrama
ER) este utilizată pentru proiectarea dependenelor logice între relaii. Să examinăm tabela noastră ne-normalizată
people utilizată anterior în cadrul leciei:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
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2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122
(2 rows)

Cu puin efort o putem împări în două tabele, eliminând necesitatea de a repeta numele străzii pentru persoanele
care locuiesc pe aceeai stradă:

select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

i:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

Putem apoi lega cele două tabele utilizând ‘keys’ streets.id i people.streets_id.

Dacă desenăm o Diagramă ER pentru aceste două tabele ar arăta cam aa:

Diagrama ER ne ajută să exprimăm relaii ‘unul la muli’. În acest caz simbolul săgeată spune că pe o stradă pot
locui mai muli oameni.

Try Yourself

Modelul nostru people are încă nite probleme de normalizare - încercai să îl normalizai în continuare i ilustrai-vă
ideile printr-o Diagramă ER.

Verificai-vă rezultatele

15.1.13 Constrângeri, Chei Primare i Chei Externe

O constrîngere într-o bază de date este utilizată pentru a garanta că o relaie se potrivete cu viziunea celui care a
modelat baza de date despre cum ar trebui stocate datele. De exemplu o constrângere pentru codul potal ar putea
garanta că numărul trebuie să se afle între 1000 i 9999.

O cheie Primară este compusă din unul sau mai multe câmpuri care fac o înregistrare unică. În mod uzual cheia
primară se numete id i este o secvenă.

O cheie Externă este utilizată pentru a face legătura unei înregistrări cu o altă tabelă (folosind cheia primară a
acelui tabel).

În Diagramele ER, legăturile dintre tabele sunt în mod normal bazate pe chei Externe legate de chei Primare.

Dacă ne uităm la exemplul cu persoane, definiia tabelei indică faptul că coloana de stradă este o cheie externă care
trimite la cheia primară din tabela de străzi:

Table "public.people"

Column | Type | Modifiers
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-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

15.1.14 Tranzacii

La adăugarea, modificarea sau tergerea datelor într-o bază de date, este important ca de fiecare dată baza de dată
să rămână într-o stare bună în cazul în care ceva nu merge bine. Cele mai multe baze de date pun la dispoziie
o facilitate numită tranzacie. Tranzaciile permit crearea unui moment de revenire la care vă putei întoarce dacă
modificările bazei de date nu au funcionat conform planului.

Să considerăm un scenariu în care avei un sistem contabil. Trebuie să transferai fonduri dintr-un cont i să le
adăugai în altul. Secvena de pai ar fi:

• eliminai R20 din Joe

• adăugai R20 la Anne

Dacă ceva nu merge bine în cadrul procesului (ex. pană de curent), tranzacia va reveni.

15.1.15 In Conclusion

Bazele de date permit administrarea datelor într-un mod structurat utilizând structuri de cod simple.

15.1.16 What’s Next?

Acum că am văzut cum funcionează teoretic bazele de date, să creăm o bază de date nouă pentru a implementa
partea teoretică prezentată.

15.2 Lesson: Implementarea Modelului de Date

Acum, că am acoperit toată teoria, haidei să creăm o bază de date nouă. Această bază de date va fi utilizată în
exerciiile noastre din leciile care vor urma.

Scopul acestei lecii: De a instala soft-ul necesar i de a-l utiliza la implementarea bazei de date exemplu.

15.2.1 Instalare PostgreSQL

Note: Dei în afara scopului acestui document, utilizatorii de Mac pot instala PostgreSQL folosind Homebrew.
Utilizatorii Windows pot folosi instalatorul grafic situat aici: http://www.postgresql.org/download/windows/. Vă
rugăm să reinei că documentaia presupune că utilizatorii rulează aplicaia QGIS pe Ubuntu.

Pe Ubuntu:

sudo apt-get install postgresql-9.1

Vei obine un mesaj de genul ăsta:
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[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Apăsai Y i Enter apoi ateptai ca descărcarea i instalarea să se încheie.

15.2.2 Ajutor

PostgreSQL are o foarte bună documentaie on-line.

15.2.3 Crearea unui utilizator pentru baza de date

Pe Ubuntu:

După finalizarea instalării, executai această comandă pentru a deveni utilizatorul postgres, i pentru a crea un nou
utilizator pentru baza de date:

sudo su - postgres

Introducei parola când vi se solicită (avei nevoie de drepturi sudo).

Acum, la promptul utilizatorului postgres, creai utilizatorul pentru baza de date. Asigurai-vă că numele utiliza-
torului este acelai cu cel de autentificare unix: vă va face viaa mult mai uoară, pentru că postgres vă va autentifica
automat atunci când suntei autentificat ca acel utilizator:

createuser -d -E -i -l -P -r -s qgis

Introducei o parolă când vi se solicită. Ar trebui să utilizai o parolă diferită pentru parola contului dumneavoastră.

Ce reprezintă aceste opiuni?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Acum ar trebui să ieii din consola bash a utilizatorului postgres, tastând:

exit

15.2.4 Verificai noul cont

psql -l

Ar trebui să returneze ceva de genul următor:
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Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Tastai q pentru a iei.

15.2.5 Crearea unei baze de date

Comanda createdb este utilizată pentru a crea o nouă bază de date. Ar trebui să o rulai din linia de comandă a
utilitarului bash:

createdb address -O qgis

Putei verifica existena noii baze de date, utilizând această comandă:

psql -l

Care ar trebui să returneze ceva de genul următor:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres: postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres: postgres=CTc/postgres
(4 rows)

Tastai q pentru a iei.

15.2.6 Pornirea unei sesiuni către baza de date, din linia de comandă

Vă putei conecta uor la baza de date, procedând astfel:

psql address

Pentru a iei din mediul bazei de date psql, tastai:

\q

Pentru ajutor în utilizarea liniei de comandă, tastai:

\?

Pentru ajutor în utilizarea comenzii SQL, tastai:

\help

Pentru a obine ajutor pentru o anumită comandă, tastai (de exemplu):

\help create table

Vedei, de asemenea, Fia de indicii Psql - disponibilă online aici.

15.2.7 Crearea Tabelelor SQL

Să adăugăm nite tabele! Vom folosi Diagrama noastră ER ca i ghid. Pentru început, să ne conectăm la baza de
adrese:
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psql address

Pentru a crea tabela streets:

create table streets (id serial not null primary key, name varchar(50));

serial i varchar sunt tipuri de date. serial îi spune lui PostgreSQL să pornească o secvenă (genera-
tor automat) pentru completarea automată a id pentru fiecare înregistrare nouă. varchar(50) îi spune lui
PostgreSQL să creeze un câmp de caractere de lungime 50.

Vei remarca faptul că comanda se termină cu ; - toate comenzile SQL trebuie terminate în acest fel. Când apăsai
enter, psql va raporta ceva de genul:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq" for
serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index "streets_pkey"
for table "streets"

CREATE TABLE

Asta înseamnă că tabelul a fost creeat cu succes, având cheia primară streets_pkey care folosete
streets.id.

Notă: Dacă apăsai enter fără a introduce ;, vei obine un prompt de tipul: address-#. Aceasta deoarece PG
ateaptă să mai introducei ceva. Introducei ; pentru a executa comanda.

Pentru a vizualiza schema tabelelor dvs., putei proceda astfel:

\d streets

Care ar trebui să arate ceva de genul următor:

Table "public.streets"
Column | Type | Modifiers

--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval(’streets_id_seq’::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

Pentru a vizualiza coninutul tabelelor dvs., putei proceda astfel:

select * from streets;

Care ar trebui să arate ceva de genul următor:

id | name
---+------
(0 rows)

După cum putei vedea, tabela noastră este vidă, în mod curent.

Try Yourself

Folosii abordarea de mai sus pentru a crea un tabel denumit people:

Adăugai câmpuri ca număr de telefon, adresă de acasă, nume etc. (acestea nu sunt toate nume valide: schimbai-le
pentru a deveni valide). Asigurai-vă că îi adăugai tabelului o coloană ID cu acelai tip de date ca i mai sus.

Verificai-vă rezultatele
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15.2.8 Crearea Cheilor în SQL

Problema cu soluia noastră de mai sus este că baza de date nu tie că oamenii i străzile au o relaie logică. Pentru a
exprima această relaie va trebui să definim o cheie externă care face legătura cu cheia primară a tabelului de străzi.

Sunt două moduri de a face asta:

• Adăugai cheia după crearea tabelului

• Definii cheia la momentul creării tabelului

Tabelul nostru a fost deja creat, deci să alegem prima variantă:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Asta spune tabelului people că valoarea câmpurilor street_id trebuie să fie o valoare validă id din tabelul
streets.

O formă mai obinuită de a crea o constrângere este să o facei la crearea tabelului:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

După adăguarea constrângerii, schema noastră arată aa:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Crearea de indeci în SQL

Dorim căutări extrem de rapide după numele oamenilor. Pentru a obine asta vom crea un index pentru coloana de
nume din tabelul oamenilor:

create index people_name_idx on people(name);

\d people

Ceea ce produce:

394 Chapter 15. Noiuni despre Bazele de date folosind PostgreSQL



QGIS Training Manual, Release 2.8

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | (’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.10 tergerea Tabelelor în SQL

Dacă dorii să scăpai de un tabel putei folosi comanda drop:

drop table streets;

Note: În exemplul curent, comanda de mai sus nu va funciona. De ce? Vezi

Dacă ai utilizat comanda drop table pe tabelul people, s-ar executa cu succes:

drop table people;

Note: Dacă ai introdus acea comandă i ai ters tabelul people, ar fi un moment bun să îl refacei, deoarece îl vei
folosi în exerciiile următoare.

15.2.11 Câteva cuvinte despre pgAdmin III

Prezentăm comenzile SQL de la promptul psql pentru că este un mod foarte util de a învăa despre bazele de date.
Cu toate acestea, există metode mai rapide i mai uoare de a face ce am prezentat. Instalai pgAdmin III i vei putea
crea, terge, modifica etc. tabele utilizănd operaii ‘point and click’ într-un GUI.

Pe Ubuntu, îl putei instala aa:

sudo apt-get install pgadmin3

pgAdmin III va fi acoperit mai detaliat în alt modul.

15.2.12 In Conclusion

Ai văzut cum să creai o bază de date complet nouă, pornind de la zero.

15.2.13 What’s Next?

În continuare vei învăa cum să folosii DBMS-ul pentru adăguarea datelor.

15.3 Lesson: Adăugarea de date în Model

Modelele pe care le-am creat vor trebui să fie populate de acum cu datele pe care trebuie să le conină.
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Scopul acestei lecii: De a afla cum se pot insera noi date în baza de date a modelelor.

15.3.1 Inserarea instruciunilor

Cum adăugai date într-o tabelă? Instruciunea SQL INSERT oferă funcionalitatea necesară:

insert into streets (name) values (’High street’);

Mai multe lucruri de reinut:

• După numele tabelului (streets), vei lista numele coloanelor pe care le vei popula (în acest caz, doar
coloana name).

• După cuvântul cheie values, plasai lista valorilor de câmp.

• irurile de caractere ar trebui să fie citate cu ajutorul ghilimelelor simple.

• Reinei că nu vom introduce o valoare pentru coloana id; acest lucru se datorează faptului că este o secvenă,
ea fiind generată în mod automat.

• Dacă setai manual id-ul, pot apărea probleme grave cu integritatea bazei de date.

Ar trebui să vedei INSERT 0 1 dacă a avut succes.

Putei vedea rezultatul aciunii de inserare, prin selectarea tuturor datelor din tabel:

select * from streets;

Rezultat:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Try Yourself

Folosii comanda INSERT pentru a adăuga o nouă stradă în tabelul streets.

Verificai-vă rezultatele

15.3.2 Secvenierea Adăugării Datelor, Conform Constrângerilor

15.3.3 Try Yourself

Încercai să adăugai un obiect persoană în tabela people cu următoarele detalii:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

Note: Reamintim că, în acest exemplu, am definit numerele de telefon ca iruri de caractere, i nu ca numere
întregi.

În acest moment, ar trebui să întâmpinai un raport de eroare, dacă încercai să facei acest lucru fără a crea mai întâi
o înregistrare pentru Main Street din tabela streets.

Ar trebui să renei, de asemenea, că:

396 Chapter 15. Noiuni despre Bazele de date folosind PostgreSQL



QGIS Training Manual, Release 2.8

• Nu putei adăuga strada folosind-ui numele

• Nu putei adăuga o stradă folosind un id, fără a crea mai întâi o înregistrare a străzii în tabela străzilor

Amintii-vă că cele două tabele sunt legate printr-o pereche de chei: primară/externă. Aceasta înseamnă că nici o
persoană validă nu pot fi creată fără a exista, de asemenea, o înregistrare de stradă validă, corespunzătoare.

Folosind cunotinele de mai sus, adăugai noua persoană în baza de date.

Verificai-vă rezultatele

15.3.4 Selectarea datelor

V-am arătat deja sintaxa pentru selectarea înregistrărilor. Să ne uităm la alte câteva exemple:

select name from streets;

select * from streets;

select * from streets where name=’Main Road’;

În sesiunile ulterioare vom intra în mai multe detalii cu privire la modul de selectare i de filtrare a datelor.

15.3.5 Actualizarea datelor

Ce se întâmplă dacă dorii să efectuai o schimbare a unor date existente? De exemplu, un nume de stradă este
schimbat:

update streets set name=’New Main Road’ where name=’Main Road’;

Fii foarte ateni la folosirea acestor declaraii de actualizare - în cazul în care mai mult de o înregistrare se potrivete
clauzei WHERE, toate vor fi actualizate!

O soluie mai bună este de a folosi cheia primară a tabelului, pentru a referenia înregistrarea care trebuie să fie
schimbată:

update streets set name=’New Main Road’ where id=2;

Ar trebui să returneze UPDATE 1.

Note: Criteriile instruciunii WHERE sunt sensibile la majuscule, astfel Main Road nu este similar cu Main
road

15.3.6 Ştergere Dată

Pentru a terge un obiect dintr-un tabel, folosii comanda DELETE:

delete from people where name = ’Joe Smith’;

Să ne uităm la tabela noastră de personal acum:

address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)
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15.3.7 Try Yourself

Folosi abilităile pe care le-ai învăat, pentru a adăuga noi prieteni în baza de date:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 In Conclusion

Acum tii cum să adăugai date noi modelelor existente, pe care le-ai creat anterior. Amintii-vă că, dacă dorii să
adăugai noi tipuri de date, poate dorii să modificai i/sau să creai noi modele, care să conină aceste date.

15.3.9 What’s Next?

Acum, că ai adăugat câteva date, vei învăa cum să folosii interogările, pentru a accesa aceste date în diferite
moduri.

15.4 Lesson: Interogări

Când scriei o comandă SELECT ... interogai baza de date pentru informaii.

Scopul acestei lecii: De a afla cum să creai interogări, care vor returna informaii utile.

Note: Dacă nu ai făcut asta în lecia precedentă, adăugai următoarele obiecte persoană în tabela people. Dacă
primii erori legate de constrângerile de cheie externă, va trebui să adăugai mai întâi obiectul ‘Main Road’ în tabela
de străzi.

insert into people (name,house_no, street_id, phone_no)
values (’Joe Bloggs’,3,2,’072 887 23 45’);

insert into people (name,house_no, street_id, phone_no)
values (’Jane Smith’,55,3,’072 837 33 35’);

insert into people (name,house_no, street_id, phone_no)
values (’Roger Jones’,33,1,’072 832 31 38’);

insert into people (name,house_no, street_id, phone_no)
values (’Sally Norman’,83,1,’072 932 31 32’);

15.4.1 Ordonarea Rezultatelor

Haidei să obinem o listă de persoane ordonate după numerele caselor lor:

select name, house_no from people order by house_no;

Rezultat:

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)
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Putei sorta rezultatele după valorile a mai mult de o coloană:

select name, house_no from people order by name, house_no;

Rezultat:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)

15.4.2 Filtrare

Foarte des nu vei vedea fiecare înregistrare din baza de date - în mod special există mii de înregistrări i suntei
interesat doar de una sau două.

Iată un exemplu de filtru numeric care întoarce doar obiecte ale cărui house_no este mai mic de 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Putei combina filtre (definite utilizănd clauza WHERE) cu sortare (definită folosind clauza ORDER BY):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Putei filtra, de asemenea, pe baza datelor de text:

select name, house_no from people where name like ’%s%’;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Am folosit clauza LIKE pentru a găsi toate numele care conin un s. De remarcat că această interogare ine cont
de capitalizare, deci înregistrarea Sally Norman nu a fost întoarsă.

Dacă dorii să căutai un ir de caractere indiferent de capitalizare, putei executa on interogare care nu ine cont de
capitalizare folosind clauza ILIKE:

select name, house_no from people where name ilike ’%r%’;

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

Acea interogare a returnat fiecare obiect people cu un r sau un R inclus în nume.
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15.4.3 Îmbinări

Dar dacă dorii să vedei detaliile persoanei i numele străzii în loc de ID-ul acesteia? Pentru a face asta, trebuie să
legai cele două tabele într-o singură intergogare. Să vedem un exemplu:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Note: Cu legături, vei spune întotdeauna din ce tabele se extrage informaia, în aceest caz persoane i străzi. De
asemenea va trebui să precizai care chei trebuie să corespundă (cheia externă i cheia primară). Dacă nu facei
această precizare, vei obine o listă cu toate combinaiile posibile de persoane i străzi, dar nu vei putea ti de fapt
cine pe ce stradă locuiete!

Aa ar trebui să arate rezultatul SQL corect:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

Vom reveni la legături când vom creea interogări mai complexe în continuare. Pentru moment reinei că permit o
metodă simplă de a combina informaii din două sau mai multe tabele.

15.4.4 Sub-Selectarea

Sub-seleciile permit selectarea obiectelor dintr-un tabel, pe baza datelor dintr-un alt tabel de care este legat printr-o
relaie la cheia sa externă. În cazul nostru, dorim să găsim persoanele care locuiesc pe o anumită stradă.

În primul rând, să facem un pic de reglare a datelor noastre:

insert into streets (name) values(’QGIS Road’);
insert into streets (name) values(’OGR Corner’);
insert into streets (name) values(’Goodle Square’);
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Haidei să aruncăm o privire rapidă la datele noastre, în urma modificărilor: putem refolosi interogarea de la
seciunea anterioară:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Rezultat:

name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)

Acum, vom efectua o sub-selecie asupra acestor date. Vrem să prezentăm doar persoanele care locuiesc în
street_id numbărul 1:
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select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Rezultat:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Dei acesta este un exemplu foarte simplu i inutil pentru seturile de date restrânse, el ilustrează utilitatea i importana
sub-seleciilor în cazul interogărilor efectuate asupra seturilor de date mari i complexe.

15.4.5 Agregarea Îmbinărilor

Una dintre cele mai puternice caracteristici ale unei baze de date o reprezintă capacitatea sa de a sintetiza datele
din tabelele pe care le conine. Aceste sinteze sunt numite interogări agregate. Iată este un exemplu tipic, care ne
spune cât de multe obiecte de tipul om sunt în tabela de personal:

select count(*) from people;

Rezultat:

count
-------

4
(1 row)

Dacă dorim un rezumat după numele străzii, putem proceda astfel:

select count(name), street_id
from people
group by street_id;

Rezultat:

count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)

Note: Pentru că nu am folosit clauza ORDER BY, ordinea rezultatelor dvs. ar putea să nu se potrivească ce ceea
ce este prezentat aici.

Try Yourself

Rezumai persoanele după numele străzii i afiai numele reale ale străzilor în loc de street_ids.

Verificai-vă rezultatele
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15.4.6 In Conclusion

Ai văzut cum se utilizează interogările pentru a returna datele din baza de date într-un mod care permite extragerea
de informaii utile.

15.4.7 What’s Next?

Mai departe vei vedea cum să creai vizualizări, pornind de la interogările scrise.

15.5 Vederile Lesson:

De fiecare dată când scriei o interogare, cheltuii o mulime de timp i efort pentru a o formula. Cu ajutorul vederilor,
putei salva definiia unei interogări SQL într-o ‘tabelă virtuală’ reutilizabilă.

Scopul acestei lecii: De a salva o interogare sub formă de vedere.

15.5.1 Crearea unei Vederi

Putei trata o vedere la fel ca pe o tabelă, însă datele sale provin dintr-o interogare. Haidei să efectuăm o vedere
simplă, bazată pe cele de mai sus:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

După cum se poate vedea, singura schimbare este crearea vederii roads_count_v ca parte de început
. Acum, putem selecta datele din această vedere:

select * from roads_count_v;

Rezultat:

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)

15.5.2 Modificarea unei Vederi

O vedere nu este fixă, i nu conine ‘date reale’. Aceasta înseamnă că o putei schimba cu uurină, fără nici un impact
asupra datelor din baza de date:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(Acest exemplu demonstrează, de asemenea, că cea mai bună practică este de a folosi MAJUSCULE pentru toate
cuvintele cheie SQL.)

Vei vedea că am adăugat o clauză ORDER BY, astfel încât rândurile din vederea noastră să fie frumos sortate:
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select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)

15.5.3 Eliminarea unei Vederi

Dacă nu mai avei nevoie de vedere, o putei terge astfel:

drop view roads_count_v;

15.5.4 In Conclusion

Vederile constau în salvarea unei interogări, urmată de accesarea rezultatelor acesteia similar ca i în cazul tabelelor.

15.5.5 What’s Next?

Uneori, atunci când are loc o schimbare asupra datelor, vei dori ca modificările să aibă efecte în altă parte din baza
de date. Următoarea lecie vă arată cum să facei acest lucru.

15.6 Regulile Lesson:

Regulile permit “arborelui de interogare” rescrierea interogărilor primite. O utilizare comună o reprezintă imple-
mentarea vederilor, inclusiv a celor actualizabile. - Wikipedia

Scopul acestei lecii: De a afla cum se pot crea noi reguli pentru baza de date.

15.6.1 Vederi materializate (Vederi bazate pe reguli)

Presupunem că dorii să înregistrai fiecare schimbare de număr_de_telefon în tabelul jurnaul_personalului. Astfel,
vei configura un tabel nou:

create table people_log (name text, time timestamp default NOW());

În etapa următoare, creai o regulă care înregistrează fiecare schimbare de număr_de_telefon în tabelul jur-
naul_personalului:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

Pentru a funcionarea regulii, haidei să modificăm un număr de telefon:

update people set phone_no = ’082 555 1234’ where id = 2;

Verificai că tabela people a fost actualizată corect:

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)
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Acum, datorită regulii create, tabela people_log va arăta astfel:

select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Note: Valoarea câmpului time va depinde de data i ora curente.

15.6.2 In Conclusion

Reguli vă permit adăugarea sau modificarea automată a datelor din baza de date, pentru a reflecta modificările din
alte pări ale bazei de date.

15.6.3 What’s Next?

Modulul următor vă va introduce în Baza de Date Spaiale cu ajutorul PostGIS, care ia aceste conceptele bazelor
de date i le aplică datelor GIS.
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CHAPTER 16

Module: Noiuni despre Bazele de date folosind PostgreSQL

Bazele de date Spaiale permit depozitarea geometriilor înregistrărilor din interiorul unei baze de date, precum i
furnizarea de funcionalitate pentru interogarea i recuperarea înregistrărilor, utilizând aceste geometrii. În acest
modul vom folosi PostGIS, o extensie a PostgreSQL, pentru a afla cum să setai o bază de date spaiale, cum
să importai datele dintr-un fiier shape în baza de date, i cum să facei uz de funciile geografice pe care le oferă
PostGIS.

În timp ce trecei prin această seciune, poate dorii să efectuai o copie a Foii de lucru PostGIS pusă la dispoziie de
Grupul de lucru în GIS din Boston. O altă resursă utilă este Documentaia online pentru PostGIS

Sunt disponibile, de asemenea, mai multe tutoriale ample cu privire la PostGIS i Bazele de date Spaiale, de la
Boundless Geo:

• Introducere în PostGIS

• Sfaturi i trucuri despre Bazele de date Spaiale

Parcurgei i PostGIS online.

16.1 Lesson: Instalare PostGIS

Instalând funciile PostGIS vom putea accesa funciile spaiale din interiorul PostgreSQL.

Scopul acestei lecii: De a instala funciile spaiale, i pentru scurte demonstraii a aplicării lor.

Note: Vom utiliza PostGIS versiunea 2.1 în acest exerciiu. Instalarea i configurarea bazei de date sunt diferite
pentru versiuni mai vechi, dar restul acestui material din acest modul va fi, în continuare, funcional. Consultai
documentaia pentru platforma dvs, pentru asistenă referitoare la instalarea i configurarea bazei de date.

16.1.1 Instalarea sub Ubuntu

PostGIS este uor de instalat din apt.

$ sudo apt-get install postgis
$ sudo apt-get install postgresql-9.1-postgis

Într-adevăr, este atât de uor ...

Note: În funcie de versiunea de Ubuntu pe care o utilizai, i de depozitele pe care le-ai configurat, aceste
comenzi vor instala PostGIS 1.5, sau 2.x. Putei găsi versiunea instalată prin folosirea unei interogări select
PostGIS_full_version(); în psql sau într-un alt instrument.

Pentru a instala cea mai recentă versiune a PostGIS, putei folosi următoarele comenzi.
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$ sudo apt-add-repository ppa:sharpie/for-science
$ sudo apt-add-repository ppa:sharpie/postgis-nightly
$ sudo apt-get update
$ sudo apt-get install postgresql-9.1-postgis-nightly

16.1.2 Instalare sub Windows

Instalarea pe Windows este un pic mai complicată, dar nu este chiar dificilă. Reinei că trebuie să fii online pentru
a instala pachetul PostGIS.

Mai întâi, vizitai pagina de descărcare.

Apoi urmai acest ghid.

Mai multe informaii despre instalarea pe Windows pot fi găsite pe Site-ulPostGIS.

16.1.3 Instalarea pe Alte Platforme

Descărcarea PostGIS de pe site-ul are informaii despre instalarea pe alte platforme, incluzând MacOSX i alte
distribuii Linux

16.1.4 Configurarea Bazei de Date pentru a utiliza PostGIS

După ce PostGIS este instalat, va trebui să configurai baza de date pentru a utiliza extensiile. Dacă ai instalat
versiunea PostGIS > 2.0, aceasta este la fel de simplu ca i execuia următoarei comenzi în psql, folosind baza de
date de adrese din exerciiul nostru anterior.

$ psql -d address -c "CREATE EXTENSION postgis;"

Note: Dacă utilizai PostGIS 1.5 i o versiune de PostgreSQL mai mică decât 9.1, va trebui să urmai un set
diferit de pai de instalare a extensiilor PostGIS pentru baza de date. Vă rugăm să consultai Documentaia PostGIS
pentru instruciuni privind modul de efectuare a acestui lucru. Există, de asemenea, unele instruciuni în versiunea
anterioară din acest manual.

16.1.5 Funciile PostGIS instalate

PostGIS poate fi considerat ca o colecie de funcii din baza de date, care extind capabilităile de bază ale Post-
greSQL, astfel încât să poatădatelor spaiale. Prin ‘a face faă’, înelegem stocarea, preluarea, interogarea i manipu-
larea. Pentru a face acest lucru, sunt instalate o serie de funcii în baza de date.

Baza noastră de date PostgreSQL, cu adrese este de acum geospaială, datorită PostGIS. Vom intra în detalii în
seciunile următoare, dar pentru început vom efectua un mic exerciiu. Să presupunem că vrem să creăm un punct
pornind de la un text. Mai întâi folosim comanda psql pentru a găsi funciile referitoare la punct. Dacă nu v-ai
conectat deja la baze de date adrese, facei acest lucru acum. Apoi rulai:

\df *point*

Aceasta este comanda pe care o căutăm: st_pointfromtext. Pentru a parcurge lista, utilizai săgeata îndrep-
tată în jos, apoi apăsai q pentru a reveni la consola psql.

Încercai să rulai această comandă:

select st_pointfromtext(’POINT(1 1)’);

Rezultat:
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st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Trei lucruri de reinut:

• Am definit un punct la poziia 1,1 (EPSG:4326 se presupune), folosind POINT(1 1),

• Am rulat o instruciune SQL, dar nu pe orice tabelă, doar pe datele introduse din promptul SQL,

• Rândul rezultat nu prea are sens.

Rândul rezultat se află în formatul OGC denumit ‘Well Known Binary’ (WKB). Vom analiza în detaliu acest
format în seciunea următoare.

Pentru a obine rezultatele înapoi, sub formă de text, putem face o scanare rapidă prin lista funciilor pentru ceva
care poate returna text:

\df *text

Interogarea pe care o căutăm acum este st_astext. Să o combinăm cu interogarea anterioară:

select st_astext(st_pointfromtext(’POINT(1 1)’));

Rezultat:

st_astext
------------

POINT(1 1)
(1 row)

Here, we entered the string POINT(1,1), turned it into a point using st_pointfromtext(), and turned it
back into a human-readable form with st_astext(), which gave us back our original string.

Un ultim exemplu, înainte de a intra cu adevărat în detaliile de utilizare PostGIS:

select st_astext(st_buffer(st_pointfromtext(’POINT(1 1)’),1.0));

Care este rezultatul acestuia? S-a creat un tampon de 1 grad în jurul punctului nostru, i s-a returnat un rezultat sub
formă de text.

16.1.6 Sistemele de Referină Spaială

În plus faă de funciile PostGIS, extensia conine o colecie cu definiii ale sistemelor de referină spaială (SRS), aa
cum au fost stabilite de către European Petroleum Survey Group (EPSG). Acestea sunt utilizate pentru operaiuni
de conversie a sistemelor de coordonate de referină (CRS).

Putem inspecta aceste definiii SRS din baza noastră de date, pe măsură ce acestea sunt stocate în tabelele normale
ale bazei de date.

În primul rând, să ne uităm la schema din tabel, introducând următoarea comandă în fereastra psql:

\d spatial_ref_sys

Rezultatul ar trebui să fie acesta:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
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Indexes:
"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

Putei utiliza interogări SQL standard (aa cum am învăat din seciunile introductive), pentru a vizualiza i manipula
acest tabel - totui, actualizarea sau tergerea înregistrărilor nu reprezintă o idee bună dacă nu tii ce facei.

One SRID you may be interested in is EPSG:4326 - the geographic / lat lon reference system using the WGS 84
ellipsoid. Let’s take a look at it:

select * from spatial_ref_sys where srid=4326;

Rezultat:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

The srtext is the projection definition in well known text (you may recognise this from .prj files in your shapefile
collection).

16.1.7 In Conclusion

Acum avei funciile PostGIS instalate în copia dvs. de PostgreSQL. Astfel, vei putea să facei uz de funciile spaiale
extinse ale PostGIS.

16.1.8 What’s Next?

Mai departe, vei învăa cum se reprezintă entităile spaiale într-o bază de date.

16.2 Lesson: Modelul Entităii Simple

How can we store and represent geographic features in a database? In this lesson we’ll cover one approach, the
Simple Feature Model as defined by the OGC.

Scopul acestei lecii: De a afla ce este Modelul SFS i cum să-l folosii.

16.2.1 Ce este OGC

Open Geospatial Consortium (OGC), o organizaie internaională de voluntariat, dedicată stabilirii unor standarde,
înfiinată în 1994. În OGC, mai mult de 370+ organizaii comerciale, guvernamentale, non-profit i de cercetare la
nivel mondial, colaborează într-un proces consensual deschis, încurajând dezvoltarea i implementarea standardelor
pentru coninut i servicii geospaiale, prelucrarea i schimbul de date GIS. - Wikipedia

16.2.2 Ce este Modelul SFS

The Simple Feature for SQL (SFS) Model is a non-topological way to store geospatial data in a database and
defines functions for accessing, operating, and constructing these data.
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Modelul definete date geospaiale din tipurile Point, Linestring, i Polygon (i agregări ale acestora în obiecte Multi).

Pentru mai multe informaii, aruncai o privire la standardul Entităii OGC simple pentru SQL.

16.2.3 Adăugai un câmp geometric la tabelă

Haidei să adăugăm un câmp de tip punct în tabela noastră de personal:

alter table people add column the_geom geometry;

16.2.4 Adăugai o constrângere bazată pe tipul geometriei

You will notice that the geometry field type does not implicitly specify what type of geometry for the field - for
that we need a constraint:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(the_geom) = ’ST_Point’::text OR the_geom IS NULL);

Aceasta adaugă o constrângere la tabelă, astfel încât ea va accepta doar o geometrie de tip punct sau o valoare
nulă.

16.2.5 Try Yourself

Create a new table called cities and give it some appropriate columns, including a geometry field for storing
polygons (the city boundaries). Make sure it has a constraint enforcing geometries to be polygons.

Verificai-vă rezultatele

16.2.6 Popularea tabelei geometry_columns

În acest moment, ar trebui, de asemenea, să adăugai o intrare în tabela geometry_columns:

insert into geometry_columns values
(’’,’public’,’people’,’the_geom’,2,4326,’POINT’);
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http://www.opengeospatial.org/standards/sfs


QGIS Training Manual, Release 2.8

Why? geometry_columns is used by certain applications to be aware of which tables in the database contain
geometry data.

Note: Dacă instruciunea INSERT de mai sus produce o eroare, rulai mai întâi această interogare:

select * from geometry_columns;

If the column :kbd:‘f_table_name‘ contains the value :kbd:‘people‘, then
this table has already been registered and you don’t need to do anything
more.

Valoarea 2 se referă la numărul dimensiunilor; în acest caz, două: x i y.

The value 4326 refers to the projection we are using; in this case, WGS 84, which is referred to by the number
4326 (refer to the earlier discussion about the EPSG).

Try Yourself

Adăugai o intrare geometry_columns adecvată pentru noul strat al oraelor

Verificai-vă rezultatele

16.2.7 Adăugai o înregistare geometrică la tabelă, utilizând SQL

Acum, că tabelele noastre sunt geo-activate, putem stoca geometrii în ele:

insert into people (name,house_no, street_id, phone_no, the_geom)
values (’Fault Towers’,

34,
3,
’072 812 31 28’,
’SRID=4326;POINT(33 -33)’);

Note: In the new entry above, you will need to specify which projection (SRID) you want to use. This is because
you entered the geometry of the new point using a plain string of text, which does not automatically add the correct
projection information. Obviously, the new point needs to use the same SRID as the data-set it is being added to,
so you need to specify it.

If at this point you were using a graphical interface, for example, specifying the projection for each point would
be automatic. In other words, you usually won’t need to worry about using the correct projection for every point
you want to add if you’ve already specified it for that data-set, as we did earlier.

Now is probably a good time to open QGIS and try to view your people table. Also, we should try editing /
adding / deleting records and then performing select queries in the database to see how the data has changed.

Pentru a încărca un strat PostGIS în QGIS, utilizai opiunea de meniu Layer → Add PostGIS Layers sau butonul
corespunzător din bara de instrumente:

Se va deschide acest dialog:

410 Chapter 16. Module: Noiuni despre Bazele de date folosind PostgreSQL



QGIS Training Manual, Release 2.8

Clic pe butonul New pentru a deschide acest dialog:
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Apoi definii o nouă conexiune, de exemplu.:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

To see whether QGIS has found the address database and that your username and password are correct, click
Test Connect. If it works, check the boxes next to Save Username and Save Password. Then click OK to create
this connection.
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Înapoi în dialogul Add PostGIS Layers, facei clic pe Connect, apoi adăugai straturile pentru proiectul dumneav-
oastră, ca de obicei.

Try Yourself

Formulai o interogare care arată numele unei persoane, numele străzii i poziia (din coloana the_geom) sub formă
de text simplu.

Verificai-vă rezultatele

16.2.8 In Conclusion

Ai văzut cum să adăugai obiecte spaiale în baza de date, i cum să le putei viziona în aplicaia GIS.

16.2.9 What’s Next?

Mai departe, vei vedea cum se importă i se exportă datele în/din baza de date.

16.3 Lesson: Importul i Exportul

Of course, a database with no easy way to migrate data into it and out of it would not be of much use. Fortunately,
there are a number of tools that will let you easily move data into and out of PostGIS.

16.3.1 shp2pgsql

shp2pgsql is a commandline tool to import ESRI shapefiles to the database. Under Unix, you can use the following
command for importing a new PostGIS table:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Sub Windows, procesul de import trebuie efectuat în două etape:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

Este posibil să întâlnii această eroare:

ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

This is a known issue regarding the creation in situ of a spatial index for the data you’re importing. To avoid the
error, exclude the -I parameter. This will mean that no spatial index is being created directly, and you’ll need to
create it in the database after the data have been imported. (The creation of a spatial index will be covered in the
next lesson.)

16.3.2 pgsql2shp

pgsql2shp este un instrument pentru linia de comandă, dedicat exportării tabelelor PostGIS, a Vederilor a In-
terogărilor SQL selectate. Pentru a face acest lucru în Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>
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Pentru a exporta datele folosii o interogare:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr is a very powerful tool to convert data into and from postgis to many data formats. ogr2ogr is part of the
GDAL/OGR Software and has to be installed separately. To export a table from PostGIS to GML, you can use
this command:

ogr2ogr -f GML export.gml PG:’dbname=<databasename> user=<username>
host=<hostname>’ <Name of PostGIS-Table>

16.3.4 SPIT

SPIT este un plugin QGIS care este livrat cu o dată cu QGIS. Putei folosi SPIT pentru a încărca fiierele shape
ESRI în PostGIS.

O dată ce ai adăugat plugin-ul SPIT prin intermediul Managerului de Plugin-uri, căutai acest buton:

Clicking on it or selecting Database –> Spit –> Import Shapefiles to PostgreSQL from the menu will give you the
SPIT dialog:
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You can add shapefiles to the database by clicking the Add button, which will give you a file browser window.

16.3.5 DB Manager

You may have noticed another option in the Database menu labeled DB Manager. This is a new tool in QGIS
2.0 that provides a unified interface for interacting with spatial databases including PostGIS. It also allows you to
import and export from databases to other formats. Since the next module is largely devoted to using this tool, we
will only briefly mention it here.

16.3.6 In Conclusion

Importing and exporting data to and from the database can be done in many various ways. Especially when using
disparate data sources, you will probably use these functions (or others like them) on a regular basis.

16.3.7 What’s Next?

Apoi, vom vedea cum se interoghează datele pe care le-am creat mai înainte.

16.4 Lesson: Interogări Spaţiale

Interogările spaiale nu sunt diferite de alte interogări de baze de date. Putei utiliza coloana de geometrie la fel
ca pe orice altă coloană de baze de date. O dată cu instalarea PostGIS în baza noastră de date, avem la dispoziie
funcii suplimentare pentru a interoga baza de date.

Scopul acestei lecii: De a afla cum sunt implementate funciile spaiale similare cu funciile non-spaiale “normale”.

16.4.1 Operatori Spaţiali

Când dorii să tii care puncte se află la o distană de 2 grade faă de un punct (X,Y), putei proceda astfel cu:

select *
from people
where st_distance(the_geom,’SRID=4326;POINT(33 -34)’) < 2;

Rezultat:

id | name | house_no | street_id | phone_no | the_geom
----+--------------+----------+-----------+---------------+-----------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

Note: Valoarea the_geom de mai sus a fost trunchiată datorită spaierii de pe această pagină. În cazul în care
dorii să vedei punctul în coordonate clare, încercai ceva similar cu ceea ce ai efectuat în seciunea “Vizualizează
un punct sub forma WKT”, de mai sus.

De unde tim că interogarea de mai sus returnează toate punctele incluse în cadrul a 2 grade? De ce nu 2 metri?
Sau oricare altă unitate?

Verificai-vă rezultatele
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16.4.2 Indeci Spaiali

De asemenea, putem defini indeci spaiali. Un index spaial accelerează mult interogările spaiale. Pentru a crea un
index spaial pe coloana de geometrie folosii:

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom);

\d people

Rezultat:

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) = ’ST_Point’::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 Try Yourself

Modificai tabelul oraelor, astfel încât coloana de geometrie să fie indexată spaial.

Verificai-vă rezultatele

16.4.4 Demo Funcii Spaiale PostGIS

În scopul demonstrării funciilor spaiale PostGIS , vom crea o nouă bază de date care conine câteva date (fictive).

Pentru a începe, creai o nouă bază de date (ieii mai întâi din linia de comandă psql):

createdb postgis_demo

Amintii-vă să instalai extensiile PostGIS:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"

Mai departe, vom importa datele prezente în directorul exercise_data/postgis/. Revedei lecia anterioară
pentru instruciuni, dar nu uitai că va trebui să creai o nouă conexiune PostGIS la noua bază de date. Avei posibil-
itatea de import de la terminal sau prin SPIT. Importai fiierele în următoarele tabele ale bazei de date:

• points.shp în building

• lines.shp în road

• polygons.shp în region
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Încărcai aceste trei straturi ale bazei de date în QGIS ca de obicei, prin intermediul Adăugării Straturilor PostGIS.
Atunci când deschidei tabelele lor cu atribute, vei observa că ambele dein atât un câmp id cât i unul gid, create
în urma importului PostGIS.

Acum, că tabelele sunt importate, putem folosi PostGIS pentru a interoga datele. Mergei înapoi în ferestra termi-
nalului (linia de comandă) i introducei promptul psql astfel:

psql postgis_demo

Vom demonstra unele dintre aceste expresii de selectare prin crearea unor vederi, pentru a le deschide apoi în
QGIS i pentru a le observa rezultatele.

Selectare după locaie

Obinei toate clădirile din regiunea KwaZulu:

SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’KwaZulu’;

Rezultat:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Sau, în cazul în care vom crea o vizualizare a ei:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b

WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’KwaZulu’;

Adăugai vederea sub formă de strat, apoi vizualizai-o în QGIS:
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Selectai vecinii

Arată o listă cu toate numele regiunilor adiacente regiunii Hokkaido:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = ’Hokkaido’;

Rezultat:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

Sub formă de vedere:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE TOUCHES(a.the_geom, b.the_geom)
AND a.name = ’Hokkaido’;

În QGIS:
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Observai lipsa unei regiuni (Queensland). Acest lucru se poate datora unei erori de topologie. Artifactele de acest
gen ne poate ateniona asupra unor poteniale probleme în interiorul datelor. Pentru a rezolva această dilemă, fără a
fi afectai de anomaliile pe care le-ar putea avea datele, am putea folosi un tampon în locul interseciei:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom
FROM region

WHERE name = ’Hokkaido’;

Aceasta va crea o zonă tampon de 100 de metri în jurul regiunii Hokkaido.

Zona mai închisă este tamponul:

16.4. Lesson: Interogări Spaţiale 419



QGIS Training Manual, Release 2.8

Selectai folosind tamponul:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.the_geom, b.the_geom)
AND b.name != ’Hokkaido’;

În această interogare, vizualizarea originală a tamponului se face similar oricărui alt tabel. Acesta primete aliasul
a iar câmpul de geometrie a.the_geom‘este folosit la selectarea oricărui poligon din
tabela :kbd:‘region (alias b) cu care se intersectează. Totui, Hokkaido este exclusă din această expresie
de selectare, nefiind dorită; vrem să obinem doar regiunile din vecinătate.

În QGIS:
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De asemenea, este posibil să se selecteze toate obiectele aflate la o anumită distană, fără etapa suplimentară de
creare a unui tampon:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = ’Hokkaido’
AND b.name != ’Hokkaido’;

Prin aceasta se obine acelai rezultat, fără a fi necesar pasul tamponului intermediar:
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Selectai valorile unice

Arată o listă cu numele unice, ale tuturor clădirilor din regiunea Queensland:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’Queensland’;

Rezultat:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Trimiteri suplimentare

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid, ST_ASTEXT(ST_SHORTESTLINE(a.the_geom, b.the_geom)) as
text, ST_SHORTESTLINE(a.the_geom, b.the_geom) AS the_geom
FROM road a, building b

WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid, ST_ASTEXT(ST_LONGESTLINE(a.the_geom, b.the_geom)) as
text, ST_LONGESTLINE(a.the_geom, b.the_geom) AS the_geom
FROM road a, building b

WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom

422 Chapter 16. Module: Noiuni despre Bazele de date folosind PostgreSQL



QGIS Training Manual, Release 2.8

FROM road a
WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM region a

WHERE a.name = ’Saskatchewan’;

SELECT ST_PERIMETER(a.the_geom)
FROM region a
WHERE a.name=’Queensland’;

SELECT ST_AREA(a.the_geom)
FROM region a
WHERE a.name=’Queensland’;

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;

CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

16.4.5 In Conclusion

Ai văzut cum se pot interoga obiectele spaiale, cu ajutorul noilor funcii de bază de date din PostGIS.

16.4.6 What’s Next?

Mai departe vom investiga structurile geometriilor complexe i cum să le creai cu ajutorul PostGIS.

16.5 Lesson: Construirea Geometriei

În această seciune vom intra în detalii despre cum sunt construite geometriile în SQL. În realitate, probabil vei
utiliza un GIS cum ar fi QGIS pentru creearea geometriilor complexe folosind instrumentele acestora; cu toate
acestea, întelegerea modului cum sunt stocate poate fi utilă pentru scrierea de interogări i înelegerea modului cum
este alcătuită baza de date.

Scopul acestei lecii: De a înelege mai bine cum să creai entităi spaiale direct în PostgreSQL/PostGIS.

16.5.1 Crearea irurilor de Linii

Întorcându-ne la baza de date address, să facem tabelul de străzi să se potrivească cu celelalte; de ex., să aibă o
constrângere pentru geometrie, un index i o intrare în tabelul geometry_columns.
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16.5.2 Try Yourself

• Modificai tabela streets, astfel încât ea să aibă o coloană de geometrie de tipul ST_LineString.

• Nu uitai să facei actualizarea coloanelor de geometrie!

• De asemenea, adăugai o constrângere pentru a preveni adăugarea geometrii care nu sunt null sau de tip
LINESTRINGS.

• Creai un index spaial în noua coloană de geometrie

Verificai-vă rezultatele

Acum, haidei să inserăm un ir de linii în tabela noastră de străzi. În acest caz, vom actualiza o înregistrare existentă
de stradă:

update streets set the_geom = ’SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)’
where streets.id=2;

Aruncai o privire la rezultatele din QGIS. (Poate fi necesar să facei clic-dreapta pe stratul străzilor din panoul
‘Straturilor’, apoi alegei ‘Transfocare la extinderea stratului’.)

Acum, creai mai multe intrări de străzi - unele în QGIS, iar altele din linia de comandă.

16.5.3 Crearea Poligoanelor

Crearea de poligoane este la fel de simplă. De reinut că, prin definiie, poligoanele au cel puin patru vârfuri, primul
i ultimul suprapuse:

insert into cities (name, the_geom)
values (’Tokyo’, ’SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))’);

Note: Un poligon necesită acolade duble în jurul listei sale de coordonate; aceasta pentru a permite poligoane
complexe având multiple zone neconectate. De exemplu

insert into cities (name, the_geom)
values (’Tokyo Outer Wards’, ’SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),

(-10 -30, -5 0, -15 -15, -10 -30))’);

Dacă ai urmat acest pas, putei verifica rezultatul prin încărcarea setului de date orae în QGIS, deschizând tabelul
de atribute al acestuia, i selectând noua intrare. Remarcai cum cele două noi poligoane se comportă ca unul singur.

16.5.4 Exerciiu: Learea Oraelor de Persoane

Pentru acest exerciiu ar trebui să facei următoarele:

• tergei toate datele din tabela de personal.

• Adăugai o coloană de cheie străină în tabela de personal, care face referire la cheia primară a tabelei oraelor.

• Utilizai QGIS pentru a captura unele orae.

• Utilizai SQL pentru a introduce câteva înregistrări de personal, verificând că fiecare are asociate o stradă i
un ora.

Schema de personal actualizată ar trebui să arate cam aa:

\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
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id | integer | not null
| | default nextval(’people_id_seq’::regclass)

name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) =

’ST_Point’::text OR the_geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Verificai-vă rezultatele

16.5.5 Analizai Schema Noastră

Acum, schrma noastră ar trebui să arate în felul următor:

16.5.6 Try Yourself

Creai marginile oraelor prin calucularea înfăurătorii convexe pentru toate adresele din acel ora i calcularea unei
zone tampon în jurul acesteia.

16.5.7 Accesul la Sub-Obiecte

Folosind funciile SFS-Model, avei la dispoziie o largă gamă de opiuni pentru accesarea sub-obiectelor geometriilor
SFS. Când dorii să selectai primul punct vertex al fiecărei geometrii poligon în tabelul myPolygonTable, trebuie
să o facei în felul acesta:

• Transformarea limitei poligonale într-un ir de linii:

select st_boundary(geometry) from myPolygonTable;

• Selectai primul vertex al irului de inii rezultant:
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select st_startpoint(myGeometry)
from (

select st_boundary(geometry) as myGeometry
from myPolygonTable) as foo;

16.5.8 Procesarea Datelor

PostGIS suportă toate funciile conforme standardelor OGC SFS/MM. Toate aceste funcii încep cu ST_.

16.5.9 Decuparea

Pentru a decupa o parte din date putei utiliza funcia ST_INTERSECT(). Pentru evitarea geometriilor vide,
folosii:

where not st_isempty(st_intersection(a.the_geom, b.the_geom))

select st_intersection(a.the_geom, b.the_geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.the_geom,32734),

b.the_geom));
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16.5.10 Construirea de Geometrii pornind de la Alte Geometrii

Plecând de la de la un tabel de puncte dat, dorii să generai un linestring. Ordinea punctelor este dată de valoarea
id. O altă metodă de ordonare ar putea fi marca de timp, cum ar fi cea pe care o primii când capturiai puncte cu
un receptor GPS.
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Pentru a creea un ir de linii dintr-un strat nou numit ‘points’, putei rula comanda următoare:

select ST_LineFromMultiPoint(st_collect(the_geom)), 1 as id
from (

select the_geom
from points
order by id

) as foo;

Pentru a vedea cum funcionează fără a crea un nou strat, putei executa această comandă în stratul ‘people’, dei
desigur nu ar avea prea mult sens în lumea reală.
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16.5.11 Curăarea Geometriilor

Putei obine mai multe informaii pentru acest subiect în această intrare de blog.

16.5.12 Diferenele dintre tabele

Pentru a vedea diferenele între două tabele având aceeai structură putei utiliza cuvântul cheie PostgreSQL
EXCEPT:

select * from table_a
except
select * from table_b;

Ca rezultat, vei obine toate acele înregistrări din table_a care nu se regăsesc i în table_b.

16.5.13 Spaiile tabelelor

Putei defini în care loc de pe disc ar trebui să stocheze Postgres datele, prin crearea numelor de spaii:

CREATE TABLESPACE homespace LOCATION ’/home/pg’;

Atunci când creai o bază de date, avei posibilitatea să specificai care spaiu de tabelă să fie utilizat, de exemplu:
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createdb --tablespace=homespace t4a

16.5.14 In Conclusion

Ai învăat cum să creeai geometrii mai complexe folosing instruciuni PostGIS. Reinei că aceasta folosete la îm-
bunătăirea cunotinelor pentru lucrul cu o bază de date spaială printr-o interfaă GIS. În mod curent nu vei avea
nevoie să folosii aceste instruciuni manual, dar o înelegere generală vă va ajuta la utilizarea unui GIS, în special
dacă întâlnii erori care ar putea să pară altfel criptice.
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CHAPTER 17

Ghidul de procesare al QGIS

This module contributed by Victor Olaya.

Cuprins:

17.1 Introducere

Acest ghid descrie modul de utilizare al cadrului de procesare QGIS. Nu sunt necesare cunotine anterioare despre
cadrul de procesare sau despre oricare dintre aplicaiile pe care se bazează. Sunt cerute, în schimb, cunotine de
bază despre QGIS. Capitolele despre scriptare presupun că avei unele cunotine de bază despre Python i, poate,
despre API-ul Python al QGIS.

Acest ghid este conceput pentru studiu individual sau pentru utilizarea într-o sesiune de instruire.

Examples in this guide use QGIS 2.0, with partil upgrades to 2.8. They might not work or not be available in
versions other than that ones.

Acest ghid este compus dintr-un set de mici exerciii, de complexitate progresivă. Dacă nu ai folosit cadrul de
procesare, ar trebui să pornii de la început. Dacă avei ceva experienă anterioară, nu ezitai să trecei peste lecii.
Acestea sunt mai mult sau mai puin independente una de alta, i fiecare prezintă unele concepte sau elemente noi,
aa cum este indicat în titlul capitolului i în scurta introducere de la începutul fiecărui capitol. Aceasta ar trebui să
facă mai uoară localizarea leciilor care tratează un anumit subiect.

Pentru o descriere mai sistematică a tuturor componentelor cadrului i despre utilizarea acestora, este recomandat
să verificai capitolul corespunzător din manualul de QGIS. Folosii-l ca text suplimentar, împreună cu acest ghid.

Toate exerciiile din acest ghid utilizează un set de date gratuit, care poate fi descărcat de pe Site-ul QGIS. Fiierul
zip conine mai multe dosare, corespunzătoare pentru fiecare dintre leciile din acest ghid. În fiecare dintre ele, vei
găsi un fiier de proiect QGIS. Doar deschidei-l i vei fi gata pentru a începe lecia.

Utilizare plăcută!

17.2 Câteva lucruri importante de reinut, înainte de a începe

Just like the manual of a word processor doesn’t teach you how to write a novel or a poem, or a CAD tutorial
doesn’t show you how to calculate the size of a beam for a building, this guide will not teach you spatial analysis.
Instead, it will show you how to use the QGIS processing framework, a powerful tool for performing spatial
analysis, but it is up to you to learn the required concepts that are needed to understand that type of analysis.
Without them, there is no point on using the framework and its algorithms, although you might be tempted to try.

Haidei să vedem, pentru mai multă claritate, un exemplu.

Given a set of points and a value of a given variable value at each point, you can calculate a raster layer from them
using the Kriging geoalgorithm. The parameters dialog for that module is like the following one.
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Arată complex, nu?

By reading this manual, you will learn things such as how to use that module, how to run it in a batch process
to create raster layers from hundreds of points layers in a single run, or what happens if the input layer has
some points selected. However, the parameters themselves are not explained. A seasoned analyst with a good
knowledge of geostatistics will have no problem understanding those parameters. If you are not one of them and
sill, range, or nugget are not familiar concepts to you, then you should not use the Kriging module. More than that,
you are far from being ready to use the Kriging module, since it requires learning about concepts such as spatial
autocorrelation or semivariograms, which probably you also haven’t heard before, or at least haven’t studied long
enough. You should first study and understand them, and then come back to QGIS to actually run it and perform
the analysis. Ignoring this will result in wrong results and poor (and most likely useless) analysis.

Although not all algorithms are as complex as kriging (but some of them are even more complex!), almost all of
them require understanding the fundamental analysis ideas that they are based on. Without that knowledge, using
them will most likely lead to poor results.

Using geoalgorithms without having a good foundation of spatial analysis is like trying to write a novel without
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knowing anything about grammar or syntax, and having no knowledge about storytelling. You might get a result,
but it is likely to have no value at all. Please, don’t fool yourself and think that after reading this guide you are
already capable of performing spatial analysis and get sound results. You need to study spatial analysis as well.

În continuare, este indicat un bun punct de referină, la care vă putei raporta pentru a afla mai multe despre analiza
datelor spaiale.

Analize geospaiale (a 3-a Ediie): Un Ghid Cuprinzător de Principii, Tehnici i Instrumente Software, Michael John
De Smith, Michael F. Goodchild, Paul A. Longley

Este disponibilă online aici

17.3 Iniierea cadrului de procesare

Primul lucru de făcut, înainte de a utiliza cadrul de prelucrare, este să-l configurai. Nu este mult de configurat,
astfel încât aceasta este o sarcină uoară.

Later on we will show how to configure the external applications that are used for extending the list of available
algorithms, but for now we are just going to work with the framework itself.

The processing framework is a core QGIS plugin, which means that, if you are running QGIS 2.0, it should
already be installed in your system, since it is included with QGIS. In case it is active, you should see a menu
called Processing in your menu bar. There you will find an access to all the framework components.

Dacă nu putei găsi acel meniu, trebuie să activai plugin-ul, din managerul de plugin-uri, i să-l activai.
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Elementul principal cu care vom lucra este setul de instrumente. Facei clic pe intrarea de meniu corespunzătoare,
apoi vei vedea bara de instrumente andocată în partea dreaptă a ferestrei QGIS.

The toolbox contains a list of all the available algorithms, divided in groups. There are two ways of displaying
and organizing those algorithms: the advanced mode and the simplified mode.

By default, you will see the simplified mode, which groups algorithms according to the kind of operation they
perform. Although some of the algorithms that you will see in the toolbox depend on other external applications
(most of them do, in fact), you will not see any mention to those applications. The origin of algorithms is hidden
in this mode, which is a facade that simplifies using algorithms through the processing framework.
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Examples in this guide only use the simplified mode. The advanced mode has some additional features and
algorithms, but it requires understanding the applications that are called, so they are a more advanced topic. Some
of these more advanced ideas are introduced in the final lessons of this book, but for the rest of them we will just
use the simplified interface.

You can change between the simplified and the advanced mode by using the selector on the bottom part of the
toolbox.

Bara de instrumente, atunci când se utilizează modul avansat, arată astfel.

Dacă ai ajuns la acest punct, acum suntei gata de utilizare a geoalgoritmilor. Nu este nevoie să configurai nimic
altceva. Putem rula deja primul nostru algoritm, lucru pe care îl vom face în lecia următoare.

17.4 Rularea primului nostru algoritm. Setul de instrumente

Note: În această lecie vom rula primul nostru algoritm pentru a obine un prim rezultat.

Aa cum am menionat deja, cadrul de procesare poate rula algoritmi ai altor aplicaii, dar conine, de asemenea,
algoritmi nativi care nu au nevoie de nici un software extern pentru a rula. Pentru a începe explorarea cadrului de
procesare, vom rula unul dintre algoritmii nativi. În particular, vom calcula centroizii setului de poligoane.

În primul rând, deschidei proiectul QGIS corespunzător acestei lecii. Acesta conine doar un singur strat, cu două
poligoane
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Now go to the text box at the top of the toolbox. That is the search box, and if you type text in it, it will filter the
list of algorithms so just those ones contaning the entered text are shown. Type centroids and you should see
something like this.

Caseta de căutare reprezintă un mod foarte practic de a găsi un algoritm.

Pentru a executa un algoritm, trebuie doar să facei dublu-clic pe numele său, în caseta de instrumente. Când facei
dublu clic pe algoritmul Centroizi, vei vedea următorul dialog.
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All algorithms have a similar interface, which basically contains input parameters that you have to fill, and outputs
that you have to select where to store. In this case, the only inputs we have are a vector layer with polygons and
a selector to select whether we want several centroids for a single feature in case it is a multipart feature, or the
algorithm should generate just one centroid for each feature.

Select the Polygons layer as input. The other field will have no effect at all, since the input layer has no multi-part
features.

The algorithm has a single output, which is the centroids layer. There are two options to define where a data output
is saved: enter a filepath or save it to a temporary filename

In case you want to set a destination and not save the result in a temporary file, the format of the output is defined by
the filename extension. To select a format, just select the corresponding file extension (or add it if you are directly
typing the filepath instead). If the extension of the filepath you entered does not match any of the supported ones,
a default extension (usually .dbf for tables, .tif for raster layers and .shp for vector ones) will be appended
to the filepath and the file format corresponding to that extension will be used to save the layer or table.

In all the exercises in this guide, we will be saving results to a temporary file, since there is no need to save them
for a later use. Feel free to save them to a permament location if you want to.

Notice that temporary files are deleted once you close QGIS. If you create a project with an output that was saved
as a temporary output, QGIS will complain when you try to open back the project later, since that output file will
not exist.

După ce ai configurat dialogul algoritmului, apăsai Run pentru a-i începe execuia.

Vei obine rezultatul următor.
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The output has the same CRS as the input. Geoalgorithms assumes all input layers share the same CRS and do
not perform any reprojection. Except in the case of some special algorithms (for instance, reprojection ones), the
outputs will also have that same CRS. We will see more about this soon.

Try yourself saving it using different file formats (use, for instance, shp and geojson as extensions). Also, if
you do not want the layer to be loaded in QGIS after it is generated, you can check off the check box that is found
below the output path box.

17.5 Mai multe tipuri de date i algoritmi

Note: În această lecie vom rula mai mult de trei algoritmi, vei învăa cum să folosii alte tipuri de intrări, i cum să
configurai rezultatele pentru a fi salvate automat într-un anumit folder.

For this lessons we will need a table and a polygons layer. We are going to create a points layer based on
coordinates in the table, and then count the number of points in each polygon. If you open the QGIS project
corresponding to this lesson, you will find a table with X and Y coordinates, but you will find no polygons layer.
Don’t worry, we will create it using a processing geoalgorithm.

The first thing we are going to do is to create a points layer from the coordinates in the table, using the Points
layer from table algorithm. You now know how to use the search box, so it should not be hard for you to find it.
Double–click on it to run it and get to its following dialog.

This algorithm, like the one from the previous lesson, just generates a single output, and it has three inputs:

• Table: the table with the coordinates. You should select here the table from the lesson data.

• X and Y fields: these two parameters are linked to the first one. The corresponding selector will show the
name of those fields that are available in the selected table. Select the XCOORD field for the X parameter,
and the YYCOORD field for the Y parameter.

• CRS: Since this algorithm takes no input layers, it cannot assign a CRS to the output layer based on them.
Instead, it asks you to manually select the CRS that the coordinates in the table use. Click on the button on
the left–hand side to open the QGIS CRS selector, and select EPSG:4326 as the output CRS. We are using
this CRS because the coordinates in the table are in that CRS.
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Dialogul dvs. ar trebui să arate astfel.

Now press the Run button to get the following layer:

The next thing we need is the polygon layer. We are going to create a regular grid of polygons using the Create
grid algorithm, which has the following parameters dialog.
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The inputs required to create the grid are all numbers. When you have to enter a numerical value, you have two
options: typing it directly on the corresponding box or clicking the button on the right–hand side to get to a dialog
like the one shown next.
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The dialog contains a simple calculator, so you can type expressions such as 11 * 34.7 + 4.6, and the result
will be computed and put in the corresponding text box in the parameters dialog. Also, it contains constants that
you can use, and values from other layers available.

In this case, we want to create a grid that covers the extent of the input points layer, so we should use its coordinates
to calculate the center coordinate of the grid and its width and height, since those are the parameters that the
algorithm takes to create the grid. With a little bit of math, try to do that yourself using the calculator dialog and
the constants from the input points layer.

Selectai Dreptunghiuri (poligoane) în câmpul Tip.

As in the case of the last algorithm, we have to enter the CRS here as well. Select EPSG:4326 as the target CRS,
as we did before.

În cele din urmă, ar trebui să avei un dialog pentru parametri de genul următor:
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(Better add one spacing on the width and height: Horizontal spacing: 0.0001, Vertical spacing: 0.0001, Width:
0.001004, Height: 0.000651, Center X: -5.695674, Center Y: 40.2477955) The case of X center is a bit tricky, see:
-5.696126+(( -5.695222+ 5.696126)/2)

Warning: The options are simpler in recent versions of QGIS; you just need to enter min and max for X and
Y (suggested values: -5.696226,-5.695122,40.24742,40.248171)

Apăsai Run pentru a obine stratul de graticule.
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The last step is to count the points in each one of the rectangles of that graticule. We will use the Count points in
polygons algorithm.

Acum avem rezultatul dorit.

Before finishing this lesson, here is a quick tip to make your life easier in case you want to persistently save your
data. If you want all your output files to be saved in a given folder, you do not have to type the folder name
each time. Instead, go to the processing menu and select the Options and configuration item. It will open the
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configuration dialog.

In the Output folder entry that you will find in the General group, type the path to your destination folder.
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Now when you run an algorithm, just use the filename instead of the full path. For instance, with the configuration
shown above, if you enter graticule.shp as the output path for the algorithm that we have just used, the
result will be saved in D:\processing_output\graticule.shp. You can still enter a full path in case
you want a result to be saved in a different folder.

Încercai să rulai algoritmul Creare grilă folosind diferite mărimi ale grilei, i, totodată, utilizând diverse tipuri de
grilă.

17.6 Reproiectarea CRS-urilor

Note: În această lecie, vom discuta despre modul în care Processing utilizează CRS-urile. Vom vedea, de
asemenea, un algoritm foarte util: reproiectarea.

CRS-urile sunt o mare sursă de confuzie pentru utilizatorii QGIS Processing, aa că aici sunt câteva reguli generale
cu privire la modul în care pot fi gestionate de către geoalgoritmi, la crearea unui nou strat.

• Dacă există straturi de intrare, se va utiliza CRS-ul primului strat. Acesta este presupus a fi CRS-ul tuturor
straturilor de intrare, atât timp cât este necesar ca acestea să-l aibă pe acelai. În cazul în care utilizai straturi
cu un CRS diferit, QGIS va emite un avertisment. Observai că CRS-ul straturilor de intrare este afiat alături
de numele său, în dialogul parametrilor.

• Dacă nu există nici un strat de intrare se va utiliza CRS-ul proiectului, cu excepia cazului în care algoritmul
conine un câmp specific pentru CRS (aa cum s-a arătat în ultima lecie despre algoritmul reticular)

Open the project corresponding to this lesson and you will see two layers named 23030 and 4326. They both
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contain the same points, but in different CRSs (EPSG:23030 and EPSG:4326). They appear in the same place
because QGIS is reprojecting on the fly to the project CRS (EPSG:4326), but they are not actually the same layer.

Deschide algoritmul Export/Adăugare coloane de geometrie.

This algorithm add new columns to the attributes table of a vector layer. The content of the columns depend on
the type of geometry of the layer. In the case of points, it adds new columns with the X and Y coordinates of each
point.

In the list of available layers that you will find in the input layer field, you will see each one with its corresponding
CRS. That means that, although they appear in the same place in your canvas, they will be treated differently.
Select the 4326 layer.

The other parameter of the algorithm allows to set how the algorithm uses coordinates to calculate the new value
that it will add to the resulting layers. Most algorithms do not have an option like that, and just use the coordinates
directly. Select the Layer CRS option to just use coordinates as they are. This is how almost all geoalgorithms
work.

You should get a new layer with exactly the same points as the other two layers. If you right click on the name of
the layer and open its properties, you will see that it shares the same CRS of the input layer, that is, EPSG:4326.
When the layer is loaded into QGIS, you will not be asked to enter the CRS of the layer, since QGIS already
knows about it.

If you open the attributes table of the new layer you will see that it contains two new fields with the X and Y
coordinates of each point.
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Those coordinate values are given in the layer CRS, since we chose that option. However, even if you choose
another option, the output CRS of the layer would have been the same, since the input CRS is used to set the CRS
of the output layer. Choosing another option will cause the values to be different, but not the resulting point to
change or the CRS of the ouput layer to be different to the CRS of the input one.

Now do the same calculation using the other layer. You should find the resulting layer rendered exactly in the
same place as the other ones, and it will have the EPSG:23030 CRS, since that was the one of the input layer.

Dacă mergei la tabela sa de atribute, vei vedea valori care sunt diferite de cele din primul strat pe care l-am creat.

Acest lucru se datorează faptului că datele originale sunt diferite (se folosete un alt CRS), i acele coordonate sunt
preluate din ea.

What should you learn from this? The main idea behind these examples is that geoalgorithms use the layer as it is
in its original data source, and completely ignore the reprojections that QGIS might be doing before rendering. In
other words, do not trust what you see in the canvas, but always have in mind that the original data will be used.
That is not so important in this case, since we are just using one single layer at a time, but in an algorithm that
needs several of them (such as a clip algorithm), layers that appear to match or overlay might be very far one from
each other, since they might have different CRSs.

Algorithms performs no reprojection (except in the reprojection algorithm that we will see next), so it is up to you
to make sure that layers have matching CRS’s.

An interesting module that deals with CRS’s is the reprojection one. It represents a particular case, since it has an
input layer (the one to reproject), but it will not use its CRS for the output one.

Deschide algoritmul de Reproiectare a stratului.
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Select any of the layers as input, and select EPSG:23029 as the destination CRS. Run the algorithm and you will
get a new layer, identical to the input one, but with a different CRS. It will appear on the same region of the canvas,
like the other ones, since QGIS will reproject it on the fly, but its original coordinates are different. You can see
that by running the Export/Add geometry columns algorithm using this new layer as input, and veryfing that the
added coordinates are different to the ones in the attribute tables of both of the two layers that we had computed
before.

17.7 Selecia

Note: În această lecie vom vedea cum gestionează seleciile algoritmii de procesare din straturile vectoriale care
sunt utilizate ca intrare, i cum se poate crea o selecie, folosindu-se un anumit tip de algoritm.

Unlike other analysis plugins in QGIS, you will not find in processing geoalgorithms any “Use only selected
features” checkbox or similar. The behaviour regarding selection is set for the whole plugin and all its algorithms,
and not for each algorithm execution. Algorithms follow the following simple rules when using a vector layer.

• Dacă stratul are o selecie, vor fi utilizate numai entităile selectate.

• Dacă nu există nici o selecie, atunci vor fi utilizate toate entităile.

Please note that you can change this behaviour by ubselecting the relevant option in the Processing → Options →
General‘ menu.

You can test that yourself by selecting a few points in any of the layers that we used in the last chapter, and running
the reprojection algorithm on them. The reprojected layer that you will obtain will contain only those points that
were selected, unless there was no selection, which will cause the resulting layer to contain all points from the
original layer.

To make a selection, you can use any of the available methods and tools in QGIS. However, you can also use a
geoalgorithm to do so. Algorithms for creating a selection are found in the toolbox under Vector/Selection
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Deschidei algoritmul de Selecie aleatoare.

Lăsând valorile implicite, se vor selecta 10 puncte din stratul curent.
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Vei observa că acest algoritm nu produce nici o ieire, dar modifică stratul de intrare (nu stratul în sine, ci selecia
sa). Acesta este un comportament mai puin frecvent, deoarece toi ceilali algoritmi vor produce noi straturi i nu
vor modifica straturile de intrare.

Since the selection is not part of the data itself, but something that only exist within QGIS, these selection algo-
rithms only must be used selecting a layer that is open in QGIS, and not with the file selection option that you can
find in the corresponding parameter value box.

The selection we have just made, like most of the ones created by the rest of the selection algorithms, can also be
done manually from QGIS, so you might be wondering what is the point on using an algorithm for that. Although
now this might not make much sense to you, we will later see how to create models and scripts. If you want
to make a selection in the middle of a model (which defines a processing workflow), only a geoalgorithm can
be added to a model, and other QGIS elements and operations cannot be added. That is the reason why some
processing algorithms duplicate functionality that is also available in other QGIS elements.

By now, just remember that selections can be made using processing geoalgorithms, and that algorithms will only
use the selected features if a selection exists, or all features otherwise.

17.8 Rularea unui algoritm extern

Note: În această lecie vom vedea cum să folosim algoritmi care depind de o teră aplicaie, în speă SAGA, care
este unul dintre principalii furnizori de algoritmi.

All the algorithms that we have run so far are part of processing framework. That is, they are native algorithms
implemented in the plugin and run by QGIS just like the plugin itself is run. However, one of the greatest features
of the processing framework is that it can use algorithms from external applications and extend the possibilites of
those applications. Such algorithms are wrapped and included in the toolbox, so you can easily use them from
QGIS, and use QGIS data to run them.

Some of the algorithms that you see in the simplified view require third party applications to be installed in your
system. One algorithm provider of special interest is SAGA (System for Automated Geospatial Analysis). First,
we need to configure everything so QGIS can correctly call SAGA. This is not difficult, but it’s important to
understand how it works. Each external application has its own configuration, and later in this same manual we
will talk about some of the other ones, but SAGA is going to be our main backend, so we will discuss it here.

If you are on Windows, the best way to work with external algorithms is to install QGIS using the standalone
installer. It will take care of installing all the needed dependencies, including SAGA, so if you have used it, there
is nothing else to do. You can open the settings dialog and go to the Providers/SAGA group.
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Calea către SAGA trebuie să fie deja configurată i să indice folderul în care este instalat SAGA.

If you have installed QGIS not using the standalone installer, then you must enter the path to your SAGA installa-
tion (which you must have installed separately) there. The required version is SAGA 2.1

In case you are using Linux, you do not have to set the path to your SAGA installation in the processing configu-
ration. Instead, you must install SAGA and make sure that the SAGA folder is in PATH, so it can be called from
the console (just open a console and type saga_cmd to check it). Under Linux, the target version for SAGA is
also 2.1, but in some installations (such as the OSGeo Live DVD) you might have just 2.0.8 available. There are
some 2.1 packages available, but they are not commonly installed and might have some issues, so if you prefer to
use the more common and stable 2.0.8, you can do it by enabling 2.0.8 compatibility in the configuration dialog,
under the SAGA group
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Once SAGA is installed, you can launch a SAGA algorithm double clicking on its name, as with any other
algorithm. Since we are using the simplified interface, you do not know which algorithms are based on SAGA or
in another external application, but if you happen to double–click on one of them and the corresponding application
is not installed, you will see something like this.

În cazul nostru, presupunând că aplicaia SAGA este instalată i configurată corect, nu ar trebui să vedei această
fereastră ci, în schimb, vei obine parametrii dialogului.

Să încercăm cu un algoritm bazat pe SAGA, cel denumit Split shapes layer randomly.
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Use the points layer in the project corresponding to this lesson as input, and the default parameter values, and you
will get something like this (the split is random, so your result might be different).

The input layer has been split in two layers, each one with the same number of points. This result has been
computed by SAGA, and later taken by QGIS and added to the QGIS project.

If all goes fine, you will not notice any difference between this SAGA–based algorithm and one of the others that
we have previously run. However, SAGA might, for some reason, not be able to produce a result and not generate
the file that QGIS is expecting. In that case, there will be problems adding the result to the QGIS project, and an
error message like this will be shown.
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This kind of problems might happen, even if SAGA (or any other application that we are calling from the pro-
cessing framework) is correctly installed, and it is important to know how to deal with them. Let’s produce one of
those error messages.

Deschidei algoritmul Creare graticule, i folosii-l cu următoarele valori.

We are using width and height values that is larger than the specified extent, so SAGA cannot produce any output.
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In other words, the parameter values are wrong, but they are not checked until SAGA gets them and tries to create
the graticule. Since it cannot create it, it will not produce the expected layer, and you will see the error message
shown above.

Understanding this kind of problems will help you solve them and find an explanation to what is happening. As
you can see in the error message, a test is performed to check that the connection with SAGA is working correctly,
indicating you that there might be a problem in how the algorithm was executed. This applies not only to SAGA,
but also to other external applications as well.

In the next lesson we will introduce the processing log, where information about commands run by geoalgorithms
is kept, and you will see how to get more detail when issues like this appear.

17.9 Procesarea jurnalului

Note: Această lecie descrie procesarea jurnalului.

All the analysis performed with the processing framework is logged in its own logging system. This allows you
to know more about what has been done with the processing tools, to solve problems when they happen, and also
to re–run previous operations, since the logging system also implements some interactivity.

To open the log, select the corresponding entry in the processing menu. You will see the following dialog.

It contains four blocks of information: Info, Error, Warnings and Algorithms. Here is a description of all of them.

• Info. Some algorithms might leave here information about their execution. For instance, those algorithms
that call an external application usually log the console output of that application to this entry. If you have
a look at it, you will see that the output of the SAGA algorithm that we just run (and that fail to execute
because input data was not correct) is stored here.
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Aceste informaii v-ar putea fi utile, pentru a înelege ce se întâmplă. Utilizatorii avansai vor putea să analizeze o
ieire, pentru a afla de ce a euat algoritmul. Dacă nu suntei un utilizator avansat, informaiile respective vor fi utile
celor care vă vor ajuta la diagnosticarea unei probleme, pentru a determina dacă a fost cauzată de instalarea unei
aplicaii externe sau de datele pe care le-ai introdus.

• Warnings. Even if the algorithm could be executed, some algorithms might leave warnings in case the result
might not be right. For instance, when executing an interpolation algorithm with a very small amount of
points, the algorithm can run and will produce a result, but it is likely that it will not be correct, since more
points should be used. It’s a good idea to regularly check for this type of warnings if you are not sure about
some aspect of a given algorithm.

• Error. Errors that appear and are not directly related to external applications are logged in this section.

• Algorithms. All algorithms that are executed, even if they are executed from the GUI and not from the
console (which will be explained later in this manual) are stored in this part of the log as a console call.
That means that everytime you run an algorithm, a console command is added to the log, and you have the
full history of your working session. Here is how that history looks like:
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Acest lucru poate fi foarte util atunci când începe lucrul cu consola, pentru a afla mai multe despre sintaxa algo-
ritmilor. Îl vom folosi când vom discuta despre modul în care se pot rula comenzile de analiză din consolă.

Istoricul este, de asemenea, interactiv, de aceea vei putea relansa orice algoritm printr-un simplu dublu-clic pe
denumirea sa. Aceasta este o modalitate uoară de a reproduce comenzi pe care le-ai mai executat.

De exemplu, încercai următoarele. Deschidei datele corespunzătoare primului capitol din acest manual i rulai
algoritmul descris acolo. Apoi mergei la fereastra jurnalului i localizai ultimul algoritm din listă, care corespunde
algoritmului pe care abia l-ai rulat. Efectuând un dublu-clic pe el se va obine un nou rezultat, la fel ca i atunci
când l-ai rulat utilizând dialogul normal, apelându-l din caseta de instrumente.

17.9.1 Avansat

You can also modify the algorithm. Just copy it, open the Plugins → Python console, click on Import class → Im-
port Processing class, then paste it to re-run the analysis; change the text at will. To display the resulting file, type
iface.addVectorLayer(’/path/filename.shp’, ’Layer name in legend’, ’ogr’).

17.10 Calculatorul raster. Valorile fără-date

Note: In this lesson we will see how to use the raster calculator to perform some operations on raster layers. We
will also explain what are no–data values and how the calculator and other algorithms deal with them

The raster calculator is one of the most powerful algorithms that you will find. It’s a very flexible and versatile
algorithm that can be used for many different calculations, and one that will soon become an important part of
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your toolbox.

In this lesson we will be performing some calculation with the raster calculator, most of them rather simple. This
will let us see how it is used and how it deals with some particular situations that it might find. Understanding that
is important to later get the expected results when using the calculator, and also to understand certain techniques
that are commonly applied with it.

Deschideti proiectul QGIS corespunzător acestei lecii i vei vedea că ea conine mai multe straturi raster.

Acum deschidei caseta de instrumente i caseta de dialog corespunzătoare calculatorului raster.

Note: Interfaa diferă pentru versiunile recente.

Dialogul conine 2 parametri.

• The layers to use for the analysis. This is a multiple input, that meaning that you can select as many layers
as you want. Click on the button on the right–hand side and then select the layers that you want to use in
the dialog that will appear.

• The formula to apply. The formula uses the layers selected in the above parameter, which are named using
alphabet letters (a, b, c...) or g1, g2, g3... as variable names. That is, the formula a + 2 *
b is the same as g1 + 2 * g2 and will compute the sum of the value in the first layer plus two times
the value in the second layer. The ordering of the layers is the same ordering that you see in the selection
dialog.

Warning: Calculator ine cont de majuscule/minuscule.

Pentru a începe, vom schimba unităile DEM-ului din metri în picioare. Formula de care avem nevoie este:

h’ = h * 3.28084

Selectai DEM-ul din câmpul straturilor i introducei a * 3.28084 în câmpul formulei.
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Warning: Pentru utilizatorii care nu sunt englezi: folosii întotdeauna ”.”, nu ”,”.

Click Run to run the algorithm. You will get a layer that has the same appearance of the input layer, but with
different values. The input layer that we used has valid values in all its cells, so the last parameter has no effect at
all.

Let’s now perform another calculation, this time on the accflow layer. This layer contains values of accumulated
flow, a hydrological parameter. It contains those values only within the area of a given watershed, with no–data
values outside of it. As you can see, the rendering is not very informative, due to the way values are distributed.
Using the logarithm of that flow accumulation will yield a much more informative representation. We can calculate
that using the raster calculator.

Open the algorithm dialog again, select the accflow layer as the only input layer, and enter the following formula:
log(a).

Acesta este stratul pe care îl vei obine.

If you select the Identify tool to know the value of a layer at a given point, select the layer that we have just created,
and click on a point outside of the basin, you will see that it contains a no–data value.
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For the next exercise we are going to use two layers instead of one, and we are going to get a DEM with valid
elevation values only within the basin defined in the second layer. Open the calculator dialog and select both layers
of the project in the input layers field. Enter the following formula in the corresponding field:

a/a * b

a refers to the accumulated flow layer (since it is the first one to appear in the list) and b refers to the DEM. What
we are doing in the first part of the formula here is to divide the accumulated flow layer by itself, which will result
in a value of 1 inside the basin, and a no–data value outside. Then we multiply by the DEM, to get the elevation
value in those cells inside the basin (DEM * 1 = DEM) and the no–data value outside (DEM * no_data =
no_data)

Acesta este stratul rezultat.

This technique is used frequently to mask values in a raster layer, and is useful whenever you want to perform
calculations for a region other that the arbitrary rectangular region that is used by raster layer. For instance, an
elevation histogram of a raster layer doesn’t have much meaning. If it is instead computed using only values
corresponding to a basin (as in he case above), the result that we obtain is a meaningful one that actually gives
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information about the configuration of the basin.

There are other interesting things about this algorithm that we have just run, apart from the no–data values and
how they are handled. If you have a look at the extents of the layers that we have multiplied (you can do it
double–clicking on their names of the layer in the table of contents and looking at their properties), you will see
that they are not the same, since the extent covered by the flow accumulation layer is smaller that the extent of the
full DEM.

That means that those layers do not match, and that they cannot be multiplied directly without homogenizing
those sizes and extents by resampling one or both layers. However, we did not do anything. QGIS takes care of
this situation and automatically resamples input layers when needed. The output extent is the minimum covering
extent calculated from the input layers, and the minimum cell size of their cellsizes.

In this case (and in most cases), this produces the desired results, but you should always be aware of the additional
operations that are taking place, since they might affect the result. In cases when this behaviour might not be the
desired, manual resampling should be applied in advance. In later chapters, we will see more about the behaviour
of algorithms when using multiple raster layers.

Let’s finish this lesson with another masking exercise. We are going to calculate the slope in all areas with an
elevation between 1000 and 1500 meters.

În acest caz, nu dispunem de un strat pentru a-l utiliza drept mască, dar îl putem crea cu ajutorul calculatorului.

Pornete calculatorul folosind DEM-ul doar ca pe un strat de intrare, i următoarea formulă

ifelse(abs(a-1250) < 250, 1, 0/0)

As you can see, we can use the calculator not only to do simple algebraic operations, but also to run more complex
calculation involving conditional sentences, like the one above.

Rezultatul are o valoare de 1 în interiorul gamei în care dorim să lucrăm, i valori fără-date în celulele din exterior.

The no-data value comes from the 0/0 expression. Since that is an undetermined value, SAGA will add a NaN
(Not a Number) value, which is actually handled as a no-data value. With this little trick you can set a no-data
value without needing to know what the no–data value of the cell is.

Now you just have to multiply it by the slope layer included in the project, and you will get the desired result.

All that can be done in a single operation with the calculator. We leave that as an exercise for the reader.
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17.11 Calculatorul vectorial

Note: În această lecie vom vedea cum se vor adăuga noi atribute în stratul vectorial, pe baza unei expresii
matematice, cu ajutorul calculatorului vectorial.

We already know how to use the raster calculator to create new raster layers using mathematical expressions. A
similar algorithm is available for vector layers, and generates a new layer with the same attributes of the input
layer, plus an additional one with the result of the expression entered. The algorithm is called Field calculator and
has the following parameters dialog.

Note: În versiunile mai noi de Processing, interfaa s-a schimbat considerabil, fiind mult mai puternică i mai uor
de utilizat.

Here are a couple of examples of using that algorithm.

First, let’s calculate the population density of white people in each polygon, which represents a census. We have
two fields in the attributes table that we can use for that, namely WHITE and SHAPE_AREA. We just have to
divide them and multiply by one million (to have density per square km), so we can use the following formula in
the corresponding field

( WHITE / SHAPE_AREA ) * 1000000

Dialogul parametrilor trebuie completai aa cum se arată mai jos.

Acest lucru va genera un nou câmp denumit WHITE_DENS

Now let’s calculate the ratio between the MALES and FEMALES fields to create a new one that indicates if male
population is numerically predominant over female population.

Introducei următoarea formulă
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"MALES" / "FEMALES"

Fereastra parametrilor ar trebui să arate acest lucru, înainte de a apăsa pe butonul OK.
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In earlier version, since both fields are of type integer, the result would be truncated to an integer. In this case the
formula should be: 1.0 * "MALES" / "FEMALES", to indicate that we want floating point number a result.

We can use conditional functions to have a new field with male or female text strings instead of those ratio
value, using the following formula:

CASE WHEN "MALES" > "FEMALES" THEN ’male’ ELSE ’female’ END

Fereastra parametrilor ar trebui să arate acest lucru.
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Un calculator de câmpuri python este disponibil în Advanced Python field calculator, care nu va fi detaliat aici
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17.12 Definirea eextinderilor

Note: În această lecie vom vedea cum se definesc extinderile, acest lucru fiind necesar unor algoritmi, mai ales
cele pentru rastere.

Unii algoritmi au nevoie de o extindere, pentru a defini zona care urmează să fie acoperită de analiză i, de obicei,
pentru a defini extinderea stratului rezultat.

When an extent is required, it can be defined manually by entering the four values that define it (min X, min Y,
max X, max Y), but there are other more practical and more interesting ways of doing it as well. We will see all
of them in this lesson.

First, let’s open an algorithm that requires an extent to be defined. Open the Shapes to grid algorithm, which
creates a raster layer from a vector layer.
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All the parameters, except for the last two ones, are used to define which layer is to be rasterized, and configure
how the rasterization process should work. The two last parameters, on the other hand, define the characteristics
of the output layer. That means that they define the area that is covered (which is not necesarily the same area
covered by the input vector layer), and the resolution/cellsize (which cannot be infered from the vector layer, since
vector layers do not have a cellsize).

Primul lucru pe care îl putei face este să tastai cele 4 valori de definire, prezentate anterior, separate prin virgulă.

That doesn’t need any extra explanation. While this is the most flexible option, it is also the less practical in some
cases, and that’s why other options are implemented. To access them, you have to click on the button on the
right–hand side of the extent text box.

Să vedem ce poate face fiecare.

Prima opiune este Use layer/canvas extent, care va afia dialogul de selecie de mai jos.
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Here you can select the extent of the canvas (the extent covered by the current zoom), or the extension any of the
available layers. Select it and click on OK, and the text box will be automatically filled with the corresponding
values.

The second option is Select extent on canvas. In this case, the algorithm dialog disappears and you can click and
drag on the QGIS canvas to define the desired extent.

După ce eliberai butonul mouse-ului, dialogul va reapărea iar caseta de text va conine deja valorile corespunzătoare
în extinderea definită.

The last option is Use min covering extent from input layers, which is the default option. This will compute the
min covering extent of all layers used to run the algorithm, and there is no need to enter any value in the text box.
In the case of a single input layer, as in the algorithm we are running, the same extent can be obtained by selecting
that same input layer in the Use layer/canvas extent that we already saw. However, when there are several input
layers, the min covering extent does not correspond to any of the input layer extent, since it is computed from all
of them together.

Vom folosi această ultimă metodă pentru a executa algoritmul nostru de rasterizare.

Completai dialogul parametrilor după cum se arată în continuare, apoi apăsai OK.
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Note: In this case, better use an Integer (1 byte) instead of a Floating point (4 byte), since the ID is an integer
with maximum value=63. This will result in a smaller file size and faster computations.

Vei primi un strat raster care acoperă exact zona acoperită de stratul vectorial iniial.
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In some cases, the last option, Use min covering extent from input layers, might not be available. This will happen
in those algorithm that do not have input layers, but just parameters of other types. In that case, you will have to
enter the value manually or use any of the other options.

Notice that, when a selection exist, the extent of the layer is that of the whole set of features, and the selection is
not used to compute the extent, even though the rasterization is executed on the selected items only. In that case,
you might want to actually create a new layer from the selection, and then use it as input.

17.13 Ieiri HTML

Note: În această lecie învăăm cum administrează QGIS ieirile în format HTML, care sunt utilizate pentru a
produce text si grafică.

Toate rezultatele obinute până în prezent au fost sub formă de straturi (vectoriale sau raster). Cu toate acestea, unii
algoritmi generează ieiri sub formă de text i grafică. Acestea sunt încapsulate în fiiere HTML i afiate în aa–numitul
Vizualizator de rezultate, care reprezintă un alt element al cadrului de procesare.

Să vedem unul dintre aceti algoritmi pentru a înelege cum funcionează.

Deschidei proiectul cu datele de utilizat în această lecie, apoi deschidei algoritmul Statistici de bază pentru câm-
purile numerice.
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Algoritmul este destul de simplu, trebuind să selectai doar stratul de utilizat i unul din câmpurile sale (unul nu-
meric). Ieirea este de tip HTML, dar caseta corespunzătoare funcionează similar cu cea pentru o ieire de tip
vectorial sau raster. Putei introduce o cale de fiier sau să o lăsai necompletată, pentru ca salvarea să aibă loc
într-un fiier temporar. Totui, în acest caz sunt acceptate doar extensiile html i htm, nefiind nici o modalitate de a
modifica formatul de ieire.

Rulai algoritmul, selectând ca intrare singurul strat din proiect i câmpul POP2000, după care va apărea un nou
dialog, similar celui prezentat anterior, iar o dată ce algoritmul este executat dialogul parametrilor se va închide.
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Acesta este Vizualizatorul de rezultate. Aici se păstrează tot rezultatul HTML generat în timpul sesiunii curente,
într-o formă uor accesibilă, astfel încât să-l putei verifica rapid, ori de câte ori este nevoie. Orice modificare adusă
straturilor se va pierde la închiderea QGIS, dacă ai ales ieirea într-un fiier temporar. Dacă ai efectuat salvarea într-
o cale permanentă, fiierul se va păstra, dar nu va apărea în Vizualizatorul de rezultate la următoarea deschidere a
aplicaiei QGIS.

Unii algoritmi generează text care nu poate fi subdivizat. Acesta este, de exemplu, cazul algoritmilor care cap-
turează textul generat de către un proces extern. În alte cazuri, rezultatul este prezentat sub formă de text, dar
în mod intern el este împărit în mai multe seciuni, de obicei sub formă de valori numerice. Algoritmul pe care
tocmai l-am executat este unul dintre acestea. Fiecare dintre valori este tratată ca o singură ieire, stocată într-o
variabilă. Dei nu sunt relevante acum, o dată ce vom trece la modelatorul grafic, aceste valori vor fi utilizate ca
intrări numerice pentru ali algoritmi.

17.14 Un prim exemplu de analiză

Note: În această lecie, vom efectua o analiză reală, folosind doar bara de instrumente, astfel încât să vă familiar-
izai cu elementele cadrului de prelucrare.

Now that everything is configured and we can use external algorithms, we have a very powerful tool to perform
spatial analysis. It is time to work out a larger exercise with some real–world data.

We will be using the well-known dataset that John Snow used in 1854, in his groundbreaking work
(http://en.wikipedia.org/wiki/John_Snow_%28physician%29), and we will get some interesting results. The anal-
ysis of this dataset is pretty obvious and there is no need for sofisticated GIS techniques to end up with good
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results and conclusions, but it is a good way of showing how these spatial problems can be analyzed and solved
by using different processing tools.

Setul de date conine fiierul shape cu decesele cauzate de holeră i locaiile pompelor, precum i o hartă OSM randată
în format TIFF. Deschidei proiectul QGIS corespunzător acestei lecii.

The first thing to do is to calculting the Voronoi diagram (a.k.a. Thyessen polygons) of the pumps layer, to get the
influence zone of each pump. The Voronoi Diagram algorithm can be used for that.
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Destul de uor, dar ne va pune la dispoziie informaii interesante.

474 Chapter 17. Ghidul de procesare al QGIS



QGIS Training Manual, Release 2.8

În mod evident, cele mai multe cazuri se încadrează într-unul dintre poligoane

To get a more quantitative result, we can count the number of deaths in each polygon. Since each point represents
a building where deaths occured, and the number of deaths is stored in an attribute, we cannot just count the points.
We need a weighted count, so we will use the Count points in polygon (weighted) tool.
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The new field will be called DEATHS, and we use the COUNT field as weighting field. The resulting table clearly
reflects that the number of deaths in the polygon corresponding to the first pump is much larger than the other
ones.
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Another good way of visualizing the dependence of each point in the Cholera_deaths layer with a point in
the Pumps layer is to draw a line to the closest one. This can be done with the Distance to closest hub tool, and
using the configuration shown next.

17.14. Un prim exemplu de analiză 477
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Rezultatul arată în felul următor:
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Although the number of lines is larger in the case of the central pump, do not forget that this does not represent the
number of deaths, but the number of locations where cholera cases were found. It is a representative parameter,
but it is not considering that some locations might have more cases than other.

A density layer will also give us a very clear view of what is happening. We can create it with the Kernel density
algorithm. Using the Cholera_deaths layer, its COUNT field as weight field, with a radius of 100, the extent and
cellsize of the streets raster layer, we get something like this.

17.14. Un prim exemplu de analiză 479
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Amintii-vă că, pentru a obine întinderea rezultatului, nu trebuie să o introducei. Facei clic pe butonul din partea
dreaptă i selectai Use layer/canvas extent.
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Selectai stratul străzilor raster iar întinderea sa va fi adăugată automat în câmpul de text. Trebuie să facei acelai
lucru cu dimensiunea celulei, selectând-o, de asemenea, din acel strat.

Combining with the pumps layer, we see that there is one pump clearly in the hotspot where the maximum density
of death cases is found.

17.15 Decuparea i îmbinarea straturilor raster

Note: În această lecie vom vedea un alt exemplu de pregătire a datelor spaiale, pentru a continua utilizarea
geoalgoritmilor în scenarii din lumea reală.

În această lecie, vom calcula un strat de pantă pentru suprafaa care înconjoară o zonă dată a oraului, dintr-un
strat vectorial cu un singur poligon. DEM-ul de bază este împărit în două straturi raster care, împreună, acop-
eră o suprafaă mult mai mare decât cea din jurul oraului în care ne dorim să lucrăm. Dacă deschidei proiectul
corespunzător acestei lecii, vei vedea ceva de genul următor.
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Aceste straturi au două probleme:

• Acestea acoperă o zonă care este prea mare pentru ceea ce dorim (suntem interesai de o regiune mai mică
din jurul centrului oraului)

• Ele se află în două fiiere diferite (limitele oraului se încadrează doar într-un singur strat raster, dar, aa cum
s-a mai zis, dorim o anumită suprafaă adiională în jurul acestuia).

Ambele sunt uor rezolvabile cu geoalgoritmii corespunzători.

În primul rând, vom crea un dreptunghi care definete zona dorită. Pentru aceasta, vom crea un strat care conine
caseta de încadrare a stratului, împreună cu limitele suprafeei oraului, apoi vom crea un tampon, astfel încât să
existe un strat raster care îl acoperă un pic mai mult decât este necesar.

Pentru a calcula caseta de încadrare, putem folosi algoritmul Poligonului din extinderea stratului
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Pentru a-l tampona, vom folosi algorimul Fixed distance buffer, cu următoarele valori pentru parametri.

Aici se află caseta de încadrare obinută, utilizând parametrii de mai sus
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Este o casetă rotundă, dar putem obine cu uurină o casetă echivalentă, cu unghiuri drepte, prin rularea algoritmului
Poligon din extinderea stratului asupra ei. Am putea să tamponăm mai întâi limitele oraului, iar apoi să calculăm
extinderea dreptunghiului, economisind un pas.

Vei observa că rasterele au o proiecie diferită faă de vector. Prin urmare, ar trebui să le reproiectăm înainte de a
trece mai departe, folosind instrumentul Warp (reproiectare).
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Note: Recent versions have a more complex interface. Select at least one compression method.

With this layer that contains the bounding box of the raster layer that we want to obtain, we can crop both of the
raster layers, using the Clip grid with polygon algorithm.
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După straturile au fost decupate, ele se pot uni cu ajutorul algoritmului GDAL Merge.
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Warning: The following paragraph is obsolete.

A cellsize is needed for the merged layer. We will use the same one of the input ones. You do not need to know it
in advance before calling the algorithm. Just click on the button in the right–hand size of the text field and you will
have a dialog to enter small mathematical formulas, and a list of frequently used values, among them the cellsizes
and bounding coordinates of all available layers.

Note: Putei economisi timp prin efectuarea mai întâi a îmbinării, i abia mai apoi a decupării, evitându-se astfel
apelarea de două ori a algoritmului de decupare. Totui, în cazul în care mai multe straturi cu o dimensiune
apreciabilă trebuie îmbinate, vă vei alege cu un strat voluminos, care poate fi dificil de prelucrat ulterior. În acest
caz, s-ar putea avea să apelai algoritmul de tăiere de mai multe ori, operaie consumatoare de timp, însă nu vă
îngrijorai pentru că vei vedea că există unele instrumente adiionale, dedicate automatizării acestui proces. Pentru
exemplul următor nu este cazul să vă facei griji, deoarece folosim numai două straturi.

Cu asta, vom obine DEM-ul final pe care ni-l dorim.

Acum este timpul să calculăm stratul pantei.

Stratul pantei poate fi calculat cu ajutorul algoritmului Pantă, Aspect, Curbură, însă DEM-ul obinut în ultima
etapă nu este potrivit ca intrare, deoarece valorile altitudinii sunt exprimate în metri, iar mărimea celulei nu este
exprimată în metri (stratul folosete un CRS cu coordonate geografice). De aceea, este nevoie de o reproiectare.
Pentru a reproiecta stratul raster, se poate utiliza iarăi algoritmul Warp (reproiectare). Vom efectua reproiectarea
într-un CRS având metrul ca unitate (cum ar fi 3857), astfel încât vom putea calcula corect panta, fie cu SAGA,
ori cu GDAL.

Here is the reprojected DEM.
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Panta poate fi de acum calculată, cu ajutorul noului DEM.
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Iar aici este stratul pantei rezultate.
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The slope produced by the Slope, Aspect, Curvature algorithm is expressed in radians, but degrees are a more
practical and common unit. The Metric conversions algorithm will help us to do the conversion (but in case you
didn’t know that algorithm existed, you could use the raster calculator that we have already used).
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Reproiectând stratului pantă convertit, cu ajutorul Reproiectării stratului raster, obinem stratul final pe care l-am
dorit.

Warning: todo: De adăugat imaginea

The reprojection processes have caused the final layer to contain data outside the bounding box that we calculated
in one of the first steps. This can be solved by clipping it again, as we did to obtain the base DEM.

17.16 Analize hidrologice

Note: În această lecie, vom efectua unele analize hidrologice. Această analiză va fi utilizată în unele din urmă-
toarele lecii, deoarece constituie un exemplu foarte bun de analiză a fluxului de lucru, pe care o vom folosi pentru
a demonstra unele caracteristici avansate.

În această lecie, vom face unele analize hidrologice. Începând cu un DEM, vom extrage o reea de canale, vom
delimita bazinele hidrografice i vom calcula unele statistici.

Primul lucru este de a încărca proiectul cu datele leciei, care conine doar un DEM.
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The first module to execute is Catchment area. You can use anyone of the others named Catchment area. They
have different algorithms underneath, but the results are basically the same.

Selectai DEM-ul din câmpul Elevaie, lăsând valorile implicite pentru restul parametrilor.
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Unii algoritmi calculează multe straturi, dar Catchment Area este cel pe care dorim să-l folosim.

Putei scăpa de celelalte, dacă dorii.

Randarea stratului nu este foarte informativă.

To know why, you can have a look at the histogram and you will see that values are not evenly distributed (there
are a few cells with very high value, those corresponding to the channel network). Calculating the logarithm of the
catchment area value yields a layer that conveys much more information (you can do it using the raster calculator).
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The catchment area (also known as flow accumulation), can be used to set a threshold for channel initiation. This
can be done using the Channel network algorithm. Here is how you have to set it up (note the Initiation threshold
Greater than 10.000.000).
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Utilizai stratul original al bazinului hidrografic, nu cel logaritmic. Acela folosete doar pentru randare.

If you increase the Initiation threshold value, you will get a more sparse channel network. If you decrease it, you
will get a denser one. With the proposed value, this is what you get.
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Imaginea de mai sus prezintă doar stratul vectorul rezultat i DEM-ul, dar ar trebui să fie i unul raster, cu aceeai
reea de canale. Rasterul va fi, de fapt, cel pe care îl vom folosi.

Now, we will use the Watersheds basins algorithm to delineate the subbasins corresponding to that channel net-
work, using as outlet points all the junctions in it. Here is how you have to set the corresponding parameters
dialog.
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Acesta vei obine.

Acesta este rasterul rezultat. Putei să-l vectorizai folosind algoritmul Vectorizarea claselor grilei.
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Now, let’s try to compute statistics about the elevation values in one of the subbasins. The idea is to have a layer
that just represents the elevation within that subbasin and then pass it to the module that calculates those statistics.
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First, let’s clip the original DEM with the polygon representing a subbasin. We will use the Clip grid with polygon
algorithm. If we select a single subbasin polygon and then call the clipping algorithm, we can clip the DEM to the
area covered by that polygon, since the algorithm is aware of the selection.

Selectai un poligon,

i apelai algoritmul de tăiere cu următorii parametri:
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Elementul selectat în câmpul de introducere este, desigur, DEM-ul pe care vrem să-l decupăm.

Vei obine ceva de genul acesta.
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Acest strat este gata de a fi utilizat in algoritmul Raster layer statistics.

Statisticile rezultate sunt următoarele.

Vom folosi i în alte lecii atât procedura de calcule a bazinului, cât i calcularea statisticilor, pentru a afla cum ne
pot ajuta alte elemente la automatizarea amândurora, cât i pentru a lucra mai eficient.
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17.17 Lucrul cu modelatorul grafic

Note: În această lecie vom folosi modelatorul grafic, o componentă puternică, pe care o putem folosi pentru a
defini un flux de lucru, i pentru a rula o înlănuire de algoritmi.

A normal session with the processing tools includes more than running a single algorithm. Usually several of
them are run to obtain a result, and the outputs of some of those algorithms are used as input for some of the other
ones.

Using the graphical modeler, that workflow can be put into a model, which will run all the necessary algorithms
in a single run, thus simplifying the whole process and automating it.

To start this lesson, we are going to calculate a parameter named Topographic Wetness Index. The algorithm that
computes it is called Topographic wetness index (twi)

As you can see, there are two mandatory inputs: Slope and Catchment area. There is also an optional input, but
we will not be using it, so we can ignore it.

The data for this lesson contains just a DEM, so we do not have any of the required inputs. However, we know
how to calculate both of them from that DEM, since we have already seen the algorithms to compute slope and
catchment area. So we can first compute those layers and then use them for the TWI algorithm.

Aici sunt dialogurile pentru parametrii care ar trebui să fie utilizai în calculul a 2 straturi intermediare.
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Acesta este modul în care va trebui să setai parametrii dialogului pentru algoritmul TWI.

504 Chapter 17. Ghidul de procesare al QGIS



QGIS Training Manual, Release 2.8

This is the result that you will obtain (the default singleband pseudocolor inverted palette has been used for
rendering). You can use the twi.qml style provided.

What we will try to do now is to create an algorithm that calculates the TWI from a DEM in just one single step.
That will save us work in case we later have to compute a TWI layer from another DEM, since we will need just
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one single step to do it instead of the 3 ones above. All the processes that we need are found in the toolbox, so
what we have to do is to define the workflow to wrap them. This is where the graphical modeler comes in.

Deschidei modelatorul, prin selectarea intrării sale din meniul de prelucrare.

Two things are needed to create a model: setting the inputs that it will need, and defining the algorithm that
it contains. Both of them are done by adding elements from the two tabs in the left–hand side of the modeler
window: Inputs and Algorithms

Let’s start with the inputs. In this case we do not have much to add. We just need a raster layer with the DEM,
and that will be our only input data.

Dublu clic pe Stratul raster de intrare, apoi vei vedea următorul dialog.

Here we will have to define the input we want. Since we expect this raster layer to be a DEM, we will call it DEM.
That’s the name that the user of the model will see when running it. Since we need that layer to work, we will
define it as a mandatory layer.

Iată cum ar trebui să fie configurat dialogul.
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Facei clic pe OK, după care intrarea va apărea în pânza modelatorului.

Now let’s move to the Algorithms tab. The first algorithm we have to run is the Slope, aspect, curvature algorithm.
Locate it in the algorithm list, double–click on it and you will see the dialog shown below.
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This dialog is very similar to the one that you can find when running the algorithm from the toolbox, but the
element that you can use as parameter values are not taken from the current QGIS project, but from the model
itself. That means that, in this case, we will not have all the raster layers of our project available for the Elevation
field, but just the ones defined in our model. Since we have added just one single raster input named DEM, that
will be the only raster layer that we will see in the list corresponding to the Elevation parameter.

Output generated by an algorithm are handled a bit differently when the algorithm is used as a part of a model.
Instead of selecting the filepath where you want to save each output, you just have to specify if that ouput is an
intermediate layer (and you do not want it to be preserved after the model has been executed), or it is a final one.
In this case, all layers produced by this algorithm are intermediate. We will only use one of them (the slope layer),
but we do not want to keep it, since we just need it to calculate the TWI layer, which is the final result that we
want to obtain.

When layers are not a final result, you should just leave the corresponding field. Otherwise, you have to enter a
name that will be used to identify the layer in the parameters dialog that will be shown when you run the model
later.

There is not much to select in this first dialog, since we do not have but just one layer in or model (The DEM input
that we created). Actually, the default configuration of the dialog is the correct one in this case, so you just have
to press OK. This is what you will now have in the modeler canvas.
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The second algorithm we have to add to our model is the catchment area algorithm. We will use the algorithm
named Catchment area (Paralell). We will use the DEM layer again as input, and none of the ouputs it produces
are final, so here is how you have to fill the corresponding dialog.
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Acum, modelul dvs. ar trebui să arate în felul următor:
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Ultimul pas este să adăugai algoritmul Indicelui Topografic de Umiditate, cu următoarea configuraie.

In this case, we will not be using the DEM as input, but instead, we will use the slope and catchment area layers
that are calculated by the algorithms that we previously added. As you add new algorithms, the outputs they
produce become available for other algorithms, and using them you link the algorithms, creating the workflow.

In this case, the output TWI layer is a final layer, so we have to indicate so. In the corresponding textbox, enter
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the name that you want to be shown for this output.

Acum, modelul dvs. este finalizat, i ar trebui să arate în felul următor:

Introducei o denumire i un nume de grup în partea de sus a ferestrei modelului, apoi salvai-l făcând clic pe butonul
Save.

You can save it anywhere you want and open it later, but if you save it in the models folder (which is the folder
that you will see when the save file dialog appears), you model will also be available in the toolbox as well. So
stay on that folder and save the model with the filename that you prefer.

Acum închidei caseta de dialog a modelatorului i mergei la instrumente. În Modele se va afla i modelul dvs.

Îl putei rula la fel ca pe oricare alt algoritm normal, printr-un dublu-clic pe el.
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As you can see, the parameters dialog, contain the input that you added to the model, along with the outputs that
you set as final when adding the corresponding algorithms.

Rulai-l folosind DEM-ul ca intrare, apoi vei obine stratul TWI, într-un singur singur pas.

17.18 Modele mai complexe

Note: În această lecie vom lucra cu un model mai complex în modelatorul grafic.

Primul model pe care l-am creat în capitolul anterior a fost unul foarte simplu, doar cu o singură intrare i cu 3
algoritmi. Pot fi create mai multe modele complexe, cu diverse tipuri de intrări i cu mai multe etape. Pentru acest
capitol vom lucra cu un model care creează un strat vectorial cu bazine hidrografice, pe baza unui DEM i a unei
valori de prag. Acest lucru va fi foarte util pentru calcularea mai multor straturi vectoriale, care corespund unor
praguri diferite, fără a fi nevoie de repetarea fiecărui pas de fiecare dată.

Această lecie nu conine instruciuni despre crearea unui model. Cunoatei deja paii necesari (dintr-o lecie anterioară)
i ai văzut deja ideile de bază despre modelator, deci ar trebui să-l încercai singuri. Petrecei câteva minute încercând
să creai modelul, i nu vă facei griji despre greeli. Nu uitai: mai întâi adăugai intrările, iar apoi algoritmii pe care
îi folosii pentru a crea fluxul de lucru.

In case you could not create the full model yourself and you need some extra help, the data folder corresponding
to this lesson contains an ‘almost’ finished version of it. Open the modeler and then open the model file that you
will find in the data folder. You should see something like this.
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This model contains all the steps needed to complete the calculation, but it just has one input: the DEM. That
means that the threshold for channel definition use a fixed value, which makes the model not as useful as it could
be. That is not a problem, since we can edit the model, and that is exactly what we will do.

First, let’s add a numerical input. That will ask the user for a numerical input that we can use when such a value
is needed in any of the algorithms included in our model. Click on the Number entry in the inputs tree, and you
will see the corresponding dialog. Fill it with the values shown next.

Acum, modelul dvs. ar trebui să arate în felul următor:
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The input that we have just added is not used, so the model hasn’t actually changed. We have to link that input
to the algorithm that uses it, in this case the Channel network one. To edit an algorithm that already exists in the
modeler, just click on the pen icon on the corresponding box in the canvas. If you click on the Channel network
algorithm, you will see something like this.

The dialog is filled with the current values used by the algorithm. You can see that the threshold parameter has a
fixed value of 1,000,000 (this is also the default value of the algorithm, but any other value could be put in there).
However, you might notice that the parameter is not entered in a common text box, but in an option menu. If you
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unfold it, you will see something like this.

The input that we added is there and we can select it. Whenever an algorithm in a model requires a numerical
value, you can hardcode it and directly type it, or you can use any of the available inputs and values (remember
that some algorithms generate single numerical values. We will see more about this soon). In the case of a string
parameter, you will also see string inputs and you will be able to select one of them or type the desired fixed value.

Select the Threshold input in the Threshold parameter and click on OK to apply the changes to your model. Now
the design of the model should look like this.
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The model is now complete. Try to run it using the DEM that we have used in previous lessons, and with different
threshold values. Here you have a sample of the result obtained for different values. You can compare with the
result for the default value, which is the one we obtained in the hydrological analysis lesson.

Prag = 100,000

Prag = 1,0000,000
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17.19 Calculele numerice din modelator

Warning: Atenie, deoarece acest capitol nu este bine testat, vă rugăm să raportai orice problemă; imaginile
lipsesc

Note: În această lecie vom vedea cum se generează ieirile numerice din modelator

Pentru această lecie, vom modifica modelul hidrologic pe care l-am creat în ultimul capitol (deschidei-l în mod-
elator înainte de a începe), astfel încât să putem automatiza calcularea unei valori valide de prag, nefiind nevoie
să cerem utilizatorului să o introducă. Deoarece această valoare se referă la variabila din pragul stratului raster, o
vom extrage din acest strat, pe baza unor analize statistice simple.

Începand cu modelul menionat mai înainte, haidei să facem următoarele modificări:

În primul rând, se calculează statisticile stratului de acumulare a fluxului, utilizând algoritmul Statisticile stratului
raster.

Acest lucru va genera un set de valori statistice, care vor fi de acum disponibile pentru toate câmpurile numerice
ai altor algoritmi.

If you double click on the Channel network algorithm to modify it, as we did in the last lesson, you will see now
that you have other options apart from the numeric input that you added.
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Cu toate acestea, nici una dintre aceste valori nu este adecvată pentru a fi utilizată ca i prag valid, atât timp
cât acestea vor produce reele de canale nu prea realistice. Putem obine, în schimb, un nou parametru pe baza
lor, pentru a obine un rezultat mai bun. De exemplu, putem folosi media, la care se va adăuga de 2 ori deviaia
standard.

Pentru a adăuga această operaiune aritmetică, putem folosi calculatorul, pe care îl vei găsi în grupul
Geoalgorithms/modeler/modeler-tools. Acest grup conine algoritmi care nu sunt foarte utili în afara modela-
torului, dar care oferă funcionalităi utile la crearea unui model.

Dialogul parametrilor pentru algoritmul calculatorului arată astfel:
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După cum putei vedea, dialogul este diferit faă de celelalte pe care le-am văzut, dar avei acolo aceleai variabile
care au fost disponibile în câmpul Threshold din algoritmul Channel network. Introducei formula de mai sus, apoi
apăsai pe OK, pentru a adăuga algoritmul.

Dacă extindei intrarea rezultatului, aa cum se arată mai sus, vei vedea că modelul este conectat la două dintre
valori, i anume media i abaterea standard, care sunt cele pe care le-am folosit în formulă.

Adăugarea acestui nou algoritm va aduce o nouă valoare numerică. Dacă mergei iarăsi în algoritmul Channel
network, putei selecta acea valoare din parametrul Threshold.
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Facei clic pe OK, după care modelul dvs. ar trebui să arate în felul următor:

Nu vom folosi intrarea numerică pe care am adăugat-o modelului, astfel încât ea poate fi eliminată. Facei clic-
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dreapta pe ea i selectai Remove

Warning: todo: De adăugat imaginea

De acum, noul nostru model este terminat.

17.20 Un model în cadrul unui model

Warning: Atenie, deoarece acest capitol nu este bine testat, vă rugăm să raportai orice problemă; imaginile
lipsesc

Note: În această lecie vom vedea cum să folosim un model într-un alt model, mai mare.

Am creat deja câteva modele, iar în această lecie vom vedea cum le putem combina într-unul singur, mai mare.
Un model se comportă la fel ca oricare alt algoritm, ceea ce înseamnă că putei adăuga un model pe care îl avei
deja, ca parte a altuia, pe care urmează să-l creai.

În acest caz, vom extinde modelul nostru hidrologic, prin adăugarea valorii medii TWI în fiecare dintre bazinele
pe care le generează ca rezultat. Pentru aceasta, avem nevoie de calculul LST i a unor statistici. Din moment
ce am creat deja un model pentru a calcula LST dintr-un DEM, este o idee bună să refolosii acel model, în locul
adăugării algoritmilor pe care îi conine în mod individual.

Să începem cu modelul folosit ca punct de plecare pentru ultima lecie.

Warning: todo: De adăugat imaginea

În primul rând, vom adăuga modelul LST. Pentru ca acesta să fie la îndemână, ar fi trebuit să fie salvat în dosarul
modelelor, în caz contrar el nefiind afiat în caseta de instrumente sau în lista de algoritmi din modelator. Asigurai-
vă că este disponibil.

Adăugai-l la modelul actual i folosii DEM-ul de intrare ca i ieire. Ieirea este una temporară, din moment ce
vrem să obinem doar stratul TWI, pentru a-l folosi la calculul statisticilor. Singura ieire a acestui model va fi, în
continuare, stratul vectorial al bazinelor hidrografice.

Iată dialogul parametrilor corespunzători:

Warning: todo: De adăugat imaginea

Acum avem un strat TWI, pe care îl putem folosi împreună cu stratul vectorial al bazinelor hidrologice, pentru a
genera unul nou, care conine valorile TWI corespunzătoare fiecărui bazin hidrografic.

Acest calcul se face cu ajutorul algoritmului Statisticilor pentru grila acoprită de poligoane. Utilizai straturile
menionate mai sus ca intrare, pentru a crea rezultatul final.

Warning: todo: De adăugat imaginea

Rezultatul algoritmului de Vectorizare a claselor grilei a reprezentat iniial produsul nostru final, însă acum dorim
doar un rezultat intermediar. Pentru a schimba acest lucru, trebuie să editai algoritmul. Efectuai dublu-clic pe
acesta pentru a deschide dialogul parametrilor săi, apoi tergei numele ieirii. Astfel, va rezulta o ieire temporară,
aa cum este în mod implicit.

Warning: todo: De adăugat imaginea

Iată cum ar trebui să arate modelul final:
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Warning: todo: De adăugat imaginea

După cum vedei, utilizarea unui model într-un alt model nu reprezintă nimic special, putând fi adăugat la fel ca
oricare alt algoritm, atât timp cât modelul este salvat în dosarul de modele i este disponibil în caseta de instrumente.

17.21 Interpolarea

Note: Acest capitol prezintă cum se pot interpola datele punctuale, i vi se arată un alt exemplu real de efectuare
de analize spaiale

In this lesson, we are going to interpolate points data to obtain a raster layer. Before doing it, we will have to do
some data preparation, and after interpolating we will add some extra processing to modify the resulting layer, so
we will have a complete analysis routine.

Deschidei datele exemplu pentru această lecie, care ar trebui să arate astfel.

The data correspond to crop yield data, as produced by a modern harvester, and we will use it to get a raster layer
of crop yield. We do not plan to do any further analysis with that layer, but just to use it as a background layer for
easily identifying the most productive areas and also those where productivity can be improved.

The first thing to do is to clean–up the layer, since it contains redundant points. These are caused by the movement
of the harvester, in places where it has to do a turn or it changes its speed for some reason. The Points filter
algorithm will be useful for this. We will use it twice, to remove points that can be considered outliers both in the
upper and lower part of the distribution.
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Pentru prima execuie, folosii următoarele valori ale parametrilor.

Pentru următoarea execuie, folosii configuraia prezentată mai jos.
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Observai că nu utilizăm stratul original ca intrare, ci rezultatul execuiei anterioare în loc.

The final filter layer, with a reduced set of points, should look similar to the original one, but it contains a smaller
number of points. You can check that by comparing their attribute tables.

Now let’s rasterize the layer using the Shapes to grid algorithm.
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The Filtered points layer refers to the resulting one of the second filter. It has the same name as the one produced
by the first filter, since the name is assigned by the algorithm, but you should not use the first one. Since we will
not be using it for anything else, you can safely remove it from your project to avoid confusion, and leave just the
last filtered layer.

Rezultatul raster arată în felul următor.
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It is already a raster layer, but it is missing data in some of its cells. It only contain valid values in those cells that
contained a point from the vector layer that we have just rasterized, and a no–data value in all the other ones. To
fill the missing values, we can use the Close gaps algorithm.
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Stratul din care lipsesc valorile fără–date arată în felul următor.
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To restrict the area covered by the data to just the region where crop yield was measured, we can clip the raster
layer with the provided limits layer.
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And for a smoother result (less accurate but better for rendering in the background as a support layer), we can
apply a Gaussian filter to the layer.
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Cu parametrii de mai sus, vei primi următorul rezultat

17.22 Mai multe despre interpolare

Note: Acest capitol prezintă alte cazuri practice de folosire a algoritmilor de interpolare.

Interpolation is a common technique, and it can be used to demonstrate several techniques that can be applied using
the QGIS processing framework. This lesson uses some interpolation algorithms that were already introduced, but
has a different approach.

The data for this lesson contains also a points layer, in this case with elevation data. We are going to interpolate it
much in the same way as we did in the previous lesson, but this time we will save part of the original data to use
it for assessing the quality of the interpolation process.

First, we have to rasterize the points layer and fill the resulting no–data cells, but using just a fraction of the points
in the layer. We will save 10% of the points for a later check, so we need to have 90% of the points ready for the
interpolation. To do so, we could use the Split shapes layer randomly algorithm, which we have already used in a
previous lesson, but there is a better way to do that, without having to create any new intermediate layer. Instead
of that, we can just select the points we want to use for the interpolation (the 90% fraction), and then run the
algorithm. As we have already seen, the rasterizing algorithm will use only those selected points and ignore the
rest. The selection can be done using the Random selection algorithm. Run it with the following parameters.
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Se vor selecta 90% dintre punctele din stratul de rasterizat

Selecia este aleatoare, astfel încât selecia dvs. ar putea diferi de selecia arătată în imaginea de mai sus.

Now run the Shapes to grid algorithm to get the first raster layer, and then run the Close gaps algorithm to fill the
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no–data cells [Cell resolution: 100 m].

To check the quality of the interpolation, we can now use the points that are not selected. At this point, we know
the real elevation (the value in the points layer) and the interpolated elevation (the value in the interpolated raster
layer). We can compare the two by computing the differences between those values.

Din moment ce vom folosi punctele care nu sunt selectate, în primul rând, haidei să inversăm selecia.

The points contain the original values, but not the interpolated ones. To add them in a new field, we can use the
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Add grid values to points algorithm

The raster layer to select (the algorithm supports multiple raster, but we just need one) is the resulting one from
the interpolation. We have renamed it to interpolate and that layer name is the one that will be used for the name
of the field to add.

Acum avem un strat vectorial care conine ambele valori, cu punctele care nu au fost utilizate pentru interpolare.
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Acum, vom folosi calculatorul de câmpuri pentru această sarcină. Deschidei algoritmul Calculatorului de câmpuri
i-l vom rula cu următorii parametri.
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If your field with the values from the raster layer has a different name, you should modify the above formula
accordingly. Running this algorithm, you will get a new layer with just the points that we haven’t used for the
interpolation, each of them containing the difference between the two elevation values.

Reprezentând stratul în conformitate cu acea valoare, vom avea o primă idee despre locaia celor mai mari dis-
crepane.

Interpolând acel strat vei obine un strat raster cu eroarea estimată în toate punctele din zona interpolată.
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You can also get the same information (difference between original point values and interpolated ones) directly
with GRASS → v.sample.

Your results might differ from these ones, since there is a random component introduced when running the random
selection, at the beginning of this lesson.

17.23 Execuia iterativă a algoritmilor

Note: Această lecie prezintă un mod diferit de a executa algoritmii care folosesc straturi vectoriale, prin rularea
lor în mod repetat, iterând entităile dintr-un strat vectorial de intrare

Cunoatem deja modelatorul grafic, care reprezintă o modalitate de automatizare a sarcinilor de procesare. Cu
toate acestea, în unele situaii, modelatorul ar putea să nu fie chiar ceea ce ne trebuie pentru a automatiza o anumită
sarcină. Vom vedea una dintre acele situaii, i cum să o rezolvăm cu uurină, folosind o funcionalitate diferită:
executarea iterativă a algoritmilor.

Deschidei datele corespunzătoare acestui capitol. Acesta ar trebui să arate astfel.
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Vei recunoate DEM-ul nostru bine-cunoscut din capitolele anterioare, i un set de bazine hidrografice extrase din
el. Imaginai-vă că trebuie să reducem DEM-ul în mai multe straturi mici, fiecare dintre ele coninând doar datele
de elevaie corespunzătoare unui singur bazin hidrografic. Acest lucru va fi util dacă dorii mai târziu să calculai
unii parametri ce in de fiecare bazine hidrografice, cum ar fi cota de elevaie sau curba hipsographică.

Acest lucru reprezintă o sarcină lungă durată i plictisitoare, mai ales în cazul în care numărul bazinelor hidrografice
este mare. Cu toate acestea, este o sarcină care poate fi uor automatizată, aa cum vom vedea.

The algorithm to use for clipping a raster layer with a polygon layer is called Clip grid with polygons, and has the
following parameters dialog.
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Putei să-l executai folosind stratul bazinelor hidrografice i DEM-ul ca intrare, apoi vei obine următorul rezultat.

După cum putei vedea, se utilizează aria acoperită de toate poligoanele bazinelor hidrografice.

Putei decupa DEM-ul după un singur bazin hidrografic, prin selectarea bazinului dorit, i apoi prin rularea algorit-
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mului aa cum am făcut-o mai înainte.

Deoarece numai entităile selectate sunt folosite, numai poligonul selectat va fi folosit pentru a decupa stratul raster.

Făcând acest lucru pentru toate bazinele, se va produce rezultatul pe care îl căutăm, dar aceasta nu arată ca un mod
foarte practic de lucru. În schimb, să vedem cum automatizăm rutina selectare i decupare.

First of all, remove the previous selection, so all polygons will be used again. Now open the Clip grid with polygon
algorithm and select the same inputs as before, but this time click on the button that you will find in the right–hand
side of the vector layer input where you have selected the watersheds layer.
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Acest buton va cauza divizarea stratului de intrare selectat în mai multe straturi, pe măsură ce se descoperă entităile,
fiecare dintre ele coninând câte un singur poligon. Algoritmul va fi solicitat în mod repetat, câte o dată pentru
fiecare dintre aceste straturi cu un singur poligon. Rezultatul, în loc de un singur strat raster, va consta într-un set
de straturi raster, fiecare dintre ele corespunzând câte unei execuii a algoritmului.

Iată rezultatul pe care îl vei obine, dacă ai rulat algoritmul de tăiere aa cum s-a explicat.
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Pentru fiecare strat, paletă de culori alb-negru, (sau orice paletă pe care o utilizai), este ajustată în mod diferit, de
la minim până la valorile sale maxime. Acesta este motivul pentru care putei vedea diferite piese, iar culorile nu
par a se potrivi la grania dintre straturi. Valorile, cu toate acestea, se potrivesc.

Dacă introducei un nume pentru fiierul de ieire, fiierele rezultate vor fi denumite folosind ca nume de fiier i, ca
sufix, un număr corespunzător pentru fiecare iteraie.

17.24 Mai multe utilizări ale execuiei iterative a algoritmilor

Note: Această lecie vă arată cum să combinai execuia iterativă a algoritmilor cu modelatorul, pentru a extinde
automatizarea.

Execuia iterativă a algoritmilor este disponibilă nu doar pentru algoritmii încorporai, ci, de asemenea, i pentru
algoritmii pe care îi putei crea, cum ar fi modelele. Vom vedea cum putem combina un model cu executarea
iterativă a algoritmilor, astfel încât să putem obine cu uurină rezultate mai complexe.

The data the we are going to use for this lesson is the same one that we already used for the last one. In this
case, instead of just clipping the DEM with each watershed polygon, we will add some extra steps and calculate a
hypsometric curve for each of them, to study how elevation is distributed within the watershed.

Since we have a workflow that involves several steps (clipping + computing the hypsometric curve), we should go
to the modeler and create the corresponding model for that workflow.

You can find the model already created in the data folder for this lesson, but it would be good if you first try to
create it yourself. The clipped layer is not a final result in this case, since we are just interested in the curves, so
this model will not generated any layers, but just a table with the curve data.

Modelul ar trebui să arate astfel:
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Adăugai modelul în dosarul corespunzător, astfel încât el să fie disponibil în bara de instrumente, apoi rulai-l.

Select the DEM and watersheds basins, and do not forget to toggle the button that indicates that the algorithm has
to be run iteratively.

Algoritmul va fi rulat de mai multe ori, iar tabelele corespunzătoare vor fi create i deschise în proiectul dvs. QGIS.
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We can make this example more complex by extending the model and computing some slope statistics. Add the
Slope, aspect, curvature algorithm to the model, and then the Raster statistics algorithm, which should use the
slope output as its only input.

Dacă rulai acum modelul, în afară de tabele, vei obine un set de pagini cu statistici. Aceste pagini vor fi disponibile
în caseta de dialog a rezultatelor.

17.25 Interfaa de prelucrare în serie

Note: Această lecie introduce interfaa de prelucrare în serie, care permite executarea unui singur algoritm, cu un
set de valori de intrare diferite.

Uneori, un anumit algoritm trebuie să fie executat, în mod repetat, cu diferite valori de intrare. Acest lucru este,
de exemplu, cazul în care un set de fiiere de intrare trebuie convertit dintr-un format în altul, sau atunci când mai
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multe straturi dintr-o anumită proiecie trebuie convertite într-o altă proiecie.

În acest caz, apelarea repetată a algoritmului din bara de instrumente nu este cea mai bună opiune. În schimb, ar
trebui folosită interfaa de prelucrare în serie, care simplifică foarte mult efectuarea unei execuii multiple a unui
algoritm dat. Pentru a rula un algoritm ca un proces în serie, identificai-l în bara de instrumente, i în loc de
dublu-clic pe el, facei clic pe el i alegei Rulare ca proces în serie.

Pentru acest exemplu, vom utiliza Reproiectare algoritm, aa că găsii-l i procedai aa cum este descris mai sus. Vei
obine următorul dialog.

Dacă aruncai o privire la datele acestei lecii, vei vedea că acestea conin un set de trei fiiere shape, dar nici un fiier
de proiect QGIS. Aceasta se datorează faptului că, atunci când un algoritm este rulat ca un proces în serie, intrările
stratului pot fi selectate fie din proiectul QGIS curent, fie din fiiere. Asta face mai uoară procesarea unei cantităi
mari de straturi, cum ar fi, de exemplu, toate straturile dintr-un folder dat.

Fiecare rând din tabelul dialogului de prelucrare în serie, reprezintă o singură execuie a algoritmului. Celulele
dintr-un rând corespund parametrului necesar algoritmului, ele nefiind dispuse una deasupra celeilalte, la fel ca
într-un dialog normal de execuie singulară, ci orizontal în acel rând.

Definirea procesului care va rula în serie, constă în completarea tabelului cu valorile corespunzătoare, iar dialogul
în sine conine multe instrumente care fac această sarcină mai uoară.

Să începem completarea, unul câte unul, a câmpurilor. Prima coloană de umplut este Stratul de intrare. În loc
să introducei numele fiecăruia dintre straturile pe care vrem să le procesăm, le putei selecta pe toate, i să lăsăm
dialogul să le ordoneze câte unul în fiecare rând. Facei clic pe butonul din celula din stânga-sus, iar în dialogul
care se va deschide, de selecie a fiierului, selectai trei dosare pentru a fi reproiectate. Din moment ce numai unul
dintre ele este necesar pentru fiecare rând, cele rămase vor fi folosite pentru a umple rândurile de dedesubt.
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Numărul implicit de rânduri este de 3, care este exact numărul de straturi pe care le avem de convertit, dar dacă
selectai mai multe straturi, noi rânduri vor fi adăugate automat. Dacă dorii să umplei manua intrărilel, putei adăuga
mai multe rânduri folosind butonul Adăugare rând.

Vom converti toate acele straturi la CRS-ul EPSG:23029, aa că vom selecta acest CRS în al doilea câmp. Ne dorim
acelai lucru pentru toate rândurile, dar nu trebuie să repetăm aceeai pai pentru fiecare rând. În schimb, stabilim
CRS-ul pentru primul rând (cel din partea de sus), folosind butonul din celula corespunzătoare, i efectuând dublu
clic pe antetul de coloană. Asta va face ca toate celulele din coloană să se completeze utilizând valoarea celulei
superioare.
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În cele din urmă, trebuie să selectai un fiier de ieire pentru fiecare execuie, care va conine stratul reproiectat
corespunzător. Încă o dată, vom face acest lucru doar pentru primul rând. Facei clic pe butonul dn celula de sus, iar
în folderul în care dorii să punei fiierele de ieire, introducei un nume de fiier (de exemplu, reprojected.shp).

Acum, când facei clic pe OK pe dialogul de selecie a fiierului, denumirea fiierului nu va fi automat înscrisă în
celulă, dar o casetă de intrare, similară cu următoarea, va fi afiată în loc.

Dacă selectai prima opiune, atunci doar celula curentă va fi umplută. Dacă o selectai pe oricare dintre celelalte,
toate rândurile vor fi umplute cu un anumit model. În acest caz, vom selecta opiunea Umplere cu valoarea
parametrului, iar apoi valoarea Stratului de intrare din meniul derulant. Acest lucru va determina ca valoarea din
Stratul de intrare (adică, numele stratului) să fie adăugat la numele fiierului pe care l-am adaugat, făcând diferit
fiecare nume de fiier de ieire. Tabelul de prelucrare în serie ar trebui să arate astfel.
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Ultima coloană stabilete dacă, sau nu, se vor adăuga straturile rezultate la proiectul QGIS curent. Lăsai implicită
opiunea Da, astfel încât să putei vedea rezultatele, în acest caz.

Facei clic pe OK pentru a rula procesarea în serie. Dacă totul a mers bine, toate straturile vor fi procesate, i vor fi
create 3 straturi noi.

17.26 Modelele în interfaa de prelucrare a loturilor

Warning: Atenie, deoarece acest capitol nu este bine testat, vă rugăm să raportai orice problemă; imaginile
lipsesc

Note: Această lecie prezintă un alt exemplu de interfaă de prelucrare a loturilor, dar de data aceasta cu ajutorul
unui model în locul unui algoritm încorporat

Modelele sunt similare oricărui alt algoritm, ele putând fi utilizate în interfaa de prelucrare a loturilor. Pentru a
demonstra aceasta, iată un scurtă exemplu în care folosim modelul nostru hidrologic, bine-cunoscut deja.

Asigurai-vă că avei modelul adăugat la setul de instrumente, apoi rulai-l ca lot. Iată cum ar trebui sa arate dialogul
de prelucrare a lotului:

Warning: todo: De adăugat imaginea

Adăugai un total de 5 rânduri. Selectai fiierul DEM corespunzător acestei lecii ca intrare pentru ele. Apoi intro-
ducei 5 valori de prag diferite, aa cum se arată în continuare.

Warning: todo: De adăugat imaginea

După cum vedei, interfaa de prelucrare a lotului poate funciona nu doar la rularea aceluiai proces pe diferite seturi
de date, dar, de asemenea, i pe acelai set de date cu parametrii diferii.
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Facei clic pe OK, după care ar trebui să obinei 5 noi straturi, cu bazinele corespunzătoare celor 5 valoril de prag
specificate.

17.27 Alte programe

**Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Note: Acest capitol vă arată cum să utilizai programe suplimentare din interiorul Procesării. Pentru a finaliza,
trebuie să avei instalate pachetele relevante, cu ajutorul instrumentelor specifice sistemului de operare.

17.27.1 GRASS

GRASS este o suită GIS gratuită, cu sursă deschisă, pentru managementul i analiza datelor geospaiale, pentru
prelucrare de imagine i grafică, producie de hări, modelare i vizualizare spaială.

Acesta este instalat în mod implicit în Windows, cu ajutorul pachetului de instalare independent OSGeo4W (32 i
64 bii), existând pachete i pentru toate distribuiile majore de Linux.

17.27.2 R

R este un mediu software cu sursă liberă i deschisă, pentru calcul statistic i grafică.

Acesta trebuie să fie instalat separat, împreună cu unele biblioteci necesare (LIST).

Frumuseea implementării Proceing este că putei adăuga propriile script-uri, fie simple sau complexe, acestea
pputând fi apoi utilizate ca orice alt modul, conectate în fluxuri de lucru mai complexe, etc.

Testai unele dintre exemplele preinstalate, dacă avei R deja instalat (amintii-vă să activai modulele R din interfaa
de configurare generală a Processing).

17.27.3 OTB

OTB (also known as Orfeo ToolBox) is a free and open source library of image processing algorithms. It is
installed by deafult on Windows through the OSGeo4W standalone installer (32 bit). Paths should be configured
in Processing.

Într-o instalare standard de Windows OSgeo4W, căile vor fi:

OTB application folder C:\OSGeo4W\apps\orfeotoolbox\applications
OTB command line tools folder C:\OSGeo4W\bin

Pe Debian i pe distribuiile derivate, aceasta va fi /usr/bin

17.27.4 Altele

TauDEM este o suită de instrumente de Modelare Digitală a Elevaiei (DEM), pentru extragerea i analizarea infor-
maiilor hidrologice. Disponibilitatea în diferite sisteme de operare este variabilă.

LASTools reprezintă un set de comenzi mixte, libere i proprietare, pentru a procesa i analiza datele Lidar. Disponi-
bilitatea în diferite sisteme de operare este variabilă.

Mai multe instrumente sunt disponibile, prin intermediul plugin-urilor suplimentare, cum ar fi:

• LecoS: o suită de statistici de acoperire a terenului i de ecologie a peisajului

• lwgeom: fostă parte din PostGIS, această bibliotecă aduce câteva instrumente utile pentru curăarea geome-
triei
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• Animove: instrumente de analiză a unei serii de animale domestice.

Mai multe vor urma.

17.27.5 Comparaie între backend-uri.

Distane i tampoane

Haidei să încărcăm points.shp i să scriem‘‘buf‘‘ în filtrul instrumentului din bara de instrumente, apoi facei
dublu clic pe el:

• Tamponul cu distană fixă: Distana 10000

• Tamponul cu distană variabilă: MĂRIMEA câmpului distană

• v.buffer.distance: distana 10000

• v.buffer.column: MĂRIMEA bufcolumn

• Shapes Buffer: valoarea fixă 10000 (dissolve i not), câmpul atribut (cu scalare)

Vedei câtă viteză diferă, i câte opiuni sunt disponibile.

Exerciiul pentru cititor: găsii diferenele din geometria rezultată prin metodele diferite.

Acum, tampoanele i distanele:

• în primul rând, încărcai i rasterizai vectorul rivers.shp cu GRASS → v.to.rast.value; atenie: mărimea
celulelor trebuie să fie setată la 100 m, în caz contrar timpul de calcul va fi enorm; harta rezultată va conine
1 i NULL-uri

• la fel, cu SAGA → Shapes to Grid → COUNT (harta rezultată: de la 6 la 60)

• then, proximity (value= 1 for GRASS, a list of rivers ID for SAGA), r.buffer with parameters
1000,2000,3000, r.grow.distance (the first of the two maps).

Dizolvare

Dizolvare entităi pe baza unui atribut comun:

• GRASS → v.dissolve municipalities.shp pe PROVINCIE

• QGIS → Dissolve municipalities.shp pe PROVINCIE

• SAGA → Polygon Dissolve municipalities.shp pe PROVINCIE (NB: Păstrare granie interioare
trebuie să fie neselectat)

Warning: Ultima nu funcionează în SAGA <=2.10

Exerciiu pentru cititor: găsii diferenele (de geometrie i de atribute) prin metode diferite.

17.28 Interpolarea i conturarea

**Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Note: Acest capitol prezintă folosirea diferitelor variante de calcularre a interpolărilor.
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17.28.1 Interpolarea

Proiectul prezintă un gradient de precipitaii, de la sud la nord. Să folosim metode diferite pentru interpolare, toate
bazate pe vectorul points.shp, parametrul RAIN:

Warning: Setează dimensiunea celulei la 500 pentru toate analizele.

• GRASS → v.surf.rst

• SAGA → nterpolare B-Spline Multinivel

• SAGA → Inverse Distance Weighted [Power: 4; Search range: Global]

• GDAL → Grilă (Distana inversă către o putere) [Putere:4]

• GDAL → Grilă (Deplasări medii) [Raza1&2: 50000]

Apoi măsurai variaia dintre metode i corelai-o cu distana până la puncte:

• GRASS → r.series [Deselectare NULL-uri Propagate, Operaia de Agregare: stddev]

• GRASS → v.to.rast.value asupra points.shp

• GDAL → Proximitatea

• GRASS → r.covar pentru a arăta matricea de corelaie; verificai semnificaia corelaiei, de exemplu, cu
http://vassarstats.net/rsig.html.

Astfel, zonele de puncte îndepărtate vor avea o interpolare mai puin precisă.

17.28.2 Curbe de nivel

Diverse metode pentru a desena linii de contur [întotdeauna pasul= 10] în rasterul stddev:

• GRASS → r.contour.step

• GDAL → Curbe de nivel

• SAGA → Curbele de nivel din grilă [NB: shp-ul de ieikre nu este valid, eroarea fiind cunoscută]

17.29 Simplificarea i netezirea vectorilor

**Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Note: Acest capitol prezintă modalităile de simplificare a vectorilor, precum i de netezire a colurilor ascuite.

Uneori avem nevoie de o versiune simplificată a unui vector, pentru a avea o dimensiune mai mică de fiier i pentru a
scăpa de detaliile inutile. Multe instrumente fac acest lucru într-un mod foarte brut, omiând uneori corectitudinea
topologică i adiacena poligoanelor. GRASS este instrumentul ideal pentru acest lucru: fiind un GIS topologic,
adiacena i corectitudinea sunt păstrate chiar i la niveluri foarte ridicate de simplificare. În cazul nostru, avem un
vector rezultat dintr-un raster, fapt indicat de modelul “zimilor” de la frontiere. Aplicarea simplificării va produce
linii drepte:

• GRASS → v.generalize [Valoarea toleranei maxime: 30 m]

De asemenea, putem proceda i invers, făcând un strat mai complex, prin netezirea colurilor ascuite:

• GRASS → v.generalize [methoda: chaiken]

Încercai să aplicai această a doua comandă atât vectorului iniial, cât i celui de la prima analiză, pentru a vedea
diferena. Reinei că adiacena nu este pierdută.

Această a doua opiune se poate aplica, de exemplu, curbelor de nivel care rezultă dintr-o raster grosier, la traseele
GPS cu noduri rare, etc.
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17.30 Planificarea unei ferme solare

**Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Note: Acest capitol arată cum să utilizai diverse criterii, în scopul localizării zonelor potrivite pentru instalarea
unei centrale fotovoltaice

Mai întâi de toate, creai o hartă a aspectului dintr-un DTM:

• GRASS → r.aspect [Tipul datei: int; cell size:100]

În GRASS, aspectul este calculat în grade, în sens invers acelor de ceasornic, pornind de la Est. Pentru a extrage
numai pantele orientate spre Sud (270 de grade +- 45), putem să-l reclasificăm:

• GRASS → r.reclass

cu următoarele reguli:

225 thru 315 = 1 south

* = NULL

Putei utiliza fiierul text furnizat, reclass_south.txt. De asemenea, reinei că, folosind aceste fiiere text
simple, putem crea reclasificări foarte complexe.

Dorim să construim o fermă mare, astfel încât vom selecta doar zonele învecinate mari (> 100 ha):

• GRASS → r.reclass.greater

În final, le convertim într-un vector:

• GRASS → r.to.vect [Tipul entităii: arie; Coluri netede: da]

Exerciiu pentru cititor: repetai analiza, înlocuind comenzile GRASS cu unele similare cu ale altor programe.
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CHAPTER 18

Module: Folosirea Bazelor de Date Spaiale în QGIS

În acest modul vei învăa despre modul de utilizare a bazelor de date spaiale în QGIS, pentru a gestiona, afia i
manipula datele, precum i pentru a le analiza prin efectuarea de interogări. Vom folosi în principal PostgreSQL i
PostGIS (care au fost acoperite în seciunile anterioare), dar aceleai concepte sunt aplicabile i altor implementări
de baze de date spaiale, inclusiv spatialite.

18.1 Lesson: Lucrul cu Baze de Date în Navigatorul QGIS

În cele 2 module anterioare am atins concepte de bază, facilităi i funcii de bază ale bazelor de date relaionale i ex-
tensii care permit stocarea, administrarea, interogarea i manipularea datelor spaiale într-o bază de date relaională.
Această seciune va intra în detaliu pentru utilizarea eficientă a bazelor de date spaiale în QGIS.

Scopul acestei lecii: Să învăai cum să interacionai cu bazele de date spaiale utilizănd interfaa QGIS.

18.1.1 Follow Along: Adăugarea Tabelelor Bazei de Date în QGIS folosind
Navigatorul

Am văzut, pe scurt, cum pot fi adăugate, sub formă de straturi QGIS, tabelele dintr-o bază de date; haidei acum
să intrăm în mai multe detalii i să vedem diferite moduri de a face acest lucru în QGIS. Să aruncăm, mai întâi, o
privire la noua interfaă a Navigatorului.

• Începei o nouă hartă goală în QGIS.

• Deschidei Navigatorul efectuând un clic pe fila Browser, din partea de jos a Panoului Straturilor

• Deschidei poriunea PostGIS a arborelui, pentru a găsi conexiunea configurată anterior (poate fi necesar să
facei clic pe butonul Refresh, din partea de sus a ferestrei navigatorului).
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• Un clic dublu pe oricare din tabelele/straturile listate aici, îl va adăuga la Canevasul Hării.

• Right Clicking on a table/layer in this view will give you a few options. Click on the Properties item to look
at the properties of the layer.
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Note: De asemenea, putei utiliza această interfaă pentru a vă conecta, de la staia dvs. de lucru, la bazele de
date PostGIS găzduite pe un server extern. Un clic dreapta pe intrarea PostGIS din arbore vă permite să specificai
parametrii de conectare ai noii conexiuni.

18.1.2 Follow Along: Adăugarea unui set filtrat de înregistrări sub forma
unui Strat

Now that we have seen how to add an entire table as a QGIS layer it might be nice to learn how to add a filtered
set of records from a table as a layer by using queries that we learned about in previous sections.

• Începei o nouă hartă goală, fără straturi

• Click the Add PostGIS Layers button or select Layer –> Add PostGIS Layers from the menu.

• In the Add PostGIS Table(s) dialog that comes up, connect to the postgis_demo connection.

• Expand the public schema and you should find the three tables we were working with previously.

• Click the lines layer to select it, but instead of adding it, click the Set Filter button to bring up the Query
Builder dialog.

• Construii următoarea expresie, utilizând butoanele sau prin introducerea directă:

"roadtype" = ’major’
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• Click OK to complete editing the filter and click Add to add the filtered layer to your map.

• Redenumire strat lines din arborele roads_primary.

Vei observa că numai Drumurile Primare au fost adăugate pe hartă, i nu întregul strat.

18.1.3 In Conclusion

Ai văzut cum se poate interaciona cu bazele de date spaiale, folosind QGIS Browser, i modul în care se pot adăuga
straturi pe hartă, în funcie de un filtru de interogare.

18.1.4 What’s Next?

În continuare, este prezentat lucrul cu interfaa Managerului DB din QGIS, pentru o serie mai amplă de sarcini de
gestiune a bazelor de date.

18.2 Lesson: Utilizarea DB Manager din QGIS, în lucrul cu bazele
de date spaiale

We have already seen how to perform many database operations with QGIS as well as with other tools, but now it’s
time to look at the DB Manager tool which provides much of this same functionality as well as more management
oriented tools.

Scopul acestei lecii: De a se învăa interaciunea cu bazele de date raster, folosind interfaa DB Manager din QGIS.

18.2.1 Follow Along: Gestionarea Bazelor de date PostGIS cu ajutorul DB
Manager

You should first open the DB Manager interface by selecting Database –> DB Manager –> DB Manager on the
menu or by selecting the DB Manager icon on the toolbar.

You should already see the previous connections we have configured and be able to expand the myPG section and
its public schema to see the tables we have worked with in previous sections.

The first thing you may notice is that you can now see some metadata about the Schemas contained in your
database.
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Schemas are a way of grouping data tables and other objects in a PostgreSQL database and a container for per-
missions and other constraints. Managing PostgreSQL schemas is beyond the scope of this manual, but you can
find more information about them in the PostgreSQL documentation on Schemas. You can use the DB Manager
to create new Schemas, but will need to use a tool like pgAdmin III or the command line interface to manage them
effectively.

DB Manager can also be used to manage the tables within your database. We have already looked at various ways
to create and manage tables on the command line, but now lets look at how to do this in DB Manager.

First, its useful to just look at a table’s metadata by clicking on its name in tree and looking in the Info tab.
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In this panel you can see the General Info about the table as well the information that the PostGIS extension
maintains about the geometry and spatial reference system.

If you scroll down in the Info tab, you can see more information about the Fields, Constraints and Indexes for the
table you are viewing.
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Its also very useful to use DB Manager to simply look at the records in the database in much the same way you
might do this by viewing the attribute table of a layer in the Layer Tree. You can browse the data by selecting the
Table tab.
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Există, de asemenea o filă Preview, care vă va arăta datele stratului într-o hartă de previzualizare.

Click-dreapta pe unul dintre straturi i, făcând clic pe Add to Canvas, acesta se va adăuga pe hartă.

So far we have only been viewing the database its schemas and tables and their metadata, but what if we wanted
to alter the table to add an additional column perhaps? DB Manager allows you to do this directly.

• Selectai din arbore tabela pe care dorii să o editai

• Selectai meniul Table –> Edit Table‘pentru a deschide dialogul :guilabel:‘Tabelei de Proprietăi.

Putei folosi acest dialog pentru a Adăuga Coloane, Coloane pentru geometrii, pentru a edita coloanele existente
sau pentru a elimina complet o coloană.

Using the Constraints tab, you can manage which fields are used as the primary key or to drop existing constraints.
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Fila Indecilor poate fi folosită pentru a adăuga i terge atât indicii spaiali, cât i cei normali.
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18.2.2 Follow Along: Crearea unei Noi Tabele

Acum, că am trecut prin procesul de lucru cu tabelele existente în baza noastră de date, haidei să folosim DB
Manager pentru a crea o nouă tabelă.

• În cazul în care nu este deschisă deja, deschidei fereastra DB Manager, i apoi extindei arborele până când
se vede lista tabelelor prezente deja în baza dvs. de date.

• Selectai meniul :guilabel:‘Table –> Create Table‘pentru a deschide dialogul de Creare a Tabelei.

• Folosii schema Public, implicită, i denumii tabela places.

• Adugai câmpurile id, place_name i elevation, aa cum se arată mai jos

• Asigurai-vă că ai setat câmpul id ca i cheie primară.

• Click the checkbox to Create geometry column and make sure it is set to a POINT type and leave it named
geom and specify 4326 as the SRID.

• Click the checkbox to Create spatial index and click Create to create the table.
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• Dismiss the dialog letting you know that the table was created and click Close to close the Create Table
Dialog.

You can now inspect your table in the DB Manager and you will of course find that there is no data in it. From
here you can Toggle Editing on the layer menu and begin to add places to your table.

18.2.3 Follow Along: Tehnici de bază pentru administrarea bazei de date

The DB Manager will also let you do some basic Database Administration tasks. It is certainly not a substitute for
a more complete Database Administration tool, but it does provide some functionality that you can use to maintain
your database.

Database tables can often become quite large and tables which are being modified frequently can end up leaving
around remnants of records that are no longer needed by PostgreSQL. The VACUUM command takes care of
doing a kind of garbage collection to compact and optional analyze your tables for better performance.

Să aruncăm o privire la modul în care putem efectua o comandă VACUUM ANALYZE din cadrul DB Manager.

• Selectai una dintre tabelele din Arborele DB Manager.

• Selectai Table –> Run Vacuum Analyze din meniu.

Asta e! PostgreSQL va efectua operaiunea. În funcie de cât de mare este tabela dvs., poate dura ceva timp până la
încheiere.
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Putei găsi mai multe informaii despre procesul de ANALIZĂ VACUUM din Documentaia PostgreSQL referitoare
la ANALIZA VACUUM

18.2.4 Follow Along: Executarea Interogărilor SQL cu ajutorul DB Manager

DB Manager also provides a way for you to write queries against your database tables and to view the results. We
have already seen this type of functionality in the Browser panel, but lets look at it again here with DB Manager.

• Selectai din arbore tabela linii.

• Selectai butonul SQL window din bara de instrumente DB Manager.

• Compunei următoarea Interogare SQL în spaiul furnizat:

select * from lines where roadtype = ’major’;

• Clic pe butonul Execute (F5) pentru a rula interogarea.

• Ar trebui să vedei acum înregistrările care corespund panoului Rezultate.

• Facei clic pe caseta de bifare Load as new layer pentru a adăuga rezultatele în harta dvs.

• Select the id column as the Column with unique integer values and the geom column as the Geometry
column.

• Introducei roads_primary ca i Nume pentru strat (prefix).

• Facei clic pe Load now! pentru a încărca rezultatele ca un nou strat în harta dvs.
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The layers that matched your query are now displayed on your map. You can of course use this query tool to
execute any arbitrary SQL command including many of the ones we looked at in previous modules and sections.

18.2.5 Importarea datelor dintr-o Bază de date cu ajutorul DB Manager

We have already looked at how to import data into a spatial database using command line tools and also looked at
how to use the SPIT plugin, so now lets learn how to use DB Manager to do imports.

• Clic pe butonul Import layer/file din Bara de Instrumente a dialogului DB Manager.

• Selectai fiierul urban_33S.shp din exercise_data/projected_data ca i set de date de intrare.

• Clic pe butonul Opiunilor de actualizare pentru a pre-completa unele din valorile formularului.

• Asigurai-vă că este selectată opiunea Creare tabelă nouă.

• Specificai 32722 pentru SRID-ul Sursă i 4326 pentru SRID-ul Destinaie.

• Activai caseta de bifare pentru a Crea îndexul Spaial

• Clic pe OK, pentru a se efectua importul.
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• Închidei dialogul care vă informează că importul a avut loc cu succes

• Clic pe butonul Refresh din Bara de Instrumente DB Manager.

You can now inspect the table in your database by clicking on it in the Tree. Verify that the data has been
reprojected by checking that the Spatial ref: is listed as WGS 84 (4326)
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Right clicking on the table in the Tree and a selecting Add to Canvas will add the table as a layer in your map.

18.2.6 Exportul datelor cu DB Manager dintr-o Bază de date

De asemenea, DB Manager se poate utiliza pentru exportul datelor din bazele de date spaiale, aa că haidei să
aruncăm o privire la modul în care se face aceasta.

• Select the lines layer in the Tree and click the Export to File button on the toolbar to open the Export to
vector file dialog.

• Click the ... button to select the Output file and save the data to your exercise_data directory as
urban_4326.

• Introducei 4326 în Target SRID.

• Clic OK pentru a iniializa exportul.
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• Închidei dialogul care vă informează că exportul a avut loc cu succes, apoi închidei DB Manager.

Putei inspecta de acum fiierul shape pe care l-ai creat cu panoul de Răsfoire.

568 Chapter 18. Module: Folosirea Bazelor de Date Spaiale în QGIS



QGIS Training Manual, Release 2.8

18.2.7 In Conclusion

Ai aflat cum să folosii de acum interfaa DB Manager din QGIS, pentru a gestiona bazele de date spaiale, pentru a
executa interogări SQL asupra datelor dvs. i cum să importai i să exportai datele.

18.2.8 What’s Next?

Next, we will look at how to use many of these same techniques with spatialite databases.

18.3 Lesson: Lucrul cu bazele de date SpatiaLite în QGIS

În vreme ce PostGIS este în general utilizat pe un server, pentru a furniza capabilităile bazei de date spaiale către
mai muli utilizatori în acelai timp, QGIS acceptă i utilizarea unui format de fiier numit spatialite, care reprezintă
un mod uor, portabil, de stocare într-un singur fişier a unei întregi baze de date spaiale. În mod evident, aceste 2
tipuri de baze de date spaiale ar trebui să fie utilizate în scopuri diferite, dar ambelor li se aplică aceleai principii
i tehnici de bază. Haidei să creăm o nouă bază de date spatialite i să explorăm în QGIS funcionalitatea oferită de
aceste baze de date.

Scopul acestei lecii: De a afla cum se poate lucra cu bazele de date raster în interfaa Navigatorului QGIS.

18.3.1 Follow Along: Crearea unei Baze de Date Spatialite cu Navigatorul

Utilizând panoul Navigatorului, putem crea o nouă bază de date SpatiaLite i să-l configurăm pentru utilizarea în
QGIS.

• Facei clic-dreapta pe intrarea Spatialite din arborele Navigatorului, apoi selectai Creare Bază de Date.

• Precizai unde dorii să stocai fiierul în sistemul de fiiere, i să-l denumii qgis-sl.db.

• Efectuai iarăi clic-dreapta pe intrarea Spatialite din arborele Navigatorului, apoi alegei Conexiune Nouă.
Găsii fiierul creat la ultimul pas i deschidei-l.

Acum, că v-ai configurat noua bază de date, vei descoperi că intrarea din arborele Navigatorului nu are nimic sub
ea, iar singurul lucru pe care îl putei face în acest moment este de a terge conexiunea. Acest lucru se datorează
faptului că, desigur, noi nu am adăugat nici un tabel în această bază de date. Haidei să mergem mai departe i să
facem asta.

• Găsii butonul pentru a crea un nou strat i pentru a folosi meniul vertical pentru a crea un nou strat SpatiaLite,
sau să selectai Layer –> New –> New Spatialite Layer.

• Selectai baza de date pe care am creat-o în paii anteriori în meniul derulant.

• Denumii stratul places.

• Bifai caseta de lângă Create an auto-incrementing primary key.

• Adăugai 2 atribute, aa cum se arată mai jos

• Clic pe OK, pentru a crea tabela.
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• Facei clic pe butonul de reîmprospătare din partea de sus a Navigatorului, pentru a vedea tabela places
listată.
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Putei să facei clic dreapta pe tabelă i să-i vizualizai proprietăile, aa cum am făcut-o în exerciiul precedent.

De aici putei începe o sesiune de editare i să adăugai date direct la noua bază de date.

De asemenea, am aflat despre cum să importăm datele într-o bază de date utilizând Manager DB, putând utiliza
aceeai tehnică pentru a importa datele în noul DB spatialite.

18.3.2 In Conclusion

Ai văzut cum să creai baze de date SpatiaLite i să adăugai tabele la ele, pentru a le utiliza ca i straturi în QGIS.
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CHAPTER 19

Anexă: Contribuii La Acest Manual

Pentru a adăuga material în acest curs este necesar de urmărit ghidul din anexă. Nu avei voie să alterai condiiile
din Anexă dar putei extinde cu clarificări. Acest lucru este necesar pentru sigurana calităii i consistenei acestui
manual.

19.1 Descărcare resurse.

Sursa acestui document se poate găsi la GitHub. Consultai GitHub.com pentru instruciunile de folosire a sistemu-
lui de versionare git.

19.2 Formatul Manualului

Acest manual este scris folosind Sphinx, un generator de documente Python care folosete limbajul cu marcaje
reStructuredText. Instruciuni privind modul de utilizare a acestor instrumente sunt disponibile pe site-urile core-
spunzătoare.

19.3 Adăugarea unui Modul

• Pentru a adăuga un nou modul, mai întâi creai un nou director (direct sub nivelul superior al directorului
qgis-training-manual) având numele noului modul.

• În cadrul acestui nou director, creai un fiier denumit index.rst. Lăsai acest fiier gol pentru moment.

• Deschidei fiierul index.rst de sub directorul de nivel superior. Primele linii sunt:

.. toctree::
:maxdepth: 2

foreword/index
introduction/index

Reinei că aceasta este o listă a numelor de directoare, urmată de denumirea index. Ea direcionează fiierul index
de nivel superior spre fiierele index din fiecare director. Ordinea în care sunt listate determină ordinea pe care o
vor avea în document.

• Adăugai numele noului modul (adică, numele dat noului director), urmat de /index, în această listă, ori
de câte ori dorii să apară modulul.

• Amintii-vă să meninei ordinea modulelor logice, astfel încât modulele ulterioare se construiesc pe
cunotinele prezentate în modulele anterioare.

• Deschidei propriul fiier index al noului modul ([module name]/index.rst).
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• În partea de sus a paginii, adăugai o linie de 80 de asteriscuri (*). Aceasta reprezintă un antet de modul.

• Follow this with a line containing the markup phrase |MOD| (which stands for “module”), followed by the
name of your module.

• Încheiai cu o altă linie de 80 de asteriscuri.

• Lăsai o linie deschisă după aceasta.

• Scriei un scurt paragraf, explicând scopul i coninutul modulului.

• Lăsai o linie deschisă, apoi adăugai următorul text:

.. toctree::
:maxdepth: 2

lesson1
lesson2

... unde lesson1, lesson2, etc., sunt numele leciilor planificate.

Fiierul index la nivel de modul va arăta astfel:

*******************************************************************************
|MOD| Module Name

*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

19.4 Adăugarea unei Lecii

Pentru a adăuga o lecie pentru un modul nou sau existent:

• Deschidei directorul modulului

• Deschidei fiierul index.rst (creat mai sus, în cazul noilor module).

• Asigurai-vă că numele leciei planificate este listat sub directiva toctree, aa cum se arată mai sus.

• Creai un nou fiier în directorul modulul.

• Folosii pentru acest fiier exact acelai nume pe care l-ai specificat în fiierul modulului index.rst, appoi
adăugai extensia .rst.

Note: În scopuri de editare, un fiier .rst funcionează exact ca un fiier text obinuit (.txt).

• Pentru a începe scrierea leciei, scriei fraza de marcare |LS|, urmată de numele leciei.

• În următoarea linie, adăugai 80 de semne egal (=).

• Lăsai o linie deschisă după aceasta.

• Scriei o scurtă descriere asupra scopului leciei.

• Includei o introducere generală în subiect. Parcurgei leciile existente în acest manual, pentru exemple.

• Sub aceasta, începei un nou alineat, începând cu această frază:
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**The goal for this lesson:**

• Explicai pe scurt rezultatul intenionat al completării acestei lecii.

• If you can’t describe the goal of the lesson in one or two sentences, consider breaking the subject matter up
into multiple lessons.

Fiecare lecie va fi împărită în mai multe seciuni, care vor fi abordate în continuare.

19.5 Adăugarea unei Seciuni

Există două tipuri de seciuni: “procedai în mod similar” i “încercai singuri”.

• A “follow along” section is a detailed set of directions intended to teach the reader how to use a given aspect
of QGIS. This is typically done by giving click-by-click directions as clearly as possible, interspersed with
screenshots.

• A “try yourself” section gives the reader a short assignment to try by themselves. It is usually associated
with an entry in the answer sheet at the end of the documentation, which will show or explain how to
complete the assignment, and will show the expected outcome if possible.

Every section comes with a difficulty level. An easy section is denoted by |basic|, moderate by |moderate|,
and advanced by |hard|.

19.5.1 Adăugai o seciune “procedai în mod similar”

• Pentru a începe această seciune, scriei fraza de marcare a nivelului de dificultate intenionat (după cum se
arată mai sus).

• Lăsai un spaiu i apoi scriei |FA| (pentru “procedai în mod similar”).

• Leave another space and write the name of the section (use only an initial capital letter, as well as capitals
for proper nouns).

• In the next line, write a line of 80 minuses/dashes (-). Ensure that your text editor does not replace the
default minus/dash character with a long dash or other character.

• Write a short introduction to the section, explaining its purpose. Then give detailed (click-by-click) instruc-
tions on the procedure to be demonstrated.

• În fiecare seciune, includei link-uri interne, link-uri externe i capturi de ecran după cum este necesar.

• Încercai să terminai fiecare seciune cu un scurt paragraf, care să se încheie i să conducă în mod natural la
seciunea următoare, dacă este posibil.

19.5.2 Adăugai o seciune “încercai singuri”

• Pentru a începe această seciune, scriei fraza de marcare a nivelului de dificultate intenionat (după cum se
arată mai sus).

• Lăsai un spaiu i apoi scriei |TY| (pentru “încercai singuri”).

• In the next line, write a line of 80 minuses/dashes (-). Ensure that your text editor does not replace the
default minus/dash character with a long dash or other character.

• Explicai exerciiul pe care dorii ca cititorul să-l finalizeze. Consultai seciunile anterioare, leciile sau mod-
ulele, dacă este necesar.

• Includei capturi de ecran pentru a clarifica cerinele, în cazul în care o descriere textuală simplă nu este de
ajuns.

In most cases, you will want to provide an answer regarding how to complete the assignment given in this section.
To do so, you will need to add an entry in the answer sheet.
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• First, decide on a unique name for the answer. Ideally, this name will include the name of the lesson and an
incrementing number.

• Creai o legătură pentru acest răspuns:

:ref:‘Check your results <answer-name>‘

• Deschidei pagina răspunsului (answers/answers.rst).

• Creai o legătură către seciunea “încercai singuri”, prin scrierea acestei linii:

.. _answer-name:

• Scriei instruciunile despre modul de completare a sarcinii, folosind link-uri i imagini acolo unde este nevoie.

• Pentru a încheia, includei o legătură către seciunea “încercai singuri”, prin scrierea acestei linii:

:ref:‘Back to text <backlink-answer-name>‘

• Pentru a face această linie să funcioneze, includei linia următoare deasupra antetului seciunii “încercai
singuri”:

.. _backlink-answer-name:

Remember that each of these lines shown above must have a blank line above and below it, otherwise it could
cause errors while creating the document.

19.6 Adăugarea unei Concluzii

• To end a lesson, write the phrase |IC| for “in conclusion”, followed by a new line of 80 minuses/dashes
(-). Write a conclusion for the lesson, explaining which concepts have been covered in the lesson.

19.7 Adăugarea unei Seciuni de Lecturi suplimentare

• Această seciune este opională.

• Write the phrase FR for “further reading”, followed by a new line of 80 minuses/dashes (-).

• Includei trimiteri către site-urile externe corespunzătoare.

19.8 Adăugarea Seciunii “Ce Urmează”

• Scriei fraza |WN| pentru “ce urmează”, însoită de o nouă linie de 80 de minusuri/liniue (-).

• Explicai modul în care a pregătit această lecie studenii pentru lecia sau modulul următor.

• Remember to change the “what’s next” section of the previous lesson if necessary, so that it refers to your
new lesson. This will be necessary if you have inserted a new lesson among existing lessons, or after an
existing lesson.

19.9 Utilizarea Marcajelor

Pentru a adera la standardele acestui document, va trebui să adăugai marcajul standard textului dvs.
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19.9.1 Noi concepte

• If you are explaining a new concept, you will need to write the new concept’s name in italics by enclosing
it in asterisks (*).

This sample text shows how to introduce a *new concept*.

19.9.2 Atenie specială

• To emphasize a crucial term which is not a new concept, write the term in bold by enclosing it in double
asterisks (**).

• Use this sparingly! If used too much, it can seem to the reader that you are shouting or being condescending.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

19.9.3 Imagini

• Când adăugai o imagine, salvai-o în folderul _static/lesson_name/.

• Includei-l în document, în felul următor:

.. image:: /static/training_manual/lesson_name/image_file.extension
:align: center

• Nu uitai să lăsai o linie, deasupra i dedesubtul marcajului imaginii.

19.9.4 Legături interne

• To create an anchor for a link, write the following line above the place where you want the link to point to:

.. _link-name:

• Pentru a crea o legătură, adăugai această linie:

:ref:‘Descriptive link text <link-name>‘

• Nu uitai să lăsai o linie, deasupra i dedesubtul acestei linii.

19.9.5 Legături externe

• Pentru a crea o legătură externă, scriei-o astfel:

‘Descriptive link text <link-url>‘_

• Nu uitai să lăsai o linie, deasupra i dedesubtul acestei linii.

19.9.6 Utilizai text monospaiat

• When you are writing text that the user needs to enter, a path name, or the name of a database element such
as a table or column name, you must write it in monospaced text. For example:

Enter the following path in the text box: :kbd:‘path/to/file‘.
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19.9.7 Etichetarea elementelor GUI

• If you are referring to a GUI item, such as a button, you must write its name in the GUI label format. For
example:

To access this tool, click on the :guilabel:‘Tool Name‘ button.

• Acest lucru se aplică, de asemenea, dacă menionai numele unui instrument fără a cere utilizatorului să
efectueze clic pe un buton.

19.9.8 Selecia meniului

• Dacă ghidai un utilizator prin meniuri, trebuie să utilizai menu → selection → format. De exemplu:

To use the :guilabel:‘Tool Name‘ tool, go to :menuselection:‘Plugins -->
Tool Type --> Tool Name‘.

19.9.9 Adăugarea notelor

• You might need to a note in the text, which explains extra details that can’t easily be made part of the flow
of the lesson. This is the markup:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]

19.9.10 Adăugarea o notă de sponsorizare/drepturi de autor

If you are writing a new module, lesson or section on behalf of a sponsor, you must include a short sponsor message
of their choice. This must notify the reader of the name of the sponsor and must appear below the heading of the
module, lesson or section that they sponsored. However, it may not be an advertisement for their company.

If you have volunteered to write a module, lesson or section in your own capacity, and not on behalf of a spon-
sor, you may include an authorship note below the heading of the module, lesson or section that you authored.
This must take the form This [module/lesson/section] contributed by [author name].
Do not add further text, contact details, etc. Such details are to be added in the “Contributors” section of the
Foreword, along with the name(s) of the part(s) you added. If you only made enhancements, corrections and/or
additions, list yourself as an editor.

19.10 Mulumiri!

Vă mulumim pentru contribuia la acest proiect! Procedând astfel, facei QGIS mai accesibil pentru utilizatori i
adăugai valoare întregului proiect QGIS.
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CHAPTER 20

Fiă de răspunsuri

20.1 Results For Adăugarea Primului Dvs. Strat

20.1.1 Pregătire

Ar trebui să vedei o mulime de linii, simbolizând drumuri. Toate aceste linii se află în stratul vectorial pe care
tocmai l-ai încărcat pentru a crea o hartă de bază.

Înapoi la textul

20.2 Results For O privire de ansamblu asupra interfeei

20.2.1 Vedere Generală (Partea 1)

Consultai iarăi imaginea care prezintă aspectul interfeei i verificai dacă vă amintii numele i funciile elementelor
de pe ecran.

Înapoi la textul

20.2.2 Vedere Generală (Partea a 2-a)

1. Salvare ca

2. Transfocare pe Strat

3. Ajutor

4. :guilabel:‘Randare activată/dezactivată

5. Măsurare Linie

Înapoi la textul
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20.3 Results For Lucrul cu Datele Vectoriale

20.3.1 Fiiere shape

Ar trebui să existe cinci straturi pe hartă:

• locaii

• apă

• clădiri

• râuri i

• drumuri.

Înapoi la textul

20.3.2 Baze de date

Toate straturile vectoriale ar trebui să fie încărcate în hartă. Probabil că nu va arăta frumos încă (vom înlocui
culorile urâte mai târziu).

Înapoi la textul

20.4 Results For Symbologie

20.4.1 Culori

• Verificai dacă putei schimba culorile după dorină.

• Este suficient să schimbai doar stratul apă pentru moment. Mai jos există un exemplu, dar acesta poate arăta
diferit, în funcie de culoarea aleasă.
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Note: Dacă dorii să lucrai asupra unui singur strat la un moment dat, i nu dorii ca alte straturi să vă distragă
atenia, putei ascunde un strat făcând clic pe caseta de validare din dreptul numelui său, în lista de Straturi. În cazul
în care caseta este nebifată, atunci stratul este ascuns.

Înapoi la textul

20.4.2 Structura Simbolului

Harta ar trebui să arate aa:
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Dacă suntei la nivelul de Utilizator Începător, v-ai putea opri aici.

• Utilizai metoda de mai sus pentru a schimba culorile i stilurile pentru toate straturile rămase.

• Încercai să folosii culori naturale pentru obiecte. De exemplu, un drum nu ar trebui să fie de culoare roie
sau albastră, dar poate fi de culoare gri sau neagră.

• De asemenea, nu ezitai să experimentai cu diferite setări de Stil de Umplere i Stil de Margine pentru
poligoane.

Înapoi la textul

20.4.3 Straturile Simbolului

• Personalizai-vă stratul de clădiri aa cum dorii, dar nu uitai că trebuie să fie uor să distingei diferitele straturi
de pe hartă.

Iată un exemplu:
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Înapoi la textul

20.4.4 Nivelurile Simbolului

Pentru a crea simbolul necesar, avei nevoie de două straturi de simboluri:
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Stratul inferior al simbolului este o linie solidă, galbenă. În partea superioară a acestuia este o linie de culoare gri,
solidă, ceva mai subire.

• Dacă straturile simbol seamănă cu cele de mai sus, dar nu obinei rezultatul pe care îl dorii, verificai dacă
nivelurile simbolului arată în genul următor:
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• Acum, harta ar trebui să arate în felul următor:
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Înapoi la textul

20.4.5 Nivelurile Simbolului

• Ajustai nivelurile simbolurilor la aceste valori:

• Experimentai cu valori diferite, pentru a obine rezultate diferite.

• Deschidei iarăi harta originală, înainte de a continua cu exerciiul următor.

Înapoi la textul

20.5 Atributele Datelor Results For

20.5.1 Atributele Datelor

Câmpul NUME este cel mai folositor pentru a afia etichetele. Acest lucru se datorează faptului că toate valorile
sunt unice pentru fiecare obiect, i este foarte puin probabil să conină valori NULL. Dacă datele dvs. conin unele
valori NULL, nu vă facei griji, atât timp cât cea mai mare parte din locaiile dvs. au nume.
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Înapoi la textul

20.6 Results For Instrumentul Etichetă

20.6.1 Personalizarea Etichetelor (Partea 1)

Harta ar trebui să prezinte acum punctele marcajelor i ale etichetelor decalate cu 2.0 mm: Stilul marcajelor i al
etichetelor trebuie să permită observarea pe hartă a ambelor, cu claritate:

Înapoi la textul

20.6.2 Personalizarea Etichetelor (Partea a 2-a)

O soluie posibilă o reprezintă acest produs final:

20.6. Results For Instrumentul Etichetă 587
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Pentru a ajunge la acest rezultat:

• Utilizai o dimensiune a fontului de 10, o Distană a etichetei de 1,5 mm, Lăimea simbolului and Înălimea
simbolului de 3.0 mm.

• În plus, acest exemplu folosete opiunea de Încadrare a etichetei după caracter:
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• Introducei un spaiu în acest câmp i facei clic pe Apliccare, pentru a obine acelai efect. În cazul nostru,
unele dintre numele de locuri sunt foarte lungi, rezultând astfel nume cu linii multiple, ceea ce nu este foarte
plăcut. i putea găsi această setare, ca fiind mult mai adecvată pentru harta dvs.

Înapoi la textul

20.6.3 Utilizarea Setărilor Definite cu ajutorul Datelor

• Fiind încă în modul de editare, setai valorile FONT_SIZE după dorină. În exemplu se folosesc 16 pentru
orae, 14 pentru suburbii, 12 pentru comune i 10 pentru sate.

• Amintii-vă să salvai modificările i să ieii din modul de editare.

• Întoarcei-vă la opiunile de formatare ale Textului pentru stratul locaii i selectai FONT_SIZE în Câmpul
atribut al meniului de suprascriere a dimensiunii fontului:
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Rezultatele, dacă se utilizează valorile de mai sus, ar trebui să fie următoarele:

Înapoi la textul
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20.7 Results For Clasificare

20.7.1 Rafinarea Clasificării

• Folosii aceeai metodă ca i în primul exerciiu al leciei, pentru a scăpa de frontiere:

Setările pe care le utilizai pot să nu fie similare, dar cu valorile pentru Clase = 6 i Mod = Intervale Naturale
(Jenks) (i folosind aceleai culori, desigur), harta va arăta astfel:
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Înapoi la textul

20.8 Results For Crearea unui Nou Set de Date Vectoriale

20.8.1 Digitizare

Simbolistica nu contează, dar rezultatele ar trebui să arate mai mult sau mai puin ca acesta:

Înapoi la textul

20.8.2 Topologia: Adăugarea Instrumentului Inel

Forma exactă nu contează, dar ar trebui să fie obinei o gaură în mijlocul entităii dvs., ca aceasta:
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• Anulai editările dumneavoastră înainte de a continua exerciiul pentru instrumentul următor.

Înapoi la textul

20.8.3 Topologia: Adăugarea Instrumentului Parte

• Mai întâi selectai Bontebok National Park:
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• Acum, adăugai noua parte:

• Anulai editările dumneavoastră înainte de a continua exerciiul pentru instrumentul următor.

Înapoi la textul

20.8.4 Îmbinare Entităi

• Folosii instrumentul de Îmbinare a Entităilor Selectate, asigurându-vă că ai selectat mai întâi ambele
poligoane pe care dorii să le îmbinai.

• Utilizai entitatea cu OGC_FID-ul 1 ca sursă pentru atributele dvs. (clic pe intrările sale din dialog, apoi
facei clic pe butonul Preia atributele din entitatea selectată):

Note:
Dacă utilizai un set de date diferit, este foarte probabil ca OGC_FID-ul original al poligonului dvs. să nu fie

1. E suficient să alegei entitatea care are un OGC_FID.
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Note: Folosind instrumentul de Îmbinare a Entităilor Selectate,vom păstra geometriile distincte, dar le vom
acorda aceleai atribute.

Înapoi la textul

20.8.5 Formulare

Pentru TIP există, în mod evident, o cantitate limitată de tipuri de drumuri, iar dacă vei verifica tabelul de atribute
pentru acest strat, vei vedea că acestea sunt predefinite.

• Setai widget-ul la Valorile Hării apoi facei clic pe Încărcare Date din Strat.

• Selectai drumurile din caseta cu derulare verticală a Etichetelor i autostrăzile pentru opiunile Valoare i
Descriere:
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• Facei clic pe Ok de trei ori.

• Dacă vei folosi instrumentul Identificare asupra unei străzi, în timp ce modul de editare este activ, dialogul
ar trebui să arate astfel:

Înapoi la textul

20.9 Results For Analiza Vectorială

20.9.1 Extragei Straturile dvs. din Datele OSM

În scopul acestui exerciiu, straturile OSM care ne interesează sunt multipoligoane i linii. Stratul
multipoligoane conine datele de care avem nevoie pentru a produce straturile case, coli i
restaurante. Stratul linii conine setul de date pentru drumuri.

Constructorul de Interogări se găsete în proprietăile stratului:
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Folosind Constructorul de Interogări asupra stratului multipoligoane, creai următoarele interogări pentru
straturile case, coli, restaurante i rezideniale.

20.9. Results For Analiza Vectorială 597
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După ce ai introdus fiecare interogare, facei clic pe OK. Vei vedea că harta actualizată afiează numai datele pe care
le-ai selectat. Din moment ce trebuie să utilizai iarăi datele multipoligoanelor din setul de date OSM, în
acest moment, avei posibilitatea să utilizai una dintre următoarele metode:

• Redenumirea stratului OSM filtrat, i re-importarea stratului din osm_data.osm, SAU

• Duplicarea stratului filtrat, redenumirea copiei, tergea interogării i crearea noii dvs. interogări în Construc-
torul de Interogări.

Note: Dei câmpul OSM clădiri are valoarea case, acoperirea din zona dumneavoastră - la fel ca i în cazul
nostru - nu poate fi completă. În regiunea noastră de test, prin urmare, este mai corect să se excludă toate clădirile
care sunt definite ca orice altceva decât casă. Ai putea decide să includei doar clădirile care sunt definite sub
formă de casă, i toate celelalte valori care nu au o semnificaie clară, cum ar fi da.

Pentru a crea stratul drumuri, rulai această interogare asupra stratului OSM linii:
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Ar trebui să obinei o hartă care arată similar cu următoarea:

Înapoi la textul

20.9. Results For Analiza Vectorială 601
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20.9.2 Distana faă de Licee

• Dialogul tamponului dvs. ar trebui să arate astfel:

Distana tamponului este de 1000 metri (adică, 1 kilometru).

• Valoarea Segmentelor de aproximat este setată la 20. Aceasta este opională, dar este recomandată, deoarece
face tampoanele rezultate să arate mai fin. Comparai aceasta:
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Cu aceasta:

Prima imagine prezintă un tampon cu valoarea Segmentelor de aproximat setată la 5, iar a doua arată valoarea
setată la 20. În exemplul nostru, diferena este subtilă, dar putei vedea că marginile Tamponului sunt mai fine o
dată cu valoarea mai mare.

Înapoi la textul
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20.9.3 Distana faă de Restaurante

Pentru a crea stratul houses_restaurants_500m, trecem printr-un proces cu doi pai:

• În primul rând, creai un tampon de 500 de metri în jurul restaurantelor i adăugai stratul la hartă:
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• Apoi selectai clădirile din zona tamponului:

• Acum, salvai acea selecie în noul strat houses_restaurants_500m:
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Harta dvs. ar trebui să arate acum numai acele clădiri care sunt la 50 m faă de drum, la 1 km de o coală i la 500 m
de un restaurant:
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Înapoi la textul

20.10 Results For Analiza Raster

20.10.1 Calculare Aspect

• Setai dialogul DEM (Analizei Terenului) în felul următor:
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Rezultatul dvs.:

Înapoi la textul

20.10.2 Calculează Panta (mai puin de 2 sau de 5 grade)

• Setai dialogul Calculatorului Raster în felul următor:
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• Pentru versiunea de 5 grade, folosii 2 în expresie i numele de fiier 5.

Rezultatele dvs.:

• 2 grade:
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• 5 grade:
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Înapoi la textul

20.11 Results For Completarea Analizei

20.11.1 Din Raster în Vector

• Deschidei Constructorul de Interogări făcând clic dreapta pe stratul all_terrain din Lista straturilor, apoi
selectai fila Dispoziii generale.

• Apoi construii interogarea kbd:“suitable” = 1.

• Clic pe OK pentru a filtra toate poligoanele în care această condiie nu este îndeplinită.

Atunci când sunt puse deasupra rasterului original, zonele trebuie să se suprapună perfect:
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• Putei salva acest strat făcând clic dreapta pe stratul all_terrain din Lista straturilor i alegei Save As..., apoi
continuai conform instruciunilor.

Înapoi la textul

20.11.2 Inspectarea Rezultatelor

Putei observa că unele dintre clădirile din dumneavoastră din stratul new_solution au fost “feliate” de instru-
mentul Intersectare. Acest lucru arată că doar o parte a clădirii - i, prin urmare, doar o parte a proprietăii - se află
pe terenul potrivit. Prin urmare, putem elimina sensibil acele clădiri din setul nostru de date

Înapoi la textul

20.11.3 Rafinarea Analizei

Pentru moment, analiza dvs. ar trebui să arate în felul următor:
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Luai în considerare o zonă circulară, continuă pentru 100 de metri, în toate direciile.

În cazul în care raza este mai mare de 100 de metri, prin scăderea a 100 de metri din dimensiunea sa (din toate
direciile) va rezulta o parte care rămâne în mijloc.
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Prin urmare, putei rula un tampon interior de 100 de metri pe stratul vectorial existent suitable_terrain. În rezul-
tatul funciei tampon, indiferent de ceea ce a mai rămas din stratul original, se vor reprezenta zonele în care există
teren potrivit pentru 100 de metri în orice direcie.

Pentru demonstraie:

• Mergei la Vector → Geoprocessing Tools → Buffer(s) pentru a deschide diaolgul Tampo(anelor).

• Setai-l astfel:
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• Folosii stratul suitable_terrain cu 10 segmente i o distană a tamponului de -100. (Distana este în mod
automat în metri, deoarece harta folosete un CRS proiectat.)

• Salvai rezultatul în exercise_data/residential_development/ ca
suitable_terrain_continuous100m.shp.

• Dacă este necesar, mutai noul strat deasupra stratului original suitable_terrain.

Rezultatele dvs. vor arăta în felul următor:
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• Acum, folosii instrumentul Selectare după by Locaie (Vector → Research Tools → Select by location).

• Setai-l astfel:

• Selectai entităile din new_solution care le intersectează pe cele din suitable_terrain_continuous100m.shp.
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Acesta este rezultatul:

Sunt selectate clădirile galbene. Dei unele dintre clădiri cad parial în afara noului strat
suitable_terrain_continuous100m, ele se află la fel de bine i în stratul original suitable_terrain
i, prin urmare, îndeplinesc toate cerinele noastre.

• Salvai selecia în exercise_data/residential_development/ ca final_answer.shp.

Înapoi la textul

20.12 Results For WMS

20.12.1 Adăugarea Altui Strat WMS

Harta dvs. ar trebui să arate astfel (este posibil să fie necesară reordonarea straturilor):
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QGIS Training Manual, Release 2.8

Înapoi la textul

20.12.2 Adăugarea unui Nou Server WMS

• Utilizai aceeai abordare ca i mai înainte pentru a adăuga noul server, i stratul corespunzător, aa cum este
găzduit pe acel server:
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• Dacă ai transfocat în zona | majorUrbanName |, vei observa că acest set de date are o rezoluie mică:

Prin urmare, este mai bine să nu utilizai aceste date pentru harta curentă. Datele Blue Marble sunt mult mai
potrivite la scări globale sau naionale.

Înapoi la textul

20.12.3 Găsirea unui Server WMS

Putei observa că multe servere WMS nu sunt întotdeauna disponibile. Uneori, acest lu-
cru este temporar, uneori este permanent. Un exemplu de server WMS care era fun-
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cional la momentul scrierii acestui articol este WMS-ul Lumea Depozitelor Minerale de la
http://apps1.gdr.nrcan.gc.ca/cgi-bin/worldmin_en-ca_ows. Nu există taxe sau con-
strângeri de acces i este global. Prin urmare, aceasta satisface cerinele. Reinei, totui, că acesta este doar un
exemplu. Există multe alte servere WMS dintre care putei alege.

Înapoi la textul

20.13 Results For Noiuni despre Bazele de date

20.13.1 Adresarea Tabelei de Properietăi

Pentru tabela noastră teoretică de adresare, am putea dori să stocheze următoarele proprietăi:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

La crearea tabelului pentru reprezentarea unui obiect adresă, vom crea coloane pentru a reprezenta fiecare dintre
aceste proprietăi i le vom denumi cu nume acceptate de SQL i, eventual, scurtate:

house_number
street_name
suburb
city
postcode
country

Înapoi la textul

20.13.2 Normalizarea Tabelei de Personal

Problema majoră a tabelei people rezidă în inexistena unui câmp de adresă singular, care să conină întreaga adresă
a unei persoane. Gândindu-ne la tabela noastră teoretică address de la începutul acestei lecii, tim că o adresă
este formată din mai multe proprietăi diferite. Prin stocarea tuturor acestor proprietăi într-un singur câmp, am
îngreuna mult actualizarea i interogarea datelor noastre. Prin urmare, trebuie să divizăm câmpul de adresă în
diferite proprietăi. Va rezulta, astfel, un tabel cu următoarea structură:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

Note: În seciunea următoare, vei învăa despre relaiile cheilor externe, care ar putea fi utilizate în acest exemplu,
pentru a îmbunătăi în continuare structura bazei noastre de date.

Înapoi la textul

20.13.3 Normaliarea Suplimentară a Tabelei de Personal

Tabela noastră de personal arată, în mod curent, astfel:
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id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

Coloana street_id reprezintă o relaie ‘una la mai multe’ între obiectul people i obiectul street, care este în
tabela streets.

O modalitate de a normaliza i mai mult tabela este de a împări câmpul în prenume i nume:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

Putem crea, de asemenea, tabele separate pentru numele oraului i al ării, corelându-le cu tabela noastră people,
prin intermediul relaiilor ‘una la multe’:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

O diagramă ER care reprezintă acest lucru ar putea arăta astfel:

Înapoi la textul

20.13.4 Crearea Tabelei de Personal

SQL-ul necesar creării tabelei de personal corecte este:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );

Schema pentru tabel (introducei \d personal) arată astfel:
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Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

Note: În scop ilustrativ, intenionat am omis constrângerea fkey.

Înapoi la textul

20.13.5 Commanda DROP

Motivul pentru care comanda DROP nu ar funciona în acest caz se datorează faptului că tabela people are o
constrângere de Cheie Externă în tabela streets. Acest lucru înseamnă că eliminarea (sau tergerea) tabelei streets
ar lăsa tabela people cu referine către date inexistente despre străzi.

Note: Este posibil să ‘forăm’ tergerea tabelului streets cu ajutorul comenzii CASCADE, dar acest lucru ar elimina,
de asemenea, tabela people i oricare alta care a avut o relaie cu tabela‘ streets‘. Utilizai-o cu prudenă!

Înapoi la textul

20.13.6 Inserarea unei Noi Străzi

Comanda SQL pe care ar trebui să o utilizai arată astfel (putei înlocui numele străzii cu altul, la alegere):

insert into streets (name) values (’Low Road’);

Înapoi la textul

20.13.7 Adăugarea unei Noi Persoane Cu Relaia Cheii Externe

Aici este instruciunea SQL corectă:

insert into streets (name) values(’Main Road’);
insert into people (name,house_no, street_id, phone_no)

values (’Joe Smith’,55,2,’072 882 33 21’);

Dacă privii iarăi la tabela străzilor (folosind o instruciune SELECT ca mai înainte), vei vedea că id-ul pentru
intrarea Drumului Principal este 2.

De aceea, am putea mai degrabă doar să introducem numărul 2 de mai sus. Chiar dacă nu vedem Main Road
scris integral în intrarea de mai sus, baza de date va fi capabilă să se asocieze valoarea street_id cu 2.

Note: Dacă ai adăugat deja un nou obiect street, ai putea descoperi că noul Drum Principal are ID-ul 3
nu 2.

Înapoi la textul
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20.13.8 Returnează Numele Străzilor

Aici este instruciunea SQL corectă, pe care ar trebui să o folosii:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Rezultatul:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

Note: Vei observa că am prefixat numele câmpurilor cu numele tabelei (de exemplu, people.name i streets.name).
Acest lucru trebuie să fie făcut de fiecare dată când numele câmpului este ambiguu (de exemplu, când nu este unic
în toate tabelele din baza de date).

Înapoi la textul

20.14 Results For Interogări spaţiale

20.14.1 Unităile Folosite în Interogările Spaiale

Unităile utilizate de interogarea din exemplu sunt în grade, deoarece CRS-ul pe care îl folosete stratul este WGS
84. Acesta este un CRS Geografic, ceea ce înseamnă că unităile sale sunt în grade. Un CRS proiectat, similar
proieciilor UTM, este în metri.

Amintii-vă că, atunci când scriei o interogare, trebuie să cunoatei CRS-ul stratului. Acest lucru vă va permite să
scriei o interogare care va returna rezultatele pe care le ateptai.

Înapoi la textul

20.14.2 Crearea unui Index Spaial

CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);

Înapoi la textul

20.15 Results For Construirea Geometriei

20.15.1 Crearea irurilor de Linii
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QGIS Training Manual, Release 2.8

alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(the_geom) = ’ST_LineString’::text OR the_geom IS NULL);
insert into geometry_columns values (’’,’public’,’streets’,’the_geom’,2,4326,

’LINESTRING’);
create index streets_geo_idx

on streets
using gist
(the_geom);

Înapoi la textul

20.15.2 Legarea Tabelelor

delete from people;
alter table people add column city_id int not null references cities(id);

(captura oraelor în QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’Faulty Towers’,

34,
3,
’072 812 31 28’,
1,
’SRID=4326;POINT(33 33)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’IP Knightly’,

32,
1,
’071 812 31 28’,
1,F
’SRID=4326;POINT(32 -34)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’Rusty Bedsprings’,

39,
1,
’071 822 31 28’,
1,
’SRID=4326;POINT(34 -34)’);

Dacă ai obinut următorul mesaj de eroare:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

atunci înseamnă că în timp ce experimentai crearea poligoanelor pentru tabela oraelor, trebuie să fi ters unele
dintre ele i să fi reînceput. Doar verificai intrările din tabelul de orae i folosii orice id care există.

Înapoi la textul
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20.16 Results For Modelul Entităii Simple

20.16.1 Popularea Tabelelor

create table cities (id serial not null primary key,
name varchar(50),
the_geom geometry not null);

alter table cities
add constraint cities_geom_point_chk
check (st_geometrytype(the_geom) = ’ST_Polygon’::text );

Înapoi la textul

20.16.2 Popularea Tabelei Geometry_Columns

insert into geometry_columns values
(’’,’public’,’cities’,’the_geom’,2,4326,’POLYGON’);

Înapoi la textul

20.16.3 Adăugarea Geometriei

select people.name,
streets.name as street_name,
st_astext(people.the_geom) as geometry

from streets, people
where people.street_id=streets.id;

Rezultatul:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

După cum putei vedea, constrângerea noastră permite null-uri care urmează să fie adăugate în baza de date.

Înapoi la textul
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Indici i tabele

• genindex

• modindex

• search
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